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Introduction

C*ystal Reports 2008 is the latest in a long and celebrated series of report
writers for personal computers. Crystal Reports is by far the bestselling
report writer package in the world, even though you might not know it by
name. (It’s been bundled with many of the most popular applications without
being acknowledged by name. For example, a version of Crystal Reports is
currently bundled into Microsoft’s Visual Studio .NET.) However, Crystal
Reports 2008 is available as a standalone product. And if you want to produce
a high-quality report quickly, Crystal Reports is the top choice to do the job.

About This Book

Crystal Reports 2008 For Dummies is a book that gets you using Crystal Reports
quickly and effectively. This book covers all the major capabilities of Crystal
Reports but doesn’t bog you down in intricate detail. The objective is to give
you the information you need to produce the types of reports that most
people need most of the time. I also get into some out-of-the-ordinary report
types that you might be called upon to generate on occasion.

Use this book as a handy reference guide. Each chapter deals with an individ-
ual feature that you might need at one time or another. Pull out the book,
read the chapter, and then do what you need to do. In many cases, step-by-
step procedures walk you through commonly needed operations. You might
find it worthwhile to put the book beside your computer and perform the
operations while you read about them.

Anyone who might be called upon to produce a report based on database data
can profit from the information contained in this book. It’s also valuable for
managers who might never produce a report but who oversee people who do.
This book tells you what’s possible, what you can do easily, and what takes a
little more effort to accomplish. This knowledge can help you estimate how
long it should take to produce reports of various types.

Conventions Used in This Book

When an instruction in the book refers to a command path — for instance,
“Choose File>Save” — that simply means to click your mouse button on File
on the main menu, and then choose Save from the submenu that drops down
from it.
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Anything you see that is printed in a monospaced font is code, or something
you’ll run across in the course of programming a database. This is a
monospaced font. Crystal Reports executes code that you enter as
formulas or SQL statements.

What You're Not to Read

You can certainly choose to read this book from cover to cover, working
through the examples, although you don’t have to. Regardless of whether
you read it all the way through in order, think of this book as a handy quick
reference by your side when you want to perform a particular operation you
haven’t used in a while (or ever).

An upcoming section of this introduction explains the icons you’ll normally
run across, and there is a good reason for paying attention to each of them.
However, consider yourself exempted from the requirement to read anything
that appears by a Technical Stuff icon.

Material placed next to one of these icons might be interesting to techies like
me (and like some of you out there) but generally isn’t necessary for a full
understanding of how to use Crystal Reports.

Foolish Assumptions

I've never met you, but I have to make a few assumptions about you and what
you know. For example, I assume that you know how to use a personal com-
puter and that you're somewhat familiar with Microsoft Word. If you know
how to navigate Microsoft Word, you already know almost all there is to know
about navigating Crystal Reports. The user interfaces of the two products are
similar.

[ assume that you’ve seen directory trees before, such as those extensively
used in Microsoft Windows. You know that if you see a plus sign (+) to the left
of a node that shows a folder (or other) icon, it means that you can click the
plus sign to expand that node to see what the node contains. Crystal Reports
treats directory trees in a similar way.

[ assume you know how to perform a drag-and-drop operation with your
mouse. In Crystal Reports, when you click an object and start dragging it,
your progress is shown by a rectangular placement frame. When you release
the mouse button to drop the item, the placement frame is replaced by a
duplicate of the item that you dragged.
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How This Book Is Organized

This book contains six major parts. Each part contains several chapters.

Part I: Reporting Basics

Part I introduces you to Crystal Reports and the art of report creation. You
find out what a report should accomplish and what it should look like. Then
you fire up Crystal Reports and use it to create a simple report based on data
held in a database.

Part II: Moving Up to Professional-
QOuality Reports

You can do many things beyond the basics to make reports more focused,
more readable, and easier on the eye. This part gives you the information
you need to do all those things.

Part I1I: Advanced Report
Types and Features

Part Il gets into serious report creation. With the information in this part,
you can zero in on exactly the data you want and display it in the most under-
standable way. You'll be able to nest one report within another, pull report
elements from multiple non-database sources, present multidimensional data
in OLAP cubes, illustrate points with charts and maps, and create stunning
visuals with Xcelsius and Flash. With these tools, you can produce reports fit
for the eyes of the organization’s CEO.

Part IU: Crystal Reports in the Enterprise

BusinesObjects Enterprise is a companion product to Crystal Reports that
controls and secures the distribution of reports. With it, you can make your
reports accessible to people on your local area network (LAN), or on the World
Wide Web. BusinessObjects Enterprise is also the home of the Repository,
which is a great place to store formulas or custom functions so they can be
used again.
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Part U: Publishing Your Reports

After you create a report, you’ll want to make it available to the people who
need it. Crystal Reports makes it easy for you to distribute your report for
viewing, whether to colleagues in your organization or to Internet users
around the world. In addition, you can publish your reports using traditional
methods. You can print it; export it to a file, or fax it to people far away. After
you complete report development, distribution is easy.

Although Crystal Reports does a great job when used all by itself, you can also
incorporate it into applications written in a computer language. The Crystal
Reports SQL Expression Fields facility gives you direct control over the data
in a report’s underlying database. Because a version of Crystal Reports is
included as an integral part of the Microsoft .NET application development
environment, you can incorporate the power of Crystal Reports into applica-
tions you write in Visual Basic, Visual C++, Visual C#, or any language compat-
ible with the .NET framework. This gives the applications you write the
sophistication of the world’s leading report writer.

Part Ul: The Part of Tens

It’s always good to remember short lists of best practices. That’s what The
Part of Tens is all about. Listed here are pointers that help you produce
outstanding reports with minimum effort, in the shortest possible time.

Icons Used in This Book

Tips save you a lot of time and keep you out of trouble.

Pay attention to the information marked by this icon because you might
need it.

As I mention earlier, Technical Stuff icons denote detail that I find interesting
(and you might, too). However, if you don’t, no big deal. These nuggets aren’t
essential to gain an understanding of the topic being discussed. Skip them if
you like.

Heeding the advice that this icon points to can save you from major grief.
Ignore it at your peril.
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Where to Go from Here

Now you're ready to start finding out about using Crystal Reports 2008 to
create professional-quality reports based on data stored in your databases.
After all, Crystal Reports 2008 is the latest version of the most-popular report
writer in the world. You can use it to quickly whip out simple reports, or you
can take a little longer and generate a world-class executive report.
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In this part . . .

rlere’s data in them thar databases, where it’s not
doing anyone any good by itself. And your manager
wants a coherent report, based on that data, on her desk
by the close of business today. What should you do?
Panic? Consider joining the Foreign Legion?

You don’t need to do anything that drastic. The chapters
in this part tell you how to quickly crank out the report
your boss so desperately needs. This part offers you just
what you need to know to put the needed information on
the boss’ desk before the lights go out tonight. And you’ll
start to build your reputation as a person who can deliver
the goods when the pressure is on.




Chapter 1

Transforming Raw Data into
Meaningful Information

In This Chapter
Outlining the major features of Crystal Reports 2008

Viewing an existing report

Computers can store and process enormous amounts of data, and with the
relentless advance of technology, those capabilities will soon become
even more mind-boggling. Even now, the major challenge of getting value from
computer systems isn’t to make them more powerful but rather to harness the
power they already have and in a way that delivers useful information to
people.

Megabytes or gigabytes of raw data are neither meaningful nor useful to people.
Instead, you need organized information, distilled and focused on answering
specific questions. In businesses and enterprises of all kinds, organizing and
presenting information has traditionally been the job of documents called
reports. These documents generally comprise multiple pages that can include
text, numbers, charts, maps, and illustrations. The best reports convey the
facts needed to make the best decisions, unobscured by a clutter of data
irrelevant to the task at hand.

Crystal Reports, a leading report-writing application package for more than a
decade, is by far the most commonly used report writer in the world. Many
people have used Crystal Reports unknowingly for years because it’s often
integrated with other applications and not specifically identified by name.

Major Features of Crystal Reports 2008

Crystal Reports 2008 includes all the features that made Crystal Reports XI
(its predecessor) a worldwide bestseller, plus it offers exciting new features
that save you time and effort while you develop your reports. Crystal Reports
2008 is tightly integrated so that all the individual components of the system
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work together seamlessly to support report creation, modification, and distri-
bution. And the tight integration extends beyond Crystal Reports 2008 to
BusinessObjects Enterprise, making the sharing of reports across large enter-
prises not only feasible but downright convenient.

The Explorers and Experts within Crystal Reports provide highly intuitive
visual tools that step you through creating a report. Features such as the
Repository (which applies to enterprise installations) and report templates
allow users throughout the organization to reuse components or entire
reports. There is never any need to reinvent the wheel. If a component in the
Repository or a report template comes close to meeting your requirements
but doesn’t meet them exactly, you can easily make minor modifications and
have a usable report quickly, which is a vast improvement over creating an
equivalent component or report from scratch.

Formatting a report

The primary job of a report writer, such as Crystal Reports, is to take data
from a database and put it into a pleasing, logical, and understandable format
for viewing. With Crystal Reports, you are well equipped to give your reports
the appearance you want — without having to become a formatting guru.

Crystal Reports offers both absolute and conditional formatting:

v Absolute formatting enables you to put text, titles, charts, maps, columns
of figures, cross-tabs, and graphics pretty much anywhere you want on
the screen. You can handle preprinted forms. You can optimize for screen
display or for printing on paper. This is close to the ultimate freedom in
report creation — but not quite.

v Conditional formatting takes you one step further toward the ultimate:
Using it, you can change the format of the data you're displaying in
response to the content of the data itself. With conditional formatting,
every time the data in a report changes, a formula that you include in
the report can make the appearance of the report change accordingly.

Chapter 8 covers absolute and conditional formatting.

One especially useful feature of Crystal Reports 2008 — carried over from
earlier versions — is the Report Alert. Suppose that a value being displayed
crosses a critical threshold that requires immediate action on the part of the
report’s target audience. When that threshold is crossed, not only is its value
displayed, but also a Report Alert dialog box pops up that can’t be ignored.

Another labor-saving feature is Template Expert, which enables you to create
and save a report template for later use. Imagine how much time you’ll save
if you have to quickly format multiple reports with a common look. Turn to
Chapter 8 for more about Template Expert.
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Generating barcodes

Go anywhere today, and you are bound to see barcodes. Barcodes identify
every product for sale in just about any store. They identify items of inventory
in a company’s warehouse. They identify the furniture in your office. They even
identify the cows on dairy farms. The day may not be far off when they identify
people. Now you don’t need expensive, special purpose equipment to generate
barcodes. Crystal Reports 2008 provides you with that capability, at a fraction
of what it would normally cost. Actually, if you already own Crystal Reports, all
it costs you is the label stock and the ink it takes to print on it. See Chapter 7 to
find out how to include barcodes in your reports.

Enhancing a report with formulas
and custom functions

Did I mention that conditional formatting makes use of formulas to change
the format of a report? Well, you can use formulas for far more than that. A
formula is like a little computer program that can do computations or other
manipulations of data before displaying the result. This makes Crystal Reports
more than merely a report writer that puts your data in a nice format. By
using formulas, you can make your report select specific records (or groups
of records) and display them the way you want, controlling that process by
declaring and using variables in your formulas. All the common flow-control
structures (If-Then-Else, Select Case, For,While Do, and Do While)
are available.

And after you create a useful formula to use later, you can save it as a custom
function. Custom functions are added to the standard functions that come
with Crystal Reports, keeping them available in one place.

[ discuss formulas in Chapter 10.

Getting visual with charts and maps

Crystal Reports has excellent capabilities for the graphical display of data.
All the most commonly used chart types are available, so you can display
your data in the most meaningful way. If you have geographical data, Crystal
Reports can display it in maps that show countries, regions, provinces, or
cities. A variety of methods are available to associate values with specific
regions, including colors, symbols of various sorts, and even charts.

Chapter 15 shows how you can include a chart in your report; Chapter 16
covers maps.

11
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Xcelsius integration

The Xcelsius design tool is a companion product that integrates tightly with
Crystal Reports. You can use it to create What-if scenarios in which a change
of input parameters causes an immediate change in visual indicators. You can
instantly see the result of a proposed change, before you make it. Turn to
Chapter 17 for more information about Xcelsius.

Adobe Flash integration

You can also include Flash animation files within a Crystal report, including
dynamic charts, graphics, and even video. Data in the report can be dis-
played in a dynamic manner, using Flash. Crystal Reports 2008 makes it easy
to include Flash content in your report. Chapter 17 gives some pointers on
adding Flash animations to a Crystal report.

Displaying a report

Crystal Reports is designed for distribution in today’s highly connected busi-
ness environment. You can build reports that are optimized for viewing on
computers attached to your organization’s local area network (LAN). You
can also put a report on the Web for folks viewing via Web connection and
browser.

Distributing a report

You can get your report into the hands of its intended recipients in many
ways — print and deliver, fax directly from your computer to a fax machine
anywhere in the world, or export the report to a file.

If you choose the latter approach, Crystal Reports supports many output file
formats, including HTML for viewing over the Web. At least one of these for-
mats is bound to be readable by the people in your audience. The one caveat
here is that if you export a report to any format other than the Crystal Reports
native format (. rpt), you might lose some of the report’s formatting in the
process. You can even export directly to an application, such as Microsoft
Word or Lotus Domino. In such a case, Crystal Reports launches the target
application and opens your report in it.
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Supplying Crystal Reports with data

As important as the output formats of a report are, the inputs to the report
are equally important. Crystal Reports shines in this area, too. It accepts
data from a wide variety of data sources, including personal computer data-
bases (such as Microsoft Access) as well as enterprise-wide client/server
databases (such as Oracle, IBM DB2, and Microsoft SQL Server). In fact,
Crystal Reports can accept data from any ODBC-compliant database or any
data source that complies with the Microsoft OLE DB standard. Essentially, if
your data exists in a commonly used modern data source, Crystal Reports
can use it.

The Lone Edition of Crystal Reports 2008

Whereas previous versions of Crystal Reports came in multiple editions, each
aimed toward a different audience, Crystal Reports comes in only one edition,
which contains the full feature set. Now, you will never be disappointed to
find that the edition you bought doesn’t do everything you want. You never
need to upgrade as your requirements grow. One product does it all.

Viewing a Report

The majority of this book tells you how to create a new report from data in a
database file, using Crystal Reports. It also tells you how to modify a report
S0 you can create a new report (similar to, but distinct from, the existing one).
These are concerns of the report designer. But what if you just want to view a
report that has already been designed?

The world has many more people viewing reports than creating reports: maybe
even you! No problem. Before I launch into telling you how to create reports
in subsequent chapters of this book, I briefly describe the simple process of
viewing reports that already exist.

Reading a printed report

Reading a printed report is obviously the simplest (but also the most limited)
way to get the information you want. It doesn’t take a lot of technical sophis-
tication to read text and view charts and maps on a sheet of paper. People
were doing so long before computers came along.
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For some kinds of information, however, printed reports aren’t as valuable as
those you can view online. For example, printed reports aren’t updated when
the database from which they were derived is updated. Thus, printed reports
might contain obsolete — thus misleading — information. This is a factor you
must always bear in mind when basing decisions on printed reports.

Viewing a report with Crystal Reports

As you might expect, you can do more than just create or modify a report with
Crystal Reports software: You can also view an existing report. This has some
major advantages over reading a printed report, provided that you have
Crystal Reports software installed on your computer:

v The report is connected to the source database while the report is
being viewed. This is an obvious advantage. If the data in the database
has changed since the last time you viewed it, you can refresh the report
before you view it again by pulling current information from the data-
base. Crystal Reports automatically checks the database to see whether
it has been updated since the last time your report was run. If so, it asks
whether you want to refresh the report with current data.

+* You can use the drill-down capability of Crystal Reports to selectively
view the detail underlying summary reports. This enables you to get
an overview of the subject by viewing the summary, and then drill down
into the specific parts that interest you for more detail. (For more on
drill-down, see Chapter 6.)

v Viewing a “live” report gives you access to the way Crystal Reports
uses hyperlinks. You can follow a hyperlink from one part of a report to
another part, from one report to another report on the same computer,
or from one report to a report on another computer on your network.

+* You can view reports that include color graphics or color text. For the
many people who don’t have high-speed color printers, this provides a
way to access the full richness of a report’s contents.

To view an existing report (on a computer with Crystal Reports installed),
follow these steps:

1. Launch Crystal Reports from your computer’s Start menu.

Crystal Reports appears, displaying the Start Page, as shown in Figure 1-1.
You can choose to start a new report or open an existing report. Several
existing reports that have been used recently are listed, or you can go to
a larger list of report files if you don’t see the one you want in the list. In
addition, use any of the several tabs in the lower part of the screen to
access a variety of helpful resources.
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2. Select the report that you want to view and then click OK.

If you don’t see the report you want, click Open File and use the Open
dialog box to select any report available on the system.

Crystal Reports retrieves and displays the report, as shown in Figure 1-2.
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3. Move through the report.

Scroll around the report, and move back and forth among its pages. You
can drill down into any summary report that supports drill down. If the
report contains hyperlinks, you can follow them to other locations in
the report or in other reports.

4. When you’re finished viewing the report, choose File=>Close to close it.

Viewing a report on a LAN or on the Web

You can use Crystal Reports Server (a separate product) to display your reports
to 20 simultaneous users on a LAN, or use BusinessObjects Enterprise to dis-
tribute the report to thousands of enterprise users or millions of users on the
World Wide Web. Users on a LAN that’s directly connected to Crystal Reports

Server can use the free Crystal Reports Viewer to access the reports they
need.

Users on the Web can view reports with a standard Web browser, such as
Internet Explorer or Firefox.



Chapter 2

Create a Simple Report
Right Now!

In This Chapter
Starting Crystal Reports

Creating your first report
Printing your report

Troubleshooting your report

Wlen you start Crystal Reports, you generally want to do one of three
things:

1 Create a report.
v Modify a report.

v Run a report against the data in your database.

You use reports to take data from a database and then process, format, and
finally output that data to a printer, computer screen, or Web site.

You probably chose Crystal Reports because you have a database that con-
tains information that’s important to you. In all likelihood, the data in that
database changes with time, and you want to be able to keep up with its
current status. Sure, you could retrieve the information you want by making
SQL queries, but that would be too much like work. It’s far better to create a
report with Crystal Reports, and then run the report whenever you want the
latest status of the information of interest. You need to create the report only
once, and then you can run it many times, getting the latest results with each
successive run. You don’t have to learn SQL or any other method of pulling
data from a database. Reports created with Crystal Reports are easy to build,
easy to read, and easy to understand. What could be better?

Crystal Reports gives you tremendous freedom in how you can lay out your
report. It also gives you great latitude in what you include in the report. In
addition to text and columns of numbers, you can include graphical images,
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charts, graphs, and maps. You could even crank out a full-length science fic-
tion novel with Crystal Reports if you wanted to (although other tools are
better suited to that task).

In this chapter, [ walk you through building your first report from scratch,
using the Crystal Reports sample data as its basis. The sample’s tables are
filled with data that you can manipulate and display with Crystal Reports.
You can use this sample data as the basis for your first report. And if you're
not exactly sure what you need to choose from the sample database in this
first-run report, don’t worry: I take you through all your choices, including
which tables and what data items to use, how to manipulate the data, format-
ting the report, and ways to output the report.

First Things First: Finding
the Sample Database

\\3

Crystal Reports has a sample database you can use for practice. It’s a Microsoft
Access database for a fictitious bike shop, named Xtreme Mountain Bikes,
Inc. If you don’t have a copy of xtreme .mdb on your computer, you can
download a copy (a Zip file) from the Business Objects Web site at

http://support.businessobjects.com/downloads/samples.asp

Unless you recently downloaded the sample database, you probably have an
older version of xtreme .mdb. This older version works fine. With the 2008
release, Business Objects made a serious attempt to reduce the “installation
footprint” of the product. To do that, Business Objects left out a number of
files that had been included in earlier versions. Many of these (including
xtreme.mdb) are available for download from the Business Objects Web
address.

The xtreme .mdb database contains a number of database tables that are
representative of the tables that a real-world bike wholesaler might maintain.
As I mention earlier, these tables are filled with sample data that you can
manipulate and display with Crystal Reports.

Starting Crystal Reports 2008

The first step when creating a report is to launch Crystal Reports from the
Windows Start menu. When you do, the Crystal Reports Start Page appears,
shown in Figure 2-1.
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If you're using Crystal Reports to report on the
contents of a database, you need to know what
a database is. In the loosest sense, a database
can be any collection of data items organized in
any way. Crystal Reports can deal with data in
several formats, but primarily it deals with the
data in relational databases. Relational data-
bases contain data in one or more tables that
are organized like spreadsheets, with rows and
columns. Each table contains data items that
are related to each other. One table might con-
tain data on a company'’s customers. Another

What's a database?

might contain data on the company's products.
Each column in a table deals with a specific
attribute, such as a customer’s last name or a
product’s unit price. Rows in a table would con-
tain the information on a specific data element,
such as Ms. Jones in the customer table or
bicycle in the product table. The columns in a
table are sometimes called attributes or fields.
The rows in a table are sometimes called
records. Don't be confused if you see these ter-
minologies intermixed. They are often used
interchangeably by database practitioners.

You can choose from among five different ways to start a new report. You can
create a Crystal Reports document by using one of several wizards or by
starting with a blank report. Alternatively (as | demonstrate in Chapter 1),
you can open a report that already exists, either to change it or to run it.

Although using the wizard can be a time- and labor-saver, it does constrain
the form of a report. The special-purpose report wizards, such as the Cross-
tab Report Wizard, are great for creating certain specialized reports. This
chapter takes you right to the point and shows you how to create a report
your way, starting from a blank report instead of using a report wizard.
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Part I: Reporting Basics

Creating a Report with the
Blank Report Option

|
Figure 2-2:
The
Database
Expert
dialog box
shows
where to
find your
source data.
|

As I allude in the introduction of this chapter, here’s what you need to decide
upfront when creating a report:

v Which tables in the database contain the data you want

v Which data items you want from those tables

» What manipulations of the data to perform to give you the information

you want

+ How you want your report to be formatted

v Whether the users of your report will retrieve it from a black-and-white
printer, color printer, local computer screen, or Web site

1. Start Crystal Reports.

For now, imagine you already know all those things.

To create a report from scratch, follow these steps:

The Crystal Reports Start Page appears; refer to Figure 2-1.

2. Select the Blank Report option.

The Database Expert dialog box appears, as shown in Figure 2-2, which
shows you possible places to find the source of your data.
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3. In the Available Data Sources pane, click the plus sign to the left of the
Create New Connection folder to expand it.

This is the folder you choose when you create a report from scratch.
Once you have connected to a database, Crystal Reports remembers
where it is from then on.

4. Double-click the database type that matches your data source.
Crystal Reports recognizes a variety of different database types.

You must select the right type. If you don’t know which type is correct,
ask someone familiar with the data source.

To follow along with this example, double-click Access/Excel (DAO). The
Access/Excel (DAO) dialog box appears, as shown in Figure 2-3.

Access/Excel (DAO) J

Connection
Please enter connection information...

Database Name [
Datahase Tyne Arress v|
Secure | agon O

Firush | l Cancel J | Help

5. Click the ellipsis (...) button to the right of the Database Name field.

The Open dialog box appears. If you are lucky, it displays the folder that
contains the xtreme . mdb database file. The sample database —
xtreme.mdb — is located wherever you placed it after you downloaded
it. You might have to browse to find this file on your system.

6. Locate the xtreme .mdb on your computer and click the Open button
to open the database file and dismiss the Open dialog box. Then, back
in the Access/Excel (DAO) dialog box, click Finish.

Database Expert reappears, as shown in Figure 2-4, with the xtreme . mdb
database connected. You can tell the connection is successful if you see
Add Command, Tables, Views, and Stored Procedures listed below the
connection in the Available Data Sources pane.
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7. Expand the Tables node, and then double-click the table on which you
want to base your report.
To follow along with the example, double-click Product.
The reference is moved to the Product table from the Available Data
Sources pane to the Selected Tables pane as shown in Figure 2-5.
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8. Click OK to close Database Expert.

A blank report fills the window, as shown in Figure 2-6.
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The Design tab (on the left edge) shows five sections of the report:

v Report Header: Appears only at the top of the report; the first thing that
a viewer sees

v~ Page Header: Appears below the report header and at the top of all other
pages in the report

v Details: The actual content of the report
1 Report Footer: Appears after the last detailed information in the report

1 Page Footer: Appears at the bottom of every page of the report

The toolbars at the top of the window give you immediate access to the
major features of Crystal Reports. You are probably already pretty familiar
with the first two toolbars, the Standard toolbar and the Formatting toolbar.
They are similar to the corresponding toolbars on any Windows application,
with a few additional items are specific to Crystal Reports. If you hover your
cursor over any of these, a tooltip appears, telling you what each one is.

The third toolbar actually combines three separate toolbars: the Insert Tools
toolbar, the Expert Tools toolbar, and the Navigation Tools toolbar. Figure 2-7
shows these toolbars.
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Allocating more space to the layout

Depending on the resolution of your computer screen, the Crystal Reports
window might not display the full width of your report. You can give yourself
a little more width in your display by changing one of the display options.
Follow these simple steps:

1. Choose File~>Options.

The Layout tab of the Options dialog box appears, as shown in Figure
2-8. Think of this as Control Center for the appearance of your report.

2. In the Design View section, select the Short Section Names check box.

This reduces the section names on the left edge of the window to one-
or two-letter abbreviations, freeing up a little horizontal real estate.

3. Click OK.
4. Drag the left edge of Field Explorer farther to the right.

You won'’t need Field Explorer right away. It’s your primary tool for
placing data into your report.

This allocates more horizontal space to the work area, which allows you
to view more of the report without resorting to horizontal scrolling.

[[] Short Saction Mamee
Show Hidden Scctiona

Grid optiona

[ Seiap To Grid

Grd Size:
0.083
n
Held opfions
[+] Stvaw Field Meess
Insest Uetail Field Headings
Insest Group Name with Group

|
Figure 2-8:
Control the
appearance
of your
report here.
|

Options 3]

Forts Smart Tag & HTML Preview Dependency Checker

Layout Databass Formula Editor Reporting Fielde

Miesign View Preview

|| Rudern || Ruters

[] Guscietines [ Guideines

[ Grid [1Grd

Tool Tips Tool Tips

Saction Namee
Page Breaka in Wide Pages
Pages Start With.

@ Full Size (100 %)

() Ft Wickh

C) Fil Page

Deaplay Proview Pancd




Chapter 2: Create a Simple Report Right Now! 25

Introducing your report

The Report Header area (at the top of the first page of the report) is the ideal
place to tell the reader exactly what the report contains. However, this forces
you, right here at the beginning, to decide what the report is to contain. No
problem: Start by considering who your target audience is and what they want
to know. (You can read more about making these decisions in Chapter 3.)

If you are Xtreme Mountain Bikes — and for this example, you are — the
target audience for your Products report is potential customers. They surely
will want to know what products you carry, including information on color
and size, where appropriate. They probably want price information. They’ll
also need to know the stock number of an item so they can specify it properly
when they decide to purchase a bike.

Adding a company logo to a report header

Placing your company logo in the report header also makes sense.
Unfortunately, the Xtreme logo isn’t available conveniently on the Crystal
Reports distribution CD or on the Business Objects Web site. For the pur-
poses of this demonstration, any logo-sized image file in one of the popular
image file formats such as JPEG or GIF will do. BMP files are not supported,
however. You can add one to the report header along with a title, such as
Product Price List.

To add a logo to a report, do the following:

1. Dismiss Field Explorer, if necessary, by clicking the X in its upper-
right corner.

2. With the Design tab selected, click the Insert Picture icon on the
Insert Tools toolbar.

You can find out the name of a toolbar icon (such as Insert Picture icon)
by hovering your cursor over it. After a few seconds, a tooltip appears,
telling you the name of the tool.

A dialog box appears, displaying the image files in the Databases folder.
had no image files in my database folder, so I looked around until I found
a sample report with the logo on it. I copied it, saved it to JPEG format,
and then inserted it into my report. Perhaps you’ll find a suitable image.
Anything that is approximately the right size and shape is fine. Your
organization’s own logo would do, as would a drawing your child made.

3. Click the picture’s filename to select it, and then click the Open button.
An outline of the logo appears on the report layout. Place it in the
upper-left corner of the report header with the mouse, and then click
to fix it in place.

Figure 2-9 shows the result.
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Adding a report title to your report header

Next, put a report title into the Report Header section. To do this, you use
several tools from the Insert toolbar.

1. Pull down the dividing line between the Report Header section and
the Page Header section so that you can place the report title below
the level of the logo.

To pull down a dividing line, hover the cursor over it until the cursor
changes shape, click and hold the left mouse button, drag the line to
where you want it, and then release the mouse.

2. Click the Insert Text Object icon on the Insert Tools toolbar.
The cursor changes to a plus sign (+).

3. Move the cursor into the Report Header section, just below the logo.
Click the mouse button to establish the upper-left corner of the text
box and then drag across the page and release the button at the
lower right of the Report Header section.

A text cursor starts to blink inside the rectangle you created.
4. At the blinking cursor’s location, type the report title.
For the example, type Product Price List.

5. Select the title you just typed, and then increase its size by clicking
the Increase Font Size icon on the Formatting toolbar.
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6. Make the title bold by clicking the Bold icon on the Formatting
toolbar.

7. Click the Align Center icon to locate the title in the center of the page.

Your report should look similar to Figure 2-10.
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Choosing the fields that
appear in your report

The next logical step is to place in the Details section the fields you want the
report to display. Simply follow these steps:

1. In Field Explorer, click the plus sign to the left of Database Fields;
click the plus sign to the left of Product to display its fields.

Because the Product table is the only available data source, it’s the only
one listed.

If Field Explorer isn’t visible, choose View=>Field Explorer from the main
menu.

Field Explorer displays the fields in the Product table, as shown in
Figure 2-11.

A\
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|
Figure 2-11:
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2. Click the first field that you want to include in the report, and then

drag it to the left edge of the Details section.

For this example, click the Product ID field. When you drag the field, a
rectangle appears. The field name appears in the rectangle in the Details
section and also above it in the Page Header section. Later, you might
want to change the column titles in the Page Header section for cos-
metic reasons. For now, just leave the default column titles.

3. Repeat Step 2 for any other fields that you want to include in the report.

For this example, place the Product Name, Color, Size, and Price (SRP)
fields in order in the Details section, leaving just a little space between
them.

Crystal Reports 2008 automatically adjusts the fields displayed to match
the field sizes you chose, and also spaces them proportionally. You can
manually adjust the field sizes by grasping the handles on the left and
right edges of the fields and moving them. Resize the fields and move
them back and forth until you arrive at a good balanced appearance.

At this point, your report layout should look similar to the one shown in
Figure 2-12.
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Improving the readability of page headers

Everything in the Page Header section appears just below the Report Header
on the first page of the report and at the top of all following pages. By default,
the field names in the Page Header section are displayed in a normal font and
underlined. I think they look better in a bold font and not underlined, so |
select the Bold attribute for each of them and deselect the Underline attribute.
I'll wait to see what the report looks like before deciding whether [ want to
change the font size as well. Figure 2-13 shows the layout with the enhanced
column headings.
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Previewing the report

rhl So far, you've been able to see the layout of your report only in the sectioned
| structure of Design mode. To get a better idea of what the report looks like at
this point, switch to Preview mode by clicking the Print Preview icon on the
Standard toolbar. This displays the Preview tab in the upper-left corner of
the work area and displays your report, complete with data pulled from the
Products table. Figure 2-14 shows as much of the report as the screen can
hold.

Note a few things about the report at this point.

v Crystal Reports automatically inserts commas between groups of three
digits in number fields, such as the Product ID field. This is not what
you want.

v The Product Name field isn’t wide enough to display the full names of
some products.

v The Color attribute must not apply to gloves because no color informa-
tion is shown for the glove products (that you can see). For all we know,
some gloves listed farther down in the report than is currently visible
could have a color attribute.
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|
Figure 2-15:
Selecting a
different
numeric
format.
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The fact that gloves have no color isn’t a problem, but the comma in the
middle of the Product ID is a problem, as is the short field width. You can
correct these as follows.

To fix the comma issue

1. Click the Design tab to return to Design mode.

2. In the Details section, select the field whose number format you want
to change.

For this example, right-click in the Product ID field.
3. From the contextual menu that appears, choose Format Field.

Format Editor appears.

4. From the Number tab, choose the numeric format that you want and
then click OK.

For this example, you want the format with no commas, as shown in
Figure 2-15. This changes the format of the Product ID field to eliminate
the unwanted commas.
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To fix the field width issue

1. Back in Design mode, click in the Product Name box in the Details area
to select it, and then move the cursor over the right edge of the box.

The cursor changes to a two-headed arrow (<—>).

2. Drag the right edge of the box further to the right, to allow more room
for long product names.

Verify your changes by returning to Preview mode. The commas are gone,
and the product names are now fully visible. By moving the sliders at the
right and bottom edges of the report window, you can verify that all columns
and rows are as they should be.

Page footers carry useful information

The bottom of each page offers you a great opportunity to display useful
information, such as page number. (Hint: If you've ever dropped a stack of
reports off your desk, you know that page footers can be a valuable aid to
putting them back in the proper order.)

When using the Product Price List, a report title and the date printed are
valuable additions to the page footer. (Prices tend to change frequently in
a fast-moving industry such as the mountain bike business, so the date

of a price list is very important.)

In Design mode, follow these steps to create a page footer for your report
that includes these three items (title, page number, and date printed).

Here’s how to put useful information into a page footer:
1. Back in Design mode, click the Insert Text Object icon on the Insert

Tools toolbar.

For this example, all the items you want to place in the page footer are
text items.

2. Place the text object rectangle in the Page Footer section and expand
it to cover the full width of the page.

3. Click the Align Center icon.

You don’t have any text yet, but you will.
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4. At the blinking cursor in the text field rectangle, type the report title,
followed by a comma and a space.

Type Product Price List, for this example. then a comma and a space.
Next, place the current date and page number into the page footer:

1. In Field Explorer, scroll down to Special Fields and expand it.
You expand a node by clicking the plus sign to its left.

2. Click the Print Date icon or the Print Date name next to it, and drag it
to the Page Footer area, right after the comma.

3. After the Print Date field is in position, type a comma and space after
it, and then type Page followed by a hyphen.

4. In Field Explorer, click the Page Number icon or the name next to it,
and drag it to the right of the hyphen.

This gives you an arrangement that looks much like Figure 2-16.

5. Click the Preview tab at the top of the work area to switch to Preview
mode.

The field names are replaced by actual values, as shown in Figure 2-17.
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|
Figure 2-17:
Page footer
in Preview
mode.
|
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Wrapping things up with a report footer

For some types of reports, you want a final item to close out the report, appear-
ing after the last of the data on the final page. These are report footers, which
are different than page footers. A report footer comes immediately after the last
line of detail information but before the final page footer. This would be a good
place, for example, to put a grand total for the entire report. If your report does
not have a grand total, you can use this section in other ways.

To illustrate this feature of Crystal Reports, put a company slogan at the
bottom of the Product Price List. Place the slogan Xtreme Mountain Bikes
Take You to the Limit into the Report Footer section the same way that you
put the report title into the Page Footer section. (See the preceding section
for the details on how to do this.) The result, in Preview mode, looks like
Figure 2-18.

Recording helpful information
about your report

If you've followed this chapter to this point, the Product Price List report is
essentially complete. Now you might want to generate some descriptive
information about the report that’s associated with the report but not nor-
mally printed or displayed. Crystal Reports has a provision for this. To add
some descriptive information, follow these steps:
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2. Fill in the text boxes with whatever information you want to associate
with your report.
[ added the information shown in Figure 2-19.
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3. Click OK.

The document properties you entered are stored along with the report;
they can be retrieved whenever anyone views the report with Crystal
Reports.
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Printing a Report

Printing a report from Crystal Reports is really easy. Open the report in
Crystal Reports and then click the Print icon or choose Filec>Print=>Printer.
Print the report the same way you would print any document in Microsoft
Windows.

Where to Go from Here

Sometimes the vision you have in your mind is not adequately reflected in
the report you produce. Perhaps your vision isn’t something that can be built
in the real world. You can’t do much about that. But you can do something
about other reasons, such as not using Crystal Reports properly or not being
aware of all its capabilities.

As I mention at the beginning of this chapter, Crystal Reports gives you tremen-
dous freedom in how you can lay out your report as well as what you can
include. Maybe text works better than columns of numbers, or your report
might benefit from using graphical images.

The bottom line is this: If you feel sure that a report ought to be able to include
something, you can almost certainly do it with Crystal Reports. This book
tells you about many of the most powerful and useful features of Crystal
Reports. If | don’t mention a feature or capability that you’d like to use, it
may nonetheless be available. Check the online help for additional informa-
tion on advanced features. Crystal Reports is a product of Business Objects,
an SAP company. More information on Crystal Reports can be found at www .
businessobjects.com.
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Report Design Guidelines

In This Chapter

Defining the purpose of your report

Deciding what your report should include
Linking a report to a database

Laying out a report

Conveying the right message

No book can tell you in a step-by-step manner exactly how to build the
report you want. However, in this chapter, [ show you some general
principles of good report design as well as some common types of reports.
From those general principles and examples, you can decide how best to
design reports that meet your specific needs.

Defining an Effective Report Design
An effective report design depends on many factors:

v The data that the report draws from the database

v How the database is structured

v The level of detail that the users of the report require

v The purpose of the report

v The capabilities of the computer that displays or prints the report

v What the users of the report really need (understanding this is critical)

Defining Your Audience

Every report has a definite audience. Here’s a key question to ask when you
begin to develop any report: “Who will be reading this report?”
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Some potential audience members might be familiar with the information
that the report contains. These people might prefer a streamlined presenta-
tion of the data. Other audience members might be unfamiliar with the report
content, so you might have to translate terms, use graphical devices (such as
charts), and include explanatory text. If you have two such divergent audi-
ences, consider producing two reports. Both contain the same information,
just presented in different ways.

Other questions to ask are, “What information does the audience need, and in
what form should it be delivered?” If your audience needs different sets of
facts for different purposes, you might be better off creating several reports,
each one focused on one specific purpose.

Although writing a report with one consistent audience in mind is the best
approach, sometimes you have to design a report for multiple audiences,
each with its own needs. The challenge is to give each audience the informa-
tion they need in a form they can easily understand, without handicapping
the members of other audiences by subjecting them to irrelevant material.
The key is to organize the information so members of each audience can
quickly and easily find and understand the information of interest to them.
Make sure to place critical information in a prominent place.

Defining the Report’s Purpose
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In addition to having a specific audience, your report should be restricted to
one specific purpose — and accomplish that purpose by providing thorough,
accurate, and timely information to the target audience. This information,
more often than not, is the basis for important decisions that the readers of
the report will make.

Restricting a report to serving a single purpose does everyone a favor. Reports
that cover multiple topics generally don’t do justice to any one of them and
tend to confuse readers. A good report covers a single topic and conveys a
message that the reader can easily comprehend and act upon.

Knowing how important the report is to its audience can also affect the amount
of time and effort you put into creating it. Is the report likely to be a basis for
“bet-the-business” decisions? Or does it simply make visible some facts that
are nice to know but not earth-shattering?

Another consideration is how often the report will be run. Some reports are
one-shot affairs: run once against the database, never to be run again. Other
reports are run repeatedly — say, weekly, monthly, quarterly, or yearly — and
need the latest information in the database every time. Reports that are run
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multiple times, by multiple people, deserve more attention to detail than
reports run only once.

Choosing Content for Vour Report

After you know who the report is for, and the kinds of decisions your audi-
ence wants to base upon the information in the report, it’s time to decide
exactly what information should be in the report. Leaving out distracting,
irrelevant material is just as important as including material of interest.

The best reports are succinct and to the point, offering readers the informa-
tion they want right away, minus the clutter of information they don’t care
about. Keeping in mind the audience and the purpose of the report, also
consider what level of formality or informality is most appropriate.

If your report has to meet the needs of several audiences, shape its content
along these lines:

v Determine which audience is the most critical.
v Determine which information is the most important to that audience.
v Display the most important information most prominently in the report.

v Put other, less-important information for the most critical audience in a
nearby but subordinate position.

v For the other audiences, cluster the information in such a way that each
group reading the report can find all the information it needs within a
single area of the report.

Choosing the Report Appearance

After you determine your audience and what the report needs to contain, the
next decision is how to present that information to that audience. Information
can be presented in a report in many different ways — narrative text, tables
of numbers, and (between those two extremes) various other methods, each
effective in its own way for certain kinds of display.

For example, if you want to produce a report on video game sales figures, you
would probably present the information in one format for game-industry
executives and in an entirely different format for teenage video game enthusi-
asts. The information in both reports might be identical — but to be effective,
the presentation of data should be vastly different.
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Making a good first impression

The old adage goes that when you meet folks for the first time, they form an
impression of you within the first 30 seconds. They decide whether they like
you, trust you, or respect you. That snap judgment, based on 30 seconds of

input, affects how they deal with you from then on.

Salespeople have known the truth about first impressions for a long time,
which is why they “dress for success” when making a sales call. They want

to make a good first impression so their prospect will be predisposed to like
them, trust them, respect them, and buy from them. For all the same reasons,
you want every report you create to make a good first impression so its read-
ers buy into what you’re selling: the information in your report.

One important way to make a good first impression is to make the appear-
ance of your report appropriate for the audience and for the occasion. Know
who your audience members are and what they expect this particular report
to tell them. When they look at the first page of your report, it should imme-
diately meet their expectations. They should see a clear indication of what
the report is, and an engaging presentation of the information they’re most
interested in.

Thus, burying the most important information somewhere in the back pages
of the report would be a mistake. For some reports, it may even be appropri-
ate to state the conclusions that can be drawn from the data, right up front.
It can encourage readers to dig deeper and digest the data pulled from the
database that backs up your conclusions.

Deciding how best to present
the information

The Report Creation Wizard, accessible from the Crystal Reports 2008 Start
Page, gives you a total of six different ways to format your report: columnar,
tabular, or justified layout, in either portrait or landscape orientation. For
reports that don’t have to impress anybody (or for quick-and-dirty reports
that you intend to run only once), one of these six options is probably fine.
I show you how to use the Report Creation Wizard in Chapter 4.

For more elaborate applications, your best bet is to create the report from
the ground up, using Design view. Do that by specifying Blank report on the
Start Page. In Design view, you have complete freedom to arrange the various
report elements on the page. You also can use many more different kinds of
report elements than the Report Creation Wizard allows, and add functional-
ity way beyond merely displaying data from the database. Throughout this
book, I show you sophisticated ways to give your report’s readers the infor-
mation they want, in the most effective way.
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Choosing graphic elements for your report

If a picture is worth a thousand words, a graph is worth a lot more than a
large table of numbers. Graphs and charts are valuable parts of any report
that needs to show relationships between data items or trends in data. |
discuss charts and graphs in Chapter 15. Some types of reports — such as
those displaying sales figures for a product or for a family of products —
have much more impact if they include graphs of the data along with the
figures that back up the graphs. Other types (such as membership lists for
organizations) won’t benefit from graphs or charts.

Pictures — such as photographs, illustrations, line drawings, or even Flash
animations — can greatly increase the value of some types of reports by pre-
senting the information in an immediate, visual way. The more pathways into
the brains of the readers you use, the more likely that they’ll fully receive and
appreciate your message.

If you think that a graph, chart, or other illustration would improve the
understanding and acceptance of the content of a report, consider adding
such an illustration. If you think such an addition would not improve things,
then don’t include one. Extraneous illustrations can distract from the mes-
sage your report is supposed to convey.

Style communicates meaning, too

The text, numbers, and graphs in a report embody the data, but how these
report elements are put together — as well as the judicious use of fonts,
color, layout, and white space — can also make an impression on the reader.
You want that impression to be favorable. Give some thought to how to use
all these style elements together to create the desired effect.

You want to communicate with the reader on an emotional level as well as on
an intellectual level. If, for instance, your report is designed to inform potential
investors about the benefits of investing in your company, the report should
convey an aura of professionalism but at the same time be consistent with
the business you're in. The prospectus for an investment-banking firm should
have a very different style from the prospectus for a cutting-edge video game
company. Each should convey the idea that the company understands the
business it’s in, but the difference in industry dictates different presentation
of company information. Reports should convey a style that readers would
expect to see from the top organization in its field. Style adds credibility, on
an emotional level, to the facts being presented.
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Choose readable, appropriate fonts

Modern word processing software makes available to you an almost infinite
variety of typefonts. You can also choose from among thousands of colors
for your text, and font sizes that range from practically invisible to one
where you can barely fit a single character on a page. Of course the tradi-
tional attributes of bold, italic, and underline are also available to you.

It is tempting to go wild with fonts for titles, column headings, text, and lists.
The use of too many style elements can be distracting. Choosing a few good
font styles that are appropriate to the content and the audience communi-
cates your message better.

Pay attention to layout

Page layout can also either help or hinder comprehension. Don’t try to cram
too much onto a single page. Make judicious use of white space. Sometimes
a background color other than white is a good idea. Always keep your target
audience in mind. What kind of layout would be most appropriate for the
people you are trying to reach? Ask yourself that question and then design
your layout accordingly. Controlling report layout is something you have
considerable control over if you start with a blank report. Your options are
much more restricted if you use one of the report creation wizards.

Making sure your report
conveys your message

Sometimes all a report needs to do is present facts in a straightforward way.
Membership lists, price lists, and inventory lists fall into this category. Another
category of reports, however, must do more to be effective. These reports try
not only to give the reader information, but also to change the reader’s think-
ing. To influence a reader, the sum of what’s in the report should convey a
uniform and unmistakable message. To make sure that point gets across,

you may want to state it explicitly at the end of the report. Crystal Reports
provides a space for a report footer, which is an ideal place for any such sum-
marizing text. If appropriate, it might also include a call to action. You can
read about report footer creation in Chapter 2.
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In This Chapter

Using the report creation wizards

Getting your report data

ou can start a report in any of several ways. Chapter 2, for example,
shows how to create a report from scratch, starting with a blank report
file. Another way is to use an existing report as a template; the new report has
different content but is structurally similar to the existing report. Generally
the quickest way is to use the Report Creation Wizard, which does much
of the work for you but makes some assumptions that limit your options.

This chapter follows the speediest approach: I walk you step by step through
building a report with the Report Creation Wizard. If you take this route, you
do give up some freedom and flexibility (compared with the from-scratch
approach), but you spend less time because the wizard does much of the
work for you — fast.

Using the Report Creation Wizard
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Using the Report Creation Wizard is often the best way to create a report that’s
conceptually simple and doesn’t require unusual formatting or a custom
appearance. The wizard is easy to access and offers a few standard layouts.

If you produce a report that’s close to one of the templates used by Standard
Report Creation Wizard, it’s usually quicker and easier than designing a
report from scratch.

When you first launch Crystal Reports, it displays the Start Page. Several wiz-
ards are listed. For example, select the plain-vanilla one named Report Wizard.
The wizard goes into action and displays the Standard Report Creation
Wizard dialog box, as shown in Figure 4-1.
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This looks very much like the Database Expert dialog box in Chapter 2; it acts
in much the same way, too. Follow along to create a report with the wizard.

Creating a report with the Standard
Report Creation Wizard

Start with a standard report, which is the one most people need most of the
time. The example is from the fictitious Xtreme Mountain Bikes Inc., which is
a business that sells mountain bikes and associated accessories. However, its
information needs are much the same as the needs of any business that buys
products from suppliers and sells them to customers. Thus, the kinds of stan-
dard reports that Xtreme needs are representative of the reports that many
retail or wholesale businesses would find useful. All the data for Xtreme’s
reports is contained in the xtreme . mdb database file (see Chapter 2 for
details about Xtreme).

Suppose that Xtreme’s sales manager wants a report on all orders placed in
December 2004. She wants the report to include the order date, order number,
salesperson’s name, and order amount. To build this report, data must be
extracted from two different tables. Follow these steps to get it done:
1. Start Crystal Reports.
The Welcome to Crystal Reports dialog box appears.
2. Make sure that the Report Wizard option is selected, and then click OK.

The Standard Report Creation Wizard dialog box appears (refer to
Figure 4-1).
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3. Connect to the target database (xtreme .mdb) if you are not already
connected.

See Chapter 2 if you don’t know how to connect to your database.

4. Click the plus sign to the left of the database name, and then click the
plus sign to the left of the Tables item.

A list of all the tables in the database displays.

To follow along with the example, click the plus sign to the left of the
Xtreme sample database, xtreme .mdb, and then click the plus sign to
the left of the Tables icon. You see the names of the tables in the data-
base, as shown in Figure 4-2.
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5. Select the tables that contain data that will be used by the report,
moving them to the Selected Tables pane.

To follow along with the example, double-click the Orders table in the
Available Data Sources pane to move it to the Selected Tables pane. Do
the same for the Employee table.

6. Click Next.

Standard Report Creation Wizard displays Link view.

The main pane in Link view shows the tables, along with the link between
them. Figure 4-3 shows what Link view looks like at this point.

b5
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The Standard Report Creation Wizard has inferred that columns with the
same name in different tables refer to the same objects — a valid assumption
in this case, but this may not always be true. If any link that the wizard has
assumed is incorrect, you can change it manually: Just click it to remove it,
and then drag the pointer from the first table to the appropriate column in
the second table add a new link.

After tables and links are arranged to your satisfaction, do the following to
continue with the example:

1. Click Next in Link view of the Standard Report Creation Wizard.

Fields view appears.

. From the selected tables in the Available Fields pane, select the fields

you want for the report and click the > button to move them to the
Fields to Display pane.

To follow along with this running example, choose the following:
e Employee table: Select Last Name and First Name.
e Orders table: Select Order ID, Order Amount, and Order Date.
At this point, the Standard Report Creation Wizard looks like Figure 4-4.

. Click Next.

Grouping view appears.

. Because you don’t want to do any grouping in this report, click Next.

Record Selection view appears. (See upcoming Figure 4-5.)

. Double-click the field in the Available Fields pane that you want to

filter on to move it to the Filter Fields pane.
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For this example, you want to filter out all orders that were not placed
during December 2004 (or December of whatever year your copy of
xtreme.mdb contains), so double-click the Orders.Order Date field.

6. Pull down the list below the Filter Fields pane and select the method
for filtering. Then make any secondary filtering selections, if necessary.

For the example, select is between. In the sublist, select the dates of the
first and last orders that were placed during December 2004 (as in
Figure 4-5). To illustrate the principle, you may select any month dis-
played in the xtreme .mdb database.
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Figure 4-6:
A standard
report of
December
2004 orders.

7. Click Finish.

The finished report is displayed, using the Preview tab in Crystal Reports,
as shown in Figure 4-6. If Field Explorer is still displayed, you can dismiss
it to show more of the right side of the report. (Read more about Field
Explorer in Chapter 2.) You can also drag the left boundary of the report
area farther to the left if needed.

Not a bad start, but you probably want to make it clear what this report is
about by adding a report header; see Figure 4-7. You can also change column
headings in the Page Header band if you want to. In general, you can use
Standard Report Creation Wizard to do the bulk of the layout for a fairly stan-
dard report, and then fine-tune the result using the tools available on the
Design tab. (Turn to Chapter 2 to add a report header.)

When you’re satisfied with your report, save it by choosing Filer>Save from
the main menu. Later on, when you run the saved report, it reflects the state
of the database at the time you saved it (the last time it was run). That’s
useful if you're reporting on historical data (as in the example report) or on
data that changes on an ongoing basis.
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Using other report-creation wizards

Using the Standard Report Creation Wizard gives you a good idea of how
Report Creation wizards work. The other report-creation wizards, which
are accessible from the Start Page, have a lot in common with the Standard
Report Creation Wizard, as follows:

v Cross-tab Report Creation Wizard builds a report that displays data as
a cross-tab object. I cover cross-tab reports thoroughly in Chapter 16.

v Mailing Labels Report Creation Wizard automates laying out sheets of
mailing labels. It’s already set up for standard commercial label formats,
but you can also design a custom label format.

v OLAP Cube Report Wizard displays OLAP (Online Analytical
Processing) data as a grid. OLAP reports are similar to cross-tab reports
but have different data sources and a distinctive data structure. (For
more about OLAP and how to report on OLAP data, see Chapter 13.)

Starting with a Blank Report

Using report wizards can save you considerable time and effort. In many
cases, however, starting with a blank report is the best choice if what you
want doesn’t jibe with what one of the report wizards is designed to produce.
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You aren’t limited to choosing one path or the other, though. Sometimes it
makes sense to use the Standard Report Creation Wizard to generate the
basic structure of your report, and then switch to the Design tab to modify
the report into the final product.

Chapter 2 leads you step-by-step through the development of a basic report
from a blank report. If you go that route, look there for pointers. In the follow-
ing chapters, you can design and build a variety of reports, each one starting
from a blank report. Later chapters of this book build upon mastering basic

from-scratch report design.

Connecting Vour Report
to Its Data Source

Crystal Reports uses several methods to accept data from a variety of data
sources. The software’s wide data compatibility makes it a versatile tool that
has uses beyond the creation of reports from data in relational databases.

Among others, Crystal Reports can accept data from direct-access database
files, XML and Web Services, ODBC data sources, JDBC data sources, Java
Beans connectivity, OLE DB data sources, OLAP files, and Salesforce.com
files. Each type of file is accessed in a different way; Crystal Reports makes

the connections for you.

Recycling an existing report

Few things are more frustrating than having to
redo work. When asked to develop a report sim-
ilar to one that already exists, some savvy report
developers save time and effort by starting with
an existing report, saving it under a new name,
and then modifying it to serve a new purpose.
This is a great time- and effort-saver if the mod-
ifications take less time and effort than building a
new report from scratch.

If you foresee that a report that you've been
asked to write could be the first of several simi-
lar reports, you can make those follow-on

reports easier to create: Save a version of the
first report containing only those elements that
you believe will be common to all follow-on
reports (be sure to save it under a new name).
What you create by default is a template for the
later reports — and a head start in producing
them. After the template is safely stored on disk,
you can add the elements to the original report
that set it apart from all others that may follow.
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Accessing database files directly

The fastest way to pull data from a database and include it in a report is
through a direct-access interface. This makes sense because the fewer layers
you have between the database and the report, the shorter the transit time
as data goes from one to the other. Another advantage is the simple connec-
tion. As a report designer, you don’t have to fuss with types of connections
and middle-tier dynamic link libraries (DLLs). You just name the data source
you want to tap for data, and tell Crystal Reports to go get that data.

However, as you know, There Ain’t No Such Thing as a Free Lunch
(TANSTAAFL). The price you pay for the speed and simplicity of a direct con-
nection is the need for a different, highly customized driver for every different
data source. This is usually not a problem because Crystal Reports offers a
wide variety of such drivers — unless your report draws data from two or
more different data sources. In such a case, you can’t use direct access; you
have to talk to each data source in its own “language,” and Crystal Reports
doesn’t support using multiple languages in a single report.

Crystal Reports has direct access drivers popular in PC database formats,
including Microsoft Access, and the dBase/FoxPro/Clipper triad known col-
lectively as xBase. In addition, it supports Microsoft DAO/OLE, Btrieve, ACT!,
COM, Microsoft Exchange, and Microsoft Outlook. Crystal Reports has direct
access drivers for the following client-server SQL databases: Microsoft SQL
Server via Microsoft .NET, Sybase, and Informix. Other data sources too
numerous to mention are also supported. If it holds data, is fairly widely
used, and runs on a Windows box, Crystal Reports probably had a direct-
access interface for it.

Connecting to ODBC data sources

In addition to using a direct access driver, you can connect to a database sev-
eral other ways. One is ODBC (Open Database Connectivity).

ODBC is a standard method of connecting to a wide variety of data sources. It
places a layer in the networking model between applications such as Crystal
Reports and the databases they use; that layer is where ODBC-standard
requests from the application are translated into the specific form required
for each different data source. Practically all data sources in use today offer
an ODBC interface, through which the ODBC driver connects to the database.
All the application has to know is that it’s communicating with an ODBC-
compliant data source.
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An ODBC database connection might not perform quite as well as a direct-
access connection because the data has to pass through an extra layer of
processing. This might or might not be a problem, depending on the imple-
mentation and the needs of the application. On the plus side, an application
that communicates to its data sources through ODBC can pull data from mul-
tiple different data sources. It puts out its request in the same ODBC format,
regardless of which data source it’s talking to. Each such source has its own
ODBC driver that translates the common ODBC commands into data source-
specific commands that the data source can understand and obey.

Data sources for which Crystal Reports has a direct-access connection are
also reachable through ODBC. For example, you can connect to Microsoft
Access either through the direct connection or through ODBC. Direct connec-
tion might give you better performance but only if your report requires data
only from Access. However, if you want to include data from both Access and
a second data source, you must use ODBC for both Access and that second
data source. Performance might be slower, but it beats not being able to con-
nect at all.

Retrieving data with SOL

You can use Crystal Reports to create SQL queries of ODBC data sources. The
query runs on a server and returns a result set to your computer. Offloading
some query processing frees your computer to concentrate on other tasks,
possibly improving overall performance. A second advantage is that you can
use the full power of SQL to retrieve exactly the data you want.

SQL is the international standard language for communicating with databases.
It differs from most common computer languages in that it’s nonprocedural:
That is, it deals with data one set at a time rather than one record at a time.
Database developers use SQL. If you're a database user (rather than a devel-
oper), Crystal Reports might provide you with everything you need to get
what you want from your databases.

Again, though, TANSTAAFL. You must be fluent in SQL to use the SQL
Expression Editor in the Formula Workshop. I cover the use of Formula
Workshop in Chapter 10. Gaining fluency in SQL requires some effort, but
might be well worth the time. Start by reading SQL For Dummies, 6th Edition,
or SQL All-in-One Desk Reference For Dummies (by yours truly, both pub-
lished by Wiley). The first book gives you a painless introduction to SQL and
a thorough description of all major features of the language. The second book
covers more topics and goes into greater depth.

When you run a Crystal SQL query, it returns a snapshot of the data at the
time the query was run. If the data in the database is updated later, you have
to rerun the query to capture the changes.
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Reporting on data in OLE DB data sources

OLE DB is a connectivity methodology similar to ODBC. (No surprise here,
seeing as how Microsoft developed both.) OLE DB adds some flexibility in
the types of data sources that it can communicate with, such as multidimen-
sional OLAP sources and Web servers. ODBC communicates with relational
databases that use SQL; OLE DB covers the rest, addressing data sources that
don’t use SQL (although it works well with relational databases, too). Crystal
Reports supports OLE DB data sources, which are OLE DB providers.

Which interface should you use?

Deciding which interface to use depends on you and your needs. (You knew |
was going to say that, didn’t you?) You can draw a few conclusions from the
information in this chapter; here are some guidelines for openers:

v If your report draws data from only one source and there’s a direct-
access driver for that source, using that driver is probably your best
bet for good performance.

v~ If your report draws data from two or more different sources, direct
access is not an option.

v If you'’re drawing data from multiple relational databases, ODBC is
designed to give you what you need.

v If one (or more) of your multiple data sources is not compatible with
ODBC but all your data sources support an OLE DB interface, OLE DB
should be your connectivity choice.

Here are two other more-specific pieces of advice:

v SQL programmers can use Crystal Reports when they want to do a com-
plex retrieval, and the connection between client and server has only
limited bandwidth.

The result set returned by an SQL query is a snapshot — it shows the
state of the data sources at the instant the query was run. It does not
necessarily reflect the current state of the data.

v IT managers can keep their users out of trouble, protect sensitive data,
and make the data sources easier to understand by building dictionaries
that give users what they need in an understandable form but don’t
expose parts of the data sources that aren’t relevant to the users’ jobs.
Such dictionaries are transparent to report developers such as you.
They are primarily to protect sensitive data. If your organization uses
such dictionaries, you probably won’t even know it.
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Now that you know how to get Crystal Reports started, and how to connect
to a data source, it’s time for the main event, actually retrieving from the data
source the information that you want. Chapter 5 tells you how.
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In this part . . .

A fter you know how to create a report based on data-
base data, it’s time to move up to the next level. In
the chapters in this part, you discover how to tease the
exact data you want out of the database, unobscured by
the irrelevant data that surrounds it. You find out how to
arrange data in the report to maximize reader comprehen-
sion. You start to master the art of formatting a report to
draw the reader’s attention to the most important infor-
mation. Finally, you preserve the valuable features that
you worked so hard on so that you can reuse them again
and again in reports that you're called on to produce in
the coming weeks, months, and years.




Chapter 5

Pulling Specific Data
from a Database

In This Chapter

Making simple retrievals with Select Expert
Selecting records with formulas
Soliciting user input with parameter fields

Troubleshooting record selection formulas

If all your reports had to do was display all the data in your data sources,
report creation would be easy. Organizations wouldn’t need people as
smart and well educated as you to design their reports. Luckily, for the job
security of folks like you and me, report creation isn’t that simple. Most
reports with value gain that value by extracting specific information from

the mass of data in the database — and only that information. This usually
requires filtering out unwanted records, leaving behind irrelevant fields, com-
bining data, and presenting data in a meaningful way. Database report design-
ers are clearly valuable to any organization that depends on timely access to
the information buried in its databases. With that in mind, this chapter intro-
duces you to some of the most useful data-retrieval tools in Crystal Reports.

Get Data Quickly with Select Expert

Select Expert is an interactive tool for defining which data items to extract
from a database and display in a report. Probably the best way to describe
Select Expert is to give examples that show it in action.

Suppose that Albert Hellstern, the business manager of Xtreme Mountain Bikes
(the sample business used throughout this book), wants to know the current
inventory status and how it compares with the minimum inventory levels that
the company likes to maintain for all its products. He will want to make sure
that any inventory items that are below their reorder point are ordered right
away. A query into the relevant tables via Select Expert retrieves the needed
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information, and you can use the Standard Report Creation Wizard to format it
into a report. Great! This sounds like just what Albert needs, but a lot of prelim-
inary work must be done before Select Expert can be employed.

Follow along to generate this report:

1.

Choose File=>New.

A submenu appears and gives you several options.

. Choose Standard Report.

The Standard Report Creation Wizard appears.

You can read about this wizard in Chapter 4.

. Find and connect to the xtreme .mdb database.

This sample database might already be connected. If not, connect to it
as described in Chapter 2.

. Add the tables needed to determine the inventory status.

For this example, select the Product, Product Type, and Purchases tables.
Be sure not to select the Purchase table by mistake. When you’re working
on databases created by people other than yourself, always be on the
lookout for table names that are similar, but not identical. In this case,
the Purchase table and the Purchases table are entirely different.

. Click Next.

Link view of Standard Report Creation Wizard appears, as shown in
Figure 5-1. You can see the links that Crystal Reports has inferred to
exist between the selected tables.

In this case, the inferred links are correct, so you don’t need to adjust
them. To read about how to adjust an incorrect link, see Chapter 4.

The icons to the left of some fields indicate that those fields are indexed,
which is a technique that increases the speed of retrievals. You can read
more about indexing later in this chapter.

. Click Next to move to Fields view.

The tree in the Available Fields pane displays the fields that are available
in the tables you chose.

. Select the fields that you want in the report, and then click the >

button to transfer them to the Fields to Display pane.

Figure 5-2 shows how the screen looks after the selection. For this running
example, choose the following:

¢ Product table: Select Product ID, Product Name, Color, Size, and M/F.
¢ Product_Type table: Select Product Type Name.

e Purchases table: Select Reorder Level, Units in Stock, and Units on.
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8. Click Next to move to Grouping view, and then click Next again to
move to Record Selection view.

Albert is primarily concerned with how the Reorder Level field in the

Purchases table compares with the Units in Stock and Units on Order

fields in that same table. Grouping is not needed for this simple task. I
discuss grouping in Chapter 6.

9. From the tree in the Available Fields pane on the left, select the
Reorder Level field, the Units on Order field, and the Units in Stock
field and add them to the Filter Fields pane on the right.
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The screen looks like Figure 5-3. Notice that when you add a field to the
Filter Fields pane, a pull-down list appears below the pane. The list dis-
plays a number of comparison operators that allow you to compare the
contents of the selected field to values that appear in that field in the
table in the database. This feature, by itself, does not give Albert what
he wants. Instead, he wants to compare the In Stock status of each prod-
uct against the specific Reorder Level for that product, not against some
fixed number. By continuing, Albert can arrive at the solution he wants.
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10. For this example, leave the default choice of is any value in place.
11. Click Next to display Template view.

Several templates are available. Many of the templates are fancy or
colorful, but Albert doesn’t care about being fancy.

12. Choose the No Template option and then click Finish.

The report is displayed in the Preview tab, as shown in Figure 5-4.

The report shows the information you expect, but the formatting could be
improved. Some columns, such as Color and Product Type Name, are wider
than necessary to fully display the data they contain. Other columns are too
narrow to fully display their headings. Switch to the Design tab and make
manual adjustments to these layout features. I showed you in Chapter 2 how
to adjust the column widths and change the column headings to a bold font
that was not underlined. You can do the same thing here. In addition, you
may want to resize the text boxes holding the column headings to accommo-
date two lines of text as shown in Figure 5-5.
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This report looks pretty good, displaying all the products and showing their
inventory levels compared with their reorder levels. However, the report
doesn’t emphasize the products in critically short supply. What Albert would
really like to see is a report that lists only those products with inventory at
or below reorder level. To get that, you have to go beyond what a straight-
forward use of Crystal Reports can provide.

01
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Suppose an emergency crops up before you can figure out how to get the
report that Albert wants. A worker comes in from the warehouse and tells
him that some of the helmets are in short supply. Keeping a full line of hel-
mets in stock is difficult because they come in several different sizes and
colors. Albert knows that the reorder level for helmets is 100 units, so he
asks you to modify the report you have just created to show only items
where fewer than 100 units are in stock.

Your job now is to quickly give Albert the information he needs, and this is
where Select Expert comes in:
1. With the inventory report open, choose Report=>Select Expert.
A submenu appears with several options.
2. Choose Record.
The Choose Field dialog box appears.

3. In the Purchases table, select Purchases.Units in Stock and then
click OK.

You can select the field from within the Report Fields category or from
the actual table.

Select Expert appears, with a pull-down list that you can use to specify a
condition for the Purchases.Units in Stock field, as shown in Figure 5-6.

Select Expert — Record =]
Purchases. Lnits n Stk | <tien>
s any v, ~ — |
| Delste
T
o [ concel [ telo Formua Editer... | | Hide Formula <<

4. Choose is less than or equal to and enter 100 in the comparison field,
as shown in Figure 5-7. Then click OK.

For this example, remember that Albert wants to know when 100 or
fewer helmets remain in inventory:.

A dialog box appears, asking whether you want to use data that was
saved earlier or to refresh the data by querying the database again.
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This question has major performance implications. For a large database
with many records, refreshing the data could take a significant amount
of time. On the other hand, saved data is available instantly. If you have
reason to believe that the database has not changed since it was saved,
you can speed up your task by using saved data. In Albert’s case, that’s
not a good idea because someone might have just bought a lot of helmets.

5. Click the Refresh Data button.

Albert wants to know what the inventory status is right now. Figure 5-8
shows the report that appears.
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The report shows all products with in-stock quantities of 100 or fewer. This
includes some helmets, some locks, and some saddles. As you can see, all
listed helmets are below their reorder quantities. However, orders have
already been placed for all but two of them. The small, white, Triumph Pro
helmet and the small, black, Triumph Vertigo helmet should be ordered
immediately. Some of the locks and saddles are below their reorder quanti-
ties and some are above, because locks and saddles have lower reorder quan-
tities than helmets. Albert can quickly tell from this report which helmets he
needs to order. However, the report would be better if it weren’t cluttered
with data about locks and saddles (not his present concerns). To have that
level of specificity, you have to use a formula.

When your comparison is on a numeric field (such as Units in Stock), the
available comparison operators (such as is less than or equal to) are appropri-
ate for making numeric comparisons. Likewise, for date type data, compari-
son operators appropriate for dates are available. The types of comparisons
you can do depend on the type of data you’re looking at.

Using Formulas to Retrieve Data

In Chapter 10, I give formulas extensive coverage. For now, you’ll see how you
can use formulas to help Albert. Suppose he decides that it is helpful to know
about products other than helmets that are also below their reorder levels —
but without having to wade through rows of products that are not below their
reorder levels. You can help.

The current selection criterion specifies that Units in Stock be less than or
equal to 100. However, you can replace it with a new, more complex selection
criterion: namely, that Units in Stock be less than or equal to Reorder Level.
In the original selection, you're comparing against a fixed quantity (100). In
the new selection, you're comparing against a quantity that varies, depending
on the type of product you're examining.

These steps get you there:

1. Choose Report->Selection Formulas=>Record.

The Formula Workshop Record Selection Formula Editor window appears,
as shown in Figure 5-9. It displays the formula that governs the current
selection that resulted in the report shown in Figure 5-8. The formula is

{Purchases.Units in Stock} <= 100

This is the formula that Select Expert creates in response to the choices
you made.
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But now you’re creating a new formula, replacing the 100 to the right of
the <= sign with {Purchases.Reorder Level}, and adding a plus sign (+)
and {Purchases. Units on Order} to the left of the <= sign. If an item is
below its Reorder Level, but an order for more has already been made,
you probably don’t want to order it again.

2. To create this new formula, select the 100 and delete it, and then
double-click Purchases.Reorder Level in the Report Fields tree (the
tree in the upper-left corner of the Record Selection Formula Editor
window).

3. To the left side of the formula, type a plus sign and then {Purchases.
Units on Order} by typing it or by double-clicking like you did with
{Purchases.Reorder Level}.

Figure 5-10 shows the result. Now, the new selection criterion restricts
retrieval to items that have a stock level plus items on order that is less
than the reorder level.

4. Click the Save and Close button in the upper-left corner of the Record
Selection Formula Editor.

Formula Workshop disappears.

5. When asked whether you want to refresh the data or use saved data,
choose Refresh Data.

The modified report appears, as shown in Figure 5-11. This report dis-
plays inventory items where the quantity in stock is less than or equal
to (and on order) the reorder level for that item. This gives Albert a
good idea of what to order.
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Using Parameter Fields to
Retrieve Data at Runtime

To show one of the many things that you can do with parameter fields, sup-
pose that Xtreme’s Vice President of Sales, Andrew Fuller, wants a report that
he can run from time to time to show him major purchases and who made
them. To help focus the company’s sales efforts, he wants to identify cus-
tomers who have placed large orders — and to specify what constitutes a

“large” order at the time he runs the report.
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The first step is to create a report that lists customers and the orders they
made. The next step is to place a condition on the report that restricts the
rows displayed to orders with a higher dollar value than the value Andrew
enters at runtime. A fixed value or a value from a database table field won’t
do the job. The report requires a parameter field.

Step 1: Creating a report
that shows everything

To create the first version of the report that Andrew needs (what I call the Big
Orders report), follow these steps:

1.

Choose Filec>oNew.

2. From the submenu that appears, choose Standard Report.

. When Standard Report Creation Wizard appears, make sure that the

xtreme .mdb database is connected.

For more information on how to connect to this database, see
Chapters 2 and 3.

. Transfer Customer and Orders to the Selected Tables pane, using the

drag-and-drop technique.

. Click Next.

Link view displays a graphical representation of the tables and the links
between them, as shown in Figure 5-12.
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6. Click Next to display Fields view.

7. Select the following fields to display on the report in the Available
Fields pane and click the > button to move them to the Fields to
Display pane:

e Customers table: Select Customer ID, Customer Name, Contact First
Name, Contact Last Name, and Phone.

¢ Orders table: Select Order Amount.

Figure 5-13 shows Fields view after you make these selections.
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8. Migrate to Template view by clicking Next three times.

No need to do anything with the Grouping or the Record Selection views
at this time.

9. In Template view, keep the No Template option, and then click Finish.
The report looks like Figure 5-14.
The spacing of the columns isn’t the greatest, but you can adjust them manu-

ally and do some other formatting. With a bit of tweaking, you can get some-
thing like the report shown in Figure 5-15.
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Figure 5-14:
First version
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Orders
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Figure 5-15:
Refined
version of
the Big
Orders
report.
|
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The report has almost 2,200 records. Each record represents a single order
by one of Xtreme’s customers. The next step is to pare down those records
to just the ones Andrew wants to see.
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|
Figure 5-16:
Create New
Parameter
dialog box,
specifying
the lower
limit
parameter
field.

Step 2: Giving the user the power
to decide what to show

To get there, create a parameter field so Andrew can enter a dollar amount as
the minimum value for those records:

1. If you can’t see Field Explorer on the right edge of the screen, choose
Viewc>Field Explorer.

Field Explorer appears.

2. In the Field Explorer tree, right-click the Parameter Fields option and
then choose the New option.

The Create New Parameter dialog box appears.

3. Enter a name for the parameter field, some prompting text to tell the
user what to enter, and the data type of the entry the user is to make.

For the example, you can name the parameter field Lower Limit and
choose the Currency data type from the Type pull-down list. In the Value
Options pane, for Prompt Text, make the Setting Enter lower limit for a
big order:. Figure 5-16 shows the Create New Parameter dialog box after
you make these entries. Leave the other options at their default values.

4. Click OK.

=) Craate Hew Paramater g
o)
Marme: Type: List of Values:

Lower Limt Currency »| |Smbc v|

x [ conce | [_1e0 |

The parameter field is ready to add to the Big Orders report as the selection
criterion, specifying which records to retrieve from the two-or-so-thousand in
the Orders table. Select Expert is the tool for this job; here’s how to put it to
work:
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1. Click the Select Expert icon on the Expert Tools toolbar.

The Choose Field dialog box appears.

2. Select the field you want to compare against and then click OK.

For this example, select the Order Amount field in the Orders table and
click OK.

Crystal Reports displays the Select Expert — Record dialog box, with the
Orders.Order Amount tab selected.

3. From the pull-down list, select is greater than or equal to.
A data entry field with a pull-down control appears to the right of the list.

4. Pull down the list and select {?Lower Limit}.

“&N\BER
© . R
< Crystal Reports denotes a parameter field by enclosing it in curly braces
and preceding the parameter field’s name with a question mark.
5. Click OK.
The Enter Values dialog box appears.
6. Enter 5000 as an initial value, and then click OK.
You're using the number 5000 to indicate a sale of at least $5,000.
The by-now familiar Change in Record Selection Formula dialog box
appears, asking whether you want to use saved data or refreshed data.
7. If there’s any possibility that the data has changed since the last time
it was saved, choose Refresh Data.
Figure 5-17 shows the result. The report looks much as it did in Figure
5-16, with only a few hundred records (instead of thousands) appearing,
and every one showing an Order Amount of at least $5,000.
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8. Save this report with the name Big Orders.rpt.

Andrew can now see at a glance which customers make a large number of
orders valued at over $5,000 as well as which ones occasionally make orders
that large. He can now formulate sales promotions targeted at these cus-
tomers. (Now imagine Andrew thanking you, and your modest reply: “Hey!
No problem, Andrew!”)

Speed retrievals with indexes

Those icons in Figure 5-12 that look like overturned Monopoly houses indicate
which fields in the tables are associated with indexes. Records in a database
table are generally not arranged in any useful order. Usually, they’re still in the
order in which they were first entered into the table.

To make a selective retrieval (such as Andrew’s, which finds all orders over
$5,000), every single record must be examined — that is, unless you sort ’em
beforehand. If you sort those records by Order Amount in descending order,
only the records that equal or exceed $5,000 have to be checked. This could
save some serious retrieval time, especially for a large table in which rela-
tively few orders had values of more than $5,000.

Not surprisingly, a lot of overhead is associated with maintaining a data table
in sorted order. In addition, sorting it on one field also unsorts it on any other
field that you might want to use as a retrieval key. The answer is to create
indexes for the fields that you'll use as retrieval keys. The icons in Figure 5-12
show which fields are indexed. As you can see, Order Amount is not one of
them. If the Orders table grows to hundreds of thousands of rows, and if
people are going to be making frequent retrievals based on Order Amount,
Andrew might want to ask Xtreme’s database administrator to create an
index field for Order Amount in the Orders table of the company’s database.

Changing parameter values
to change the report

Suppose that now, after seeing the hundreds of entries in the report in
Figure 5-17, Andrew wants to see a list containing only the customers who
have made really big orders — those that exceed $9,000. All you have to do
is rerun the report and then follow these steps:

1. Click the Refresh icon on the Navigation Tools toolbar to rerun the
report.

It looks like two arrows chasing each other around in a circle.
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The Refresh Report Data dialog box appears, asking whether you want to
use the current parameter values or prompt for new parameter values.

2. Choose the Prompt for New Parameter Values option, and then
click OK.

The Enter Parameter Values dialog box appears.
3. Enter 9000 in the text box below the prompt phrase, and then click OK.

Now the report contains only 43 records. Only orders of at least $9,000
are included in this version of the Big Orders report.

You can rerun the report as many times as you want, changing the Lower

Limit parameter each time, to get a precise idea of which customers make
large buys, regardless of how you want to define a large buy. (Gotcha cov-
ered, Andrew.)

Troubleshooting Tips When
Retrieving Data

Three basic problems might arise when you try to retrieve specific data from
a database:

v You don'’t retrieve all the data you want.
v You retrieve data you don’t want.

» You retrieve all the data you want and none of the data you don’t want,
but the retrieval takes an unacceptably long time.

The first two problems sometimes have an easy explanation:

v~ Failing to specify all the tables you need: Some tables might not contain
a single field you want to display, but they’re needed anyway to provide a
link between the tables that do contain fields you want displayed.

v~ Failing to specify all the fields you need from the tables you select:
Make sure you understand exactly how the tables relate to each other —
and to the information you’re asking for. If what you need depends on
multiple fields in multiple tables, be sure to select all those fields.

1 Specifying your selection condition incorrectly with Select Expert:
You must choose from a number of comparison operators, and you must
then apply the operator to the correct constant value, field value, or
parameter value. You can verify that you're comparing against the cor-
rect constant value or field value when you create the report. However, if
the user enters an incorrect parameter value at runtime, it could cause
incorrect results that might slip by undetected.

/3
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Slow retrievals are another matter; they can cause problems when you have
to deal with large data sets. Often a careful analysis — followed by indexing
the fields that serve as retrieval criteria — can speed up retrieval time
tremendously. This is a job for the database administrator, however, not the
report designer.



Chapter 6

Sorting, Grouping, and
Totaling Report Data

In This Chapter

Putting report data in a logical order by sorting
Clustering similar data items with grouping
Figuring out percentages

Adding drill-down functionality

Adding things with running totals

Solving sorting, grouping, and totaling problems

Fe primary goal when creating a report is to put database data into a
meaningful and easily understandable form. To achieve this goal, you
must extract only the data you want, from the specific rows and columns
of the relevant tables. However, if you don’t present the information in the
report in a logical manner, meaning and understanding can suffer.

You can greatly enhance the value of a report by arranging the retrieved

data in a way that clearly conveys what that data means and emphasizes its
important features. Sort the records, and group related records in such a way
that the significant information is emphasized. Crystal Reports has powerful
tools to help you sort report data in a variety of ways, group related data,
and summarize data within groups.

Sorting Report Data

In most cases, the original order of the data in a database is not the most
helpful order, so you need to reorder the data for your purposes. The sort
function in Crystal Reports does this for you.
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The way in which data is sorted depends on how you specify the sort as well
as on the type of data that you want to sort. You can sort data in ascending
order or descending order. In general, ascending means lowest to highest, and
descending means highest to lowest. What ascending and descending mean
for any given sort, however, depends on the type of data you're sorting.

The data types you might want to sort include the following:

v Single-character string fields
v Multiple-character string fields
v Currency fields

v Number fields

v Date fields

v Date-time fields

v Time fields

v Boolean fields

Assuming an ascending sort order, Table 6-1 shows how data types will be
sorted. For descending order, just reverse the sequence.

Table 6-1 Ascending Sort Order for Various Data Types
Field Type Sort Order
Single-character string field Blank

Punctuation mark

Numeral

Uppercase letter
Lowercase letter

Multiple-character string field First character, then second, then third,
and so on; for example, mm comes before
mmm, and ALLEN comes before Abe

Currency field Numeric order

Number field Numeric order

Date field Chronological order

Date-time field Chronological order, first by date and
then by time

Time field Chronological order

Boolean field False, and then true
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If a sort is based on a field that contains null values, the null values are
sorted before non-null values. A field is said to have a null value when it
has nothing in it. In contrast, zero is not a null value. Its representation in a
computer memory is 30 in the hexadecimal number system. A blank space
also has a definite value, hex 20. However a null value really means nothing.
It is represented by a hex 00. Zeros and blank characters at least have an
existence, but null values do not.

Sorting based on multiple fields

When you sort data items based on the value of one field, the outcome is
straightforward. If the sort is ascending, it proceeds according to the rules
in Table 6-1. If the sort is descending, the sorted order is the reverse of an
ascending sort. Sometimes, however, you want to sort data based on the
contents of more than one field.

Consider, for example, the Customer table in the Xtreme database. (Xtreme is
the name of the fictitious company in the sample database examples used in
this book. You can read about the database and how to find it in Chapter 2.)
Xtreme’s Sales Manager wants a list of customers sorted first by country,
then by region within a country, and finally by customer name within a
region. Crystal Reports can perform such a nested sort. In fact, it can do so
for as many levels of nesting as you want. To build such a report, follow
these steps:

1. From the Crystal Reports Start Page, select Report Wizard.

2. Add the Customer table from the xtreme.mdb database to the
Selected Tables pane.

3. In the Standard Report Creation Wizard, click Next to display Fields
view.

4. Add the Customer ID, Customer Name, Region, and Country fields to
the Fields to Display pane.

5. Click Next three times to display Template view.

At this point, you don’t want to group records or select specific records,
so skip those views.

6. Retain the No Template option, and then click Finish.
The report shown in Figure 6-1 appears.
At this point, the report has the data you want, but it’s sorted by Customer ID
because that’s the first field you specified in Fields view. Furthermore, the

columns are not centered, and the report needs a title. To correct these
problems, do the following.
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1. Switch to Design view by clicking the Design tab.
The report appears like that shown in Figure 6-2.

Page Header

Report Header
+ Crystal Ropors - [Ropodt7] - = x
format Database Report Window Help
28 Ao
= A A w2 n A
lam N xoBWme0i0 8|88 7S5k 0L b K
Start Page  Report4  ReportS  Big Orders Report? = rield Explorer 7
Desidn  Preview £ | & Y
® (0 Datsbase Fieds
""" A e e g S e ———— et | 75 Formds Pilds
s T 5L Expression Feke
. (7 Parameter Fiids
| Print Date ¥ Hunning Total Fieids
: . (B Groun Name Fiekds
+ T specsl Fiekds

Figure 6-2:

S sbo mar Sustamar Mama

Design view
of the first
draft of the
Customer
report.
|




Chapter 6: Sorting, Grouping, and Totaling Report Data 79

2. Change the justification of all fields to center by clicking the Align
Center icon when each field is selected, both in the Page Header
and in the Data section.

This balances the appearance of the report.

3. Pull down the border between the Report Header section and the
Page Header section to make room for the report title in the
Report Header.

4. Click the Insert Text Object icon on the Insert Tools toolbar, and drop
it into the Report Header.

5. In the text box, type Customer List, Sorted by Country and Region.
This is the report title.

6. Expand the text box to the left and right so that it spans the entire
width of the report. Expand it vertically as well so that it can
accommodate a large font.

#] 7. Center the report title in the text box, make it bold, and increase its
..I'EL font size by clicking the Increase Font Size icon on the Formatting
toolbar.

Figure 6-3 shows what Design view looks like after you make these
modifications.

This design produces the report preview shown in Figure 6-4.
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|
Figure 6-4:
A preview of
the modified
Customer
report,
sorted by
country and
region.
|

|
Figure 6-5:
Use the
Record Sort
Expertto
specify how
the report
will be
sorted.
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The report looks nice, but it’s not sorted by country and region. To remedy
that problem, follow these steps:

1. Choose Report=>Record Sort Expert.
The Record Sort Expert appears, as shown in Figure 6-5.

2. In the Available Fields pane, select Customer.Country, and then click
the > button. Do the same for Customer.Region and then for
Customer.Customer Name.

3. Make sure that the Sort Direction is Ascending for all three fields, and
then click OK.

The report’s records are sorted first by country, then by region within a
country, and finally by customer name within a region. Figure 6-6 shows
the properly sorted report.
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Figure 6-6:
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report,
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Notice in the figure:

v The first sort key is Country. The first record is for a customer in
Argentina, and the second is for a customer in Aruba.

v The second sort key is Region. Within Australia, New South Wales
comes before Queensland, which precedes Tasmania and Victoria.

v The third sort key is Customer Name. Within Victoria, Bruce’s Bikes
comes before Kangaroo Trikes.

The report meets the objectives of the development effort in terms of both
information content and ease of understanding.

Sorting and performance

How long it takes Crystal Reports to produce a report can depend, to a large
measure, on the sorting that the report requires. For databases with tables
consisting of many records, sort times often account for a major portion of
the total time it takes to produce a report.

The sort time is affected by the fields on which you sort. In most cases,

you can sort a large table on an indexed field orders of magnitude faster than
you can sort the same table on a nonindexed field. The lesson here is to

sort on indexed fields whenever possible. If you regularly run reports that
include sorts on nonindexed fields, consider talking to your database admin-
istrator (DBA) about adding indexes to those fields. A performance penalty
is associated with maintaining an index (because it can consume a significant
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amount of time), but if you don’t update the data table often and run reports
frequently, the updating overhead might be insignificant compared with the
ability to generate reports more quickly.

It does not make sense to index a field in a table with few records, or a table
with many records if the index field can take on only one of a small number
of values. The cost of maintaining the index exceeds the benefit you would
gain from it.

Adding Sort Controls to a Report

|
Figure 6-7:
The Sort
Control
dialog box
shows fields
for which
sorts exist.

Different people have different needs, when it comes to reports. For the
Customer List shown in Figure 6-6, a report reader might be very familiar with
customer names and want to see the report sorted by customer name. For
such a person, having a report that is sorted first by country, then by region,
and finally by customer name might not be the best. Crystal Reports 2008 has
a new feature that enables the end user to sort the report. This provides a
customization ability that was absent in earlier versions of Crystal Reports.
By placing sort controls on the report, the report developer can give the user
the ability to change the order in which the records are sorted. To add sort
controls to the Customer List, Sorted by Country and Region report, follow
these steps:

1. Right-click Customer Name in the Page Header section.
This surfaces the Field Heading menu.
2. Click Bind Sort Control.

The Sort Control dialog box appears, as shown in Figure 6-7.

Sort Control %]

The Sert Control will change the following sort

< Mot Interactve >

=3 A - Customer, Country

= A - CuStomer Region

= A, - Cugtomer, Customer Name

K i cancel

3. Select A - Customer.Customer Name and then click OK.

A sort control with up and down arrows appears to the right of the
Customer Name label in the Page Header, as shown in Figure 6-8.
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Logically enough, when the user clicks the up arrow, the column below
the sort control is sorted in ascending order. Clicking the down arrow
causes a descending sort.

4. Put a sort control on the Country column in the same manner that you
use for the Customer Name column. Shrink the horizontal dimensions
of the text boxes in the Page Header so that the sort controls are
located closer to the text they are bound to.

Figure 6-9 shows the report after both sort controls have been added
and the associated text boxes have been shrunk.
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Figure 6-10:
The report
is now
sorted by
country in
descending
order.
|
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Because the report is already sorted, first by country, next by region,
and finally by customer name, all in ascending order (pshew!), see what
happens when you sort by country in descending order.

5. Click the down arrow to the right of the Country label in the Page
Header.

Figure 6-10 shows the result. The first record is from Zimbabwe, followed
by the records of customers in Wales, Vietnam, Venezuela, and the USA.

Notice that within a country, Region is still sorted in ascending order.
Alabama comes before Arkansas, which comes before Arizona. Also,
within a region, Customer Name is still sorted in ascending order, too.
Benny — The Spokes Person comes before Psycho-Cycle, which comes
before The Great Bike Shop.

What happens when the Customer Name sort control is clicked for a
descending sort?

6. To perform a descending sort on Customer Name, click the down
arrow to the right of the Customer Name label.

Figure 6-11 shows what happens.

Running a descending sort on Customer Name brings the customer
whose name is closest to the end of the alphabet to the top, regardless
of country or region. Because each customer is in one and only one
region, in one and only one country, sorting by customer name (ascend-
ing or descending) destroys any sorts on region or country that might
exist. This is in contrast to the earlier descending sort on country. It left
the ascending sorts by region and customer name intact.
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Grouping Related Items

A simple sort, such as the one in the preceding section, works fine when all
you want to do is put a list of items in some order. Often, however, you want
to do more with your data, such as displaying subtotals, counts, averages, or
other summary information along with each group. Crystal Reports offers
great flexibility in specifying groups as well as a wide variety of summariza-
tion facilities. These grouping and summarization capabilities are among the
most advanced of any reporting tool. A group can be any collection of ele-
ments that have one or more attributes in common.

To demonstrate a small fraction of the power of Crystal Reports’ grouping
facilities, take another look at the Xtreme Mountain Bikes database. Suppose
that the Vice President of Sales wants to get a better idea of where customer
orders are coming from. Focusing on Mexico, he wants a report that shows
order totals grouped by state and sorted by customer name within each
state. Follow these steps to build that report:

1. From the Crystal Reports Start Page, select the Report Wizard.

2. From the Available Data Sources pane, add the Customer and Orders
tables to the Selected Tables pane.

3. Click Next.
The Link view appears.
4. Click Next.

Fields view displays.
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\\3

Figure 6-12:
The reportis
grouped

by the
customer’s
region.
|

5. Select the Customer Name and Region fields from the Customer table
and the Order Amount field from the Orders table.

6. Click Next.
Grouping view appears.
7. To meet the Vice President’s needs, group by Region.

To do so, move Customer.Region to the Group By pane, as shown in
Figure 6-12.

8. The default sort order (in ascending ordey) is fine, so click Next.
Summaries view appears, as shown in Figure 6-13.
9. Click Sum of Orders.Order Amount to select it.

A pull-down menu appears, with the default selection of Sum. Crystal
Reports assumes that type of summarization you want to perform on
the Order Amount field is summation. This is a good assumption.

Even though the default summary type of Sum is the one you want for
this report, several other options are available. Average gives you the
average value for the group, Maximum displays the maximum value
for the group, and Minimum displays the minimum value. Statistical
functions and a simple count of the number of records in the group are
available as well.

10. Click Next three times.

You don’t need to change anything on Group Sorting view, and you don’t
want a Chart, so skip these views.

—
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Figure 6-13:
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11. In Record Selection view, include in the report the records for Mexico
customers only.

In the Available Fields pane, select Country from the Customer table
and add it to the Filter Fields pane. In the pull-down list below the Filter
Fields pane, select Is Equal To; from the pull-down list that pops up
below it, select Mexico.

12. Click Next.
Template view appears.
13. Retain the No Template option and then click Finish.
The report shown in Figure 6-14 appears.
As with most reports created by the Standard Report Creation Wizard, this
one could use some tuning. Here are some problems you might want to fix:
v The customer region names appear too often.

v The region summaries should be located under the Order Amount
column.

v The report could use a bold, centered title.
Switch to the Design tab and make the adjustments that will correct these

problems. After you make the adjustments, Design view appears (as shown in
Figure 6-15), and the Preview tab view appears (as shown in Figure 6-16).
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The Vice President of Sales can now easily see which states in Mexico are
producing orders and which customers in those states are placing orders.
Thanks to the group subtotals and a Grand Total at the bottom of the report,
he can also see the total value of orders in each state and in the entire
country.

Save the report as Customer Report Grouped by Region (Mexico). Every time
you run the report, it will show the updated results based on the current
database contents.
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Calculating Percentages

Suppose that Xtreme’s Vice President of Sales feels it would be more instruc-
tive to know the percentage rather than the dollar value of Mexico’s order
total coming from each state. Simply modify the existing report to include
percentage summary fields rather than the sum field:

1. In Design view, right-click the Sum of Orders.Order Amount field in
the GF1 band and choose Edit Summary from the contextual menu
that appears.

The Edit Summary dialog box appears, as shown in Figure 6-17.
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Figure 6-18:
The
Customer
report
showing
state totals
asa
percentage
of the
country total
(Mexico).
|
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2. Select the Show as a Percentage Of check box.

This activates the drop-down list that shows the default choice, Grand
Total: Sum of Order Amount.

3. Click OK to display the group totals as percentages of the Grand Total.
The Design view of your report appears to be unchanged.
4. Switch to the Preview tab.
The report looks like Figure 6-18.
This report makes it immediately obvious that more than half of Mexico’s
orders are coming from Distrito Federal. This information might cause the

company to change its marketing strategy to encourage orders in other
parts of the country.
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Drilling Down for Detail

In the report prepared for Xtreme’s Vice President of Sales (in the preceding
section), you can easily see where most sales are coming from because the
company doesn’t have many customers in Mexico. The same report would
not be as informative if it were run for the United States, where many more
customers are located. The first page of the same report for the United States
looks like Figure 6-19.
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Figure 6-19:
A Customer
report
showing
state totals
asa
percentage
of country
total (USA).
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To change the Mexico report to a report on USA orders, follow these steps:

1. Choose Report=>Select Expert.
The Select Expert dialog box appears.

2. From the submenu that appears, select Record.
The Select Expert — Record dialog box appears.

3. Select Customer.Country is equal to USA in place of the existing
Customer.Country is equal to Mexico.

4. Click OK; then, when prompted, click Refresh Data.

5. Edit the text in the report header to read Customer Orders,
Grouped by State or District (Usa).

6. (Optional) If you have to reduce the font size of the report header
to fit everything on one line, click repeatedly on the Decrease Font
Size icon on the Formatting toolbar.

7. Save this report as Customer Orders Grouped by State or District

(USA).

This report is not very helpful. You can’t even tell what percentage of USA
orders are coming from Alabama by looking at the first page. The first page
tells you that Benny — The Spokes Person, Psycho-Cycle, and The Great Bike
Shop in Alabama have made a lot of orders, but that’s about it — unless
you’re willing to riffle through a lot a pages.
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|
Figure 6-20:
The
Customer
report with
the details
hidden.

You can hide specific customer information to present a more general picture
of orders. If report viewers then want the specific information about any
particular state, they can drill down by double-clicking that item. When a
user hovers the cursor over the group header of interest, it changes to a mag-
nifying glass. At that point, double-clicking displays the hidden detail data
about individual orders.

To add drill-down functionality to this report, do the following:

1. Switch to Design view.

2. Right-click the D designator to the left of the Detail band and select
Hide (Drill-Down OK).
The Detail band appears dimmed.

3. Switch back to Preview mode.
You see the report shown in Figure 6-20.

4. Save this report as Customer Orders Grouped by State or District with
Drilldown.

This information is much more helpful for strategic decision making. You
can easily see which states are contributing to Xtreme’s bottom line and

which are not. If report viewers want to see the detail for a specific state,
they can hover the cursor over the group header or group footer for that
state. Figure 6-21 shows what this looks like for Oregon.
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Double-clicking while the cursor looks like a magnifying glass drills down to
the detail level, giving you what you see in Figure 6-22.

The drill-down capability of Crystal Reports provides tremendous flexibility
to online report viewers. Different viewers can see different levels of detail,
even though they’re all viewing the same report. Be sure that you save this
report before moving on to the next section.
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Don’t try drilling down on a report that has been printed on paper. You can
click all day. You can even place your mouse directly on top of the paper. It
is no use; the details will not be displayed. Drill-down works only for online
report viewing.

Keeping Track of Things
with Running Totals

Reports with summarized group totals, like those in the preceding section,
are valuable for many purposes, but they don’t satisfy all needs. Sometimes
it’s helpful to see how the status of an item changes with time. Crystal
Reports’ running total facility gives you that kind of information.

To see how that might work, I build on the running example in this chapter
to construct a variant of the Orders report for Mexico where the total value
of all orders is tracked as a function of the order date:

1. From the Start Page, select the Report Wizard and the xtreme.mdb
database.

2. Select the Customer and Orders tables and make sure they’re linked
by the Customer ID field.

3. Add the Customer Name field from the Customer table and the Order
Amount and Order Date fields from the Orders table to the Fields to
Display pane in the Standard Report Creation Wizard.

4. For this report, skip Grouping view and move to Record Selection
view.

5. Add the Customer table’s Country field to the Filter Fields pane. In the
pull-down lists that appear below, select is equal to, and Mexico.

This means the report will display results only for Mexico.
6. Retain the No Template option, and then click Finish.

You're not really finished, as you can see by looking at the report preview
shown in Figure 6-23.

The running total column is not on the report, the Order Date column shows
times, and the report title is missing. Switch to the Design tab to put the
report into final form. You can add the title — Mexico Orders, with Running
Totals — in much the same way that you did for the previous examples.

You can change the format of the Order Date field to eliminate the time infor-
mation. Just right-click the Order Date field to display the shortcut menu.
Select Format Field from the menu; then when the Format Editor appears,
use it to change the date format.
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For the running total, you want to place a fourth column to the right of the
Order Date column. To do that, follow these steps:

1. Make sure that the Design tab is displayed. If Field Explorer isn’t
displayed, choose Viewr>Field Explorer.
Field Explorer appears.

2. Select the Running Total Fields option.

3. Click the New icon at the top of Field Explorer.

Figure 6-24:
The Create
Running
Total Field
dialog box,
with a
default
name in the
Running
Total Name
text entry
field.

The Create Running Total Field dialog box appears, as shown in

Figure 6-24.
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4. In the Running Total Name box, replace the default name with Order
Total.

5. In the Available Tables and Fields pane, select Order.Order Amount
from the Report Fields area. Then click the > button pointing to the
Field to summarize box.

The default sum appears in the Type of Summary pull-down list. This is
what you want, so proceed to the next step.

6. In the Available Tables and Fields pane, select Orders.Order ID from
the Orders table. In the Evaluate area, click the On Change of Field
option, and then click the > button pointing to the Evaluate area.

The report will display all the orders for Mexico, so you want the
running total to be updated for each order (each time the Order ID
changes).

7. Because you want the running total to be cumulative for the entire
report, leave the Reset option set to Never. Then click OK.

The Create Running Total Field dialog box disappears, once again show-
ing Field Explorer.

8. Drag the Order Total running total field from Field Explorer onto your
report, just to the right of the Order Date field.

9. Dismiss Field Explorer. In the Report Header section, center the title
Mexico Orders, with Running Totals. In the Page Footer section, drag
the page number object to the right. Move all the elements in the page
header and the details sections to the left to center them on the page.

Your Design view should look similar to Figure 6-25.
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10. Switch to Preview mode.

The report preview looks similar to Figure 6-26.
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The report is now nicely laid out and balanced, but it’s not sorted in chrono-
logical order. To remedy that situation, follow these steps:

A l 1. Click the Record Sort Expert icon on the Expert Tools toolbar.

The Record Sort Order dialog box appears.

2. Add Orders.Order Date to the Sort Fields pane.
3. Leave the Sort Direction at Ascending, and then click OK.
4. Switch to Preview mode, if necessary.

You can see that the report is sorted in chronological order.

5. Save the report as Mexico Orders with Running Totals Sorted by Date.

Troubleshooting Sorting, Grouping,
and Totaling Problems

What can go wrong when you try to include sorting, grouping, or totaling in a
report? In this section, I take each case in turn.
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Sorting problems and how to solve them

Crystal Reports gives you many options for sorting, so many things can

go wrong. Crystal Reports will always do exactly what you tell it to do. The
problem is that it’s not always clear what you should tell it. You can sort
on one field or multiple fields. You can sort an entire report or within each
group in the report.

The main solution to any sorting problem is to have a clear idea of how you
want the report to be sorted:

+ Decide which fields you want to sort on and which should be speci-
fied first. For a field with multiple sort keys, the second sort key comes
into play only when multiple records have the same value for the first
sort key.

v Decide whether you want the sort to be ascending or descending.

After you decide exactly how you want your information to be sorted, choose
ReportoRecord Sort Expert or click the Record Sort Expert icon to display
the Record Sort Order dialog box. The left pane shows all the fields you might
want to sort by; the right pane (Sort Fields) is waiting for you to add them.

You must add the fields to the Sort Fields pane in the correct order. First

add the field that you want as your primary sort key; next, add the field that
you want as the secondary sort key, and so on. After you choose the appro-
priate sort direction (ascending or descending) for each sort key, click OK to
execute the sort.

In the Sort Fields pane, the letter A precedes fields that will be sorted in
ascending order. Similarly, the letter D precedes fields that will be sorted
in descending order. A field with multiple sort keys might be sorted in an
ascending direction for one key and a descending direction for another.

Unusual grouping options

Separating report records into groups of related items is not difficult, but the
rich array of options for grouping might be confusing. For example, you can
sort not only individual records but also groups. You can sort the groups in
ascending order, descending order, the original order in which they appear in
the database, or in some other specified order. To place a new level of group-
ing into an existing report, choose Insert=>Group and specify the options you
want in the Insert Group dialog box that appears.
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|
Figure 6-27:
Group
Expert

dialog box.
|

You can choose to include some groups in the report and exclude others.
Select Expert is the tool you use to do that job. With Select Expert, select the
groups to display by specifying a field to select on or by specifying a formula
that determines which groups to include.

If you've created groups in a report but later decide that the grouping you've
created is not the best, you can change it. Choose Report=>Group Expert to
display the Group Expert dialog box, shown in Figure 6-27.

Use this dialog box to change the field that the group is sorted by, the sort
order, and the name of the group. You can specify whether you want to keep
the group together after the change, and whether you want to repeat the
group header at the top of each page.
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Getting the right totals

Crystal Reports enables you to print subtotals in group footers as well as

a grand total at the end of the report. You can also print running totals.
With all these possibilities, you might specify your subtotals incorrectly. It’s
a good idea to run your report with a few records of sample data, for which
you know what the correct subtotals should be. If what you get isn’t what
you expect, check how you specified the subtotals to be computed. If you
find an error in how you specified a subtotal, you can delete the erroneous
specification and replace it with the correct one.
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Chapter 7
Mastering Report Sections

In This Chapter

Resizing sections

Controlling group placement
Creating summary and drill-down reports
Generating barcodes

Creating mailing labels

A s I discuss in other chapters, Crystal Reports divides a report document
into sections, including the Report Header, Page Header, Details, Report
Footer, and Page Footer sections. These sections offer tremendous flexibility.
A report can have multiple copies of each section, each one serving a
different purpose.

You have a lot of leeway in how you format a section. You can vary the
height, the background color, and even the number of columns in each sec-
tion. By using Crystal Reports tools creatively, you can give your report the
appearance you want.

In this chapter, you can read how to change section size, use different types of
formatting, place groups, generate barcodes, and work a little postal magic.

Changing the Size of a Section

The width of a section is the same as the width of the report that the section
is in. You determine this value when you set your margins.

The height of a section begins at some default value. If that value gives you
the appearance that you want, you can leave it the way it is. If you want a
different height for a section, say to accommodate a larger font, it’s easy to
change, as described next.

Consider the vertical spacing between the lines of a variant of the Mexico
Orders, with Running Totals report that I show you how to create in Chapter 6.
This version of the report has a box around the fields and horizontal lines
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between the rows. You can add this effect to your reports in Design mode by
using the Insert Box and the Insert Line icons on the Insert Tools toolbar.
Figure 7-1 shows the result.

In addition to adding a box around the text, [ added a horizontal line above
each line of text. To do this, in Design mode, expand the height of the Details
section by dragging down its lower boundary line. Make this easy adjustment
by following these steps:

1. Make sure you are in Design mode.
2. Move the cursor to the bottom of the Details section.

The cursor changes shape, as shown in Figure 7-2. When the cursor
takes on the appearance of the sizing cursor, you can use it to drag the
section boundary up or down to give you the vertical height you want
for the section in question.

. If necessary, you can adjust the height and width of a text box to give
you the appearance you want. You can also adjust the positioning of
the text boxes, both vertically and horizontally, leaving you with a
report looking like Figure 7-1.

Make sure you don’t drag a text box border line beyond the boundary line of
a section. If you do, you get a weird result that you probably don’t want.
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Formatting with the Section
Formatting Menu

To create a summary report in Chapter 6, I show you how to use the Hide
(Drill-Down OK) function from the Section Formatting menu. Right-clicking
in the area to the left of a report section displays a contextual menu. The
options on the Section Formatting menu (as shown in Figure 7-3) provide
you with a convenient way to make basic formatting changes to a section.
Figure 7-3 shows the menu for the Details section, as seen in Preview mode.

The following list provides a brief description of each option in this menu:

v Hide (Drill-Down OK): Doesn’t display this section of the report but
allows the user to drill down to view it.

v Suppress (No Drill-Down): Doesn’t display this section of the report
and doesn’t allow the user to view it by drilling down.

v Section Expert: Displays Section Expert. You can read more about this
tool shortly.

v Show Long Section Names/Show Short Section Names: Toggles
between showing either full or abbreviated section names.

v~ Insert Line: Adds an additional horizontal guideline to the section.
If there’s not enough room for an additional line, the section is
automatically expanded to accommodate the additional guideline.
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v Delete Last Line: Deletes the bottom guideline from the section and
raises the bottom of the section up to just below the next higher

guideline.

v Arrange Lines: Arranges guidelines vertically so that they’re evenly
spaced. Adds more guidelines if there aren’t enough.

v~ Fit Section: Brings the bottom of the section up to the bottom of the
lowest object, removing any guidelines that are lower.

v~ Insert Section Below: Adds another section of the same type as the
current section, just below it. We'll be covering this soon.

v Select All Section Objects: Selects all objects in the section. This can be
useful if, say, you want to move everything over to the right by a half
inch. It beats moving each item individually and trying to maintain their

relative positions.
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Using Section Expert for Easy
Section Formatting

Section Expert is the primary tool you use to change the formatting of a sec-
tion. With it, you can set a number of options to determine what is displayed,

how it’s displayed, and what color the display is.

has three tabs: Common, Paging, and Color.

@ Invoke it by clicking the Section Expert icon on the menu bar. Section Expert



Chapter 7: Mastering Report Sections ’ 05

Common tab, Section Expert

Figure 7-4 shows the default settings for the Report Header section of the
Common tab. (Each section has different default settings.)

Section Expert %]
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Figure 7-4: [Clunderiay Folowing Sections E
The
Common tab
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Re port [[JRead-only
Header [MRelative Posilions
section.
— [ ox ][ comes ][ heo ]

Here is a short description of the options on the Common tab:

v Hide (Drill-Down OK) hides the section. However, drilling down displays
the section’s contents.

v Suppress (No Drill-Down) hides the section, and drilling down does not
override the suppression.

v+~ Print at Bottom of Page prints the section at the bottom of the page.
This option doesn’t make much sense for a Details section, but it’s
useful when applied to a Report Footer that otherwise could be printed
near the top of the last page of a report.

1~ Keep Together prevents a page break in the middle of a section. This
option is useful if a section contains a small number of detail lines that
should be viewed together, regardless of where they happen to fall
on a page.

1 Suppress Blank Section closes the gap between the preceding and the
following sections if a section is blank. If this option is not selected
(checked), the empty space assigned to the section is on the report.

v Underlay Following Sections prints the section and then prints all the
following sections right on top of this one. The function is often used to
apply a watermark to a page. It can also be used to overlay two types of
content, such as text and a chart.
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Clicking the Formula Editor icon (located to the right of most of the options)
on the Common tab displays Format Formula Editor. With this editor, you can
write a formula that tests a condition. For true/false conditions, if the condi-
tion is satisfied (true), the chosen formatting option is applied; if false, the
formatting option is not applied. For multivalued conditions, an If-Then-Else
structure is used, which defines which one of several formatting options to
apply. For more on formulas, see Chapter 10.

Paging tab, Section Expert

Figure 7-5 shows the Paging tab of Section Expert.

Section Expert %]
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The Paging tab is a new feature of Crystal Reports 2008. The first option
on this tab, New Page Before, is grayed out because the New Page Before
option doesn’t apply to the report header (which is what is selected in
the figure). This makes sense because nothing comes before the report
header. However, this option is active for the Details section and the
Report Footer section.

The second option, Reset Page Number After, resets page numbering to the
beginning of the sequence. For example, if you apply this setting to a Group
Footer, the first page of the next group is numbered 1 rather than the number
that would follow the last page number of the current group. You can read
about groups in Chapter 6.
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Gee. I guess | haven'’t really explained what a Group Footer is yet. Just as a
Page Header is located at the top of every page and a Page Footer is located
at the bottom of every page, a Group Header is located at the top of a group
and a Group Footer is located at the bottom of a group. Group Footers are a
great place to put totals or other summary information.

The third option, New Page After, prints the next section after the current one
at the top of a new page.

The orientation options, portrait and landscape, are self explanatory.

Color tab, Section Expert

From the Color tab, you can specify a background color for a report section.
Each section can have a different background color. To do so, use the Format
Formula Editor to write a formula that specifies which sections have a spe-
cific background color. I discuss formulas in detail in Chapter 10. Figure 7-6
shows the Section Expert Color tab.

Section Expert =]
Sectiona: Insan + Common | Paging | Color
[Renort Header m
Faye Header
Dedails
Fage Footer
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If you don’t select the Background Color option, Crystal Reports doesn’t give
the background any color. Selecting the check box activates the drop-down
list and basic color-choice palette, as shown in Figure 7-7.

Quite a few colors are available. If the standard choices don’t meet your
needs, click More to display a more-comprehensive Color palette. As shown
in Figure 7-8, you can define thousands of colors from the Color palette.
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Sectiona:

Fage Header
Delails

Paue Foole
Mot looter

=

Hue: [ 160

Sat: {0
ColorSobd | (121

Red: | 192
Green: 132
Blue: | 192
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Good design principles suggest that you select color schemes that are appro-
priate for the material you are presenting. Also make sure that there is suffi-
cient contrast between the color of your text font and the background.

Using different colors for different sections

You can specify a background color for each section of your report.
Depending on the effect you want to convey, you might leave all section back-
grounds uncolored or maybe create a rainbow effect, with each section a
different color. A more conservative approach is to use colored backgrounds
sparingly but tastefully.

Be aware of how your users will view your report. If you anticipate that your
viewers will print the report on a black-and-white printer, don’t go overboard
with color. However, if users will view the report on computer screens or will
print it on a color printer, take advantage of the expanded possibilities that
color gives you.
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Giving reports a classic banded look

You can simulate a classic banded look in your reports by using a conditional
formula. To demonstrate this, follow these steps to add silver bands (or
bands of any other color) in the background of the Big Orders report that I
show you how to build and save in Chapter 5.

. Open the Big Orders report and switch to the Design tab.

. Right-click the Details tab and choose Section Expert.

. In Section Expert, switch to the Color tab.

. In the Sections area, select the Details section.

. Select the Background Color check box.

S U e W N -

. From the pull-down list, select a color and then click the Formula
Editor icon.

For this example, select Silver (or whatever color you prefer). Formula
Workshop appears in Format Formula Editor: Background Color mode.

7. In the text area in the bottom half of the editor, enter the following
formula, replacing color with the color you selected:

If Remainder (RecordNumber, 4) In [1,2] Then color Else NoColor

If you follow along with the example, the formula should be the same as
the one shown in Figure 7-9. The comments show how to specify a color:
in this case, crSilver.

-+ Formula Workshop - Format Farmula Editar - Background Color =1 %]
B sove snd ciose [ save % | 7 ¢ 8 |

# oo oo (T OB AR NG TR %R oy S w || Exceptions For Nuds w|

=8 w3 B Rapon Rsids x| & g Functions = & g COoarstcn
2l 5 [ CADecuments and Setinga'user' Dekaog'CF |4 -

5 [} e
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8. Click the Save and Close button.
9. Click OK in Section Expert to dismiss it.
10. Switch to the Preview tab.
You can see the effect of this change on the single-month Orders report,

as shown in Figure 7-10.

This report brings back memories of the good old days (which you can read
about in the nearby sidebar) and also makes it easy to correlate the Order
Amount on the right with the Customer Name on the left.
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Placing Groups Where You Want Them

Depending on the type of report you're creating, you might want to depart
from the default positioning of groups within the Details section or of an
entire section. You can do so in several ways.

Starting each group at the
top of its own page

Suppose that you have a number of groups, and each group includes a large
number of detail lines. Each group ends at some random place in the middle
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of a page, with the next group following immediately. For large groups, you
might want to start each group at the top of a new page, which will provide
a proper separation between groups.

Figure 7-11 shows the top of one page of Xtreme’s Customer Report Grouped
by State or District (USA). It has the last of many records for California,

followed by the Colorado group.

For branch managers responsible for single states, it makes sense to have
each state’s records start on a new page. This makes it easier to distribute
the appropriate information to the appropriate manager, while not revealing
what is happening in other states.
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Back in the early days of computing (the 1950s
and 1960s), computers printed reports on wide
paper that was sprocket-fed through electro-
mechanical line printers. The paper had
sprocket holes on the left and right edges and

Printing reports old school

alternating green and white horizontal bands.
Each band was high enough to hold two printed
lines. The bands helped you keep lines of print
straight when you scanned across the paper
from left to right.

111
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To make each group start on a new page, follow these steps:

1. Right-click the GH1 (Group Header 1) area to the left of the first group
header on the report and choose Section Expert from the contextual
menu that appears.

Section Expert appears; refer to Figure 7-4.

2. On the Paging tab of Section Expert (refer to Figure 7-4), select the
New Page Before option.

On a report such as this one, which has a report header, selecting this
option causes a page feed after the report header is printed on the first
page, and the first group will appear at the top of the second page.
Here’s how to avoid this problem:

a. When you select the New Page Before check box, also click its
Formula Editor button to display the Format Formula Editor.

b. In the formula entry area, type Not OnFirstRecord.

This ensures that the first group always prints on the first page of
the report.

3. Click the Save and Close button to close the Format Formula Editor
and then click OK in Section Expert.

Printing totals at the bottom of a page

For a multipage report with subtotals for each group and a grand total at
the end, you might want to print the grand total at the bottom of the last
page. This is not the default format in Crystal Reports, which puts the
grand total immediately after the subtotal for the last group, as shown in
Figure 7-12.

Xtreme did not have many sales from West Virginia (WV), so the grand total
prints near the top of the last page. Printing the total at the botfom of the
page is another job for Section Expert:

1. Right-click in the area to the left of the Report Footer section and
choose Section Expert from the contextual menu that appears.

2. On the Common tab (refer to Figure 7-4), select the Print at Bottom
of Page check box.

This puts the grand total at the bottom of the page, where it’s
traditionally located.
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Restarting page numbering at
the beginning of each group

If you're starting each group on a new page and the group extends for multi-
ple pages, consider restarting the page numbering every time you start a new
group. This causes less confusion for those folks who receive a distribution
from their manager consisting of only their own group. Here’s how to restart
page numbering at the beginning of each new group:

1. Access Section Expert from the Group Footer.

2. Select the Reset Page Number After option on the Paging tab.

Hiding Details with Summary
and Drill-Down Reports

In Chapter 6, I give you a brief look at summary reports and how to drill
down into them to see the hidden detail they contain. By making a simple
selection from the Section Formatting menu, you can choose to either
display or hide a report’s detail information. You can print a detailed report
for one client, and then print a summary that hides the detail but shows the
summary information in the group footer for another client.
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For example, say you give a full, detailed report to a branch manager
responsible for a single state but give a drill-down-able summary report for
a national sales manager. In addition, though, you can also produce a sum-
mary report for which drill-down is not possible. And — bonus — you can
produce all three types of reports from the same basic report.

To create a drill-down-able report, use the Hide (Drill-Down OK) option

from the Section Formatting menu. Conversely, to create a similar summary
report for which drill-down is not enabled, use the Suppress (No Drill-Down)
option instead. With one report, you can satisfy the needs of three classes of
users. Sweet.

Generating Barcodes

These days, just about anything you can buy comes with an identifying bar-
code. Barcodes are fantastically useful. In inventory applications, reading a
product barcode when a product leaves a warehouse automatically decre-
ments the units-in-stock tally for that item. Barcodes also eliminate a lot of
mistakes that easily happen when a human has to enter a long, meaningless
number via keyboard. Crystal Reports 2008 gives you the ability to convert
not only numeric fields, but also text fields and date/time fields, into
barcodes.

You might ask, “Why would anyone want to put a barcode into a report?”
Good question. You wouldn’t want to put barcodes into a sales report or a
customer list. But, as [ mentioned, barcodes are fantastically useful, and you
can use Crystal Reports to generate them. Just put label paper into your
printer and print away! Crystal Reports enables you to put machine-readable
identifiers on your products at minimal cost, because you already have
Crystal Reports and the computer it runs on.

To demonstrate the barcode function, follow these steps to add barcodes to
the Product Price List | show you how to create in Chapter 2.
1. Open the Product Price List report, as shown in Figure 7-13.

2. In Design view, pull down the bottom boundary line of the Details
section to provide room for a barcode on each line.

3. Right-click one of the entries in the Product ID column.

The menu, shown in Figure 7-14, appears.
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4. Choose Change to Barcode.
The Select Barcode Type dialog box displays, as shown in Figure 7-15.
5. Choose the Code 39 Full ASCII option and then click OK.
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6. Switch to Preview mode.

A barcode corresponding to the Product ID is inserted on every detail

line (see Figure 7-16).

Because this sample report wasn'’t initially designed to contain barcodes, the
placement is rather arbitrary. Crystal Reports chooses to locate the barcode
in the first blank area it could find beyond the Product ID field. If you plan at
the beginning to include a barcode in a report, allocate space for it after the

field from which it is derived.
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Creating Mailing Labels

You’ll use multicolumn reports in a variety of situations. One example is

a report for printing three or four columns of mailing labels on 8% x 11"
label stock. Crystal Reports recognizes that people frequently want to print
mailing labels, so it provides the Mailing Label Report Wizard for this task.

To create a report that prints mailing labels in multiple columns, follow
these steps:

1.

From the Crystal Reports Start Page, select Mailing label report
wizard and then click OK.

. In the wizard, connect to the xtreme .mdb database and add the

Customer table to the Selected Tables pane.

For more information on this process, see Chapter 2.

3. Click Next to display Fields view.
4. Add the following fields from the Available Fields pane to the Fields

to Display pane: Contact First Name, Contact Last Name, Customer
Name, Address 1, Address 2, City, Region, and Postal Code.

. Click Next to display Label view.

In Label view, you can select a standard label type or specify the dimen-
sions and margins of nonstandard labels. You can also specify the
direction in which they will be printed: across the page and then down,
or down and then across.

The standard label choice includes not only labels that you might put
on envelopes, but also disk labels, audiocassette labels, videotape
labels, and Rolodex cards.

. Select a standard label type.

For this example, choose Avery 5160.

7. Click Next to display Record Selection view.

8. Specify which records you’re printing labels for.

For this example, suppose you want to write to customers only in the
United States. You can restrict the label printing to those customers
by specifying that the Country field from the Customer table is equal
to USA.

. Click Finish.

You get the report shown in Figure 7-17.

Hmm. The three columns of labels aren’t laid out in the most readable way.
To correct that, follow these steps:

1.

Switch to the Design tab to move things around a little; see Figure 7-18.
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2. Concatenate the Contact First Name field and the Contact Last Name
field on the first line, to make a full name with one space between the

first and last.

a. Move the fields into the Page Header temporarily.

b. Click the Insert Text Object icon and place a text box into the Da
section.

c. Expand the text box to the full width of the label.
d. Drag the Contact First Name into the text box.
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e. Right-click the text box to display the context menu and select Edit
text.

f. Locate the cursor immediately after the Contact First Name item and
enter a space.

g. Drag the Contact Last Name item into the text box and drop it after
the blank space.

You have to right-click in the Da section and choose Edit Text from
the contextual menu to insert the blank space.

3. Concatenate the Addressl and Address2 fields on the third line,
putting a couple of spaces between them.

a. Move Address2 and City out of the way temporarily.

b. Click the Insert Text Object icon and drag a text box into the Dc
section.

c. Drag the Address1 and the AddressZ2 fields into the text box.

d. Insert the editing cursor between the two fields, and press the
spacebar twice.

4. Move Region and Postal Code out of the Dd section, and then drag a
text box down into that section. Move City into the text box in Dd.

5. Type a comma and a space after the City field, and then move the
Region field after that. Follow Region with a space, and then drag
Postal Code into the text box after the space.

The result should look similar to Figure 7-19.
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6. Switch to the Preview tab.

Your report should look similar to Figure 7-20. These labels look great
and will fit nicely on the Avery 5160 label stock.
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Saving Money on Postage with a ZIP Sort

Figure 7-20 shows an example of how the addresses would print on label
stock. The labels look great, but they’re in the order in which they were
entered into the database — which means no particular order at all. That
matters because the United States Postal Service (USPS) offers a postage
discount on mass mailings of first-class letters if the letters are sorted by
ZIP code when you bring them to the post office.

Sure, you could create your labels, apply them, and then sort your mailing
by ZIP (ugh), but let Crystal Reports help you by printing your labels in
ZIP-sorted order in the first place. That way, your labels are in order while
you apply them.

Start with the report shown in Figure 7-20 and then follow these steps:

A ,L 1. In Design mode, click the Record Sort Expert icon.

The Record Sort Order dialog box appears.

2. In the Record Sort Order dialog box that appears, add
Customer.PostalCode to the Sort Fields pane.
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3. Leave the sort direction as Ascending and then click OK.
4. Switch to Preview mode.

The report shown in Figure 7-21 appears. The labels are now sorted in
ZIP code order, going down the page. Lovely!
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Chapter 8

Enhancing Your Report's
Appearance

In This Chapter
Comparing absolute and conditional formatting
Enhancing readability with Highlighting Expert
Inserting a picture into a report
Working with preprinted forms
Importing text-based objects from a file
Using the Formatting Options dialog box
Adding special fields to a report
Emphasizing important information with Report Alerts

Speeding development with report templates

F)rmatting is the primary reason for the existence of Crystal Reports —
or any report-writing software, for that matter. Any ol’ database manage-
ment system (DBMS) can retrieve results from a database and then display
or print them. The primary purpose of a DBMS is to maintain data. Putting
retrieved results in the most understandable form isn’t the DBMS

vendor’s job.

Crystal Reports offers you a comprehensive, creative array of tools that you
can use to excel at transforming the raw data retrieved from a DBMS into a
report that communicates your data to your desired audience. To achieve
your goals, use the full power of formatting in Crystal Reports to shape the
appearance of any report you generate, which allows you to create the
desired impression for your readers.

In this chapter, | compare absolute and conditional formatting, showing
you the advantages of using one or the other. I go on to describe the
Crystal Reports formatting tools at your disposal, including Highlighting
Expert, Report Alerts, and Report Templates.
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Absolute Formatting
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Absolute formatting is the regular kind of formatting that you can apply to text
and fields with Crystal Reports in your quest to present data the best way
for your audience. After you apply absolute formatting, the format is fixed,
regardless of the values of the data making up the content of the report.

[ also want you to note the following, which is both a good and a bad thing
about using absolute formatting: After you set a format with absolute format-
ting, the format is fixed unless you change it from the Design tab or Format
Editor. Every time you run the report, the formatting is the same.

Absolute formatting can comprise setting how elements and text look —
fonts, font color, centered or bold text, and so on — as well as how certain
elements are presented, such as a date format.

Setting the fonts and their
formatting for emphasis

Sure, the report might show what you want, but consider giving the report
more visual appeal by changing the fonts of various report elements. A
change as simple as making the text bold is a snap. Just select the text you
want to change (in Design view, double-click the text box) and then click
whatever formatting icon you want (say, Bold) from the Formatting toolbar.

Choosing the best font for the job, though, takes a little more consideration.
You want the data presented in your report to be as clear, informative, read-
able, and attractive as possible. With that in mind, take the following into
consideration:

1 Readability

Choose a font that is easy on the eyes. The tried-and-true fonts, such
as Times New Roman and Arial, are pretty safe choices.

Choosing a font couldn’t be much more easy. Just select the font you
want from the appropriate pane at the left end of the formatting toolbar.
If you don’t like what you see, it is easy to choose another.

1 Viewer-available

Choose fonts that are likely available on all the computers and printers
used by the people who view the report.
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If viewers don’t have the same fonts loaded on their machines, Crystal
Reports substitutes the one that it thinks is the closest to what you have
specified. To see the most common fonts — the ones I recommend that
you use to assure universally readable reports — see Table 8-1.

v Appropriate

Choose fonts that fit your report. As I mention earlier in the book, you
probably want to stick with something staid for a standard corporate
presentation. However, if your business is a little on the adventurous
side, you can get away with something sharper. Just envision your audi-
ence, and make sure that avante garde doesn’t mean unreadable.

v Color

Don’t overlook using a color for your font. Color can really make a head-
ing or a block of text stand out and command attention. Of course, that
assumes that your viewer will be seeing this in color (not a problem in a
slideshow or an online venue) or printing in color (a little more risky).
Just remember to make the font color harmonize with whatever back-
ground color you choose. Of course, black text on a white background is
very readable, and black text on a yellow background is supposed to be
the most readable combination available. If you really want something to
stand out in red text, though, avoid using that fuchsia background that
caught your eye.

Here’s how to change font color:
a. Right-click the text you want to change.

b. Choose Format Field or Format Text (whichever is an option on the
context menu that appears) to display the Format Editor.

c. On the Font tab, choose whatever as the font color. You can also
choose font, font style, and font size from here.

 Variety and continuity

You can certainly mix and match fonts — to a point. Generally accepted
design rules call for using sans serif fonts (without serifs, like Arial) for
major headings and serif fonts (such as Times New Roman) for body
text. Don’t get carried away and use a lot of fonts, styles, colors, and
sizes just because you can. Too jumbled an appearance gives you report
an amateur look. On the other hand, using the same font for a repeated
element adds an air of professionalism and continuity to your reports,
giving readers a visual cue as to what a section will contain.

v Size

Common sense will see you through this choice. Choose larger sizes
for headings, smaller for subordinate headings, and smaller still for
body text.
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Table 8-1 Safe, Common Fonts
Name Looks Like This

Times New Roman Times New Roman

Avrial Avrial

Courier New Courier New
Bookman 0Old Style Bookman Old Style

In this section, [ show you how to tinker with the formatting in the Customer
Report, Grouped by Region (Mexico), which is one of the reports from
Chapter 6. The report is shown in Figure 8-1.
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Sure, the report shows what you want, but consider giving the report more
visual appeal by changing the fonts of various report elements. For example,
alter the report title:

1. In Design view, click the report title.

2. From the contextual menu that appears, right-click the text to activate
Edit Text mode, and then select the entire title.

3. From the Formatting toolbar, choose one or more of the fonts
available on your machine to give the report title a different look.
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Make sure that whatever font you choose is also available on all the
computers and printers used by the people who view the report. This is
not a problem if you work in an organization where everyone has the
same standard software on their machine. In a more diverse environ-
ment, you might have to give some thought to what might be running on
your target audience’s machines. Alternatively, you could play it safe
and stick to the fonts listed in Table 8-1.

4. Select the style, size, and color of the font.

In the present case, the style (bold, italic, and so on) and size are fine,
but you might want to experiment with font color to get the look you
want. Here’s how:

a. Right-click the text you want to change.
b. Choose Format Text to display the Format Editor.
c. On the Font tab, choose whatever as the font color.

Figure 8-2 shows the report at this point (in black and white).

I chose the Bookman Old Style font face — a distinctive font, available on
Windows machines — for the report title. I chose green as the color for the
report title, date, grand total in the report footer, and the group headers. You
can’t see that in this book, but the color change adds some contrast to the
report, grabbing more of the reader’s attention.

I think that centering the date is a good idea. You might also want to change
the date format. Crystal Reports provides a presentable default format —
March 08, 2008 — but you can choose from many others: for example,
08-Mar-2008. Figure 8-3 shows the Date tab of Format Editor with a longer
date format selected.
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Adding graphical elements for emphasis

Another technique you can use to improve the visual appeal of your reports
is to add graphical elements (such as lines and boxes) for emphasis. For
example, set off the report title from the body of the report by enclosing it in
a box. Follow these steps to see how it changes the visual impact of a report:

1. Give the title some more vertical space, to make room for the outlin-
ing box.

Expand the Report Header section: In Design view, drag down the lower
border of the Report Header section about % inch.

2. Center the report title vertically in the Report Header section.

3. Switch to Preview mode. Then on the Insert Tools toolbar, click the
Insert Box icon.

The cursor changes to a pencil.

4. Draw a box around the title by clicking and holding over one corner,
dragging diagonally to the opposite corner, and releasing the
mouse button.

After you draw the box, you can format it.
5. Click the box to select it; then right-click it and choose Format Box.

Format Editor appears, as shown in Figure 8-4.
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6. From the Box tab, select a line thickness and a color (or other options,
if you like).
I chose a medium thickness for the line and green as the color.
7. (Optional) Click the Rounding tab, and then choose the amount of
rounding.
Use settings on the Rounding tab to round the box corners to whatever
extent you like, all the way from a rectangle to a circle. I selected a little
bit of rounding (4%), as shown in Figure 8-5.
See the result in Figure 8-6. It’s a substantial improvement over the first
version, which was created automatically by the Standard Report
Creation Wizard.
Box Rounding
|
Figure8-5: | ™= ° =
You can -
change the
appearance
of the box. —
QK J l Cancal J ‘l Hedn
|
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that you're displaying, use the extensive conditional formatting capabilities
of Crystals Reports, which I discuss next.

Conditional Formatting Using
the Format Editor

In contrast to absolute formatting (which is fixed after you complete a
report’s design), you use conditional formatting to vary the appearance (or
even the presence or absence) of a particular field, depending on the value
contained in the field. From these choices, you get greater flexibility in how
you can help your report’s audience focus on relevant details.

For example, Xtreme (the company in the sample database used for this
book) might want to draw attention to underperforming regions by
coloring group totals red for all states or districts that have cumulative
orders less than $2,000. A state might qualify for a red group total one
month but (through additional sales) earn the right to a black group total
the following month.

To demonstrate how to add conditional formatting to a report, use the
Mexico Orders report from the preceding section and add the condition that
group totals less than $2,000 should show as red rather than black.
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1. Switch to Design view.

2. In the Group Footer section, right-click the Sum of Orders.Order
Amount field and choose Format Field from the contextual menu that
appears.

Format Editor appears.
3. Click the Font tab.

You can see that the default color is black, which is the color you want
most of the time, but not this time.

w2 4. To add a condition for low order totals, click the Formula Editor
== button to the right of the Color menu.

The Format Formula Editor dialog box appears, as shown in Figure 8-7.
Comments list the available color names.

+ Formula Workshop . Format Formula Editor - Font Color 5]
B sove sngcose [l save % o 7 ) X
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|

5. Expand the Report Fields node in the first of the three panes above
the work area, so the items shown in Figure 8-7 are visible.

6. Build the formula shown in Figure 8-7.

To do so, type the keyword If. Then double-click the £ Group #1 line in
the Report Fields node (in the upper-left pane above the work area).
Complete the formula by typing the following:

< 2000 Then Red Else Black
The final formula should look like this:

If Sum ({Orders.Order Amount}, {Customer.Region}) < 2000 Then crRed Else
crBlack

7. Click the Save and Close button in Format Formula Editor.
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|
Figure 8-8:
The
Customer
Report, with
group totals
of less than
$2,000
displayed
inred.
|

8. Click OK in Format Editor.

Preview mode now displays the report in Figure 8-8. State totals of less
than $2,000 are displayed in red, and all totals greater than $2,000 are
shown in black.
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Format Formula Editor is a powerful tool that you can use for creating com-
plex conditions that govern what’s shown on a report as well as how it prints.
To maximize the capabilities of this editor, though, you need to know either
the default formula-language syntax used in Crystal Reports or the BASIC
language syntax. You can type a formula by hand or build it up by selecting
fields, functions, and operators from the panes in the top half of the Editor.

There is, however, an easier way to get some of the features of Format
Formula Editor — and without learning formula syntax: Use Highlighting
Expert, coming up next.

Creating Emphasis with
Highlighting Expert

Highlighting Expert is one of the easiest-to-use formatting tools in the Crystal
Reports repertoire. Compared with Format Formula Expert, Highlighting
Expert has limited flexibility, but you could use it instead of a formula to get
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the same red group total in the preceding section. Here’s a major difference
to note: Highlighting Expert operates only on number and currency fields;
Format Formula Editor works on any type of field.

To see Highlighting Expert in action, follow these steps:
1. Click the Design tab of the Customer Report shown earlier in

Figure 8-8.

2. In the Group Footer section, right-click the Sum of Orders.Order
Amount field and choose Highlighting Expert from the contextual
menu that appears.

The Highlighting Expert dialog box appears, as shown in Figure 8-9.

Ttem lict Ttem editor
Sample Condition

Priority

|
Figure 8-9:
The
Highlighting
Expert new |

dialog box.
|

(§55,555.56)

o) Cone ) e )

You can change the font color, the background color, or the border of
the selected item. For this example, put a single-line box around all state
or district order totals equal to or greater than $5,000.

3. Click the New button.

4. In the Value of This Field box, select is greater than or equal to. In
the text box below Value of, enter $5,000.00.

5. In the Border box, select Single box.

The Highlighting Expert dialog box now appears, as shown in
Figure 8-10.

6. Click OK.

These settings produce the report shown in Figure 8-11. The total for
Distrito Federal is enclosed in a box because its value is greater than
$5,000. The other group totals are unchanged.
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Adding Pictures to Vour Report

You can add graphical images to a report to further enhance its visual appeal.
You can even add Flash animations. I cover Flash animations and the interac-
tivity that is possible with them in Chapter 17. Here I stick to talking about
static pictures.
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To add a picture — bitmapped graphic images — to your report, follow
these steps:

1.

Make sure you have space where you want to place the image.

I'm putting a Mexican flag in the report header. Unfortunately, I didn’t
think of this earlier and filled the report header with the report title.
This isn’t a problem, though. I just change the title to a smaller font and
then redraw the box around the title, freeing up space for the flag. (You
can read how to change the box and reset the box size earlier in this
chapter.)

2. On the Insert Tools toolbar, click the Insert Picture icon.

3. From the dialog box that appears, select the appropriate image file.

5.

You

On the report, a rectangle appears that you can move around with the
mouse.

. Position the rectangle where you want the image to be located, and

then click.

The image appears on the report. Figure 8-12 shows the result of placing
a Mexican flag in the report. The flag image was a little too tall to fit in
the report header, but when I released the mouse button, the report
header expanded just enough to hold the image.

Save the report as Customer Orders by State or District (Mexico).

now have a report fit for the eyes of a Vice President of Sales!
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Aligning Preprinted Forms

Preprinted forms are designed to be filled out by hand or run through a
sprocket-fed line printer. When using a laser or inkjet printer, it’s devilishly
hard to line up text with the lines and boxes on the form that are supposed to
hold that text. Most people are more likely to have a laser or inkjet printer
than a sprocket-fed printer these days, so alignment can be a problem.

Crystal Reports offers a clever solution to aligning text to preprinted forms.
Because a report can have both text and graphical elements, and one can
overlie the other, you can align text perfectly to a preprinted form by follow-
ing a few simple steps involving a scanner:

1. Scan the preprinted form and save it as a bitmapped file.

2. Place the scanned form in the Page Header section of the report as
a bitmap.

3. Select the Underlay Following Sections option on Section Expert’s
Common tab.

4. Add text fields in the appropriate places of the Details section to line
up with the form.

5. Both the form and the data print in one operation.

Adding Text from a File

Crystal Reports is primarily designed to take data from a database, process
it, format it, and then display it to the user. However, it can also display
blocks of text from document files. You can control the formatting of the text
block by sizing the text object that you insert it into.

To insert a block of text into a report, follow these steps:
1. Insert a text object into the report at the location where you want the

text to appear.

2. Right-click the object and choose Insert from File from the contextual
menu that appears.

An Open dialog box appears, listing files in whatever directory was
accessed last.

3. Find the directory that has the file you want to insert.
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4. Click Open.

The text file is transferred to the text object.

Formatting Options

Report developers can customize the development environment from
settings available on the Options dialog box (see Figure 8-13).
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[+] Stvaw Field Meess
Figure 8-13: Insest Uetail Field Headings
. Insest Group Name with Group
Options
dialog box,
with Layout
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ok J[ Concet [ e ]
| 1

To open this dialog box, just choose File>Options The Options dialog

box has eight tabs, with the Layout tab on top by default. As you can see in
Figure 8-13, you can change many options, all of which amend what gets
displayed and how. Most options are self-explanatory. Following is a quick
rundown of each tab:

v Layout: Select what will be displayed on the work surface in both Design
and Preview modes.

v Database: View system tables and any synonyms or stored procedures
that the database has. You can look for approximate matches in table
names, and decide how tables and fields are listed. The default values
of the Advanced Options, as shown in Figure 8-14, are better left as they
are unless you have a compelling reason to change them.
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v Formula Editor: Customize the formatting options for the text you
create with any of the editors, and specify some options for the
Formula Editor.

+ Dependency Checker: Decide whether to check formulas, expressions,
custom functions and other items for syntax errors and validity.

v Reporting: Set a number of miscellaneous options.

v Smart Tag & HTML Preview: Define the Web server and viewing
page you want to use when selecting Office smart tags for Crystal
report objects.

v~ Fonts: Set default fonts for fields, charts, and text objects.

v~ Fields: Customize the formats of the various field types.

As you can read to this point, the broad array of Crystal Reports’ formatting

options gives you a lot of creative latitude for how your reports present
information. Those options make your job of communicating much easier.
However, Crystal Reports offers other modes of communication that are just
as effective. One of the most powerful is Crystal Reports’ charting capability,
which is the subject of Chapter 15.
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Special Fields Contain Report Metadata

Crystal Reports enables you to include report metadata within the report
that the metadata is describing. Metadata is data about data, and report meta-
data is descriptive data about a report. For many kinds of reports, you might
want to include metadata items in the report itself. For example, readers
might want to know the date when the data in the report was last refreshed.
They might want to know the name of the author of the report. You can dis-
play such things in your reports as special fields, which are accessible from
the Special Fields list in Field Explorer. Well over a dozen special fields are
available there, each one holding pertinent information about the report. You
can drag them onto your report and drop them wherever you like.

Raising a Red Flag with Report Alerts

Sometimes the data in a report indicates a condition that requires urgent
attention on the part of the report reader, but the urgency might not be read-
ily apparent just from perusing the report. To make sure that the urgency
gets across, Crystal Reports offers Report Alerts, which are custom messages
that appear when certain conditions are met by data in the report. You can
set a Report Alert to merely inform the reader of the condition, or specify a
course of action to take.

Create a Report Alert by entering a formula, using the Formula Workshop.

[ discuss the Formula Workshop extensively in Chapter 10. In a Report Alert,
the formula evaluates conditions that you specify. If the overall condition
evaluates to TRUE, the alert is triggered, and its message is displayed. The
message can be a text string, either by itself or combined with one or more
report fields.

As an example, suppose that the Xtreme sales manager wants to be alerted
whenever a customer in Mexico orders more than $5,000 of merchandise.
A Report Alert added to the Customer Orders by State or District (Mexico)
report will do the job. First, create the text of the alert. Then, set the
condition that will trigger the alert.

Here’s how to add the message itself:
1. With the target report active, choose Report=>Alerts from the main
menu.

2. From the submenu that appears, click Create or Modify Alerts.

The Create Alerts dialog box appears, as shown in Figure 8-15. This
dialog box lists alerts by name and tells whether they are enabled
or disabled.
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3. Click the New button to display the Create Alert dialog box.
Note: This is not the same as the Create Alerts dialog box in Step 2.
4. In the Name field of the Create Alert dialog box, enter BonusTime.

5. Click the Formula Editor button to the right of the Message Field to dis-
play the alert Message Formula Editor version of Formula Workshop.

6. From the Report Fields pane, drag Customer.Customer Name, and
drop it in the upper-left corner of the formula area that fills the lower
half of the Workshop.

7. Type a space, a plus sign, and then another space to the right of the
Customer.Customer Name field in the formula area.

8. To the right of the plus sign and space, type the text string, “ has made
a BIG order!”

Note the blank space between the opening quote and the first word.

Be sure to include the opening and closing double quotes in the string
that you type. The formula should appear as shown in Figure 8-16.
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9. Click the Save and Close button to return to the Create Alert
dialog box.

10. In the Create Alert dialog box, click the Condition button.
The Alert Condition Formula Editor version of the Formula Workshop
appears.

Now specify what condition must occur that will trigger the display of this
Report Alert:

1. From the Report Fields pane, drag the Orders.Order Amount field into
the formula area and drop it in the upper-left corner.

2. In the Operators pane, expand the Comparisons node and drag the
Greater Than operator down. Drop it just to the right of the
Orders.Order Amount field.

3. To the right of the Greater Than symbol, type 5000.
This produces the formula shown in Figure 8-17.

4. Click Save and Close to once again return to the Create Alert
dialog box.

5. Ensure that the Enabled condition is selected (checked), and then
click OK.

This puts your new Report Alert into the Create Alerts dialog box, as
shown in Figure 8-18.

6. Click the Close button to return to your report.
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To see the Report Alert in action, just click the Refresh icon on the Standard
toolbar. The Refresh Report Data dialog box pops up, asking you whether you
really want to refresh the report data. And you do, so click OK.

If any customers have orders that exceed $5,000, now a Report Alert pops up
to let you know. Figure 8-19 shows what one looks like.

To see exactly how big the order total is, click the View Records button in the
Report Alerts dialog box.

+ Report Alerts %}
The following alerta were tiggered on proceaaing the report.
hame Meszage
[ BorwsTime Depones Mexico Cty has made a BIG order!

Using Report Templates to

Save

Time and Effort

Crystal Reports does indeed make report creation easy, but it still takes con-
siderable thought and work on your part to design reports that are well pro-
portioned, presented with an attractive choice of fonts, drawing elements,
colors, and layout.
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Considering the time that you invest to create one report, it would be nice if
you could recycle your work to use in a similar report down the road. You
save time and effort, while creating a visual consistency from one report to
the next that conveys professionalism.

You can achieve that consistency and save that time and effort by using a
report template, which is an existing report, complete with formatting, that
you can use as a starting point for a new report that you create. You don’t
have to create the new report from scratch; you have to change only the
things that are different between the template report and the new report you
are creating. And sometimes you don’t have to change anything.

Apply the template as the last step in your report creation process and voila!
You're finished, creating a polished, professional report in a fraction of the
time it would normally take to create one.

Applying a template to a report

Here are the ways to apply a template to a report.
v When creating a report: Select a template from the Template view in
the Standard Report Creation Wizard.
1~ After you create a report: Select a template, using the Template Expert.

v~ Using an existing report: Use it as a template for your new report. Using
areport as a template adds it to your mental list of available templates
for possible use in the future.

1 Creating a report specifically as a template: It can serve as a pre-
formatted skeleton for a variety of reports.

Applying a template to an existing report

Applying a template to an already existing report is easy. To see just how
easy, look again at the Big Orders report from Chapter 5; see Figure 5-17 (with
a $5,000 lower limit) and again here in Figure 8-20 (with a $9,000 lower limit).

It looks pretty plain, but you can spruce it up with one of the Crystal Reports
standard templates. Here’s how:

1. Click the Template Expert icon on the Expert Tools toolbar.

The Template Expert, as shown in Figure 8-21, opens.
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Figure 8-20:
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2. From the Available Templates pane, select Block (Blue), then click OK.

The Template Expert disappears. After a few seconds, the Block format-

ting is applied to your report. In this example, the result looks like
Figure 8-22.
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In this case, the template’s headings override the original headings. (The
detail rows are unchanged.) And if the formatting that the template gives you
is close to what you want but not exactly perfect, change to Design view and
make the changes you want. For starters, you probably want to replace the
Business Objects logo in the page header with your own logo.

Any template alterations you make are much less work than setting all your
formatting from scratch.

When you're finished tweaking, save this report with the name Big Orders
with Template.

Applying a template to a
report you're creating

When you create a report with the Standard Report Creation Wizard, the
wizard steps you through a series of views. We have already seen several of
these. Below is a complete list, the last of which is Template view.

v~ Data: Select tables to include in your report.

v Links: If you're including more than one table, specify here how the
tables are linked.

Chapter 8: Enhancing Your Report's Appearance ’ 45
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v~ Fields: Specify which fields from the selected tables you're going to use.

v Grouping: Separate records into groups in the report (for example,
grouping customers by country).

v Summaries: Specify any summaries that you want to include in the
report, such as totals or averages of numerical data.

v Group Sorting: Specify the order in which you want groups sorted.

v~ Chart view: Specify what kind of chart you want to create to give a
graphical representation of your data.

1 Record Selection: Filter out records that you don’t want.

1 Template: Choose this from the Template view of the Standard Report
Creation Wizard. This wizard, as shown in Figure 8-23, looks very similar
to the Template Expert shown in Figure 8-21. They resemble each other
because they serve similar purposes.

If some of the preceding listed views aren’t relevant, they don’t appear,
depending on the choices you make as you progress through the wizard.
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In this part . . .

Fis part introduces you to the major leagues of report
creation. With the knowledge you gain here, you’ll be
able to produce reports that are the ultimate in sophisti-
cation. You uncover ways to select the data that your
report will include and sort it for maximum understand-
ability. You make reports that use formulas and almost
think for themselves. Cross-tab reports expose correla-
tions in your data. OLE enables you to include data from
nontraditional data sources. OLAP introduces you to
multidimensional reporting. Charts and graphs tell your
story in a way that words can’t express.




Chapter 9

Displaying Your Top Ten
(Or Top N) with Group Sort

In This Chapter

Sorting groups by performance rather than by name

Selecting by percentage
Sorting groups in reverse

Troubleshooting problems with group sorts

A n old saying in the sales business is that you get 80 percent of your
sales from 20 percent of your customers. It’s called the Pareto Principle,
or the 80/20 rule, and it’s not restricted to sales. When doing the same work,
some people or things are more productive than others. If you identify the
most productive salespeople, machinery, or whatever, you can analyze the
factors that make them so effective and perhaps apply what you learn to
increase productivity overall.

In Chapter 6, I cover how to sort records and group them. A valuable extension
of these capabilities is producing a report that shows only the top producers.
In this chapter, you find out how to do just that.

Sorting Groups Based on Performance

In Chapter 6, I discuss the creation of a report for Xtreme Mountain Bikes that
shows the dollar totals of individual sales orders, sorts the orders by customer
name, groups records by state, and sorts the groups by state. That report, how-
ever, isn’t very helpful to the Vice President of Sales, who is trying to get a feel
for which customers are buying the most.
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|
Figure 9-1:
Customer
and Orders
tables
selected
from
Standard
Report
Creation
Wizard.

Adding drill-down capability to the report (as you can see in Chapter 6) shows
which states are responsible for the most sales (on a percentage basis) but
doesn’t show which customers are the best. To get the information you want,
in the form that’s easiest to understand, a Top N report is probably your best
choice. If you're interested in finding out more about your top five customers,
then N equals 5. If you want to know about the top ten, then N equals 10.

Starting a Top N Report

To build a Top N Report, follow these steps:

1. Select Report Wizard from the list of options on the Start Page.

A blank report appears on the workspace, and Database Expert gives
you the opportunity to connect to a data source.

2. Connect to the xtreme.mdb database, and then select the Customer
and Orders tables, as shown in Figure 9-1.

If Steps 1 and 2 are I'peek (Greek) to you, hop to Chapters 2 and 4 for
how to do these basic tasks.
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3. Click Next to display Link view.

You see the Customer table connected to the Orders table by the

Customer ID field.

4. Click Next to display Fields view.
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|
Figure 9-2:
Group
Sorting
view,
showing

the Top 5
Groups
option.
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. Move Customer Name, Region, and Order Amount to the Fields to

Display pane.

. Click Next to display Grouping view.

The Vice President of Sales wants to list the five top U.S. customers, along
with their states and the total amount of their orders. The easy way to do
this is to group the records by Customer ID, hide order detail, sort by the

sum of the order amount for each customer, and include the top five cus-

tomers in the report.

. Move Customer.Customer Name to the Group By pane and specify

descending order.

This puts the customer with the highest total first.

. Click Next to display Summaries view.

In the Summarized Fields pane, Crystal Reports infers that you want to
summarize Sum of Orders.Order Amount. It is the only field of the three
that you specified as numeric. It also infers that the specific type of sum-
mary you want is a Sum.

9. Click Next to display Group Sorting view, which is shown in Figure 9-2.

+ Standard Report Creation Wizard <}
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Comparing summary values torthe lop or Bottom groups:
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10. Select the Top 5 Groups radio button.

In the Comparing Summary Values for the Top or Bottom Groups pull-
down list, Crystal Reports has selected Sum of Orders.Order Amount
for you.

11. Click Next to display Chart view, and then click Next again to display

Record Selection view.
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12. You're interested in only U.S. sales at present. Move Customer.Country
from the Available Fields pane to the Filter Fields pane. In the drop-
down menus below the Filter Fields pane, select is equal to and USA.

Figure 9-3 shows Record Selection view filled out.
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13. Click Next to display Template view.
14. Select a template for the report.

To follow along with the example, select the Block (Blue) template. (I
cover templates in Chapter 8.)

15. Click Finish.
Crystal Reports builds your report and it appears onscreen, as shown in
Figure 9-4.

It’s not exactly what the Vice President of Sales had in mind. You need to
make the following adjustments:
v Delete the Business Objects logo, which appears at the top of every page.
v Give the report a title.

v Change the Region column heading to State, and center the state data
under it.

v Space the columns horizontally.
v Delete the repeated customer name entries in the detail lines.
v Hide the individual entries for each order.

v Display the sum of the orders for each displayed customer.
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To make the needed adjustments, follow these steps:

1.
2.

Switch to Design mode.

Right-click the Business Objects logo in the page header and choose
Cut from the contextual menu that appears.

In the Page Header section PHa, an area has been set aside for the report
title. If you're wondering about PHa: In this template, the Page Header is
subdivided into two sections, labeled PHa and PHb.

3. Drop a text box onto the report title area in the page header.

4. Type Top Five USA Customers inside the newly placed text field.

5. Center the text and increase its font size to 22 to make the heading

easier to read.

. In the Report Description text object, after the words Report

Description, type The Top Five USA Customers. Expand the
text box to the right to accommodate the entire description.

Things are going well.

. Change the Region column heading to State and center the two-

character state abbreviations below it.

Make the change to the column heading in group header GHb. To center
the state abbreviation, click the Region field in the Details section, and
then click the Align Center icon on the Formatting toolbar.
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8. Spread out the group headers and details columns for State and Order
Amount on the page, while eliminating the Customer Name column.

Because the customer name appears in the group header, you don’t
need to repeat it in the Details area.

At this point, the report looks like Figure 9-5.

file Ldit View Insert format Database Report Window llelp
SR F A= NG e - e | .- Y R SE &
Bz U A=
1B ECDZMNY O DO 0 = b8l o | 4o o A 5

Start Page  Reporl§
Design Preview

Y TS - ey e ——
RH B e e e o el e o o A e A P A P A B A PP A S A
| PHe
Figure 9-5: . Report Title Top Five USA Customers
The page 2 -:jh';ulrl Description: The Top Fve USA Customers
header, | Report Comments X
column
headers,
and details
lines have i
been 0 A oA IL T
" A A A o o A 7
modified.
— | ror Help, press 11 TR R ==I——

Displaying a group total
The next thing to do is display a group total in the Group Footer section:
1. Pull down the lower boundary of the shaded rectangle drawing object
from GFla (Group Footer) to GF1b.

This enables you to put a group sum into the GFla space. Note the
grayed-out field at the left edge of the GFla section. This is the sum field
for the group named Sum of Orders.Order Amount. It is grayed out
because it is currently suppressed.

2. Right-click the Sum of Orders.Order Amount field in GFla. From the
contextual menu that opens, choose Format Field.

The Format Editor dialog box appears, with the Number tab selected.
3. Click the Common tab (see Figure 9-6).
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4. Clear the Suppress option (uncheck it) and then click OK.
The Sum of Orders.Order Amount field is fully visible.

5. Move the Sum of Orders.Order Amount field to the right so that it
lines up directly beneath the Order Amount column.

6. Switch to Preview mode.

Crystal Reports displays the Sum field in the appropriate place in the
GF1la section, below the Order Amount heading.

Hiding the details

The next thing you might want to do to produce a summary report for a top
executive is to hide all the detail lines:

1. Right-click the area to the right of the Details section and choose Hide
(Drill-Down OK).

The report now looks like Figure 9-7. This is still not quite what you
want. The customer name is bigger and bolder than it needs to be for
a one-line entry. The state information has been hidden, and you still
have only one customer per page. These defects are easy to correct.
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2. Click the Insert Summary icon.

The Insert Summary dialog box appears.

. Make the selections shown in Figure 9-8.

These selections are as follows:
a. Summarize the Customer.Customer Name field.
b. Use the Maximum summary operator.
c. Choose Group #1 for the summary location.

Crystal Reports automatically places the Customer Name field in the
appropriate place in the GFla section, below the Customer Name head-
ing. You might have to move the summary to line it up with the template
and with the numerical sum on the right side of the report.

. Repeat Step 3 for the Customer.Region field to insert it below the

State heading.

. With the Region still selected, click the Align Center icon to center the

state abbreviation below the State heading.

. Delete the Customer.Customer Name field from GH1a.

This leaves each group with all the information you want and none of
the extra stuff you don’t want to display.
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Removing page breaks

Now all you have to do is remove the page breaks between groups. The page
breaks were set by a formula in the Group Footer #1 specification. To delete
the formula, follow these steps:

1. Right-click the area to the left of the GFla section and choose Section
Expert.

From the context menu, choose Section Expert. The Section Expert dialog
box appears, as shown in Figure 9-9. Group Footer #1a is selected.
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2. Move the Group Footer #1a selection up one row to Group Footer #1,
and switch to the Paging tab in the pane on the right.

Note that for the Group Footer #1 section, the New Page After check box
is selected. A color change in the formula icon for that selection indicates
that this action is controlled by a formula. Blue has turned to red.

w2 3. Click the Format Editor icon.
Format Formula Editor appears, as shown in Figure 9-10.
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I

4. Delete the not onlastrecord formula (in the formula area).

Deleting this formula just keeps things clean and tidy. It has no effect
after Step 6.

5. Click the Save and Close icon.

6. Back in Section Expert, clear the New Page After check box and then
click OK.

This gives you the five top customers, their states, and the amount each
has purchased, as shown in Figure 9-11.

7. Save this report as Top5USAfinal.rpt.



Chapter 9: Displaying Your Top Ten (Or Top N) with Group Sort ’59

203 i ). s =

el S
al = E £ 350
Start Page  Reports =

Deslgn | Preview

file Edit View Insert format Database Heport Window Help

z %1

.| &) £ | 2 ‘ lof 1

PHa
Top Five USA Customers
Report Description: The Top Five USA Customers |
P
GHls
Gl [ Staic | |
GFla Paycho-Cycle Al $103,535.50
Gl
GHla
|
G T |
GFla Crank Componenis (18 SE1.47T7.20
|
Figure 9-11: e e —
The Hooked on Helmets MH §70.245.79
completed
report. Rt N
EES— | FOr Help, press F1 | oo 7 i#

Crystal Reports offers a number of different sum-
marizations in addition to simple sums such as
the one | discuss here. When you click the
Summarization icon (the capital sigma, X), the
Insert Summary dialog box appears, as shown in
the following figure. Available summary functions
appear in the pull-down list, some of which you
might wantto use, depending on your application.

For numeric fields, the summary options are as
follows: Sum; Average; Sample Variance; Sample
Standard Deviation; Maximum; Minimum; Count;
Distinct Count; Correlation With; Covariance
With; Median; Mode; Nth Largest; Nth Smallest;
Nth Most Frequent; Pth Percentile; Population
Variance; Population Standard Deviation; and
Weighted Average With.

For text fields, you choose from a smaller range
of possibilities: Maximum; Minimum; Count;
Distinct Count; Mode; Nth Largest; Nth Smallest;
Nth Most Frequent.

Summary fields do more than just compute sums

These choices give you just about any type of
summary you'd ever want.

Choose the field to summarize:
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Caloutate this summary:
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Going with the Percentages

Sometimes it’s more helpful to know who is responsible for the largest percent-
age of an organization’s total sales rather than the specific dollar amount. The
Group Sorting screen of the Standard Report Creation Wizard handles sum-
maries expressed as percentages as well as straight numbers. You could build
areport from scratch (similar to the one in the preceding section) by following
most of the same steps, with just a slight difference at the summarization step.

Rather than going through all that again here, though, just modify the com-
pleted report (refer to Figure 9-11) to display percentages rather than group
totals. Just follow these steps:

1. In Design mode, right-click the Sum of Orders.Order Amount field in
the Group Footer #1a section.

The menu shown in Figure 9-12 appears.

Field: Sum of Orders.Order Amount
Hnd in Formulas

] Format Ficld...
+' Format Painter

Edit Summary...
[@  Highlighting Expert...

] Select Expert Record...
Select Fxpert Group...

Flgure 9-12: Select kxpert Saved Data...
Menu for = \
jove
Orders. Size and Position...
Order | , .
X Cut
Amgunt R copy
field. |7 paste
— Delote

2. Choose Edit Summary.
The Edit Summary dialog box appears.

3. Select the Orders.Order Amount field to summarize; calculate the Sum
summary, and select the box to the left of Show as a Percentage Of.

The drop-down list below the Show as Percentage Of line holds the value
you want (Grand Total: Sum of Order Amount).

4. Click OK.
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Now when you switch to Preview mode, you see the report shown in

Figure 9-13. The five top customers are listed along with their percentage of
Xtreme’s total sales. This report tells you something that you didn’t get from
the previous report: The top five customers combined, account for less than
15 percent of Xtreme’s orders. Looks like Xtreme is in the healthy position of
not depending too much on a small number of customers. Sales volume is
distributed over a large customer base.
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What if you want the top 17
instead of the top 5?

The group sort used here to produce the latest reports happened to ask for
the top five customers. Okay, that’s suspiciously convenient; the Standard
Report Creation Wizard gives you the option of selecting the top 5 or bottom
5 — but not the top 10, top 17, and so on. If you want your report to return
some number of groups other than five, use Group Sort Expert.

o Click the Group Sort Expert icon, on the Expert Tools toolbar, to open the
=| Group Sort Expert dialog box, as shown in Figure 9-14.

M
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The default values for the current report are shown. The type of sort is Top
N, based on Sum of Orders.Order Amount, where N is 5. If you want to see the
percentage sales of the top 17 customers instead of the top 5, just replace
the 5 with a 17 in the Where N Is field, and then click OK. The only task that
remains to make this a complete report is to change the references to Five in
the page header to Seventeen. Figure 9-15 shows the result.
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Figure 9-16:
The

revised Top
Seventeen
report.
|

Hmmm. Maybe you’re not finished after all. Now the report extends over two
pages, and it seems redundant to repeat column headings above each cus-
tomer line. Also, the space between records is excessive. You can tighten up
the report as follows:

1.

In Design mode, right-click the area to the left of PHb (page header) and
choose Insert Section Below from the contextual menu that appears.

One way to tighten up your report is to move the column headings from
the Group Heading section to the Page Heading section. This means you
have to expand the Page Heading section by adding a new subsection —
in this case, PHc.

. Drag the column headings up from GH1b to PHc, placing them at the

top of the PHc space.

3. Drag the bottom of the section up to the bottom of the column headings.

4. Drag the bottom of the shaded box Drawing Object (that provides the

background color) down into the Page Footer section.

5. Drag the top of the box down to the bottom of the GHb section.

6. Right-click the area to the left of Group Header a to display a contextual

menu, and then use it to suppress GHa.

This eliminates GHa, which is doing nothing but taking up space. At this
point, the report looks like Figure 9-16.

. Save the report as Top17USA.

Hie Edit View [nsert Format Database Report Window Help
Start Page  TopbUSAfinal =

Daskgn
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spsssssssn®s

Preview x
Top Seventeen USA Customers
Report Description: The Top Sevenleen USA Customs
[ Psycha.Cycle &l 350 %
Crank Components I8 283%
Hooked on Helmets MH 2T%
The Great Bike Shop AL 284%

Hlazing Saddles wi 264 %

The Biker's Path I 248%

Tandem Cyde in 243%

Sporting Wheels inc. A 242%

Rockshocks for Jocks X 227%
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A Choice of Group Sorts

If you've read this chapter to this point, you can probably guess (from what
you have seen so far) that everything you can do for the top performers, you
can also do for the bottom performers. Take a closer look at the Group Sort
Expert dialog box. Figure 9-17 shows it with the group sort list pulled down.
The options on this menu are No Sort, All, Top N, Bottom N, Top Percentage,
and Bottom Percentage.

¢ Group Sort Expert %]

Analyze report or chart reaults by taking the Top M or Sort of totals.

Customer Customer Name

Forthis group sort

|
Figure 9-17:
Group Sort
Expert
dialog box, [Jinchude ties
showing
group

sort list.
|

v|  basedon Sum of Ordera Order Amaunt v|

[include Cehars wah the name

ok__|[ cancel ][ Hew

[ explain earlier what choosing Top N does. Choosing Bottom N does the
same thing, just for the tail-enders rather than the leaders. The other four
options require a little explanation.

v No Sort: Using the No Sort option does what it says: nothing. It leaves
the lines of the report in the order in which the corresponding groups
appear in the database. You might wonder why this option even exists.
Maybe you want to build a new report based on an existing one, but the
existing report is sorted. If you want your new report to reflect the order
of the records in the database rather than the sort order of the old report,
one way to get what you want is to use the No Sort option.

v All: Using the All option sorts and displays all the groups, not restricting
the display to any given number. A report built according to this option
contains all the data of a Top N report, plus all the data of a Bottom N
report, plus data on all the groups not included in either of those.

v Top Percentage: When using a Top Percentage group sort, you specify
the top percentage that you want to see in the report. For example, if you
want to see whether the 80/20 rule applies to your organization, specify a
Top Percentage group sort, and enter 80 in the Where Percentage Is box.
For example, if you have 90 customers, the 80/20 rule holds if the report
lists about 18 customers (representing 20 percent of the total).
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+ Bottom Percentage: To report on the customers who order the least
amount of product, use the Bottom Percentage group sort. For Xtreme
Mountain Bikes, the companies in this report need help or should be
replaced by companies that can do a better job.

Troubleshooting Group Sort Problems

Because Group Sort Expert walks you through the process of sorting and
summarizing group data, there aren’t many ways for you to get into trouble.
However, here are a few things to keep in mind when adding group-sort
capability to a report:

v You can’t perform a Top N, a Bottom N, or other type of group sort
unless your report contains a summary value. If you have trouble cre-
ating a Top N or a Bottom N report, make sure that the sort is based on
a summary value.

v Creating a subtotal for a group might not work if the report data is
drawn from tables linked in a one-to-many relationship. For such a
case, you might have to use a running total instead of a subtotal. If
you’re not getting the summary values you want and your report is
drawing data from multiple tables, check whether the tables have a one-
to-many relationship. If such a relationship exists, try using a running
total rather than a subtotal for each group. (Chapter 6 explains the use
of running totals.)

What’s a one-to-many relationship, you ask? It’s a relationship between
two database tables where one record in the first table corresponds to
multiple records in the second table. For example, the relationship
between the CUSTOMER table and the ORDERS table is one to many.
One customer can make multiple orders, but each order is made by one
and only one customer.

1 Watch out for invisible objects. Sometimes, you’ll want to shrink the
size of a section by dragging up its lower boundary. If you find that the
section will shrink only so much and no more, an invisible object might
be in the section. You can’t shrink a section past the border of an object
that the section contains, even if you can’t see the object. Check carefully
to see whether the border of a drawing object or an empty text object is
hidden under the boundary line that you're trying to drag up. When you
drag your mouse over a hidden object, its border line appears. This is
your clue that the object exists. Once you know it is there, you can
delete it.
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Chapter 10
Adding Formulas to Reports

In This Chapter

Understanding formula syntax

Writing formulas with Formula Workshop
Deleting formulas you no longer want

Using data types in formulas

Manipulating data with variables in formulas

Altering reports at runtime with control structures

ou can create a report by dragging database fields onto a blank report,

adding text and images, and performing a variety of summaries. Such
reports are fine for many applications, but sometimes you want to do more
than merely summarize data. You might want to process it in some way
before displaying it. Crystal Reports has a formula capability that gives you
much more latitude in creating the report you want. If you're already a pro-
grammer, using formulas won’t be tough. If you’re not a programmer, you
might be surprised to see how soon you can do useful things with formulas.
Formulas enable you to perform arithmetic, logical, and string manipulation
operations on your data. Using formulas, you can present in your report the
information you want your readers to see, even if it’s not present in the
proper form in your database.

In this chapter, I show you how to use formulas to massage raw data into a
presentable form. Crystal Reports includes a number of built-in functions
that you can include in your formulas to speed your development efforts. In
addition to the built-in functions, you can create your own custom functions
to perform operations that are a little out of the ordinary.

Formula Overview and Syntax

You can use formulas in a number of ways.

One common use of a formula is to perform a calculation that modifies the
contents of a database field. Suppose you have a database table named
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Product that holds data (including price) on all the products you sell. To
calculate a 10-percent discount from your normal price, you could use a
formula such as this:

{Product.Price} * .9

Formulas follow one of two Crystal Reports syntaxes, either one of which you
can use to write them. The two syntaxes are equivalent, so you can use which-
ever you find easier. The preceding formula (for example), written with BASIC
syntax, looks like this:

formula = {Product.Price} * .9

Crystal Reports Basic syntax is similar to Visual Basic syntax. If you're a Visual
Basic programmer, you might be most comfortable using BASIC syntax — and
it'll work. If you’re not particularly biased toward Visual Basic, you might
prefer to use Crystal Reports syntax (unchanged since the early versions of
the product). Although Crystal Reports syntax can do a few things that BASIC
syntax can’t, neither has a universal advantage over the other. In the example
formulas in this book, [ use Crystal Reports syntax.

In this chapter, I throw at you a number of new words. Here are some simple
definitions to help you understand how these terms are used in a program-
ming context.

v Formula: Any legal combination of symbols that represents a value.

v Function: A section of a formula that performs a specific task.

v Operator: A symbol that represents a specific action. For example, the
(+) sign is the operator for the addition operation.

v Parameter: A variable that is passed to a function.
»* Argument: A parameter.

v Clause: A subsection of a formula.

v Variable: A symbol or name that stands for a value.

v Data type: Classification of a particular type of data. Different data types
include Date, Integer, and Character.

Lessening the Workload with Functions

Crystal Reports has a number of predefined functions, which you can include in
formulas to reduce the size and complexity of the formula code that you have
to write yourself. For example, suppose that you have a database application
with a data entry form in which users enter a customer’s name and address
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information. In the Region field, users are supposed to enter an uppercase, two-
letter state or province code. If the user accidentally fails to use uppercase, the
following Crystal Reports UpperCase function corrects that problem:

UpperCase ({Customer.Region})

This formula converts whatever is in the Region field of the Customer table
to uppercase. As you can see, the argument of the function is enclosed in
parentheses. The combination of the UpperCase function and its argument
{Customer.Region} constitutes a formula. If the contents are already in
uppercase, no change occurs. If any of the letters are lowercase, though,
they’re changed to uppercase. When you use this function, you don’t have
to bother checking the case of an entry, and then correcting it if necessary. I
discuss functions in greater detail when I talk about the Formula Editor com-
ponent of Formula Workshop, later in this chapter.

Creating a Custom Function
in Formula Workshop

Figure 10-1:
The main
categories
of functions
and
formulas for
inclusion in
your report.
|

After you have a report open in Crystal Reports, you can access Formula
Workshop from the Expert Tools toolbar. When you click the Formula Work-
shop icon, the screen shown in Figure 10-1 is displayed.

The Workshop tree in the left pane of Formula Workshop displays several
folders: Report Custom Functions, Repository Custom Functions, Formula
Fields, SQL Expression Fields, Selection Formulas, and Formatting Formulas.
[ discuss most of these options later in this chapter.

(=[]
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Figure 10-2:
Custom
Function
Editor is
waiting

for you to
specify
what the
function
will do.
|

After you create a formula, you can give it a name and save it as a custom
function. You can then use the custom function again in the same report or
in other reports.

To create a custom function, follow these steps:

1.

Open the report where you want to use the function.

To follow along with this example, open the Top5USAfinal.rpt report
file from Chapter 9.

. On the Expert Tools toolbar, click the Formula Workshop icon to open

Formula Workshop.

. Right-click the Report Custom Functions branch on the Workshop tree

and choose New from the contextual menu that appears.

The Custom Function Name dialog box appears, asking you to enter a
name for the custom function you are about to create.

. Enter a meaningful function name.

I named this function ConcatwithlSpace. You'll use this function to
concatenate (combine) a customer contact’s first and last name, with
one blank space in between.

. Click the Use Editor button.

The Custom Function Editor appears, as shown in Figure 10-2. In the
center are the Functions pane (with various predefined functions that
you can include in your custom function) and the Operators pane. You
use operators to combine function elements or operate on function
elements. You can also find a collection of predefined functions in the
Functions pane on the left and an array of operators in the Operators
pane on the right.

+ Formula Workshop - Custom Function Editor - ConcatWith15pace ==}
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Gl SO T T T ¥ |3 (2 | Couta Syrta | "
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(L) Formdn Fieida i g Songa B (g Smnga
& g Dot and Time ¥ (gf Ranges
= b i) (@4 Dte Riangea #) (34 Bosiear
4 Ferinird g o
o (g Panges i [ 9§ Pasom
ol (gff Type Conversen bl [ Coreml Snastimms

+ [ Pogmemng Shotcus

o e
+ igpSenon

/(i Venable Dieclarstions

s Lire Malches for =




Chapter 10: Adding Formulas to Reports

6. If they’re not already displayed, expand the Functions and Operators
nodes to see the functions and operators.

Figure 10-3 shows the Functions and Operators panes with the main

nodes expanded.

“» Formula Waorkshap Custom Function Editor Concll\'ﬁﬂ!ﬁacﬂ (5[]
Bl sove st cose [ save 0 =% |~ |7 :' o &
0w [N 4R B |2 |2 | [ont Srie «| M
zx | = d = e |
13 Repert Custom Functions _‘_j ?!}&"Ft::;-»- S .‘.J' !ﬁm{ o
# Concai'ith1Space i i Cernn
%) [ Repoatory Custom Functiona 5 (88 Fonaroc Cormpiariaar
| 1) Fomuia Feids 8 Frarvcial B Comparisorn
. ) 501 Expreasion Feids o il o
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and j Fermuls L= Matches for ™
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As you can see, there are quite a few different types of functions and of

operators.

Function types are
Formatting Functions
Financial
Date and Time
Ranges
Programming Shortcuts

Xcelsius
Available types of operators are

Arithmetic
Comparisons
Ranges

Arrays

Control Structures

Scope

Math

Strings

Arrays

Type Conversion
Variable Constants

Additional Functions

Conversion
Strings
Boolean
Pattern
Other

Variable Declarations

171
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Within each function type, a number of specific functions are available.
Figure 10-4 shows some of the String functions that you can use, and all
of the String operators. The UpperCase () function used earlier in this
chapter is on the list of string functions because it operates on strings
of characters. Other function and operator types are equally well

represented.
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Figure 10-4: - %
String
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operators.
|
You can drag functions and operators down to the formula entry area to
build a custom function, or you can directly type the function into the
formula entry area.
7. Either drag the elements you need from the Functions and Operators
panes or type your function directly.
To follow along with this example, expand the Strings branch in the
Operators pane (because concatenation is a string function). You could
specify concatenation in two ways: (x + y) and (x & y). If you drag the
first formula (x + y) down into the formula-entry area, it deposits a plus
(+) sign. If you drag down the second one, it deposits an ampersand (&).
s

In many cases (as in this example), it’s easier to just type the formula
rather than drag pieces of it from the trees in the panes above the
formula-entry area.

8. In the pane below the Functions and Operators panes, type the para-
meter declarations and the body of the function. Note that the word
Function () is already there.
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<MBER

The parentheses enclose any parameters that the function might use.
Even if the function has no parameters, the parentheses remain, enclos-
ing nothing.

For the example, you want to concatenate the contact first name and
the contact last name from the Customers table, with one blank space
between them. The two parameters, x and y, represent the two names
you want to concatenate. Both are declared as string variables
(stringVar). Type the following:

Function (StringVar x, StringVar y)
(x+ " " +y);

This function concatenates a string with a blank space, and then con-
catenates the result with a second string.

9. Click the Save and Close button to save the custom function
ConcatWithlSpace.

This is just what you need to create a full name for customer contacts. It may
also be useful in a number of other contexts. After you create a custom func-
tion, you can use it in many places and with any two string arguments.

Formula Editor

You can’t use a custom function directly in a report; you must wrap the func-
tion in a formula. Therefore, the next order of business is to create a formula
that applies your general concatenation function: specifically, concatenating
the first and last names of customer contacts:

- 1. Click the Formula Workshop icon.

f X 2. In the Workshop tree on the left edge of Formula Workshop, right-
click Formula Fields and choose New from the contextual menu that
appears.

3. In the Formula Name dialog box appears, enter a name, such as
ContactFullName.

4. Click OK.

Formula Editor appears, as shown in Figure 10-5. It looks a lot like
Custom Function Editor (refer to Figure 10-2), with some differences.

In the Workshop tree on the left, expand the Report Custom Functions

node. If you followed the running example in this chapter, notice that
ConcatWithlSpace is listed under it. Note also that ContactFullName is
listed under Formula Fields even though you haven’t added functionality to it
yet. The formula exists; it just doesn’t do anything yet.
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Like with the Custom Function Editor, you get useful things to include in your
formula: The Functions tree contains standard functions, and the Operators
tree contains operators. You can drag these functions and operators down to
the appropriate spot in the formula you’re building, or you can type them by
hand. Often, it’s easier to type them than to drag them. Formula Workshop
also has a Report Fields tree, which Custom Function Editor doesn’t have.
You can drag fields from the Field tree into the appropriate spot in the for-
mula you’re building.

If you've been following along, you don’t need these handy tools just now —
although they’re good to know about — because you already did most of the
work of building this formula when you created the ConcatWithlSpace
custom function. In that case, all you need to do next is the following:

1. Click your custom function under the Report Custom Functions node
in the Workshop tree to send it down to the Formula pane.

To follow along with the example, click ConcatwithlSpace. It appears
in the Formula pane.

2. Click the Save and Close button.

The next step is to add the contact’s full name to the report. You do that with
the help of the Formula Expert.
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|
Figure 10-6:
Details

of the
Contact-
FullName
formula.
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Formula Expert

Currently, the Top Five USA Customers report lists the customer name, state,

and order total for the five U.S.

customers who have purchased the most

merchandise from Xtreme Mountain Bikes. Suppose that at each of these cus-

tomer sites, you want to insert

the full name of the contact person between

the Customer Name and the State columns:

1. Switch to Design view.

2. Move the State and Order Amount columns in all the appropriate sec-
tions to the right to make room for the new column that will contain

the contact’s full name.

3. On the Expert Tools toolbar, click the Formula Workshop icon.

4. Expand the Formula Fields node in the Workshop tree, and then click

the ContactFullName formula.

. Click the Use Expert/Editor icon on the menu bar (magic wand icon).

Formula Expert appears in the Formula Workshop. The Custom Function
Supplying Logic pane offers two entries: Report Custom Functions and
Repository Custom Functions.

6. Expand the Report Custom Functions node, and then click
ConcatWithlSpace, as shown in Figure 10-6.

In the Function Arguments pane, the x and y arguments from the
ConcatWithlSpace custom function await values. For this report,
you want x to be Customer.ContactFirstName and y to be
Customer.ContactLastName.
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7.

10.

11.
12.

13.

Click the Value field of the x row and then choose Choose Other Field
from the drop-down menu that appears.

The Choose Field dialog box appears.

. In the Customer table, select Contact First Name and then click OK.

The selected field appears in the Value column for the x row.

. Click the Value field of the y row and then choose Choose Other Field

from the drop-down menu.

In the Customer table, select Contact Last Name and then click OK.
The selected field appears in the Value column for the y row.

Click Save and Close.

Back in Design mode, display Field Explorer (if it’s not already dis-
played). From Field Explorer, drag ContactFullName from under
Formula Fields and place it in the data band just to the left of the
Region column.

Add Contact as a heading to section GH1b, above the full-name field.

An easy way to do this is to copy the State header, paste it above the
ContactFullName column, and then edit it to read Contact instead of
State.

Next, add the full name of the contact to your report:

. On the Insert Tools toolbar, click the Insert Text Object icon.

. Place the resulting placement frame to a spot in GFla, between the

Customer column and the State column.

. Drag ContactFullName from the Formula Fields node of Field Explorer

to the placement frame.

. On the Formatting toolbar, with ContactFullName selected, click the

Bold icon.

The font in this column matches the font in the other columns. You
might want to center the contact name, as was done with the state
abbreviation.

. Switch to Preview mode to confirm that the names of the customer

contacts appear where you want them.

You can always switch back to Design mode and adjust the position of
the new column.

Figure 10-7 shows the result.

. Save the report as Top5USAwithContact.
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Figure 10-7:
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SOL Expression Editor

SQL Expression Editor is another incarnation of Formula Workshop. It’s very
similar to Formula Editor, but you use it to build SQL expressions from tables,
functions, and operators. With an SQL expression, you can issue commands
to the database that underlies your report — but you can retrieve no more
than one database record at a time. With an SQL statement, you can retrieve
multiple records in a single operation. Chapter 23 covers using SQL state-
ments. To really handle SQL properly, though, you have to know more about
it than this book has space to cover. For a thorough treatment, read SQL For
Dummies (by yours truly, also from Wiley).

The SQL Expression Editor view of Formula Workshop looks exactly like the
Formula Editor view of Formula Workshop except for the name in the title
bar. You operate on it the same way, too. The only difference is that the
expression that you build must adhere to legal SQL syntax. The SQL Expression
Editor is an advanced feature; you probably won’t use it until you have gained
considerable experience with both Crystal Reports and with SQL.

Selection formulas

Crystal Reports offers three kinds of selection formulas:

v Group selection: By apply a group selection formula to a report you can
restrict retrieval to a single group or to specific desired groups.
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v Record selection: With a record selection formula, you can restrict
retrieval to specific records. For example, in a report that groups sales
figures by state, you can use a group selection formula to pull out the
sales for a specific state. Similarly, you can use a record-selection for-
mula to retrieve selected records (of specific customers and so on).

1 Saved data selection: Saved data selection filters report data after the
records have been stored in the report. The formula deals with only this
saved data. Changing a saved data selection formula does not trigger a
refresh from the database.

Group selection

To see an example of a group selection formula in action, start by opening the
Customer Report, Grouped by State or District (USA) report (as described in
Chapter 6). Note that the first page shows sales for Benny the Spokes Person,
Psycho-Cycle, and The Great Bike Shop in Alabama because Alabama is the
first state or district in an alphabetical sort on Region. Note also that the right
side of the tab bar indicates that the report has multiple pages (1 of 1+).

This is the full report, with results for all Xtreme customers in the United
States. But suppose you want to print a report for only a single state, North
Carolina. Follow these steps:

1. On the Expert Tools toolbar, click the Formula Workshop icon.

2. Expand the Selection Formulas node in the Workshop tree to display
the Group Selection, Record Selection, and Saved Data Selection
options.

3. Select Group Selection.

Group Selection Formula Editor appears in the Workshop. You want to
retrieve the records where the value of the Region field is NC.

4. Drag Customer.Region from the Report Fields pane down to the blank
pane below the Fields pane.

You want to set that field equal to NC.
5. After the Customer.Region field, type an equal sign (=).

Alternatively, you could instead expand the Comparisons node in the
Operators pane and drag down an equal sign.

6. Finish the formula by typing (after the equal sign) the two-letter state
abbreviation, surrounded by single quotes.

Type ‘NC’ to follow along with this example. The resulting formula is
shown in Figure 10-8.
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7. Click the Formula Editor icon, located below the Save and Close
button, to check your formula for syntax errors.

8. Click the Save and Close button to save the formula and close

Formula Workshop.

Now when you look at the report, it consists of only a single page, show-
ing information for only North Carolina. However the Grand Total in the
report footer still shows the total order amount for the entire country.

9. Close the report without saving.

The North Carolina report is a one-shot report that you probably won’t

have to run again.

Record selection

For record selection, you follow substantially the same steps as for group
selection. Suppose you want to see all transactions in Customer Orders,
Grouped by State or District (USA) in which the order amount was greater

than $10,000. After opening the report, follow thes

e steps:

1. On the Expert Tools toolbar, click the Formula Workshop icon.

2. Expand the Selection Formulas node in the Workshop tree to display

the selection options.
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3. Select Record Selection.

Record Selection Formula Editor appears in Workshop. The Formula
pane already contains a formula

({Customer.Country} = "USA")

To add an additional constraint to retrieve records where the value of
the Orders.Order Amount field is greater than 10,000, you must add a
new clause to the formula.

4. To the existing formula, append the keyword AND.

5. Drag Orders.Order Amount from the Report Fields pane down into
the Formula pane below the existing formula.

6. Type > (a greater-than sign) after the Orders.Order Amount field.
7. Finish the formula by typing an amount after the greater-than sign.

Type 10000 to follow along with the example. The resulting formula is
shown in Figure 10-9.

+ Formula Workshop - Record Selection Formula Editor (5[]
B save and cose [ saee 0O -|% & T 4 R 2 -
X M 4R RR B T e
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w2 8. Click the Formula Editor icon to check the formula for syntax errors.

9. Click the Save and Close button to save the formula and close
Formula Workshop.

Presumably this is the type of information that management will want to
see more than once while making decisions.

Now, when you refresh the data and look at the report, only orders greater
than $10,000 are shown. Only ten states have customers with orders in
excess of $10,000.
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Formatting formulas

You can use formatting formulas to change various aspects of the format of a
report. In this section, [ show you how to change the heading color of the
Customer Report, Grouped by State or District (USA) report (used in the pre-
vious section):

1. Open Formula Workshop.

2. Expand the Formatting Formulas node in the Workshop tree.

Several subnodes appear, including the Report Header node.
3. Expand the Report Header node.

The screen looks like Figure 10-10.

':_Eglmula Waorkshop 2]%]
Bl saveandckee 0O - % 5 7 v o X (%8 |

": Formula Lre Matches for =

4. Right-click the report title entry (Customer Orders, and so on) under
Report Header and choose New Formatting Formula from the contex-
tual menu that appears.

5. In the New Formatting Formula dialog box that appears, select
Background Color, and then click the Use Editor button.

Format Formula Editor appears. Comments in the Formula pane, all
preceded by a double slash (//), show the available colors.

6. Select a color.
[ chose Aqua, by typing crAqua in the Formula pane.

7. Click the Formula Editor icon to check the syntax.
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8. Click the Save and Close button to save the new formula and close
Formula Workshop.

When Formula Workshop disappears, you see that the report now has a
colored report heading.

You can add or change the formatting of any aspect of a report in the same
way. Do a little looking around in the Report Fields, Functions, and Operators
panes of Format Formula Editor to get an idea of what’s available.

Changing and Deleting Formulas

Data

In earlier sections of this chapter, I show you how to use Formula Workshop
to create a formula. Modifying an existing formula is just as easy. Just display
it in the Formula Workshop Formula pane, make whatever modifications you
want, check it, and save it. Deleting a formula is even easier: Select it in the
Workshop tree, and then click the Delete icon on the Workshop toolbar.

Types

Formulas deal with data, and databases can hold several different types of
data. You use formulas to manipulate this data, but you must be careful to do
it properly. For example, you can use the common addition, subtraction, mul-
tiplication, and division mathematical operators on number type data, but
you can’t multiply a number by a string. Specific operations apply to specific
data types.

Simple data types

Some data types are more complex than others. The simplest data types are
number, currency, string, date, time, datetime, and Boolean. Range types and
array types are more complex. Look at the simple types first.

Number

The number type includes positive and negative integers and real numbers.
When you enter number data, however, don’t separate each group of three
digits with commas. The only non-numeric characters allowed in a number
are the decimal point and the negation sign. Following are examples of
number-type data:
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-273
3.1415927
93000000.

You can perform addition, subtraction, multiplication, and division opera-
tions on number data. Just make sure that you don’t divide by 0. Doing so
causes an error (not to mention gray hair on your poor old math teacher).

Currency

Currency data is similar to number data except that it starts with a dollar sign
($), and numbers to the right of the decimal point are rounded differently.
Following are a few examples of currency type data:

$19.95
-$4000000000.
$64000

String

Character strings use different operators than those you use with numbers
and currency. You can’t add two strings, but you can concatenate them. You
can convert a string to all uppercase or all lowercase, which is something
you can’t do with a number.

Strings must be enclosed in either single or double quotes. Here are a few
strings:

"I Left My Heart in San Francisco"

"$19.95"

'You can put "quoted text" within a string.'

'You can even include an apostrophe in a string''s text'

As you can see, sometimes you must use quotes in an unusual way to keep
from confusing the string parser. (The string parser is the part of Crystal
Reports that analyzes and interprets strings, one character at a time.)

Anything within quotes is a string, even if it looks like a number or a currency
value.

Date, time, and datetime

As you might surmise, the date data type holds dates, the time data type holds
times, and the datetime data type holds a combination of the date and time.
Date and time data types are somewhat redundant because the datetime data
type can hold dates without times and times without dates. You might want to
use the date or the time data type anyway, though, because data in those two
types takes up less storage space in memory and on the hard disk than the
same quantity stored as a datetime data type.



1 84 Part lll: Advanced Report Types and Features

Datetime values are not strings or numbers. They are literals, which are han-
dled differently from the way either strings or numbers are handled. Datetime
literals are enclosed in pound (#) signs. This differentiates them from strings
(which are quoted) and numbers (which are not enclosed in anything).
Following are some examples of values that can be stored in the datetime
data type:

#July 20, 1969#

#20 Jul 1969 4:18 pm#
#7/20/1969 16:18:00#
#7/20/1969#

#4:18 pm#

Boolean

Boolean data is named after the British mathematician George Boole, who
invented Boolean algebra, which gave logic a mathematical foundation.
Boolean data has only two values, True and False. Crystal Reports accepts
Yes and No as synonyms for True and False. Boolean logic has been critical
to the development of the digital computer, which uses ones and zeros to
represent True and False.

Range data types

Crystal Reports enables you to restrict the values of data elements to a speci-
fied range for all data types except Boolean. For example:
70 To 100 includes values between, and including, 70 and 100.
70_To_100 includes values between, but NOT including, 70 and 100.

70_To 100 includes values between 70 and 100, including 100 but not
70.

UpTo 100 includes all numbers up to and including 100.

"A" To_ "z" includes all character strings starting with an uppercase
letter, except for strings starting with "z".

UpFrom #1/1/2000# includes all dates after the once-dreaded Y2K day.

Array data types

Arrays are ordered lists of values that are all the same type. In Crystal Reports,
an array can contain data of a simple type or of a range type. Array elements
are enclosed in square brackets, as in this example:

(2, 3, 5, 7, 11, 13]
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This array contains the first six prime numbers. Or try planets:
["Mercury", "Venus", "Earth", "Mars"]

is an array containing the string values of the names of the terrestrial planets
in our solar system.

You can subscript an array by specifying the index in square brackets after the
array. (A subscript specifies a particular element of an array.) For example,
the following use of brackets

(2, 3, 5, 7, 11, 131 [3]

specifies 5, the third element in the array.

You can also specify a range of elements, as follows:
["Mercury", "Venus", "Earth", "Mars"] [3 To 4]

This creates a new array, ["Earth", "Mars"].

Variables in Formulas

In the discussion of Formula Workshop, I use the x and y variables to act as
placeholders for specific values in the ConcatwithlSpace custom function.
Whenever the formula parser encounters a variable in a formula, it looks

for the value represented by that variable, and then plugs the value into

the formula. Because the value of a variable can be changed by the user

or assigned in the formula, variables give Crystal Reports considerable
flexibility.

Declaring a variable

Before you can use a variable, you must declare it to make Crystal Reports
aware of it. When you declare a variable, you must specify three things: its
name, its scope, and its data type. The name could be something simple,
such as x or y. It could also be something more descriptive, such as fopic.

When you declare a variable’s data type, stick Var on the end of the type, as
in StringVar or NumberVar. Scope may be local, global, or shared. If a vari-
able is declared locally, it is valid only in the formula in which it is declared.
If a variable is declared globally, it’s available to all the formulas in a report
that declare it (except for subreports).
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A shared variable is available to all formulas in a report that declare it, includ-
ing subreports. Subreports are covered in Chapter 11.

Assigning a value to a variable
After you declare a variable, you can assign it a value. Here’s an example:

//Declare topicl to be a global variable of String type that
//specifies a book topic.

Global StringVar topicl;

topicl := "Crystal Reports";

You can also declare a variable and assign it a value in a single statement, as
follows:

Global StringVar topic2 := "SQL";

You can now use the variable in a formula.

Control Structures

Control structures enable you to alter the flow of execution from a strict
sequential order to something else. For example, you can branch one way or
another with an If-Then-Else control structure. You can branch multiple
ways with a Select Case structure. You can loop through an expression
or a set of expressions multiple times with a For or While Do structure.
You can implement business logic (or illogic) to a fare-thee-well with these
structures.

If-Then-Else

The If-Then-Else control structure is useful when you want to do one thing
if a condition is true and another thing if the condition is false. Suppose you
want to give a 5-percent discount to customers who order more than $10,000
worth of products in a single order. Before printing their invoice, you could
have Crystal Reports make the calculation for you as follows:

//Give 5% discount for orders > $10,000
If {Orders.Order Amount} > 10000.
Then
{Orders.Order Amount} * 0.95
Else
{Orders.Order Amount};
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If the condition is satisfied, Order Amount is multiplied by 0.95, giving a
5-percent discount. Otherwise, Order Amount is unchanged. The change
to Order Amount applies only to this report. The data in the database is
not affected.

The Else clause is required even though it doesn’t change anything. The
data type of the result returned from the E1se clause must match the data
type of the result returned by the Then clause. If you leave out the E1se
clause and the condition is not satisfied, the formula returns the default
value for the data type.

Select Case

Use the select Case control structure when you have more than two alter-
natives to choose from and you want to do a different thing in each case.
Suppose the 5-percent discount you offered your customers last month
resulted in a huge increase in sales, so you decide to expand the offer this
month. Using a Select Case statement does the job:

//Give volume-based discounts
Select {Orders.Order Amount}
Case 15000. To 1000000.:
{Orders.Order Amount} * 0.93
Case 12000. To 14999.99:
{Orders.Order Amount} * 0.94
Case 10000. To 11999.99:
{Orders.Order Amount} * 0.95
Default:
{Orders.Order Amount};

If an order is between $15,000 and $1,000,000, a 7-percent discount is applied.
Lesser discounts are applied for smaller orders. Below $10,000, no discount
is applied. If an order comes through for more than $1,000,000, there must be
a mistake, so no discount is applied. The Default clause is optional. If you
omit it, the value of the selection condition is not changed. (It isn’t changed
in the preceding example either, but you avoid confusion by making it explicit.)

For loop

Like the If-Then-Else structure and the Select Case structure, using a
For loop alters the flow of execution, but it alters it in a different way. Whereas
using If-Then-Else and the Select Case constructs cause execution to
take one path of execution rather than another, using a For loop causes
execution to pass through a single piece of code multiple times.
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A For loop is the best tool to use when you want to execute a section of code a
predetermined number of times. Suppose you have a character field named
Size in a table named Product, and you want to know how many instances of
the letter x it contains. You can find out with a formula containing a For loop:

Local NumberVar Index;

Local NumberVar Xcount := 0;
Local NumberVar StringLength := Length ({Product.Size});
//loop through the characters in Size and count X's
For Index := 1 to StringLength Step 1 Do
(If ({Product.Size} [Index] = "x") Then
(Xcount := Xcount + 1;)
Else (Xcount := Xcount;)
) g
Xcount

In the preceding example, Product .Size is treated as a string array, and
Index is the subscript that points to each character in the array in turn.
Execution steps through the Size field, one character at a time, counting
the occurrences of x as it goes. If x occurs three times in the Size field,
Xcount holds a 3. The last line in the formula returns the value of Xcount.

While Do loop

Whereas a For loop is designed for situations in which you know (or can
compute) how many iterations of the loop you want to execute, using a
While Do loop is ideal when you don’t know the number of iterations.
Awhile Do loop depends on the Boolean truth value of a condition. As long
as the condition remains true, execution continues to loop. When the condi-
tion turns false, the current iteration of the loop is completed, and looping
terminates. If the condition is initially false, the loop is not executed at all.

Suppose that in the preceding example, you wanted to know the character
position of the first x rather than the total number of instances of x in the
string. Because you don’t know how far into the string the first x occurs (if
at all), using awhile Do loop is appropriate:

Local NumberVar Index := 1;
Local NumberVar Xpos := 0;
Local NumberVar StringLength := Length ({Product.Size});

//Find location of first x in Product.Size
While Index <= StringLength And Xpos = 0 Do
(If ({Product.Size} [Index] = "x") Then
(Xpos := Index;)

Else (Xpos := Xpos;)

Index := Index + 1;

) g
Xpos
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Note that if Index were initially greater than StringLength, the loop would
be skipped.

Do While loop

A Do While loop is similar to the Wwhile Do loop, but whereas awhile Do
loop doesn’t execute if the condition is not initially satisfied, a Do While loop
is always guaranteed to execute at least once, regardless of whether the condi-
tion is satisfied. Sometimes you want the behavior of While Do, and other
times you want the behavior of Do While. Crystal Reports gives you both.

With a Do While loop, you can accomplish the same character location task
that was illustrated in the While Do loop example. The code is just a little
bit different:

Local NumberVar Index := 1;
Local NumberVar Xpos := 0;
Local NumberVar StringLength := Length ({Product.Size}) ;

//Find location of first x in Product.Size
Do
(If ({Product.Size} [Index] = "x") Then
(Xpos := Index;)
Else (Xpos := Xpos;)
Index := Index + 1;
While Index <= StringLength And Xpos = 0
) 5
Xpos

In this case, the loop is executed once, and the first character of Product.
Size is checked to see whether it’s an "x". This occurs even if the condition
is not satisfied because execution doesn’t reach the condition until after the
loop has been executed once. Thus, if (by some mischance) the value of
Index was greater than StringLength, an "x" located beyond the end

of the Product . Size string would cause Xpos to take on a nonzero value.
This could be misleading and cascade into a significant error.

It’s important to choose your loop type according to whether you want the
loop to execute at least once, regardless of whether the condition is satisfied.
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Chapter 11
Creating Reports within a Report

In This Chapter

Combining unrelated reports, using subreports

Linking a subreport to the data in a primary report
Using subreports with unlinkable data

Creating an on-demand subreport

Passing data between reports and subreports

Troubleshooting problems with subreports

n other chapters, you see how to build reports based on the data contained

in several related tables in a database. This is wonderful, but sometimes
you want to build a report that displays data from two or more sources that
are unrelated or related only indirectly. Crystal Reports meets that need by
enabling you to embed one report in another: a subreport. Subreports allow
you to take data from diverse sources and present it on one or a small number
of pages, for ease of comprehension.

Combining Unrelated Reports

A standard report created by Crystal Reports can’t display data from two
tables that are not linked, but a subreport can. You use subreports when you
have data tables that are unrelated or have an indirect relationship. With a
subreport, information that doesn’t need to be directly related to information
in the primary report can be presented in a compact and convenient form.

The easiest kind of primary report/subreport combination to produce is one
in which the two reports are unrelated but are of interest to the reader.
Because the primary report and the subreport aren’t directly related, you
don’t need to worry about linking them. Aside from the details of building
the primary report and the subreport, your main concern is the placement
of the subreport within the primary report.
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Figure 11-1:
The Top
Seventeen
USA
Customers
report.
|

You can embed a subreport within another report in two ways:

v Open the primary report and create a subreport within it from scratch.
v Embed an existing report into another report as a subreport.

In this section, I show you an example of embedding an existing report

into a primary report.

Suppose the management at Xtreme Mountain Bikes wants to see the results
of two reports — the Top Seventeen USA Customers report (Topl7USA.rpt)
from Chapter 9 and the Big Orders report (highest-value orders from cus-
tomers worldwide) created in Chapter 5 — in a single report. Crystal Reports
makes it easy to do: Just add the Big Orders report to the Top Seventeen USA
Customers report. Big Orders becomes a subreport. From this report, you
can easily tell not only which customers have a large cumulative total of

purchases but also which of them tend to buy in large lots.

To start, follow these steps:

1. Open the report that you want to use as the main report.

To follow along with the example, open the Top Seventeen USA Customers
report. (The report file, Top17USAfinal . rpt, is shown in Figure 11-1.)
This summary report fits on a single page. The Big Orders report also
fits on a single page, so putting it into the report footer of the Top
Seventeen USA Customers report gives you a handy two-page report.
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Figure 11-2:
The report
in Design
mode.
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2. Switch to Design view.

The report sections are displayed, as shown in Figure 11-2. The report
footer appears gray, indicating that it’s suppressed. To display anything
in this section, you must first reverse the suppression.
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. Right-click the area to the left of the report footer section and choose

Don’t Suppress from the contextual menu that appears.

Now whatever you put in the report footer will be displayed.

. On the Insert Tools toolbar, click the Insert Subreport icon.

The Insert Subreport dialog box appears.

5. Select the Choose an Existing Report option.

6. Click Browse.

A standard Open dialog box appears.

. Find and select the report that you want to use as the subreport. Then

click the Open button to enter it in the Report File Name text box.

To follow along with this example, find and open the Big Orders with
Template report.

8. Click OK.

9. Drag the placement frame that appears at the cursor location into the

report footer.

This gives you the layout shown in Figure 11-3.
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The template for the Top Seventeen USA Customers report was designed
to take up the full width of a page and so was the Big Orders with
Template report. A more common approach is that both the report and
the subreport are half a page wide or less. That way the two reports can
appear side by side without piling up, one upon the other. Thus these
two reports are best used as an illustration, not as a realistic application
of a subreport. The idea here is to show you how to include a subreport
in a main report; make sure the template for your report can accommo-
date this operation.

10. Switch to Preview mode.

11. If your report has a parameter field, a dialog box appears. Enter a

value and click OK.

To follow along with this example, enter 9000 for the lower-limit value.
Page 1 of the report is unchanged, but clicking the right-pointing arrow
in the Navigation Tools toolbar displays Page 2, which includes the report
footer, showing the Big Orders subreport. It includes all orders of $9,000
or more, as shown in Figure 11-4.



|
Figure 11-4:
Page 2

of the

report and
subreport.
|

\

Chapter 11: Creating Reports within a Report 7 95

file fdit View Insert format Database Report Window |lelp

|

B E [

Start Page

: ]
. 01 N )
Top1 7USAfinal =

o+ o | FLEL ¥ & S

0 = |48 8]

- | &) fe

]

2of2

Design

Prosviewe «

Bigy Orchers with Templ

st pt

Fhs

PHo
PHe

Top Seventeen USA Customers

Report Description

The Top Seventeen USA Custlom

Big Orders with Template.rpt

Report Description:

o
Business Object

54 Cychpath

Scott

66 Fioain Georg Fipps
5 Trad Blazer's Flace Henandra Burns
2% Blazing Saddies Trisha Sanders
Pedal Pusher Bikes Ine. Tany Gameau
FRoad Runners Parsdise Juls Jackson
0 Falk och fa HB Marie Larsson
n ToTheLimit Bkong Co. Richaed Grewal

5 Extreme Cyding

Fach

For Help, press F1

Underlay formatting for side-by-side
location of subreport

In the preceding example, | show you how to insert a subreport at the bottom
of a primary report. For some applications, though, a subreport works best
placed alongside the primary report for comparison. For this type of format-
ting (and several others), you use the underlaying feature of Crystal Reports,
which enables you to lay a subreport under other material in the primary
report.

When you underlay the material in any section, it goes “under” the material
in the next section. In effect, the next section is overlaid, which might seem
strange to do. After all, wouldn’t underlaying just make the material in both
sections unreadable? Yes, it would, if you left it that way — but here comes
the trick that makes underlaying worthwhile.

Offset the overlaid material to the right of the underlaid material. One such use
would be to place a chart immediately to the right of the data it’s developed
from. Another use is to place a subreport immediately to the right of related
material found in the primary report.
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Both the Big Orders report and the Top Seventeen USA Customers report are
too wide to fit comfortably side by side on standard 8% x 11" paper in portrait
orientation. However, if you know ahead of time that you want to combine
two reports as a primary report/subreport combination, you can format them
so they work together to effectively convey the information you want to
deliver. Here’s how:

1. Place your subreport in the Report Header or a Group Header sec-
tion.

2. Click the Section Expert icon on the Expert Tools toolbar.
The Section Expert dialog box appears.
3. Select the section into which you have placed the subreport.
4. Select the Underlay Following Sections option, and then click OK.

The subreport now lays under the sections that follow it: in effect,
putting them on top.

Make sure you format the subreport so that it’s offset far enough to the right
to not interfere with any content in the primary report.

Drilling down in a subreport

As I explain in Chapter 6, drill-down enables you to keep the focus on your
summary while also keeping details available offstage. The capability hides
detailed information when you want to produce a summary report while still
keeping that information available if a user wants it. If hidden detailed infor-
mation is available in a summary report, the user’s cursor changes to a mag-
nifying glass when it passes over the summary field. Double-clicking while
the cursor is a magnifying glass makes the detailed information appear. When
you have placed a subreport in a primary report, however, drill-down works a
little differently.

Subreport drill-down versus report drill-down

When you pass the cursor over a subreport, the cursor changes to a magnify-
ing glass, regardless of whether the subreport itself supports drill-down. If
you double-click, a Preview tab for the subreport appears to the right of the
Preview tab of the primary report. No additional detail appears in the report
(vet), and the cursor changes back to the normal pointer.

After you open the subreport, however, drilling down works just like it does
in a normal primary report. When you move the cursor over a summary field
that supports drill-down, the cursor changes into a magnifying glass. Double-
click to make the detailed information that supports the summary appear. A
drill-down tab for that information also appears to the right of the subreport’s
Preview tab.
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Handling tab overflow

When you implement drill-down, the tab bar starts to fill up. With the tabs for
the primary report (including possible drill-down tabs) and the tabs for the
subreport (including multiple possible subreports), the tab bar might become
over-full. If it can’t display all the tabs at once, click the left and right arrows on
the tab bar to move left and right (respectively) through the tabs. In addition,
click the x in the current tab when you want to close it. The tab immediately

to its left opens. This is a helpful tool for getting rid of tabs that you no longer
need.

Figure 11-5 shows the tab bar, including drill-down tabs, left and right move-
ment arrows on the right, and the x button that closes the current tab.
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Linking a Subreport to a Primary Report

One of the most valuable uses of a subreport is to have it supplement related
information displayed in the primary report. To set up this useful relationship,
link the subreport to the primary, using a field that’s shared by the tables
forming the basis of the primary report and the subreport. (Alternatively,

you can form the link by using formula fields.)

Suppose you have a primary report that holds name and address information
for Xtreme’s customers in Michigan. Another report — soon to become the
subreport — holds order data for Michigan customers.

The primary report, Mlcust, is a simple report, containing the CustomerID,
Customer Name, Address1 and Address? fields, as well as City, Region, and
Postal Code. The fields from the Customer table have been dropped into text
fields to allow formatting of lines that contain more than one database field.
This is the technique I use in Chapter 7 when creating mailing labels. A filter
has been applied so only the customers whose Region is MI appear in the
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|
Figure 11-6:
Design view
of the
Mlcust
report.
|

report. The subreport, Mlorders, contains Order Date, Order Amount, and
Ship Date for all orders made by Michigan customers. It also includes the
Customer table, although no fields from that table are displayed. The table
is present only to provide a link to Mlcust.

To create the full report, follow these steps:

1.

From the Start Page, click Blank Report.

Database Expert appears.

. Select xtreme .mdb, expand the Tables node, move Customer to the

Selected Tables pane, and then click OK.

. Click OK to dismiss Database Expert. Display Field Explorer if it isn’t

already visible on the workspace.

. In Field Explorer, expand the Database Fields node to display the

available tables.

. Expand the Customers node to show the columns in the Customers

table.

6. Expand the Details area downward to accommodate three lines of text.

7. Using text boxes and the fields in Field Explorer, put a three-line

address in the Details area, with the following:
e Customer Name on the first line
e Addressl and Address2 on the second line, separated by a comma

e City, Region, and Postal Code on the third line, with a comma and a
space between City and Region, and a space between Region and
Postal Code

. Save the report with the name Mlcust.

Figure 11-6 shows what the report looks like in Design view.
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With the primary report in place, create the subreport:

1.

Choose Insert->Subreport.

The Insert Subreport dialog box appears. It gives you a choice between
using an existing report as a subreport or creating one with the report
wizard.

2. Select Create a Subreport with the Report Wizard.

3. For the New report name, enter Mlorders.

4. Click the Report Wizard button.

The Standard Report Creation Wizard appears.

5. Connect to the xtreme .mdb database.

6. Expand the Tables node; from the list of columns that drops down,

11.

12.

13.

14.
15.

select Customer and Orders.

. Click Next to display Link view.

Link view shows that the Orders table is connected to the Customer table
by the Customer ID column, which they have in common.

. Click Next to display Fields view. Transfer Order Date, Order Amount,

and Ship Date to the Fields to Display pane on the right.

. Click Next twice to skip Grouping view.
10.

In Record Selection view, transfer Region from the Customer table to
the Filter Fields pane. In the menus that pop up below the Filter Fields
pane, specify is equal to and ML

Click Next to move to Template view, verify that No Template is
selected, and then click Finish.

When the Insert Subreport dialog box reappears, click OK.

The Insert Subreport dialog box disappears, and a placement rectangle
appears at the cursor.

Drop the placement rectangle in the Details area, to the right of the
Customer Name field.

Click the Mlorders tab to display it in Design view.

Because Mlorders is the subreport, suppress RHa, RFa, and RFb to
free up some vertical room. Delete Print Date from RHb and close up
the vertical space that it leaves behind, leaving only enough room
for the column titles.

Figure 11-7 shows the Mlorders report in Design view at this point.

Micust now looks like Figure 11-8 in Design mode and like Figure 11-9 in
Preview mode.
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Figure 11-10:
The
subreport
menu.
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|
Figure 11-11:
The
Subreport
Links

dialog box.
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To establish the link between the primary report and the subreport, do the
following:

1. With the primary report open, right-click the subreport.

The menu shown in Figure 11-10 appears.
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2. Choose Change Subreport Links.

The Subreport Links dialog box appears, as shown in Figure 11-11.
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3. Select one or more fields in the Available Fields pane and click the >

button to move it to the Field(s) to Link To pane.

These fields should be present in one of the tables used in the primary
report.
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To follow along with the example, choose CustomerID as the linking
field. The Subreport Links dialog box now looks like Figure 11-12.
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4. Click OK.
The Change in Record Selection Formula dialog box appears and asks
whether you want to use saved data or refresh the data.
5. Click Refresh Data.
Now the records appearing in the subreport correspond to the primary
report records in the same data section. Showing only Michigan records,
the report only has two pages instead of more than 500.
[ use Record Sort Expert to sort the subreport by order date, and then
use Format Editor to remove the default border line around the subre-
port. (To invoke Format Editor, right-click the Mlorders rectangle in
the Mlcust Design view of the report and chose Format Subreport.) The
report now looks like Figure 11-13.
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Subreports need not be linkable

The example in the “Linking a Subreport to a
Primary Report” section shows how to link a
subreport to a primary report when the linking
field is shared by both reports. However, some-
times, you want to combine two reports that
don’t have a column in common. Such reports
can't be linked in the usual way, but you might be
able to link them by using a formula field.

Suppose one of your reports is based on a table
that has a First Name field and a Last Name field.

The other report you want to use is based on a
table that has a Full Name field; no other fields in
the two tables are even close to being the same.
A solution to the problem would be to create a
formula in the first report that concatenates the
First Name and Last Name fields with a single
blank space in between. The resulting full name
could then be used as a linking field with the Full
Name field in the second table. Problem solved.
(Chapter 10 covers formulas in detail.)

On-Demand Subreports Boost Efficiency

On-demand subreports can be valuable when you have a report that contains
multiple subreports. The primary report doesn’t actually contain the sub-
reports. Rather, it contains hyperlinks to the subreports. The subreports
aren’t read from the database until the user clicks the hyperlink. This way,
only subreports that are viewed travel from the database server to the user’s
client, reducing the load on the network from what it would be if the user
downloaded the full report, including all subreports.

To make Mlorders an on-demand subreport of the Mlcust primary report,

follow these steps:

1. Place Mlorders into your primary report, select it, and then choose
Format-~>Format Subreport from the main menu.

The Format Editor dialog box appears.

2. Click the Subreport tab, as shown in Figure 11-14.

3. Select the On-demand Subreport check box.

4. Click OK.

Instead of including each customer’s orders in the report, each order
now has a hyperlink. The report size has shrunk to a single page, as

shown in Figure 11-15.

On-demand subreports are purely electronic; they don’t work with printed
reports. (Ever try to click a printed hyperlink? But you knew that.) On-
demand subreports require a database connection.
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Passing Data between Reports

Crystal Reports allows you to pass data from a primary report to a subreport
or from a subreport to its primary report. You can do so by using formulas
containing shared variables that are common to a report and all its subreports.
You must declare shared variables in a formula in the main report, and then
declare the same shared variables in any subreports that need to exchange
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data with the main report. You might want to pass a shared variable from a
primary report to a subreport for display in the subreport or as a selection
criterion in the subreport.

Before a value can be passed between the main report and the subreport,
these conditions have to apply:

v A shared variable must be declared and assigned a value in a formula
in the main report.
You can read about using formulas in Chapter 10.

1 The same shared variable must be declared in a formula in the
subreport.

1+ To pass a value from the subreport to the main report, you must make
both declarations but assign the value in the subreport.

Troubleshooting Subreport Problems

Sometimes, you get odd results from reports containing subreports because
of the order in which reports are processed. Formulas in the main report are
processed before those in subreports. Thus, if you set the value of a shared
variable in a subreport and then pass the variable to a group footer in the
main report, you might find that the main report is using the value of the
shared variable from the previous group rather than from the current group.
To avoid this problem, create an additional group footer in the main report,
such as Group Footer 1b (GF1b). Place the subreport in GFla and retrieve the
value of the shared variable in GF1b. This associates the shared variable with
the proper subreport.

As you might expect, reports that contain subreports process more slowly
than reports that don’t. However, you can do a few things to lessen the
problem:

v If your report contains multiple subreports: Consider changing the
subreports to on-demand subreports. This way, only the subreports
that the user is interested in are downloaded from the server. This
tweak could have a major effect on system-response time.

v If you're using linked subreports: Make sure that the linking field is
indexed. Doing so can bring a tremendous boost to performance.

v If you're linking a report to a subreport using a formula field: Make
sure that the formula field is on the main report — and that it corresponds
to a database field in the subreport. Requiring a formula calculation in the
subreport makes the processing migrate from the server to the client,
using network bandwidth and performing calculations on a slower
machine.
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Chapter 12

Combining Report
Elements with OLE

In This Chapter
Understanding OLE
Embedding and linking files as OLE objects
Embedding and linking OLE objects taken from files
Editing OLE objects in a report

Fe primary purpose for a report is to present database data to users in a
form that’s easy to understand. Crystal Reports gives you all the tools
you need to do that. Sometimes, however, you want a report that does more
than just present database data. For example, you might want to include text
from a word processing file, or data that resides in a spreadsheet, or a graphi-
cal image stored as a bitmapped image file. To allow the sharing of various
kinds of information in different kinds of files, Microsoft developed the OLE
(Object Linking and Embedding) architecture.

Overview of OLE

Reports that you create with Crystal Reports can serve as OLE container
applications. That is, they can contain OLE objects that were created by
other applications, called OLE server applications. Such contained objects
are container documents. The corresponding objects in the server applica-
tions are server documents. Microsoft Word and Microsoft Excel are examples
of OLE server applications, and Microsoft Word document files and Excel
spreadsheets are examples of server documents. You can take text from a
Microsoft Word file or take an Excel spreadsheet as an OLE object and place
it in a Crystal report.
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Crystal Reports can also function as an OLE server application. You can
define a report as an OLE object and place it into a Word text file, an Excel
spreadsheet, or any other OLE-compatible container application. In cases
such as this, the report residing in Crystal Reports is the server document,
and its corresponding object in the Word text file or Excel spreadsheet is the
container document.

OLE offers an unusual advantage: When you bring an OLE object into Crystal
Reports and place it in a report, the object maintains a relationship with the
application that created it. The nature of that relationship depends on whether
the OLE object is static, embedded, or linked.

Static OLE Objects

WMBER
@8‘
&

A static OLE object is a snapshot of an object that’s copied from the original
application to the container application. Here’s the rub, though: After you
place a static OLE object in a Crystal report, you can’t edit it or change it in
any way (except to delete it). A static OLE object doesn’t maintain any con-
nection to the application that created it.

A static OLE object is not the thing itself but merely a graphical image of that
thing — and that’s why static OLE objects can’t be edited. Four pixel-based
image formats are supported:

v Windows bitmap (BMP)

v TIFF

v JPEG

v PNG

In addition, the vector-based Windows metafile (WMF) format is supported.

Inserting a static OLE object into a report

Here’s how to insert a graphic image into a report. Follow along by inserting
the Xtreme logo, or some other suitable image into the report header of the
Big Orders report that you can see how to create in Chapter 5 and then modify
in Chapter 8:

1. Open Big Orders.rpt and switch to Design mode (if you’re not
already in if).

The Report Header is empty.
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|
Figure 12-1:
The Open
dialog box,
showing
available
files.

|
Figure 12-2:
Place a logo
as a static
OLE object.

2. Choose Insert=>Picture.

The Open dialog box appears, as shown in Figure 12-1.
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3.

Select an image.

Make sure that the file is a supported type (see the preceding section),
and that you choose an image about the size of a company logo. Other
than those two caveats, it doesn’t matter what you choose because the
point of this exercise is just to show you how to insert any static OLE
object into a report. For this example, | use the Xtreme logo.

. Click Open.

A placement rectangle appears on your form.

. Place the placement rectangle in the upper-left corner of the form and

then click the mouse to place it there.

The Report Header section automatically expands vertically to accom-
modate your image. Figure 12-2 shows the Big Orders report in Design
view at this point.
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6. Right-click your newly placed image.

In the contextual menu that opens, you can see that the image is identi-
fied as an OLE Object.

7. Switch to Preview mode.

You get the report shown in Figure 12-3.

fle Edit View Insert Fformat Database Report Window lelp
el SRS E T o I s M I | W
D £ U
1. 150 288 o 08 il | Dt : 0= 8] - | &) fe Ll n 10f1

Start Page  Big Onders

Design | Proview

“
Al
— Eltrerne
- . Mountain Bikes
Figure 12-3:
. . PH
Blg Ob]ects 1203112007
repor‘t W|th Customur ID Customer Name Contact First Name Conlact Last Name Phone Order Amount
[} 54 Cyciopath Seoft Wugller 401-766-2360 $14,672.30
o 8 Piccolo Goorg Pipps 43-882.972262 £10,250.10
new |Ogo o 3 Trad Blazers Place  Alexandra Durrs 606-273-4003 $12.323.10
. o 26 Blazing Saddes Trisha Sanders 414.364.0524 £5 353 30
inreport | & 24 Pedal Pusher Bikes Ir Tony Gameau 004414547 $10,886.79
D 36 Road Runnors Paradi Jusia Jacksan 401-788-3133 511621 52
header. | & 70 Fok och 13 HB Warie Larsson 06 721 $14.741.15 -
I | For Help. press i1 e[ 11 it

At this point, double-clicking the OLE object has no effect because this is
merely a static OLE object. For more excitement, I talk later about embedded
OLE objects. For now, consider what you can do if you want to modify a
static OLE object in a report.

Making a static OLE object editable

Although you can’t edit a static OLE object, you can change it into a bitmap
image object. Applications such as Microsoft Paint — which, like Word and
Excel — is an OLE server application, can operate on a bitmap image object.

Here are the steps to make a static OLE object editable:

1. Right-click the static OLE object that you want to edit.
2. From the menu that pops up, choose Convert Picture Object.

The Convert dialog box, as shown in Figure 12-4, opens.
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3. Select Paintbrush Picture as the object type and then click OK.
This permanently changes the selected picture from a static OLE object
to a Paintbrush picture object.
4. Right-click the picture object.
The contextual menu now has an entry named Bitmap Image Object,
which has a submenu, as shown in Figure 12-5.
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5. Choose Edit.

Microsoft Paint launches. You have access to the Paint editing tools to
modify the object. When you save the modified object, it appears in
modified form in your report.
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Embedded OLE Objects

As with a static OLE object, an embedded OLE object is downloaded entirely
to the container application, but with an important difference: An embedded
object is no snapshot. It has an “awareness” of which server application
created it, and you can edit it within the container application (namely,

your report). When you double-click an embedded OLE object, it becomes
editable. The server application takes over the menus and toolbars to allow
editing. For example, if you embed an Excel spreadsheet into a report, you
can edit the spreadsheet from within Crystal Reports using the Excel menus
and toolbars.

A\
To edit an Excel spreadsheet, for example, that’s embedded in a Crystal
Report, Excel must be present on the machine on which you're editing.
Embedding an OLE object into a report
To see how to embed an OLE object into a report, we could use a Word docu-
ment, an Excel spreadsheet, or any other container object. To keep things
simple, use a graphical image. This time, use a bitmap (BMP) file. This file
type uses Microsoft Paint as its default application.
1. Load the Big Objects report into the Crystal Reports workspace and
switch to Design mode.
2. From the main menu, choose Insert=>OLE Object.
The Insert Object dialog box opens, as shown in Figure 12-6.
Insert Object 2]
——— Object Type: 0K
Figure 12:6: | """ met bt 2 [ caee ]
The Insert | %% mcrsotGancran
Object SN, | Dot
dialog box, Miroech PowsrPoit Side v
showing | a.w
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types. ’
=

3. Select the Create from File radio button.

The dialog box changes to appear like Figure 12-7.
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If you select Create New rather than Create from File, you could then
create an OLE object directly within your report. It could be any of the
object types listed in the Object Type list, provided that the appropriate
OLE server application is present on your computer.

(Tnsert Object

2]

() Create New

He:

CAHawai

[ Erowes.. [ Link

(%) Create from Fie

Reault
Inseats the contents of the fie as an objed o

your document so that you may activate it using
[ | ¥ pwgrin ehich Erntedt &

K

[[] Display As lcon

4. Fill in the name of the file you want to embed — or browse for it —

and then click OK.

A placement rectangle appears on your form.

5. Place the rectangle where you want the image to appear in the report.

For this example, place the placement rectangle in the upper-right corner
of the form and then click the mouse to place it there. Figure 12-8 shows

the result.
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RF .
FF .
zl je tumpe; |
OLE Object: | o i) it

The image on the right looks just like the one on the left, but looks can be
deceiving. The image on the left is a bitmap image object (from earlier in
this chapter), and the one on the right is an embedded OLE object.
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6. Double-click the embedded OLE object (in this example, the image on
the right).

The drawing tools from the Paint OLE server application become avail-
able within Crystal Reports (see Figure 12-9).
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embedded .Customer IO © ustomer Nome . ContactfirstMame . ContactLastNome  Phone . . Order Amount
object
ithi o 1 5 O
within the |
report. —
I | OLE Object:

-

zantact F st Namo

égN\BEﬁ' Although the embedded object in the report is editable — using the tools of
& its server application — it’s not the original file but only a copy. Any changes
that you make to the embedded object have no effect on the original file from
which the embedded object was taken.

Linked OLE Objects

Linked objects are like TV screens: The actual data items don’t move to the
container application. Instead, the container application contains an image of
the linked object (which remains in the server application). This link means
that whenever the original object in the server application is updated, the
linked object in the container application is updated as well, and vice versa.
Suppose, for example, that your server application is Excel, and you update
the data in a linked spreadsheet. The next time you run your report in Crystal
Reports, it pulls the latest data from the Excel file to display in the report.

Using linking is best if

v Your report must always reflect the latest data.

»* You want the data in multiple applications to remain synchronized.
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An advantage of using a linked image is that it takes up less space than
embedding a large spreadsheet or Word document, which makes the report
faster to load. However, reports containing linked objects are less portable
than reports containing embedded objects.

Another point of consideration is the server application. For the link to work,
the original server application must be present on the machine that’s running
Crystal Reports. By contrast, an embedded object needs no link to its source
file although it does require a copy of its OLE server application to be available.

Creating a linked OLE object is very similar to creating an embedded one. In
the preceding section, I show you how to embed an existing file into a report.
You could just as easily embed a file created from scratch.

Linking differs from embedding in that you can link to an existing file, but cre-
ating a file from scratch within your report does not involve linking. In order
to link to a file, it must first exist outside your report.

Here are the steps for linking to a server document:

1. Display your target report in Design mode.
2. Choose Insert=>OLE Object.

The Insert Object dialog box appears (as shown in Figure 12-10),
listing the types of files you can insert as OLE objects.

Insert Object (1]
0K

) Create N

(%) Create from Fie C:\Hawai'Simple drawing bmp

Erowes.. | [ Link

Reault

Inseats the contents of the fie as an objed o
your document so that you may activate it using
[ | ¥ pwgrin ehich Erntedt &

3. Select the Create from File radio button.
4. Specify the file you want to link to.

For this example, I select a bitmap image of a simple drawing that [ made,
but you could use any file of the supported object types.

5. Select the Link check box to enable it (as shown in Figure 12-11) and
then click OK.
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An object-placement frame appears at the cursor position.
6. Drag the placement frame to the appropriate section of the report.

For this example, place the new image in the center of the report header
by clicking the left mouse button. The image of the linked object appears
where you place it, as shown in Figure 12-12.
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7. To edit the newly placed linked object, double-click it.

The object’s server application launches, which you can then use to
edit the object.

Your edits are reflected in both the original object and in the image
in your report.

Figure 12-13 shows the linked object after it’s been edited in Paint.
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Embedding or Linking an
Object Taken from a File

To embed or link an object taken from an OLE server application (rather than

an entire file) into a report, follow these steps:

1. Copy the object to the Windows Clipboard.

2. From the Crystal Reports menu, choose Edit=>Paste Special.

The Paste Special dialog box appears.

3. Select Paste or Paste Link.

| 38 Humbei |

For Help, press Pl | | DD j_:.i__

y ) Database

If you select Paste, the Clipboard object is embedded in your report. If

you select Paste Link, the object is linked.

When a linked object is updated in the OLE server application, it’s likewise
updated in your report. If the object is embedded, such an update in the

server application doesn'’t affect it.

Integrating Shockwave Flash
Objects into Your Reports

Shockwave Flash objects (SWF files) typically contain animations, but can also
contain applets. (Applets are small programs that perform some operation.)
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Figure 12-14:
The Insert
Flash Object
dialog box.

You can embed a Shockwave Flash object in a report in the same way that you
embed an OLE object in a report. Likewise, you can link to a Shockwave Flash
object the same way you link to an OLE object. The major difference is that
you must choose Flash from the Insert menu rather than choosing OLE
Object.

Flash animations can be annoying, particularly if they are overused. Don'’t fall
into the trap of adding Flash animations to your report just because you can.
Animations used sparingly and tastefully can be a plus, but it is easy to go
overboard. One possible use in a report might be an animated company logo.
Another might be an animation that illustrates a process that is described in
the text of the report.

After you tell Crystal Reports that you want to insert a Flash object, the
Insert Flash Object dialog box displays. Fill in or browse for the location
of your Flash object, as shown in Figure 12-14.
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A placement rectangle appears. Deposit the Flash object in an appropriate
spot on your report.

You can add SWFs that perform animations to any section of your report. The
same is true for some SWFs that execute applets. The exception occurs when
an applet extracts data from the report and displays it graphically. This is a
major new capability of Crystal Reports 2008. When the data binding capabil-
ity is used in conjunction with Crystal Xcelsius, the communication power of
areport reaches a new level. I discuss using Crystal Reports with Crystal
Xcelsius in Chapter 17.

When you embed a Flash object in a report, changes to the data bound to the
Flash object are dynamically reflected in the Flash display. Chapter 17 is where
I discuss data binding. When you link to a Flash object, you see a static repre-
sentation of the object. If the object is updated by its server application, you
must close your report and then reopen it to view the changes.

To test the functionality of Flash objects within a Crystal Report, you must
have Flash Player 9 or later installed on your machine. If the report is not
being viewed from within Crystal Reports itself, you also need a viewer that
supports Flash rendering such as the .NET Web form or the Java DHTML
viewer. A default image is associated with each Flash object, and that is
what is displayed on a printed report or on one that has been exported.
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Creating and Updating
OLAP Reports

In This Chapter
Defining and applying OLAP
Retrieving OLAP data with Crystal Reports

C omputer geeks have a maddening tendency to refer to things by in-
scrutable acronyms, sometimes even pseudo-acronyms, such as SQL —
which, believe it or not, does not stand for Structured Query Language. (Read
the sidebar on SQL to see why.) The letters in BASIC, FORTRAN, and COBOL
once stood for something, as did the letters in the late, lamented SNOBOL.
OLAP is a new entry in the list of obscure computer acronyms, but at least
it’s real. OLAP stands for On-Line Analytical Processing. In this case, the
name does bear some resemblance to what the technology is actually about.

OLAP is a form of data mining that enables non-programmers to extract the
information they need from an OLAP database. OLAP databases are structured
differently from the way ordinary relational databases are structured, in order
to make possible the retrieval of desired information using OLAP grids. With
Crystal Reports, you can build OLAP grids that operate on OLAP databases, in
effect pulling needles out of digital haystacks, without the aid of a formal query
language such as SQL.

What's OLAP, and Why
Might You Need It?

OLAP is called On-Line because it happens in real time, with the user sitting in
front of the screen while there’s a direct connection to a database. The results
of user actions are immediate (more or less). The operation itself is called
Analytical Processing because its main function is to quickly analyze huge quan-
tities of data and deliver meaningful information to the user. The information
arrives in a form that the user can readily comprehend and act on.
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What do the letters SQL stand for?

SQL is an industry-standard data sublanguage
that descended from a language that IBM devel-
oped in the 1970s for its internal use only. The
rough prototype language went by the acronym
SEQUEL (pronounced the same as the English
word), which stood for Structured English QUEry
Language. Hey, it made sense at the time; state-
ments in SEQUEL looked a lot like statements in
English, but they were more structured.

When IBM released its first relational database
product (SQL/DS) in 1981, the Big Blue team
wanted to deliver a commercial-quality data sub-
language along with it. They performed a major
overhaul on SEQUEL, creating a more robust lan-
guage. Before release, they discovered that
another company had trademarked the name
Sequel, so they dropped the vowels, and called it
SQL (pronounced ess-que-ell).

However, many people persisted in pronounc-
ing SQL as seque/ — and that was mistake
number one. Mistake number two was the
assumption that SAL stood for Structured Query
Language because SQL is not a structured lan-
guage: It breaks the cardinal rule of structured
languages by allowing branches to remote
locations. It might be structured English, but it
isn’t a structured computer language in the
sense that computer scientists use that term.

So where does that leave us? Simple: SQL doesn't
actually stand foranything. Like with C, C++, or C#,
it's simply the name of a language — which most
people mispronounce and misunderstand — but
atleast you and | know what they're reallytalking
about.

Who uses OLAP?

Huge amounts of data are stored in relational databases belonging to organiza-
tions of all sizes and types. You can retrieve information from these databases
using queries written in SQL, or by using a graphical approach such as Query
By Example (QBE), which gets translated into SQL and then executed. Either
way is great — if you're an SQL guru or someone equally skilled in QBE usage.

OLAP is for people who don’t even know what a nested SELECT is, let alone a
LEFT OUTER JOIN. OLAP is atool designed for managers who must make
decisions based on a needle of information buried in a haystack of data.
OLAP gives people who are not database specialists the capability to find
that needle quickly.

Creating multidimensional views

A spreadsheet gives you a two-dimensional view of the data you're displaying,
as do most reports you create with Crystal Reports. It’s the classic row-and-
column approach: for example, a company’s line items for income and expense
arranged in rows, while months or quarters go in columns. Another example is
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an instructor’s course records: say, student names in rows, and assignment
grades and exam scores in columns. Many common situations can be repre-
sented very well with these two dimensions. Others, however, require three
(or even more) dimensions to convey what the data means.

OLAP is designed to work with these more challenging data sets. A multidimen-
sional OLAP representation of complex data is an OLAP cube. Even though the
word cube implies three dimensions, an OLAP cube can have more than three
dimensions. (This does not mean that parts of some OLAP cubes reside in
hyperspace. These extra dimensions are conceptual, not spatial.)

What kinds of reporting tasks might require more than two dimensions?
Suppose that a company displaying income and expense data by month
wants to expand the report to show the data for the past ten years. Income
and expense could be one dimension; January through December could be
a second dimension; and the years could be a third dimension.

Here’s another example. Suppose that an instructor is teaching a distance-
learning course with clusters of students meeting in 15 different cities. An
OLAP cube could have student names in one dimension, assignment grades
and examination scores in a second dimension, and student location in a
third dimension. Any application that lends importance to more than two
aspects of the data is a candidate for storage in an OLAP cube and presenta-
tion in an OLAP report.

Connecting to an OLAP data source

Multidimensional OLAP data is different from ordinary relational data in a
relational database. Consequently, you access it differently than you access
relational data. Here are the two ways to access OLAP data:

v Directly: For a direct connection to function, you need an installed
OLAP client and some specialized DLLs (dynamic link libraries).

v An Open OLAP gateway: An Open OLAP connection doesn’t require
either an OLAP client or any special DLLs. However, it does require a
Name Server host that communicates with both Crystal Reports and
your OLAP data source.

OLAP Reporting with Crystal Reports

Crystal Reports doesn’t create OLAP cubes — the database management
system (DBMS) that Crystal Reports is working with does that. Crystal
Reports currently creates OLAP reports based on three types of data source.
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v Hyperion Essbase (7.0, 7.1)
+* IBM DB2 OLAP (8.2) Enhanced
v Microsoft OLE DB Provider for OLAP Services 8.0

The IBM product is actually Essbase in disguise. IBM acquired Hyperion and
integrated Hyperion’s products into the IBM product line.

Operating on OLAP grid objects

A report containing OLAP data consists of one or more OLAP grid objects,
which are two-dimensional slices through a three-dimensional cube. Multiple
slices give the report a third dimension.

Depending on how you want to look at the data, you might slice a cube in dif-
ferent directions. This process, called slicing and dicing, allows you to play
with the data until you display it in the most informative way. You can also
add dimensions to either the horizontal or vertical axis to analyze three or
more dimensions in a single OLAP grid. Alternatively, you can create multiple
OLAP grids within a report.

If you have a choice between building a wide report with many columns
across the page and little or no depth, or a report with fewer columns across
the page coupled with more depth into the third dimension, take option two.
Crystal Reports processes narrow and deep grids faster than it processes
wide and shallow ones.

Creating a three-dimensional report

To demonstrate how to create an OLAP report, here’s a chance to slice and
dice some data from a cube based on the Xtreme database and see what it
can tell you. The Business Objects Web site has a sample OLAP cube that you
can download named Sales Reports.cub. It records the sales, budget, and
cost records for a fictitious grocery store chain. You can find it at

http://support.businessobjects.com/communityCS/FilesAndUpdates/
cr_xi_xtreme_report_samples_en.zip.asp

This is the same place where you can download the xtreme .mdb database.
Download the ZIP file if you haven’t already done so, and unzip it. In the en
folder, select Samples, and then select Databases.

The following sections take you through a step-by-step procedure for creat-
ing an OLAP report based on the Sales Reports.cub cube. You start by
specifying a data source. Then you define the grid structure, set sliced dimen-
sions and add pages, apply a predefined style, and finally generate a report.
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Figure 13-1:
The OLAP
Connection
Browser.
|

Specifying a data source

The first step in the process is to tell Crystal Reports where to find the data
that the report will be based upon.

1. From the Crystal Reports Start Page, select the OLAP Cube Report
Wizard.
The OLAP Data dialog box appears.

2. Click the Select Cube button.

The OLAP Connection Browser appears, showing connected OLAP
servers, as shown in Figure 13-1.

"? OLAP Connection Browser 1%}
@ ouar Cubes | Open
@ Favorites
Add.. |
| Cancel J
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3. If the source of your cube is listed on the OLAP Cube tree, select it
and then click Open. If not, click the Add button.

When you click Add, the Connection Properties dialog box appears.

4. In the Connection Properties dialog box (see upcoming Figure 13-2),
specify the location of your cube (whether on a remote server, as a
local CUB file, or as an HTTP cube on the World Wide Web).

To follow along with the example, for Server Type, select Microsoft OLE
DB Provider for OLAP Services 8.0.

5. For Caption, fill in some appropriate identifier for this connection.
For this example, type xtreme cube 1.

6. Under Server Options, specify Local Cube file (CUB) and click the
ellipsis button (with three dots) to the right of the File text box.

In the Open dialog box that appears, find the Sales Reports.cub file.
It’s located wherever you placed it when you downloaded it.
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7. Select Sales Reports.cub and then click the Test Connection
button.

If all is well, a small OLAP dialog box appear with the cheerful connected
successfully message.

8. Click OK. Back in the Connection Properties dialog box, click OK.

At this point, the Connection Properties dialog box should look some-
thing like Figure 13-2.
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You return to the OLAP Connection Browser, which now displays your
cube in the tree (showing that the Xtreme cube is connected), as shown
in Figure 13-3.
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9. Click the plus sign to the left of the icon for xtreme cube 1.
This drops down to a level named Sales Report.
10. Click the plus sign to the left of the folder icon for Sales Report.
This displays the cube itself, named Sales Report.
11. Select your cube and then click Open.

The OLAP Data dialog box displays, as shown in Figure 13-4.
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12. The identifying information about your cube is already filled in.
Verify that it is correct and then click Next.
The Rows/Columns dialog box appears, as shown in Figure 13-5.
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Defining a grid structure
Now structure the OLAP grid the way you want it.

This cube has three dimensions: Products, Sales, and Dates. The wizard sug-
gests that Sales entries (which are things that can be measured) be shown in
columns and that Products entries be shown in rows. You want to take a slice
through the cube that shows the data for the first week of last year. To do so,
leave alone the structure that Crystal Reports has assumed in the Rows/
Columns dialog box, and click Next. The Slice/Page dialog box appears, as
shown in Figure 13-6.

+ Slice/Page =]

Slice/Fage E

Clwmer 0 rio with the demensiana that zem nat mves or colmna in the gnd

Evary obd disclaved will have the dmensions set bo the value selectad for i in the Sice st
Aseperate gid will be deplayed for each selected value of dmermiors in the Page kst

Sebect orm valos for sach demerson Dvag & chmension o this ksl box and select
mukpls vale
| Select Sice |
I Link t Penmeter CoateEat | Link to Pammeter
Figure 13-6:
Slice/Page
dlalOQ box. < Back teo> | [ Fosh | [ Concel | [ bew
|

Setting sliced dimensions and adding pages
The task here is to specify the timeframe you want the report to cover.

1. Select Week = All Weeks and then click the Select Slice button.
The Member Selector dialog box shown in Figure 13-7 is displayed.
2. Click the + sign to the left of All Weeks to expand the tree.
The tree expands as shown in Figure 13-8.
3. Select 01 and then click OK.

4. Upon returning to the Slice/Page dialog box, select Year = All Years.
and then click the Select Slice button.

The Member Selector dialog box appears, this time showing All Years.
5. Click the + sign to the left of All Years to expand the tree.
6. Select Last Year, as shown in Figure 13-9, and click OK.
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7. Upon returning to the Slice/Page dialog box, click Next.

The Style dialog box opens, as shown in Figure 13-10.
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Applying a predefined style
Select a style from the Style dialog box, and then click Next. For this example,
I'm going with the simple and classic Original style.

Generating a chart

If you want to include a chart in your report, select a chart type from the Chart
dialog box. Fill in the appropriate entries for Chart Type, On Change Of, and
Subdivided By. I chose not to include a chart for this example.

Finishing your report
When you have your report set up, click Finish in the Chart dialog box.

A completed report with no associated chart appears, as shown in Figure 13-11.
Depending on the complexity of your report and the speed of your computer,
this could take some time. Some tweaking is in order; the numbers in the
Sales, Cost, and Margin columns are too large to fit in the boxes provided.
These are easy to expand, however, by switching to Design view and dragging
the right-side handles of the Value fields horizontally to the right.

Adjusting column widths

To adjust the widths of the columns, switch to Design view, which looks
something like Figure 13-12.
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in Design
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1. Select the Value text object and expand it to the right by dragging its
right drag handle.

2. Repeat Step 1 for the Products.Level text object.

Your report, in Design view, now looks like Figure 13-13.
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In Preview view, the report now looks like Figure 13-14.
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Digging deep for details

Click the + sign to the left of All Products. The All Products category expands
to show the breakdown between major product categories. The total Sales,
Cost, and Margin figures remain at the top, but now there are individual totals
for Bakery, Frozen Goods, Fruits and Vegetables, Grocery, Meat, and Wine and
Spirits, as shown in Figure 13-15.
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Now the major product categories also have a + sign to the left. By clicking
the + sign at each level of detail, you can delve down to a deeper level.
Figure 13-16 shows the result of expanding the Bakery category,

and Figure 13-17 goes one level deeper.
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An OLAP report can be a powerful tool for analyzing multidimensional data,

enabling decision makers to make better decisions, based on a better under-
standing of the facts.

Updating an OLAP Report

Because an OLAP report is based on an OLAP cube created by a database
management system, any change in the underlying cube could cause errors
in the production of the report. The report might even come out blank if, for
example, the location of the OLAP cube has changed, and Crystal Reports
can no longer find it. Other problems occur if a dimension has been removed
from the cube or a field used by the report is removed.

To reconnect a report to a cube whose location has changed, perform the
following steps:

1. In the report, select the grid by right-clicking within the border.

2. From the menu that pops up, choose Set OLAP Cube Location.

A dialog box appears, reading, “Warning: It is not possible to undo this
command. Would you like to perform the command anyway?”
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3. If you’re sure that your OLAP cube location has changed and that your
report is no longer valid, click Yes.

The Set OLAP Cube Location dialog box appears, displaying what
Crystal Reports currently thinks the cube location is.

4. Specify the new OLAP Server location by clicking Select and then use
the Crystal OLAP Connection Browser that appears to locate the cube.

The Connection Properties dialog box displays.
5. Select the new cube location and click Open.
6. In the Set OLAP Cube Location dialog box that appears, click OK.

Your OLAP cube is now reconnected to its source database at its new
location.

Formatting Data in an OLAP Report

You can do a number of things to enhance the appearance of an OLAP grid.
Often such enhancements make it easier to convey the important facts con-
tained in the grid. As I mentioned earlier, you can easily change the width and
height of the grid cells by moving to Design view, selecting them, and then
dragging the cell handles to give the cell the desired dimensions.

You can do lots of other things:

v~ Highlighting Expert: You can use Highlighting Expert to apply condi-
tional formatting to the grid fields. Access Highlighting Expert by right-
clicking the field you want to format, and then choosing Highlighting
Expert from the contextual menu that pops up. See Chapter 8 for more
about Highlighting Expert.

v+ Format Editor: You can use Format Editor to apply absolute formatting
to fields in the grid. For this function, right-click the field you want to
format, and choose Format Field from the contextual menu. Chapter 8
covers Format Editor.

v+ Formula Workshop: You can use Formula Workshop to create your own
custom formula for conditional formatting. This can be as elaborate and
obscure as you like. Formula Workshop is the most powerful tool for
controlling formatting of an OLAP grid. I cover Formula Workshop in
depth in Chapter 10.

1 OLAP Expert: You can use OLAP Expert to reformat the entire OLAP
grid. It can do everything that the OLAP Report Creation Wizard can do,
plus a couple of additional functions. One of the many things you can do
with the OLAP Expert is to change a dimension’s background color.
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Changing a dimension’s background color

Here’s how to change the background color of one of the dimensions of the
OLAP grid that I show you how to create earlier, as shown in Figure 13-8.

1. Invoke OLAP Expert by right-clicking in the upper-left corner of the
grid and choosing OLAP Grid Expert from the contextual menu that
appears.

OLAP Expert appears. At this point, all the identifying text fields should
be filled in, as shown in Figure 13-18.
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Figure 13-18:
OLAP
Expert.

2. Click the Customize Style tab.

Figure 13-19 shows what this looks like. Note that the background color
for the Product Name, Level 0 group option is set to Custom.
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3. Pull down the Background Color menu and choose the color you want
for the background of the Product Name columns.

For this example, I chose aqua.
4. Click OK.

Figure 13-20 shows the result. The Level 0 product column now has a
background color of aqua. The Level 1 background column is unaffected,
as are the other areas of the grid. Of course in this book, you cannot tell
that the background color has changed to aqua. However, you can tell that
it has changed to something other than white. Take my word for it. [ am
looking at it on a color screen. The Level 0 background color has changed
to aqua.
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Creating an alias for a dimension

Dimension names come from their source cube, so they’re not under your
control. These dimension names could be extremely long, making them
tedious to include in formulas. To remedy this, you can substitute an alias
for a dimension name.

1. On the Customize Style tab of OLAP Expert (refer to Figure 13-19),
select the dimension for which you want to create an alias.

2. With the dimension selected, in either the Rows or Columns boxes,
enter the alias name in the Alias for Formulas field.
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|
Figure 13-21:
The Format
Grid Lines
dialog box.

3. Click OK.

You can now use your shorter alias in any formulas involving that
dimension.

Formatting grid lines

The default grid lines that define the rows and columns of the grid are fine for
most applications. However, you have the flexibility of either displaying the
grid lines or not, as well as selecting their color, style, and width.

1. On the Customize Style tab of the OLAP Expert (refer to Figure 13-19),
click the Format Grid Lines button.

The Format Grid Lines dialog box appears, with a layout of a sample
grid, as shown in Figure 13-21.
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2. In the list on the left, specify the row label attributes, column label
attributes, or cell attributes that you want to change. Alternatively,
you can select the line you want to change by just clicking it.

3. From the pull-down menus on the right, specify the color, style, and
line width that you want for the specified attributes.

4. When the grid image in the top part of the dialog box matches what
you want, click OK.

I chose solid red lines, with a line width of 2 points, giving me the appear-
ance shown in Figure 13-22. Actually, you probably can’t tell that the lines
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are red. You might be able to discern that they are not as dark as black
lines would be. You should certainly be able to tell that they are thicker
than the standard hairline grid lines.
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Labeling dimensions

You can control which dimensions are labeled and which remain unlabeled.
Use the Labels tab of OLAP Expert to display labels. Figure 13-23 shows the

Labels tab.
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As you can see, you can choose which dimensions are labeled and which are
not. You can also choose where to position a label as well as the vertical and
horizontal spacing between labels.

Changing Data Appearance
in an OLAP Report

|
Figure 13-24:
The Sales
Reports
cube.
|

You can change quite a few things in Preview mode. Some of these are dis-
cussed in the previous section. Others are discussed in this section. You can
also make changes in Cube view. To take a look at Cube view, right-click in the
upper-left corner of the grid to display the shortcut menu. From the menu,
choose View Cube. The cube from which your grid is derived displays. It
most likely looks something like the cube | have been using in the examples
so far, as shown in Figure 13-24.

In this section, I stick to describing the changes you can make in Preview
mode. You may never have to exercise the advanced capabilities available in
Cube View mode.
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|
Figure 13-25:
A dimension
has been
hidden.

Showing and hiding dimensions

Suppose you want to hide a dimension to reduce potentially confusing clutter
in the grid.
1. Right-click the dimension of the members you want to hide.
In this example, I right-click Bakery.
2. From the shortcut menu, choose Collapse Member.

The details disappear, as shown in Figure 13-25.
You can expand a dimension in a similar manner.

1. Right-click the dimension of the members you want to show.
I right-click the Bakery cell.
2. From the shortcut menu, choose Expand Member.

The details now show, as shown in Figure 13-26.
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Adding totals to an OLAP grid

You can add totals to a grid with the following steps:

1. Right-click the dimension that you want to total.
For this example, I right-click in the Sales cell.
2. From the shortcut menu, choose Automatic Totals.
3. From the submenu that appears, choose Rows (Across).

The amounts in the rows are now totaled, and the totals are displayed in
the grid, as shown in Figure 13-27.

Pivoting an OLAP grid

To exchange the roles of rows and columns, you can pivot the OLAP grid.
Right-click the border of the grid to display a shortcut menu. From the menu,
choose Pivot OLAP Grid. This flips the grid, as shown in Figure 13-28.
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Reordering fields

You can change the order of the members in the grid, either rows or columns.
Here’s how:

1. Expand the row or column that you want to reorder. (Refer to
Figure 13-26.)
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I picked the Frozen Goods cell.

2. Right-click the dimension you want to reorder to display its shortcut
menu.

3. From the menu, select Reorder Displayed Members.

The Reorder Displayed Members dialog box appears, as shown in
Figure 13-29.
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The customers are displayed in the order they hold in the cube.

4. Select an individual member, such as Frozen Goods, and then move it
up or down in the list, using the up and down arrows to the right of
the list of members.

5. When you have the members arranged the way you want, click OK.

The OLAP grid reflects your revised ordering.

Sorting data

In addition to rearranging individual rows and columns in a grid, you can also
sort rows and columns based on the values they contain. You can easily add
multiple sorts to a grid, and just as easily edit or delete them.
1. To add a sort to a grid, right-click the desired row or column member.
2. From the shortcut menu that appears, choose Add First Sort.
A submenu appears with options:
¢ Ascending

¢ Descending
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¢ Ascending, Break Hierarchies
¢ Descending, Break Hierarchies
3. Choose one of the submenu options.
The arrangement of items changes.
You can change the direction of a sort or remove a sort from the shortcut
menu. You can also pile one sort upon another, sorting first on one member
and then on others. You can either retain the Level 0/Level 1 hierarchy to

keep related members together, or break that hierarchy to sort things with-
out regard to group membership.

Filtering data

You can filter data to exclude data from the grid that is not important for your
purposes. For example, you could filter out the top or bottom N members, or
the top or bottom N percent of members.

1. Right-click the field that you want to filter.

2. From the shortcut menu that appears, choose Add Filter.

The Define Filter dialog box appears, giving you three choices in the
Filter Type area: Actual Values, Top / Bottom N, and Top / Bottom N%.

3. Select a filter type.

4. In the Filter Definition area, select either Show Rows or Hide Rows
and specify a condition, such as Cell value is less than 1000.

5. Click OK.

Making calculations

You can add calculations to an OLAP grid, using values in the grid as operands.
The results of the calculations are added to the grid as extra rows or columns.
Quite complex calculations are possible.
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Chapter 14

Using Cross-Tab Reports
to Mine Your Data

In This Chapter

Defining a cross-tab object
Creating a cross-tab report
Using a cross-tab report to summarize

Formatting a cross-tab object

F)r some people, a summarization of one sort or another is far more
valuable than reams of detailed data. However, reports with summaries
in a Group Footer or the Report Footer don’t always display summaries in a
form that is good for comprehension and decision making. In some of these
cases, a cross-tab object can present the data in a form that’s both easy to
understand and capable of conveying the significance of the data.

The main advantage of using a cross-tab is that it can put multiple summaries
together in a compact form. You can draw inferences from a single cross-tab
on a single page, which displays separate summaries that are nonetheless
related.

Creating a Cross-Tab Object to
Summarize All Report Data

Suppose that the Sales Manager at Xtreme Mountain Bikes would like to see
how the various product categories are contributing to total sales volume in
Canada. A cross-tab report is ideal for presenting that information in a way
that can be easily viewed and comprehended. Follow these steps.
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1. From the Crystal Reports Start Page, select Cross-tab Report Wizard.

The Cross-Tab Report Creation Wizard appears, showing available data
sources.

2. Select the Customer, Orders, Orders Detail, Product, and Product
Type tables from the xtreme .mdb database.

3. Move the tables to the Selected Tables pane.
4. Click Next to display Link view.

Link view shows the five tables connected to each other by the fields
that they have in common.

5. Click Next to display the Cross-tab view of the Cross-Tab Report
Creation Wizard, which is shown in Figure 14-1.
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6. In the Available Fields pane, expand the Customer node and select
Region. Then click the right-facing arrow to the left of the Rows pane.

Each row of the cross-tab now corresponds to a region (in this case,
a province of Canada).

7. In the Available Fields pane, expand the Product_Type node, and drag
Product Type Name to the Columns pane.

Each column of the cross-tab now corresponds to a product type.

To get the report to make the specific summaries you want, follow these
steps:

1. In the Available Fields pane, expand the Orders node. Drag Order
Amount to the Summary Fields pane.
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Figure 14-2:
Chart view
of the
wizard, with
descriptive
chart title.
|

The default value in the pull-down list below the Summary Fields pane
displays Sum, which is the type of summary you want for this report.

2. Click Next to display Chart view.
You can add a bar, line, or pie chart to the report, if you want.
3. Select Bar Chart to see what it will give you.

When you select a chart type, the wizard suggests a chart title that you
can override if you want. It also asks that you verify several other
assumptions it has made about what you want the chart to show.

4. Change the Chart Title to Sales by Province and Product Type, as
shown in Figure 14-2.
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5. Click Next to display Record Selection view.

For this report, you want to deal with records only from Canadian
customers.

6. In the Available Fields pane, expand the Customer node and move
Country to the Filter Fields pane. In the pull-down lists that appear
below the Filter Fields pane, select is equal to and Canada.

7. Click Next to display Grid Style view, which is shown in Figure 14-3.

A good assortment of styles is available, some more appropriate than
others for various kinds of reports.

8. Retain the Original style, and then click Finish.

The report is displayed in Preview mode. The upper part of the report
is shown in Figure 14-4.
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9. Save the report.

For this example, save the report as Sales by Province. You'll use

this report later.

This chart should be of interest to the Sales Manager. It shows that competi-
tion bikes are outselling mountain bikes by a factor of almost three to one. It
also shows that Xtreme is deriving almost as much revenue from the sale of

helmets as it is from the sale of mountain bikes. This kind of information can

be a great help to decision-makers.
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Figure 14-5:
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Moving down the page to the actual cross-tab report shown in Figure 14-5,
you can see that most sales are coming from British Columbia. This
information might also be important to the Sales Manager.
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The overall totals for each province are off the screen on the right edge of
the report, with a grand total in the bottom-right corner. Also notice that the
sales total for competition bikes for British Columbia and the overall total are
so large that they don't fit in the space allotted, and are replaced by # signs.
One solution to this is to reformat that column to make it wider. I cover for-
matting later in this chapter. At any rate, with this cross-tab object and its
accompanying chart, the manager can quickly grasp the overall situation and
make valid decisions.

Summarizing the Contents of
a Group with a Cross-Tab

As you can see in the preceding section, you can add cross-tabs to a Report
Header or Report Footer. This section shows you how to add cross-tabs to a
Group Header or Group Footer.

You can’t put a cross-tab in page headers, page footers, or the Details
sections.

The section in which a cross-tab object is located in a report is related to the
data it contains. For example, if the cross-tab should include all the data in
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the database for customers in Canada, as in the preceding section, the cross-
tab must be located in either the Report Header or the Report Footer. This
makes sense: The displayed data is a summary of data from all the Canadian
provinces, so it must appear in a report section that encompasses data from
all those provinces.

You can also create individual cross-tab objects for each group in a report.
For example, you could create a report similar to the preceding one, but with
summaries for each province rather than one overall summary for all of
Canada. Follow these steps:

1.

From the Crystal Reports Start Page, select Report Wizard.

Because there’s more to this report than just a cross-tab, you use the
Standard Report Creation Wizard (rather than the Cross-Tab Wizard) to
create the report.

. Place the Customer, Orders, Orders Detail, Product, and Product Type

tables in the Selected Tables pane.

. Click Next to display Link view.

The links between these tables are straightforward, so the wizard has
assumed them correctly.

. Click Next to display Fields view.

Your report won'’t include any fields other than those in the cross-tabs,
so there’s no need to select any fields here.

. Click Next to display Template view.

You won'’t use a template, either.

. Leave the default choice (No Template) intact; click Finish.

This creates a report with nothing in it but a date and a page number.

To continue building the report

1.
2.

Switch to Design mode.

Expand the Print Date field in the Page Header to make it big enough
to display a date in a long format.

3. Add a text field in the Report Header to hold the report title.

Here’s how:

a. On the Insert Tools toolbar, click the Insert Text Object icon and then
place the text rectangle in the Report Header.

b. Expand the rectangle across the entire width of the page, and then
type the report title.
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|
Figure 14-6:
An empty
cross-tab
has been
placed into
group
header GH1.

To follow along with the example, type Sales of Product Types by
Province.

c. On the Formatting toolbar, click the Align Center icon to center
the text.

d. Enlarge the font and make it bold to make it more readable.
4. On the Expert Tools toolbar, click the Group Expert icon.
The Group Expert dialog box appears.

5. Expand the Customer node and then move Region over to the Group
By pane. Click OK.

Group Header 1 (GH1) and Group Footer 1 (GF1) are created.

6. Drag the bottom boundary of the Group Header section down to make
room for the cross-tab you will place there.

7. On the Insert Tools toolbar, click the Insert Cross-Tab icon.

Drag the placement rectangle that appears into group header GH1 and
release it with a mouse click.

8. If it’s not already visible, display Field Explorer so that you can select
database fields from it to place into your cross-tab.

Figure 14-6 shows the screen at this point.

9. Select Customer Name from Field Explorer and drag it onto the
cross-tab object, and then place it at the lower left-hand corner.

This makes Customer Name the item displayed in the rows of the
cross-tab. Figure 14-7 shows the cross-tab object after you do this step.
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10. In Field Explorer, drag Product Type Name from the Product_Type
table onto the cross-tab object, at the upper-right corner.

This establishes the columns of the cross-tab. Figure 14-8 shows the
cross-tab object after this is accomplished.
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11. Drag Order Amount from the Orders table in the Field Explorer into
the Insert Summarized Field Here cells.

Your cross-tab object should look like Figure 14-9.
12. Switch to Preview mode.

The report looks like the one shown in Figure 14-10.
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You have cross-tabs all right, but they’re not the ones you want. The first is
for the customer in Abu Dhabi, and the second is for customers in Alabama.
There are more than 3,600 records. You want the report to show only cus-
tomers in Canada. To do that, you have to work on the report just a little
bit more:

= 1. On the Expert Tools toolbar, click the Select Expert icon.

The Choose Field dialog box appears.
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2. Expand the Customer node, select Country, and then click OK.

The Select Expert dialog box appears, with the Customer.Country tab on
top.

&?«MBE” . From the pull-down lists, select is equal to and Canada. Click OK.
&
You want to select only Canadian customers.
. When the dialog box asks whether you want to use saved data or
refresh the data, click one of the options.
In this case, it doesn’t matter which you choose because the database
has not changed since the last time you ran the report.
The report, which is shown in Figure 14-11, now contains only Canadian
customers, but there’s a formatting problem. Below the cross-tab for
British Columbia, you can see a large number of detail lines indicated in
the left margin — all empty. Get rid of them so the cross-tabs for all
provinces are displayed one below another.
. Right-click in the area to the left of the Details section and choose
Suppress (No Drill Down) from the contextual menu that appears.
The report shown in Figure 14-12 appears. The data for Manitoba is right
below that for British Columbia, and the data for Nova Scotia is right
below Manitoba’s. This is what you want.
6. Save this report as Sales of Product Types by Province.
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Making Calculations within
a Cross-Tab Row or Column

Suppose you want your report to show the result of a calculation based on
the data in the report. You can do this by creating a Calculated Member. For
this example, suppose you want to display the totals of gloves and helmets
combined, for all the customers in your report. Follow these steps:

1. In the cross-tab, right-click the Gloves column header.

2. From the shortcut menu that pops up, choose Calculated Member.

3. From that submenu, choose Select “Gloves” as first value.

A dialog box appears and tells you that you have just selected the first
value for a predefined calculation.

. Click OK.
. Right-click the Helmets column header.

. From the shortcut menu, choose Calculated Member.

N S G e

. From that submenu, choose Sum of “Gloves” and “Helmets.”

A dialog box appears telling you that you have just added a calculated
row/column.
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8. Click OK.

A new column appears in the cross-tab to the right of the Helmets
column. It contains the sum of the values in the Gloves and the Helmets
columns.

Figure 14-13 shows the report as it now looks.
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Enhancing the Appearance and
Readability of a Cross-Tab Object

You can do a number of things to enhance the appearance of a cross-tab
report. This section experiments with achieving different effects in the
reports [ show you how to create earlier in this chapter.

Changing the width and
height of cross-tab cells

The width and height of cross-tab cells are easy to change in Design mode.
Merely select the cell you want to change and then drag its width or height
handle in the direction you want. If you drag a width handle, all the cells in
that column are changed along with the cell you're dragging. If you drag a
height handle, all the cells in the same row are changed in the same way. This
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Figure 14-14:
Format
entire
cross-tab
objects
here.
|

retains size consistency across columns and rows. It’s not uncommon to
need to enlarge cells to display all that they contain because the default size
assigned by the Cross-Tab Wizard is often not adequate.

Formatting entire row's and columns

You can apply formatting to an entire cross-tab object by right-clicking the
blank area at the top-left corner of the object and choosing Format Cross-Tab
from the menu that pops up. The Format Editor dialog box appears, as shown
in Figure 14-14.

You can specify various attributes such as Read-Only and Lock Position and
Size. By switching to the Border tab, you can also specify refinements such as
border lines, drop shadows, and foreground and background colors. From
the Hyperlink tab, you can associate your cross-tab with a Web site, an e-mail
address, or a disk file.
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Formatting individual fields

To format an individual field, right-click it and choose Format Field. This
displays a version of the Format Editor tailored to the data type of the field
you’re formatting. For example, a currency field displays font options and
currency format options in addition to the Common, Border, and Hyperlink
options that appear when you're formatting an entire cross-tab.
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Figure 14-15:
Suppress
the display
of empty
rows and
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|

You can give multiple cross-tab cells the same formatting by selecting them
simultaneously by Shift+clicking, and then applying formatting in the same
way you would for a single cell.

Suppressing selected cross-tab data

Sometimes the cross-tab objects you create might contain empty rows or
columns because no data is available to fill them. For readability, you might
want to suppress these empty rows and columns. To do so, right-click the
blank area in the upper-left corner of the cross-tab object and choose Cross-
Tab Expert. One of the tabs for this Expert is Customize Style. Click that to
display the dialog box shown in Figure 14-15.

The lower-right portion of the dialog box shows that you can suppress
not only empty rows and columns, but also row and column grand totals.
A variety of other customizations are also available.
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Printing cross-tabs that
span multiple pages

Commonly, a cross-tab object is wider or longer than the specified page size.
Crystal Reports automatically formats the report on as many extra (exten-
sion) pages as needed. Column headings are repeated on all such extra
pages. By default, row labels are not repeated. If you want row labels to be
repeated on extension pages, select the Repeat Row Labels option on the
Customize Style tab of Cross-Tab Expert (refer to Figure 14-15).



Chapter 15
Enhancing Reports with Charts

In This Chapter

Creating charts

Choosing the right kind of chart
Finding out about the chart layout choices
Placing charts in the right spot

Troubleshooting chart format and placement problems

rle essential purpose of a report is to communicate meaning to its read-
ers. Lines of text and columns of numbers undeniably communicate
meaning, but sometimes they don’t do so as forcefully as a visual image. The
right picture can sometimes be worth much more than a thousand words.

Crystal Reports delivers information visually in several ways. In several of
the previous chapters, I told how to include a company logo in a report. You
can use the same technique to include a wide variety of graphical images. In
Chapter 16, I discuss adding a visual dimension to geographical information
with maps. In this chapter, I tell you how to add charts to a report. Charts are
probably the most popular method used to convey an overview of data that
might otherwise be difficult to interpret. Trends in the data clamor to be
recognized. Anomalies are much more noticeable than they would be, buried
in a column of numbers. If your report contains numerical values of any kind,
it would probably benefit from the inclusion of one or more charts.

Using Chart Expert

The tool you use to create all the charts is Chart Expert. You can open Chart
|-I Expert by clicking the Insert Chart icon on the Insert Tools toolbar or by
choosing Insert=>Chart from the main menu. Either method calls up the Chart
Expert dialog box.
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|
Figure 15-1:
The Type
tab, Chart
Expert.
|

Type tab

The first tab on the left when you first open Chart Expert is the Type tab (see
Figure 15-1).

From this tab, you can select the type of chart you want to include in your
report. As you can see, 12 different bar charts are available (three 2-D
vertical, three 2-D horizontal, three vertical with depth effect, and three
horizontal with depth effect). The other types of charts have multiple
variants as well.

When you select the Vertical option, the bars rise vertically from the

bottom of the chart. When Horizontal is selected, the bars move horizontally
from left to right. These options don’t appear when you select a chart

type that doesn’t distinguish between vertical and horizontal (such as a

pie chart).
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Data tab

The Data tab, which is shown in Figure 15-2, has two areas: Layout and Data.
The Layout options are described in the later section, “Different Chart
Layouts for Different Data Types.” In the Data area, you specify what data to
show in the chart and what event will trigger the chart display. The triggering
event is the change in the value of some field.
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Figure 15-2:
The Data
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|
Figure 15-3:
The Axes
tab, Chart
Expert.
|
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Axes tab

The Axes tab relates to only some of the chart types. It gives you the option
of showing gridlines on the chart, scaling the axes, and indicating the number
of divisions displayed. Figure 15-3 shows the Axes tab.
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Options tab

The Options tab is shown in Figure 15-4. The areas on this tab are Chart
Color, Data Points, Customize Settings, Layout, and Legend. You can
specify a chart color of either Color or Black and White. Black and White,
for use with grayscale printers, uses different patterns to show the
different areas.

< Even if you have a grayscale printer, it might be better to specify color
anyway. The different colors show up as different shades of gray on a
grayscale printer and thus might be easier to interpret.

In the Data Points area, you can put labels and values in the vicinity of
points on the graph. Sometimes these are helpful, but often they just clutter
up the chart, without adding much additional information. In many cases,
leaving both options unchecked is a good idea.

Select the Transparent Background check box of the Customize Settings
area to underlay content beneath a chart and make the underlaid content
visible. You can select from several marker sizes, marker shapes, and bar
sizes (for a bar chart). The defaults are good choices to start with.

On charts, a legend is not a tale of heroic deeds handed down from long
ago. It’s an explanation of what the various elements of the chart
represent.
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|
Figure 15-5:
The Color
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Expert.
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Color Highlight tab

From the Color Highlight tab, you can give the individual elements of a chart
the exact color that you want rather than merely accepting the default colors
that are automatically assigned to each element. Figure 15-5 shows the Color
Highlight tab.
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Text tab

The Text tab in Chart Expert, which is shown in Figure 15-6, is where you

add some text to the chart. The two areas are Titles and Format. In the Titles
area, the Auto-Text check boxes are selected by default. This means that
Chart Expert selects a title for you, based on the fields that the chart uses.
(Usually the default choice is not the best albeit somewhat descriptive.) The
Format area at the bottom of the dialog box displays the default fonts chosen
for the different types of text objects on the chart. You can select a different
font for each of the Title, Subtitle, Footnote, and Legend Title categories by
clicking the Font button. Doing so displays the Font dialog box, from which
you can specify the font you want.

Creating a Chart

In this section, you run through the steps of using Chart Expert to create a
chart. It’s not difficult after you do it a few times, but in the beginning, there
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are behaviors that might have you scratching your head. Before you can
create a chart, you must have a report, and the report must have data upon
which to base the chart:

1. Open a report and switch to Design mode.

For the example, use the Customer Orders, by State or District (Mexico)
report from Chapter 8 as the basis for the chart. The chart shows the
relative contributions of the various states or districts. Figure 15-7
shows what this report looks like.
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. Click the Insert Chart icon on the Insert Tools toolbar or choose

Insert=>Chart, and then drop the orange rectangle that appears into
the Report Footer.

. Right-click within the chart image that appears.

The Chart menu appears.

. Choose Chart Expert.

Chart Expert appears.

. Switch to the Type tab (refer to Figure 15-1); if necessary, make your

selections.

To follow along with the example, from the Choose Your Chart Type
selection pane, select Pie (probably the best way to show the fraction of
sales orders coming from each state).

The Vertical and Horizontal options at the bottom disappear because
they don’t apply to pie charts.

. Switch to the Data tab (refer to Figure 15-2) and make your selections.

To follow along with this example, make the following choices:
a. The only layout allowed is Advanced, so keep that.

b. In the Data area, keep the default choices of On change Of:
Customer.Region and Show: Sum of Orders.Order Amount.

Again, Crystal Reports has guessed correctly. You want the pie
chart to start a new segment when Customer.Region changes.
Customer.Region is the field that contains the state or district
names. Also, the quantity you want to depict with the chart is the
Sum of Orders.Order Amount field. Chart Expert didn’t have to be
too smart to select this field because it’s the only numeric field in
the report.

. Click the Options tab (refer to Figure 15-4) and make your selections.

To follow along with this example, make the following choices:
a. In the Chart Color area, select the Color radio button.
b. In the Data Points area, select the Show Label check box.

c. In the Customize Settings area, select Detach Pie Slice and then
Largest Slice.

d. In the Legend area, select the Show Legend check box, keep Right
Placement, and leave Layout as Percentage.

. Click the Text tab (refer to Figure 15-6) and make your selections.

To follow along with the example, make the following choices:

a. Clear the Title Auto-Text check box and replace the default title with
Orders by State or District.
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|
Figure 15-8:
Pie chart

for the
Customer
Orders by
State or
District
(Mexico)
report.
|

b. Clear the Subtitle Auto-Text check box and type for Mexico.

c. In the Format area, accept the defaults or change them to fonts you
like better.

9. When you’re finished, click OK to add the chart to your report.

The bottom of the report page looks like Figure 15-8. The pie chart is
displayed, the largest slice is pulled out, and the legend appears on the
right. It is clear that Distrito Federal is by far the biggest contributor
to sales.
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Drilling down from a chart

The steps in the preceding section create a chart based on a report in which
the details were hidden. Because the details are hidden — and not sup-
pressed — you can drill down to see them if you hover the cursor over the
subtotal fields in each Group Footer. When the cursor changes from the
arrow shape to the magnifying-glass shape, a double-click drills down to the
detail of the group.

You can do the same thing with the chart. When you hover over one of the
pie slices in the chart, the cursor changes to the magnifying glass drill-down
cursor, and you can double-click. You see the same detail that you'd see if
you drilled down from the associated Group Footer. At the same time, a new
tab appears to the right of the Preview tab, corresponding to the group you
drilled into. From now on, when you want to view the detailed information for
that group, you need only click its tab.
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Changing a chart

After you create a chart on a report and viewed it, you might want to change
it. Perhaps the audience for the report has changed, and a new chart type
would be more appropriate. Perhaps some changes would improve the chart.
Here’s how:

1. Right-click somewhere in the chart and choose Chart Expert.

Chart Expert appears, with all the options and other selections that you
have made.

2. Make your changes:
¢ To change the type of chart: Use options on the Type tab.
¢ To change the layout: Use options on the Data tab.

You can change any of the parameters that you originally set when you
created the chart.

3. Click OK.

Your changes are instantly incorporated into the chart.

Choosing the Best Chart
Type for Your Data

The charting capabilities of Crystal Reports give numbers and statistics an
added dimension of communication. Numerical data represented visually in a
chart can much more readily reveal trends or show relative sizes. Different
types of data are best displayed with different types of charts, and Crystal
Reports offers a wide variety to accommodate just about any data set you
may have. This section provides a brief summary of each chart type.

Side-by-side bar chart

A side-by-side bar chart represents data as a series of bars, lined up side by
side and extending vertically from the bottom or horizontally from the left
edge of the chart. This type of chart is an excellent choice for displaying com-
parative values, such as the annual sales volume for a company’s major divi-
sions for a period of several years. Not only sales totals, but also any trends,
in sales would be evident.

Figure 15-9 shows a 2-D, side-by-side bar chart (top). Another option is the
side-by-side chart using depth effect, also shown in Figure 15-9 (bottom).
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|
Figure 15-9:
2-D, side-
by-side bar
chart (top)
and 3-D
side-by-side
bar chart
(bottom).
|
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Percent bar chart

A percent bar chart also represents multiple series of data as vertical or hori-
zontal bars, but a single bar represents each value for all series. The value of
the second series is stacked on top of the value of the first series, the value of
the third series stacked on top of the second series’ value, and so on. Using a
percent bar chart is good to show how the relative contributions of the ele-
ments of each series change over time. Figure 15-10 shows a 2-D percent bar
chart. 3-D percent bar charts are also available.

Line chart

A line chart displays one or more lines that each connects a series of points.
This type of chart is excellent for showing the value of a single variable as it
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changes over time or the values of several variables with comparable scales.
Figure 15-11 shows a line chart of calories consumed daily for the week start-

ing January 1, 2008.

Carb-Fat-ProteinPercentages
for First Week of 2008
E— " Eri
Figure 15-10: B
A 2'D M Sum of Food_ Carkh ™
percent bar
chart.
|
Calorie Consumption
for First Week of 2008
§ 1200
——— ¢ ®
Figure 15-11: e
Aline chart. T
T
Area chart

In an area chart, areas that are filled in with colors or patterns represent

the values of variables. This type of chart is good for showing the percentage
contribution of a small number of variables to a total. Figure 15-12 shows

an area chart displaying the same information as the bar charts earlier in

this chapter.
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Figure 15-12:
An area
chart.

|
Figure 15-13:

A pie chart.
|
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Pie chart

Pie charts are 2-D circular charts that display one series of data values,

where each value determines how large a sector of the pie that element of the
series receives. You might use a pie chart to show the relative contribution
each operating division makes to a corporation’s sales. Or you might use it to
look at food consumption. Figure 15-13, which is a pie chart that looks at only
the fat data for the first week of 2008, shows that fat consumption varied
quite a bit.

Fat Consumption
for First Week of 2008

11472008

Doughnut chart

A doughnut chart is similar to a pie chart, but the center of the pie is cut

out. In Crystal Reports, the hole is either a 2-D or 3-D ring that encircles a
number, which might or might not bear any relationship to what you're
trying to emphasize with your chart. The number is supposed to show

how many records are being represented; however, depending on your data,
that number might not relate to anything pertinent. Figure 15-14 shows a
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Figure 15-14:
A doughnut
chart.
|

|
Figure 15-15:
A 3-Driser
chart.
|

doughnut chart for the same data illustrated by the pie chart in Figure 15-13.
The doughnut’s colored sections are equivalent to the pieces of the pie. In
this case, the number in the center of the doughnut is unrelated to the
percentage of fat in a person’s meals.

Pie charts and doughnut charts are used for pretty much the same things.
Which one you choose to use is largely a matter of personal preference.

Fat Consumption

~f 2NNA
LUUG

3-D riser chart

A 3-D riser chart is a cool way to represent several series of data points.

If the number of series and the number of data points are both under about
ten, a 3-D riser chart can convey a lot of meaning — and look great, too.
Values are represented by 3-D pillars rising from a plane. Various shapes of
objects are available.

Figure 15-15 shows a 3-D riser chart. It uses octagon-shaped risers, which I
think are the best looking of the several available riser shapes. For some data
sets, however, one of the other shapes may be better. Try them all out to see
which one communicates your data best.

Carb-Fat-ProteinPercentages
for First Viaak of 2008

IrsiVess
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|
Figure 15-16:
A3-D
surface
chart.
|

3-D surface chart

A 3-D surface chart represents several series of data points with a multicolor
surface that sits over a plane. Several variants of the 3-D surface chart are
available. With a 3-D riser chart (see the preceding section), a 3-D surface
chart is most meaningful with fewer than ten series and ten data points
within each series.

Figure 15-16 is an example of a honeycomb, 3-D surface chart. It gives the
data a different look from that obtained with the 3-D riser chart.

Carb-Fat-Protein Percentages
for h/ls_w k of 2008

XV scatter chart

XY scatter charts are effective when you have a large number of data points
and you want to see (for example) whether any clusters show up in the
data — and, if so, how compact the clusters are. These graphs are also
good at showing whether two variables are correlated. If they are, you'll
be able to draw a line with a characteristic slope through the average
location of the points. The slope indicates the nature of the relationship.
The closeness of the points to the line indicates the strength of the
relationship.

This chart in Figure 15-17 plots carbohydrate consumption on the horizontal
axis against fat consumption on the vertical axis. The two are definitely
correlated because they fall close to a straight line. The variation from a
perfect linear relationship is caused by varying protein consumption

(not shown) from day to day. The legend to the right of the chart is not
legible. The XY scatter chart was apparently not designed for this many
data points.
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|
Figure 15-17:
An XY
scatter
chart.
|

|
Figure 15-18:
Aradar
chart.
|

January 2008 Carb/Fat Ratio

Carb %

Radar chart

A radar chart is a polar graph that looks somewhat like a radar screen or a
plot of an antenna’s radiation characteristics. Arrayed around the perimeter
are the changing values that generate the chart. The magnitudes of the one
or more series of data depicted by the chart are shown by how far they
extend from the center toward the perimeter. This type of chart is good for
showing how several quantities vary with respect to each other as time or
some other variable changes.

The chart in Figure 15-18 shows the same data as the XY scatter chart, but

in a very different form. In this chart, the outer jagged line shows the amount
of carbohydrate consumed on a daily basis, and the inner jagged line shows
the amount of fat.

January 2008 Carb/Fat Ratio

Bubble chart

A bubble chart is similar to an XY scatter chart, which illustrates the relation-
ship between two data series. In a bubble chart, though, the markers that
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|
Figure 15-19:
A bubble
chart.
|

indicate data points are circles that vary in size, depending on the value of a
third data series. The larger the value of a point in that third data series, the
bigger the circle. The value of one variable is plotted against the X axis; the
value of a second variable is plotted against the Y axis; and the value of a
third variable is indicated by the size of the bubble. Use this type of chart
when you have three series of data that vary with time or with some other
fourth variable.

The bubble chart in Figure 15-19, like the XY scatter chart, shows a definite
linear relationship between carbohydrate and fat. In addition, the bubble
chart explicitly shows the magnitude of the protein variable. Once again, the
legend to the right of the chart is unreadable. Bubble charts have many of
the characteristics of XY scatter charts.

January 2008 Carb/Fat Ratio

Far %

o

Carb %

Stock chart

A stock chart is familiar to anyone who reads the financial section of a news-
paper. It’s used to show the daily price ranges of stocks and of indexes, such
as the Dow Jones Industrial Average. For a given date, a line indicates the
range of the variable, extending from the variable’s lowest to highest values
for that day. Crystal Reports gives you a similar chart; you can create it with
or without the little tick marks that identify the opening and closing prices.
To include the opening and closing tick marks, you need to have four
columns of data: Open, High, Low, and Close.

This type of chart is good for showing the differences between two variables.

Figure 15-20 shows a stock chart.
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Figure 15-20:
A stock
chart.
|

Figure 15-21:
Chart
Expert,
showing the
six numeric
axis chart
types.
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Numeric axis chart

Numeric axis charts come in six types, as shown in Figure 15-21. They are
the numeric axis bar, line, and area charts; and the date axis bar, line, and
area charts.

These charts are similar to the ordinary bar, line, and area charts except that
their X axis must be a numeric or date type. The ordinary, bar, line, and area
charts are more flexible, but the numeric axis charts may be somewhat sim-
pler to create, assuming that you want the horizontal axis to represent either
numbers or dates.

Figure 15-22 is a numerical axis chart, showing one month of data on the
composition of a person’s food intake.
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January 2008 Carb/Fat Ratio

Gauge chart

A gauge chart displays a graphic that looks like an automobile speedometer
gauge, with a rotating hand indicating the value of the reported quantity. This
type of chart is appropriate only when you have a small number of values to
display. If you have too many, the gauges get stacked one atop the other in a
jumbled mess.

Figure 15-23 shows a gauge chart of a person’s food intake for January 19,
2008.

Showing GrandTotals

Figure 15-23:
Gauge chart
showing
protein,
carb, and fat
intake.
|

Gantt chart

Project managers often use Gantt charts to track progress. Figure 15-24, for
example, shows five weeks of data on how quickly Xtreme Mountain Bikes,
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Figure 15-24:
Gantt chart
showing
order
turnaround
for a five-
week
period.
|

Figure 15-25:
A funnel
chart of
carbo-
hydrate

con-
sumption.
|

Inc. ships its products. Each bar represents the interval of time between the
entry of an order and when that order was shipped. As you can see, some
orders are shipped promptly while others are not. Management can examine
which orders were shipped after an excessive delay, and possibly make
changes to enable the faster shipment of such orders.

Shipment Times

Funnel chart

A funnel chart, usually used in customer relationship management (CRM)
applications, shows how one series of data points varies over a period of
time. Figure 15-25 shows a week of carbohydrate consumption. This type of
chart is not particularly applicable to nutrition data, but this example does
show what a funnel chart looks like.

Carbohydrates Consumed by Date

for First Week of 2008
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|
Figure 15-26:
A histogram
of fat con-
sumption.
|

Histogram

A histogram divides data up into intervals called “buckets” and displays the
relative amounts of whatever is being measured that falls within each inter-
val. Figure 15-26 shows a histogram that displays how much fat a dieter con-
sumed during the first week of 2008. Histograms differ from bar charts in that
each bar in a histogram represents a range of values, while each bar in a bar
chart represents a single discrete value.

Fat as Percentage of Diet

for First Week of 2008

SLhe Fat %

Different Chart Layouts for
Different Data Types

Crystal Reports deals with data sets of four different types. The most basic is
data retrieved from the database and sent more or less directly to the Details
section of the report. No grouping or summarizing is involved. The Advanced
chart layout deals with this kind of data; using it, you can filter the data with
one or two conditions. You can also group values in several different orders,
plot a value for each data record, plot a grand total for all records, and base
charts on formulas or running-total fields.

The Group layout provides a higher-level overview than an Advanced layout
can. It displays summary information when the value of a specified field
changes. Logically enough, you can use the Group layout with only those
reports that have at least one group — and at least one summary field for
that group.

Figure 15-27 shows a cross-tab report of glove inventory for Xtreme Mountain
Bikes, Inc.

The OLAP layout is the structure of a chart based on an OLAP cube. Figure
15-28 shows an example of a chart derived from an OLAP cube. (You can read
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Figure 15-27:
The upper-
left corner

of an
Xtreme
cross-tab
report.
|

Figure 15-28:
An OLAP,
3-Driser

chart
breaking
down
California
sales by
Customer
and

Product.
|

about using OLAP and OLAP cubes in Chapter 13.) It shows how Xtreme’s hel-
mets are selling in California. Clearly, Bike Shop from Mars is selling more
Triumph Pro helmets than the other dealers. The Triumph Vertigo helmet is
selling well at Off the Mountain Biking and Sporting Wheels, Inc.
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Seeing How Chart Placement Affects
the Data It Represents

As you can read earlier in this book, a report has multiple sections: a Report
Header; a Page Header; zero or more Group Header sections; Details sections;
and Report, Page, and Group Footer sections. Charts can appear in the
Report Header and Footer or in a Group Header and Footer.

A chart in the Report Header or Report Footer section draws its data from
the entire report. A chart in a Group Header section draws its data from only
that group.

With a chart in the Report Header or Report Footer, you can graphically
convey the main point of the report. With charts in either a Group Header or
a Group Footer, you can show a chart that displays the important information
specific to each group.

Figure 15-29 shows a Report Header chart located above data for one of
Xtreme Mountain Bikes, Inc.’s customers in California. It shows the values of
the sales that Xtreme’s various salespeople have made to this customer.
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Troubleshooting Chart Problems

|
Figure 15-30:
The chart

is getting
busier.
|

Sometimes the chart you're creating for a report just doesn’t turn out the
way you expect. This is less likely to happen as you gain experience with
Crystal Reports, but in the beginning, it might occur frequently. Some prob-
lems result from a beginner’s unfamiliarity with the powerful Crystal Reports
features. It’s also possible to envision a report that simply isn’t possible to
create, regardless of the power of your report writer. Other problems occur
if you try to squeeze too much information into too small of a space.

Selecting data to make a chart
readable and meaningful

Earlier in this chapter, | show you how to create a chart that displays cumula-
tive sales orders for all the states and districts in Mexico where Xtreme
Mountain Bikes, Inc. has customers. Suppose you want to create a similar
chart for the United States. The report would be essentially the same, but
with a different selection condition. That is, Customer.Country is equal to
USA instead of Mexico. However, if you build the same report in the same
way, but this time for the USA rather than Mexico, you might get something
like Figure 15-30. I changed the selection condition to USA, but did not yet
change the subtitle from Mexico.
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Figure 15-31:
Customer
Order chart
for USA with
moved
legend.
|

If you had sales in all 50 states plus the District of Columbia, you’d have too
many states to make a good pie chart. The result would not communicate
very well (tiny slices, hard to see, that sort of thing). However, if you display
only the states with the ten largest sales volumes, you get a reasonable chart.

The placement of chart elements matters

When you created the chart for Mexico, I had you keep the default legend
placement (on the right side of the page). If you select a bottom placement,
however, your chart looks quite different, as shown in Figure 15-31.

The legend at the bottom is so tall that it covers the entire chart. If you

ever encounter bizarre behavior such as this, check whether one element of
the chart is hogging the area that rightfully belongs to another element. If it
is, you can usually find a way to rearrange things so that everything is
displayed.
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Chapter 16

Adding Geographic
Detail with Maps

In This Chapter
Discovering different map layouts and map types
Creating group, cross-tab, and OLAP layout maps
Troubleshooting maps problems

M any reports contain geographic information, which is easier to com-
prehend when you add maps that show how the information relates to
relevant geographic locations. For example, the Xtreme database (the sample
database used throughout this book) contains information on customers
located in various cities, regions, and countries around the world. A sales
manager might want to know which localities have a concentration or lack of
customers, or a high or low sales volume.

All the reasons why charts are a valuable addition to a report apply to maps
as well. For data that has a geographical connection, maps are even more
valuable. If you can identify a fact (such as a sales total) with a particular city,
state, or country, you lock that fact into the reader’s mind much more
securely than you would if you displayed only a table of numbers.

Crystal Reports has a built-in feature for adding maps to reports, with several
different layouts and map types. The various choices enable you to create a
map that does the best job of communicating important parts of your report.

Choosing the Right Crystal Reports Map

Before you can create a map with Crystal Reports, you must have a data
source with one or more geographical fields (such as City, Region, or
Country). Depending on the specific data you have (and on how you want
to display it geographically), you can choose the kind of map most likely to
have the biggest effect on readers. You can choose both the map layout and
the type of map.
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Map layouts

Four map layouts are available: Group, Cross-Tab, OLAP, and Advanced. Each
layout is designed for a specific kind of report, as follows:

v Group layout is usually best when your report has groups, and you
want to associate a map with each group. Chapter 6 covers how to
create groups in your report.

v Cross-Tab layout is designed to be a part of a cross-tab report. I cover
cross-tab reports in Chapter 14.

v OLAP layout is designed for use with a report containing an OLAP grid.
Chapter 13 discusses OLAP reports.

v Advanced layout is for any map that doesn’t fall into the other three cat-
egories. It works well for reports that don’t have groups or summaries,
as well as reports that do.

Map types

In addition to the four map layouts, you can choose one of five map types.

If the data you're reporting has a geographic component, one of these map
types is probably the best way to show the geographical relationships of the
data. The major value of Crystal Reports maps is that they associate some
numerical quantity (such as a sales total) with a geographic location in a
memorable visual impression that is more likely to be retained.

Ranged type

For numerical quantities that can take on an almost infinite variety of values
(such as sales totals), it’s helpful to aggregate records with similar values
into bins — digital storage areas for related records. Each one holds the
records for a range of values: a subset of the total range of values. By assign-
ing each bin a different color, shade of gray, or other indicator of magnitude,
you can associate geographical regions on a ranged map with specific quanti-
ties, making comparisons easy. You can establish bin size in four ways:

v Equal count: With an equal count ranged map, the same number of
regions (or as close to the same number as possible) appears in each
bin. For example, if the regions are the 50 states of the United States
and 10 different bins show ranges of sales volume, each of 10 different
shades of gray can be applied to 5 states. The five states with the
highest level of sales would perhaps be shown as white, and the five
states with the lowest level of sales would be shown as black, with
progressively darker shades of gray in between, moving from high
sales volume to low.
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This map type is best to use when values are unevenly distributed
among the regions. It prevents a situation in which most regions are the
same color, with only one or a few that fall into different bins and thus
have different colors.

v Equal range: This map type has bins of equal size (or as close to equal
as possible), regardless of how many records fall into each bin. Equal
range maps are most useful when the distribution of values being dis-
played is fairly uniform, with approximately equal numbers of records
in each bin.

v Natural break: This map type applies only to reports that contain sum-
mary values. It assigns separate clusters in the data into separate bins.

v~ Standard deviation: This map type is used to show statistical analysis.
It is best used with three bins: no more, no fewer. The middle bin shows
regions associated with values within one standard deviation of the mean
of the entire data set. The bins above and below hold the regions that
are more than one standard deviation removed from the mean.

Dot density type

The dot density type of map is a good tool to use for giving the reader a
general idea of where concentrations of records are located and the overall
distribution of records. One dot is placed on the map for each record. A com-
pany might use this type of map to show the locations of their dealerships.
The map would make obvious which regions are adequately covered and
which are not — but wouldn’t be good at conveying quantitative information.

Graduated type

The graduated type of map is similar to the ranged type, putting a symbol

in the middle of each region (instead of giving an entire region a specific
color or shade of gray) to represent the numerical value associated with that
region. The size of the symbol corresponds to the magnitude of the associ-
ated value. The default symbol is a circle, but you can use a different symbol
if you want.

Pie chart type

The pie chart type of map associates a pie chart with each geographic area
being displayed. It’s useful only when you’'re comparing the values of several
related items in a geographic region. For example, if you want to know the
relative sales levels of Xtreme’s five major product categories in each region,
a pie chart associated with each region on the map would give you a visual
picture of that comparison.

Pie charts make sense only if the values of all segments of the pie add up to
100 percent of the total.



286 Part lll: Advanced Report Types and Features

Bar chart type

As with pie charts, bar charts associated with maps are useful only when
you're comparing the values of several related items in a geographical region.
Unlike pie charts, bar charts don’t require that the total of all values repre-
sented by the bars add up to 100 percent. You can use bar charts to show, for
instance, the relative sales of bicycles and helmets for the regions of interest,
ignoring the other products that Xtreme sells.

Map placement

Where you place a map on a report depends on the information you want it
to display. If the map uses data taken from the entire report, you want to
place it in the Report Header or Report Footer section so it can access the
needed data. If you want to associate a map with a specific group in the
report, place the map in the Group Header or Group Footer for that group.
You can also place a map in a subreport of your main report. (See Chapter 11
for information on subreports.)

Creating a Map Step by Step

To create a map, start with a report that has the kind of data best illustrated
by a map. This means the report should have at least one geographical field,
such as city, state, or country. It also should have at least one numerical field,
the value of which varies from one geographical location to another. Certain
kinds of maps, such as the pie chart and bar chart types, have additional
constraints, as noted previously.

Creating an advanced layout map

This section uses the Advanced layout to add a map to a report:

1. Load the Customer Orders, by State or District (Mexico) report.

See how to create this report in Chapter 8.

‘__" 2. On the Insert Tools toolbar, click the Insert Map icon.

The Data tab of Map Expert appears.

3. In the Placement area, select Once Per Report for the Place Map
pull-down list, and then select the Footer option.

This places the map in the Report Footer.
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layout
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4. In the Layout area, click the Advanced icon.

The display of the Data area changes, as shown in Figure 16-1.
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5. Drag Customer.Region from the Available Fields pane to the
Geographic Field text box.

The Customer.Region field automatically appears in the On Change Of
text box, also.

6. Drag Report Area:Sum of Orders.Order Amount from the Available
Fields pane to the Map Values pane.

7. Click the Type tab.

The default type shows as Ranged, which is what you want, so keep it.
The other defaults are good, too, so leave these setting as they are:

e Number of Intervals: 5
e Distribution Method: Equal count
e Color of Highest Interval: White
¢ Color of Lowest Interval: Black
8. Verify that the Allow Empty Intervals option is checked.
9. Click the Text tab.
10. Type a map title and legend titles, if appropriate, and then click OK.

Map Expert generates your map, as shown in Figure 16-2.
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The five states or districts appear in five shades of gray as you specified.
The top-producing Distrito Federal is white — and a little difficult to see
because it encompasses only Mexico City. The state of Guerrero is black
because it has the lowest order total. The three other states that have
Xtreme customers have three different shades of gray.

You can make various alternate choices — different types, different fields, dif-
ferent options — but the procedure for any of the Advanced layout reports is
essentially the same. The procedure for the other layouts is a little different.

Creating a Group layout map

To create a map with a Group layout, your report must have at least one
group and at least one summary field for that group. To illustrate this, you
can use the Customer Orders, Grouped by State or District (USA) report
created for the United States in Chapter 6. The Mexico report doesn’t have
enough states to show grouping.

To create a Group layout map, do the following:

1. Click the Insert Map icon.
2. Make sure that the Data tab of Map Expert is displayed.
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Figure 16-3:
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3. In the Placement area, specify a placement of Once Per Report, in the
footer.

4. Confirm that in the Layout area, Group is selected.

5. In the Data area, retain the Customer.Region option in the On Change
Of pull-down list, and the Show: Percentage of Sum of Orders.Order
Amount option.

6. Switch to the Type tab and verify that Ranged is selected, the Number
of Intervals is 5, and the Distribution Method is Equal Count.

Also, leave Color of Highest Interval as White, and Color of Lowest
Interval as Black. Leave the Allow Empty Intervals check box marked.

7. Click OK.

The map shown in Figure 16-3 appears in the Report Footer. As the map
shows, several states (including Pennsylvania, California, and Idaho) are
doing substantial business. However, Maine, Mississippi, and Georgia
(among others) are doing relatively little.
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Creating a Cross-Tab layout map

To create a Cross-Tab layout, your report must have a cross-tab summary
field, and the rows or the columns must contain a geographical field. In
Chapter 14, I show you how to build a report that shows Xtreme’s sales from
several provinces of Canada (Sales by Province). You can use that report as
the base for a Cross-Tab layout map.
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To create a map showing the relative sales figures for Canadian provinces
that contain Xtreme customers, do the following:

i 1. Click the Insert Map icon, or choose Insert->Map.

The Data tab of Map Expert appears.

2. In the Placement area, select the Footer radio button.

w

. Click the Cross-Tab icon to change the Data area to the Cross-Tab
function.

. In the Data area, for the Geographic Field, select Customer.Region.
. Verify that Map Values pane contains Sum of Orders.Order Amount.

. Click the Type tab, and verify that the Ranged type is selected.

IS S BN

. Adjust the options the way you want them, and then click OK.

I chose white to be the color of the highest interval and black to be the
color of the lowest, with five intervals, because Xtreme has dealers on
only five provinces. Crystal Reports draws your map, which should look
something like Figure 16-4. British Columbia is white, indicating it has
the highest order volume. Manitoba is black because it had the smallest
order totals. The other regions are in shades of gray.
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Creating an OLAP layout map

The procedure for creating a map with an OLAP layout is similar to the proce-
dure with a Cross-Tab layout. The main difference is that the report must con-
tain an OLAP grid rather than a cross-tab object. One of the dimensions of
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the grid must be a geographical field. Chapter 13 describes creating a report
with an OLAP grid. However, it doesn’t have a geographical dimension, so a
map with an OLAP layout would make no sense in that report.

To add a map to OLAP grid that does have a geographical dimension, follow
these steps:

‘__‘ 1. With any report that has an OLAP grid with a geographical dimen-
sion, click the Insert Map icon (on the Insert Tools toolbar).

Map Expert appears.
2. In the Placement area, select either Header or Footer.
3. In the Layout area, click the OLAP icon if it’s not already selected.

4. In the Data area, select a geographical field in the On Change Of
pull-down list.

5. If you're adding a pie chart or bar chart to the map, select a field in
the Subdivided By pull-down list. For a ranged map, leave this option
at None.

6. For a simple map, leave the Other Dimensions option alone.
7. Click OK.

Crystal Reports draws the map you specified, basing it on the
information in the OLAP grid.

Including maps in subreports

You can include maps in subreports. The procedure for including a map in a
subreport is the same as that for a report except that the subreport Design
tab must be active.

Changing maps

After you add a map to a report, it’s not cast in concrete. You can change it
easily. Just right-click the map and choose Map Expert. Now you have the
same control over the map as you had when you first created it.

Troubleshooting Map Problems

If you create a map and it doesn’t look the way you expect it to, make sure
that the Preview tab is active. If the Design tab is active, Crystal Reports
displays a generic placeholder map in the location where the actual map
is located.
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If you create a map and all you see is a blank rectangle, make sure you based
the map on a geographical field. If you based it on a non-geographical field,
Crystal Reports displays a non-geographical map — in effect, nothing.

If you create a map of the Ranged type and you don’t get the spectrum of
colors or shades of gray that you expected, check to make sure that the
distribution method you chose is appropriate for the data you're
illustrating.



Chapter 17
Interactivity Features

In This Chapter

Performing What-If analyses with Crystal Xcelsius

Embedding an Adobe Flash animation within a report

Setting parameters with the Parameter panel

C’ystal Reports 2008 makes a major leap forward in interactivity. To an
extent never before possible, users can interact with Crystal Reports,
using new dynamic capabilities. These new capabilities aren’t provided by
Crystal Reports alone, but rather are the result of Crystal Reports collaborat-
ing with other software programs. One of these programs, Crystal Xcelsius,
is a Business Objects product, but others come from Adobe and Microsoft.

Crystal Xcelsius Overview

Crystal Xcelsius is a data-visualization design tool that serves as a decision
support tool, providing users with a visually rich presentation, enabling them
to interact with and more easily analyze their data. The result can be better
business decisions, arrived at more quickly. Figure 17-1 shows an example of
a Crystal Xcelsius visualization, which is also sometimes called a dashboard
presentation.

What you see in Figure 17-1 is only part of the story because it’s but a snap-
shot of a dynamic visualization. When you move the sliders at the lower left
of the display, the bars on the bar chart change in length, the pie segments
in the pie chart change in relative size, and the needle on the gauge changes
position, as does the number displayed within the gauge. With these con-
trols, a person can easily create What-If scenarios. Say, the growth rate of
laptops were to double. By moving the Laptops slider, you can see what the
overall result on product mix and revenue would be.



294 Part lll: Advanced Report Types and Features

Computer Power Sales Projection - Crystal Xcelsius Designer 4.5 SO
Flle Fdit Dama View Format Tools Help
Oz & L= R EE e E | e EEERE

Computer Power Sales Projections: 2008

Computer Power Computer Power

W Desktops
A Laptops
} M Servers
W PDAs

— v W Software

D v s Product Line Growth Rate
Laptops  r{———— 7
— SEQGETE (e iireTe=p—m— &
Figure 17-1: Ehas 1 T '. ;
Example & 10 \
Crystal $4,353
Xcelsius Product Line Growth Rate
visualization. | Profected Sales
] oLl el [ Objeci Bro &) &3 ode Import Cone

Crystal Xcelsius uses Microsoft Excel as a data source and data modeling
tool, and Macromedia Flash Player as a rendering engine. Programmers
using Crystal Xcelsius Designer can use the combination of products to
compile dynamic visualizations that can then be added to a Crystal report.

Adding Xcelsius Capability to a Report

Although Crystal Xcelsius is a separate product from Crystal Reports 2008, it
can add impressive visualizations to a Crystal report. To use Crystal Xcelsius,
data from a report’s data source must be copied to an Excel spreadsheet file.
Xcelsius takes data from the spreadsheet file and creates a Flash visualization
of the data in the form of a Flash SWF file. You can either embed the Flash file
in your report or link to it.

Placing an Xcelsius visualization in a Crystal Report is a multi-step process.
The steps are

1. Copy the data you want to display from your data source to an Excel
spreadsheet.

Of course, if your data source is an Excel spreadsheet, you can skip
this step.
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Use Crystal Xcelsius to create a visualization model and then save it to
a Flash SWF file.

Set up the Crystal Xcelsius model to receive real-time data from Crystal
Reports.

This enables the model to respond the operations on controls, such as
slider controls, by the report user.

. Embed the Crystal Xcelsius model within a Crystal report, or alterna-
tively create a link to it.

Assuming that you already performed Step 1 and that your data resides in an
Excel XLS file, Figure 17-2 shows the spreadsheet that serves as the basis for
the Xcelsius visualization shown in Figure 17-1.
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Creating an SWF file with Crystal Xcelsius

The next step is to create a visualization model with Crystal Xcelsius. Crystal
Xcelsius is a separate product from Crystal Reports, and I don’t have space in
this book to cover that process. For complete details, read through Crystal
Xcelsius For Dummies, by Michael Alexander (Wiley). Figure 17-3 shows the
user interface of Crystal Xcelsius Designer 4.5.

After your Crystal Xcelsius visualization exists as a Flash file, you must set it
up to receive input from the Crystal report it’s embedded within. This opera-
tion is also performed by Crystal Xcelsius. The steps are fairly straightfor-
ward and also necessary for Crystal Reports to deliver the interactivity that
Xcelsius makes available.
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1. From the Crystal Xcelsius menu, choose File->Export Settings.
The Export Settings dialog box, shown in Figure 17-4, opens.

2. Select the Use Flash Variables radio button.

3. Select CSV format.

CSV stands for comma-separated values. CSV files are just about the
simplest data files in existence. They consist of a string of values,
separated by commas.

4. Click the Define Variables button.

The Replace Data Selection dialog box, shown in Figure 17-5, opens.
5. Click Add.
6. In the Name text box, replace Range( with Values.

7. Click the select range icon (to the right of the Variable Selection text
box) to display the source data spreadsheet.

The Select a Range dialog box opens.
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8. Select the range B5 to F5 in the Select a Range dialog box, as shown
in Figure 17-6, and then click OK.

You return to the Replace Data Selection dialog box.

9. Click OK to return to the Export Settings dialog box.
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10. Click OK in the Export Settings dialog box.

11.

From the main menu, choose Filec>Export>Macromedia Flash (SWF).

12. In the Export Macromedia Flash (SWF) dialog box that appears,

specify a location and filename, and then click Save.

Embedding your Crystal Xcelsius
model in a Crystal report

After you create an Xcelsius model, you can insert it into a Crystal report.
Here’s a step-by-step process for doing that:

1.

Start Crystal Reports 2008; under Start a New Report, click Blank
Report.

. In Database Expert, connect to your spreadsheet model (if you’re not
already connected to it) and select the sheet that contains your data.

. With Formula Workshop, click the New icon; from the menu that

appears, choose Formula.

. In the small Formula Name dialog box that pops up, enter

BuildValuesString and then click OK.

. Enter the following formula into Formula Editor:

global stringvar ValuesString;
* %

if
(ValuesString = "") then
ValuesString := Cstr({Sheetl_.Projected Sales})
else
ValuesString := ValuesString + "," +
Cstr({Sheetl_.Projected Sales});
ValuesString;

6. Click Save and Close to exit Formula Workshop.

7. From the main menu, choose Insert->Flash.

8. From the Insert Flash Object dialog box that appears, do the

following:

a. Browse for and select the SWF object you exported from Crystal
Xcelsius.
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b. Make sure the Embed radio button is selected.
c. Click OK.

9. Locate the placement rectangle in the Report Footer and click the left
mouse button to place it there.

10. Click the Flash object on the report to highlight it, right-click it, and
choose Flash Data Expert from the menu that appears.

11. In the Flash Data Binding Expert section, click the button with the
plus (+) sign.

12. Type Values for the variable name, and then click within the Value
field to the right of it.

13. To pass the value into the Values Flash variable, click the drop-down
button on the text box and select an existing field object to pass to
the Flash variable.

In this case, select the BuildValuesString formula.
14. Click OK to exit the Flash Data Binding Expert.

You can now switch to Print Preview mode and move the slider controls.
As you do, the bars on the bar chart move, the pie segments in the pie
chart change proportions, and the needle in the gauge moves to reflect the
changing values of the product line growth rates. Figure 17-7 shows the
Flash object embedded in the report, after the slider controls have

been moved.

file Edit View Insert format Database Report Window |lelp
R M DL & Dl o-o- AR 0
B L U|E A - -t BB D
dBE QLS OB Wsg i -} L1 - | &) S i | I T lofl
Start Page  Report?
Deskgn | Preview

RF

Computer Power Sales Projections: 2008

Computer Power Computer Power

—HNeé

DKo s, 34 Product Line Growth Rate
Laplaps s 31
Serven ———————F+——— 11

ol
R T ¥
Sottware sr————————f W
$5,540

Product Line Growth Rate

W Ceskrops
Laplops

Promcied Sales

——

.H:r Help, press F1 Rmon:ls:. 10 J-J ‘_-‘JI]_ m«- . iil = .'. j. -_l-;j ::_

Chapter 17: Interactivity Features 2 9 9



300 Part lll: Advanced Report Types and Features

Enhancing a Report with the
Tasteful Use of Flash
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Xcelsius Flash visualizations provide an interactive experience that is directly
related to the data being conveyed by a Crystal report. This is probably the
most powerful use of Flash in a report. In addition, you can include other
Flash objects in your reports, regardless of their origin. Although not bound
to the data in the report, they may nonetheless enhance the report’s appear-
ance. For example, you could include an animated logo in a report. You could
even include an animated movie that illustrates a process or operation.

Viewing Flash visualizations

In order to view a Flash object in a Crystal Report, you must have a viewer
that supports Flash functionality. Of course, Crystal Reports 2008 itself sup-
ports that functionality, as do .NET Winform, .NET Webform, and Java DHTML
viewers.

The free, downloadable Crystal Reports Viewer XI does not support Flash.
However, Crystal Reports Viewer 2008 might support Flash functionality by
the time you read this book.

Dynamic interaction with a report
using a Parameter panel

You can add a parameter to a report and issue a prompt to the user to enter a
value for the parameter, via the Parameter panel. The following steps create a
parameter that appears on the Parameter panel:

1. Open the Customer Orders by State or District (Mexico) with Map
report.
2. From Field Explorer, select Parameter Fields, and then right-click it.
3. From the contextual menu that opens, choose New.
The Create New Parameter dialog box shown in Figure 17-8 is displayed.
4. Enter a name for your parameter in the Name field.
[ use Order Lower Limit.
5. Choose the appropriate data type from the Type field.

I selected Currency from the drop-down list.
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10.

11.

12.

13.

. From the Value Field drop-down list, select a value.

I selected Order Amount.

. From the Description Field drop-down list, select a value.

I selected Customer ID.

. Click the Actions drop-down indicator and select Append All Database

Values.

All the applicable values are moved to the Values area. This operation
can take significant time for a large table.

. In the Value Options area, make sure that the Show on (Viewer) Panel

setting is set to Editable, that Allow multiple values is set to True, and
that Min Value is set to 500.

These settings will establish a lower limit of $500 for Order Amount.
Click OK.

The Order Lower Limit parameter field now appears in Field Explorer.
Drag your parameter field onto the report.

I dragged mine into report footer RFc. If you don’t want it to appear on
the report, you could also drag it into a section that is suppressed.

Switch to Preview mode.

The Enter Values dialog box opens. The prompt says Please Specify a
Currency Value Greater Than or Equal to 500.

Click the double right-arrow to place all qualifying values into the
Selected Values pane, as shown in Figure 17-9.

This dialog box enables you to select specific values out of all the values
that satisfy the condition of being equal to or greater than 500. I chose to
select them all.
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All the qualifying values appear in the Parameter panel at the left of the

window, as shown in Figure 17-10.

-+ Cryatal Rnparts - [Custampr Ordors by Stawtn or District (Mesieo] with Map] o=
Hle Edit View jnsert Format Database EReport Window Help
DE&-AS DS |k b R I st | [ a7 Y L A,
%| -| A | 8T 3 A i
ERPTI 0 N g B N - % O - ) 08| Wil 7Skl 4 4 1ol 1+ [
Start Page  Customer Orders by State or District (Mexico) with Map =
Design | Preview =
Parameters Tiempo Libes A capulco s152970 L-]
02 $1.528.70
Entar Orderl %
502.05-4 Quintana Hoo
Biciciotas do Montafia Cancr §2,204 55
50335-2
500.65-65 §2.294.55
5128517 Sinaloa
5156722 Guadalaara en ruedas §2,37219
Ll $2.37218
52035-71
521 26-51
52475-74
-E_} Groups
! Parameters
4 Fnd
-
>
L For telp, press 1 1172008 2:25PM L a0 e U Pl



Part IV

Crystal Reports in
the Enterprise

The 5th Wave By Rich Tennant
ORIGTENNANT

N\ R i
IZ(%,, ,

//,’ i Q’l‘/’r‘”

|

“Well, T got in touch with the Enterprize like you said, and
some Kirk guy asked me toKeep an ege on this for him.”

77




In this part . . .

Besides being a great standalone report writer, Crystal
Reports is an integral part of an enterprise-spanning
data retrieval, analysis, documentation, and publishing
system. In this part, [ show you how Crystal Reports fits
into the bigger picture of effective communication in a
large organization.




Chapter 18
Crystal Reports Server

In This Chapter

Understanding Crystal Reports Server architecture

Data connectivity for Crystal Reports Server

Using the Repository

Exploring Crystal Reports Server platform services

Using Crystal Reports Server web and application services

Finding report viewers

Crystal Reports Server Xl isn’t a single product but rather a collection
of tools that work together to provide reporting services to meet the
needs of small-to-medium-sized businesses. It covers the gamut from data
access through report design to report management and delivery, as well
as integrating with web portals and enterprise applications.

The components of the Crystal Reports Server XI system include

v Data access services

v Crystal Reports XI

v Report publishing, security, and processing services

v Management tools

v Application services for integration with applications

v Web services for integration with portals

v A simplified user interaction tier
In this chapter, I give an overview of Crystal Reports Server XI, for the sake
of completeness, even though it doesn’t include Crystal Reports 2008 and
indeed doesn’t run in conjunction with Crystal Reports 2008. If you work for a
small to medium-sized business that has between five and twenty users on

your local area network, you might have to deal with Crystal Reports Server,
either the current XI version or the 2008 version when it appears.
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How does Crystal Reports Server fit in?

Crystal Reports Server Xl is not a part of Crystal
Reports 2008. It is not even a part of the prede-
cessor of Crystal Reports 2008, named Crystal
Reports XI. Crystal Reports Server Xl is a sepa-
rate product, which includes Crystal Reports XI
as a subset.

Crystal Reports 2008 and Crystal Reports Xl are
standalone products designed to run on a single

class business intelligence (Bl) platform, which
includes Crystal Reports functionality, and
runs on large networks. Between those two
extremes is Crystal Reports Server XI, which
runs on small networks, supporting from 5-20
simultaneous users. As of this writing, there is no
Crystal Reports Server 2008, although one is
undoubtedly in the works.

computer. Business Objects Xl is an enterprise

Connecting to Data Sources

A report can draw from a number of different types of data sources. A single
report might require data from multiple sources, which might be of different
types. And different data sources might well require different ways of con-
necting to them. Crystal Reports Server XI offers all the most widely used
connection options.

Connecting directly or indirectly

The simplest and most efficient way to connect to a data source is via direct
connection, using a native driver specifically designed to connect to that par-
ticular type of data source. Crystal Reports Server Xl includes more than 35
of the most popular native drivers for relational, XML, OLAP, and in-memory
data. In addition, ODBC, OLE DB, and JDBC indirect connection mechanisms
are also supported. That means that you can pull data from just about any
data source that you're likely to encounter for use in a Crystal report.

Using Business Views to
simplify connectivity

Business Views are features of Crystal Reports Server XI that enable you to
create a simple interface for non-technical users. When combined with the
security features of Crystal Reports Server, a single report you create can
deliver appropriate content to users at several different privilege levels. Each
of the reports would contain only data that’s appropriate for the particular
user to whom it is displayed.
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Formatting Reports with Crystal
Reports Developer

Crystal Reports Server XI contains the Developer Edition of Crystal Reports
XI. You want to use this rather than Crystal Reports 2008 when creating any
reports that will be distributed via Crystal Reports Server XI. The report files
created by Crystal Reports 2008 contain elements that are not recognized by
Crystal Reports XI, and you will be warned to this effect whenever you try to
open a report in Crystal Reports XI that was created with Crystal Reports
2008. In all likelihood, the report will still be readable by Crystal Reports XI
Server, but some features might not operate as advertised.

Also present in Crystal Reports Server Xl is the Crystal Reports Server
Repository. The Repository is a central location where you can store report
elements, and they will be available for use in any of the reports created in
the Crystal Reports Server environment.

Providing Platform Services

Crystal Reports Server XI provides platform services similar to those pro-
vided by BusinessObjects Enterprise on larger systems. These services
include data processing, document processing, and end-user interactivity.
Crystal Reports Server Xl includes a communication framework that handles
the movement of information between platform services and the software
development kits available for Java, .NET, COM, and web services.

Platform services enable users to view and interact with reports, and partici-
pate in discussion threads with other users. All users have access to a
common schedule, and reports can be distributed based on events, business
calendars, or specified intervals.

Publishing and distributing reports

Crystal Reports Server XI includes a Publishing Wizard that you can use to
upload Crystal reports to the web. In addition to uploading reports, the
wizard also gives you the means to configure report processing schedules,
security, parameters, and database logons. By establishing privileges, you
can decide who can publish reports and then what the publication destina-
tions can be.
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If you have reports that were created with an earlier version of Crystal
Reports, use the Publishing Wizard to convert them to Crystal Reports XI
format, enabling you to use the full power of Crystal Reports XI Designer
to update them.

With the scheduler, you can schedule reports for automatic distribution to
FTP servers, e-mail distribution lists, printers, or file servers. You can even
simultaneously send different versions of the same report to different
recipients, based on different security settings.

Providing security

With Crystal Reports Server XI, you can manage which folders and report
objects are available to individual users or defined groups of users. You can
use a third-party entitlement database (such as LDAP, Kerberos, or Windows
NT/Active Directory) or the integrated Crystal Reports Server security
system. You can even use a combination, authenticating some users with
one entitlement database and other users with another.

Managing the system

The central management server (CMS) maintains a database that includes
information on users and groups, security levels, and reports. With the CMS,
you can enforce access rights and the types of tasks users can perform. The
CMS also manages the Repository database.

Crystal Reports Server XI stores reports, report instances, and discussion
threads in a repository database. This database is virtual, containing point-
ers, rather than duplicate copies of the items it holds. This provides faster
access to the stored information.

The report job server schedules the publication of reports, as well as the
format in which the reports will be delivered, and the destinations to which
they will be sent.

The page server serves up individual pages upon request. This page-on-
demand capability saves you from retrieving an entire report, when the
information you seek is all contained on a single page. Network traffic is
greatly reduced.

The cache server minimizes the delays inherent in database hits by
fulfilling page requests from cache rather than the database, whenever a
needed page is present in cache. This happens frequently when a page is
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accessed repeatedly. Active data sharing improves performance even
more, when different applications use the same pages. Those pages are
more likely to be in cache and thus quickly retrievable, because they
are more frequently accessed.

Useful Management Tools

Considering all the capability that Crystal Reports Server XI gives you, con-
trolling all that power could be a daunting task. Thankfully, a couple of tools
are provided to make that control a lot easier. Those tools are the central
management console (CMC) and the central configuration manager (CCM).

The CMCis a .NET or Java web-based environment for centralized system
management, deployment, and configuration. With it you can set up user
roles, security access, server administration, password management, and
other administrative tasks. With the CCM, you can view and configure
advanced server settings. You can also start, stop, enable, and disable
servers. With the CMC and CCM, server managers can keep on top of a
dynamic environment with a minimum of stress.

Application Services

The services oriented-architecture of Crystal Reports Server XI gives applica-
tion developers the tools needed to create and manage multiuser applica-
tions. The reporting services are implemented through a set of software
development kits (SDKs). With these SDKs, you can build end-user interfaces,
and control the handling of application content and its delivery.

Crystal Reports Server Xl is tightly integrated with Java and Microsoft-based
platforms, using native J2EE, .NET, and web services SDKs. You can install
your applications on the most popular application platforms, including BEA
WebLogic, IBM WebSphere, Apache, Oracle 10g Application Server, Sun ONE
application server, and Microsoft IIS.

Web Services

A web-services SDK, consisting of web-based functions that use .NET or J2EE
platforms, is included with Crystal Reports Server XI enabling developers to
integrate documents directly into applications. The web services provider is



3 ’0 Part IV: Crystal Reports in the Enterprise

deployed on the server side with Crystal Reports Server XI. The API (applica-
tion program interface) provided gives developers the tools to create cus-
tomized web sites, applications, or web services, which access to services
available in Crystal Reports Server XI.

Viewing and Interacting with Reports

Users, typically not in possession of a copy of Crystal Reports, can view
reports with InfoView, which is a customizable, zero-client web portal. It is
a central web environment that enables end users to find reports and then
navigate them.

In addition to InfoView, other report viewers are available, including the
previously discussed Crystal Reports Viewer XI, as well as a Java viewer, an
ActiveX viewer, a DHTML viewer, and an Advance DHTML viewer.



Chapter 19

BusinessObjects Enterprise
Repository

In This Chapter

Adding folders and objects to BusinessObjects Enterprise Repository
Adding Repository objects to reports

Modifying objects

Updating connected Repository objects in reports

Deleting items from the Repository

A s its name implies, BusinessObjects Enterprise Repository is a central
location where you can store report objects. It delivers two benefits to
you as a report developer:

+ You can store different types of objects there. The Repository saves
you from reinventing the wheel. After you create an object — a text
object, a bitmapped image, a custom function, or an SQL command —
you can store it in the Repository. From there, you can add it to any
other reports that you or your colleagues create.

+~ The Repository remains connected to all the reports that have drawn
objects from it. You can take an object from the Repository, put it into a
report, update it, and then return it to the Repository. All other reports
that contain that object are automatically updated, saving you from
having to keep track of which versions of a particular object are in
which reports. You have to manually update the object only once, rather
than in all the reports that use it.

The Repository is hosted by the central management server (CMS) system
database in BusinessObjects Enterprise. Thus, it’s only available on systems
that include BusinessObjects Enterprise. Standalone copies of Crystal
Reports do not have access to the Repository.
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Vg\“\NG! The first release of Crystal Reports 2008 doesn’t support Repository
S functionality. After a Service Pack is issued for Crystal Reports 2008 and
a new version of BusinessObjects Enterprise is released, this functionality
will be supported. This upgrade is expected some time in 2008.

The Repository holds the master copy of any object it contains, and no one
can modify that master copy while it’s there. To update an object, you must
move it into a report, modify it there, and then move it back into the
Repository. This eliminates the possibility of object corruption in the
Repository from concurrent file access and editing.

Adding Folders to Vour Repository

Naturally, keeping objects in the Repository organized allows you to find
them more easily when you want to add them to your reports. To impose
order, use folders and subfolders in a tree structure in the Repository.
You have complete freedom to organize those folders however you want.
Follow these steps to add a folder:

1. In Crystal Reports 2008, open a report — any report.

2. On the Standard toolbar, click the Repository Explorer icon.

= The Log On to BusinessObjects Enterprise dialog box appears.

3. Log on to BusinessObjects Enterprise.
Repository Explorer appears at the right edge of the screen.
4. Click the Insert a New Folder icon.
A new folder appears, with the default name New Folder.
5. Give the new folder a meaningful name, and then press Enter.

6. To create subfolder, select the folder and then click the Insert a
New Folder icon.

7. Name the new folder.

Storing Your Valuables in
BusinessQbjects Enterprise Repository

After you create an object in one report, you can put it into the Repository,
where it remains available for reuse in other reports and by other developers.
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Adding a report object to the Repository is easy, but the methods differ
depending on the type of object. The following sections describe these
methods.

Adding text and bitmapped
objects to the Repository

To show you how to add a text object or a bitmapped object to the
Repository, in this section, I use the Customer Orders by State or District,
Mexico report from Chapter 6.

Suppose you plan to create other reports about sales in Mexico, and you
want to retain the Mexican flag in the Repository. The flag is an image, but
you're likely to be putting other flags in there as well, along with other kinds
of images. To keep things straight, you could first create an Images folder,
and then create a Flags subfolder of the Images folder. Then you could place
the Mexican flag image in the Flags folder, like this:

1. Add an image to a Repository subfolder by selecting the image and
then dragging it to the subfolder in Repository Explorer.

For this example, select the image of the Mexican flag and drag it to the
Flags folder.

2. When the Object Information dialog box opens, enter a name for
the object.

3. (Optional) Add the author’s name and a description.
4. Click OK.

The object is added to the folder in the Repository.
a\J
You can verify that the object is in the Repository by clicking the plus sign to
the left of your new (in this case, Flags) folder. Your new object now appears
in the Repository Explorer tree.

You can add a text object in a similar manner. Just drag it to the appropriate
folder in Repository Explorer and name it. From that point on, the object
resides in the Repository, still connected to the report you took it from.

Adding custom functions to the Repository

You can create custom functions for use in the formulas you create with
Formula Workshop. (I cover Formula Workshop and creating custom func-
tions in Chapter 10.)
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A\

Putting custom functions in the Repository so they can be reused is a great
labor saver.

Adding a custom function to the Repository from Formula Workshop is easy;
just click the Add to Repository icon in Formula Workshop.

Adding SOL commands to the Repository

Relational databases are created and manipulated by commands in SQL. You
can add such commands to the Repository in much the same way you would
add text objects, image objects, or custom functions. In Chapter 23, I give

an overview of SQL commands and describe how to create one. For a more
complete exposition of SQL, refer to my book SQL For Dummies (Wiley).

For now, here’s how to add an existing SQL command to the Repository,
where it will be readily available next time you need it:

1. In the Selected Tables pane of Database Expert, find the command
you want to add to the Repository.

2. Right-click the command and choose Edit Command.
The Modify Command dialog box appears.

3. Select Add to Repository, and then click OK.
The Add Item dialog box appears.

4. Specify a name and Repository location for the command.

The command appears in the Repository node of Database Expert, the
Set Datasource Location dialog box, and the Data screen of Report
Creation wizards.

Using Repository Objects in a Report

Moving an object from the Repository to a report is essentially the reverse
of moving an object from a report to the Repository. There is one method for
text and image objects, a second method for custom functions, and a third
method for SQL commands.

Adding text objects and images

To add a text object or an image object from the Repository to a report,
follow these steps:
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1. On the Standard toolbar, click the Repository Explorer icon.

= 2. Log on to BusinessObjects Enterprise, if you’ve not already done so.

3. Expand the folder you want to place your text object or image into,
whichever is appropriate.

4. Drag the desired object into your report where you want it.
That’s all there is to it.

Adding custom functions

Adding a custom function from the Repository to a report is only a little more
complicated than adding text objects and images:

- 1. On the Expert Tools toolbar, click the Formula Workshop icon.

f X 2. In Formula Workshop, expand the Repository Custom Functions node.
3. Right-click the desired custom function and choose Add to Report.

The function is added to the report. If the function you added requires
other functions for its operation, those functions are automatically
added, too.

Adding SOL commands

Adding an SQL command from the Repository to a report is similar to adding
a custom function:

= 1. On the Expert Tools toolbar, click the Database Expert icon.

U 2. In Database Expert, expand the Repository folder.

3. Right-click the command you want to add and then choose Open.

Your command appears in the Available Data Sources area of Database
Expert. Add it to your report as you would any other data source.
I cover SQL commands more extensively in Chapter 23.

Modifying a Repository Object

After an object is in the Repository, you can include it in multiple reports.
When a user opens these reports, the Repository is checked to see whether
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the object has been updated since the last time the report was open. If the
object has been updated, the new version of the object is downloaded to
the report.

You don’t have control over when other users might open a report containing
an object you want to modify, so Crystal Reports doesn’t allow Repository
objects to be modified. To update (or otherwise modify) a Repository object,
you must first disconnect the object from the Repository, and then change
the object. Then, after the change is complete, you can add the object back
to the Repository. The next time anyone opens a report that contains that
object, your updated object is the one supplied.

To modify an object in the Repository, follow these steps:

1. Open a report in Design view.

You might want to open the Mexico Orders, with Running Totals Sorted
by Date report from Chapter 6. However, for this example, any report
will do.

2. Drag the object you want in your report from the Repository to
your report.

For this example, from the Flags folder of BusinessObjects Enterprise
Repository, drag the Flag of Mexico object to the left edge of the Report
Header.

3. In Design view in the report, right-click the object you just dragged
into the report and choose Disconnect from Repository.

4. Right-click the flag object again and choose Format Graphic from the
menu that pops up.

Format Editor appears.
5. Modify the object.

For example, you could click the Border tab and change the Left, Right,
Top, and Bottom Line styles to Single, and then click OK.

6. Drag the modified graphic object from the report back to the Flag of
Mexico icon in Repository Explorer.

The Add or Update Object? dialog box appears.
7. Click the Update button, and then click OK.
The Modify Item dialog box appears.
8. Click OK.

The Mexican flag in the Repository now has a single black line border
around it.
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Deciding Whether to Update
Reports Automatically

WMBER
Q‘?‘
&

To automatically update or not? That’s an important question, and each
choice has its argument.

To guarantee that all reports using a Repository object are using the same
version, consider setting an organization-wide policy that whenever a
Repository object is updated, all the reports that use that object receive
the update the next time they’'re opened.

On the other hand, people who create reports might not want to surrender
control of their report to whomever makes a Repository update. They don’t
want their reports to be automatically updated when opened after a
Repository update.

Crystal Reports can be configured to work in either of these two ways. In
addition, you can decide — on an individual basis — whether you want a
specific report to receive updated Repository objects.

To have all reports that use Repository objects receive updated objects when
they’re opened, configure Crystal Reports in the following manner:

1. Choose File=>Options.
The Options dialog box appears.
2. Click the Reporting tab.
3. Select the Update Connected Repository Objects on Open option.
4. Click OK.

From now on, whenever any report is opened, the version numbers

of the Repository objects it contains are compared against the current
version numbers of those objects in the Repository. If the Repository
contains a newer version, it replaces the older version in the report.

If you don’t want the automatic update feature, make sure that Update
Connected Repository Objects on Open is not checked.

To update the Repository objects in a single report — rather than globally
for all reports — note the dialog box that you use to open a report. At the
bottom of that dialog box is an option that reads Update Repository Objects.
Repository objects will be updated on the report you open, but not on

any others.
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Deleting Objects from the Repository

A\

Sooner or later, Repository objects become obsolete and should be deleted.
Removing a Repository object is simple. You can do it in three easy steps:

1. On the Standard toolbar, click the Repository Explorer icon.

2. Move to the appropriate folder in the Repository Explorer and select
the object you want to remove.

3. Press the Delete key, and then click the Yes button to respond to the
Confirm Delete dialog box.

The object is removed.

Any existing reports that already include a deleted object still contain it, but
the object can’t be included in any other reports from this point on.

Of course, you don’t want just anyone deleting Repository objects that other
people might want to continue using in their reports. How do you control
who has permission to delete Repository objects?

Fortunately, the Repository is stored in a relational database, and relational
databases have built-in protections against unauthorized tampering. One

of those protections is basic to the database’s structure: The database
administrator (DBA) assigns permissions to all users. One of those permis-
sions is the right to delete records from database tables. Only those users
who are granted permission to do so may delete objects from the Repository.
(Naturally, the DBA should choose such people with care.)
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Navigating with Report Parts

In This Chapter

Choosing what part(s) of a report or of several reports to display

Enabling users to move from one report object to another

Employing highly selective drill down

Hyperlinking between reports
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R eport Parts allows developers to extract and display only selected parts
of a report (report objects) while the rest of the objects on the source
pages are not displayed. With Report Parts, advanced developers can inte-
grate key elements of an existing report — such as summary data, tables, and
charts — into workflow applications that users can access through a Web
portal, PDA, cell phone, or other wireless device.

In this chapter, [ discuss the two ways you can use Report Parts:

+* Report Part Drill-down: This method uses a drill-down capability that is
a more restricted method than the standard drill-down available when
you perform regular page navigation.

v Another Report Object: This method involves defining a hyperlink path
to other objects in the same report (or in a different report).

Using the Report Parts facility requires the use of a scripting language, such
as VBScript, to create the Report Parts Viewer. After you create the Report
Parts Viewer, you integrate it into the HTML code that produces the Web
application that actually presents the Report Parts to your audience.

Understanding Report Parts Navigation

The Report Parts facility allows you to focus attention on the specific parts
of a report that are relevant to a given user community. By crafting different
Report Parts for different user communities, you can address multiple audi-
ences with a single report. The members of each audience see only the
information that concerns them; other parts of the report aren’t displayed.
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You can view reports in several ways:

v Through the Crystal Reports development environment: Keep in
mind, however, that not everyone who needs to view the reports will
be a report designer. Those who are not designers won’t have
Crystal Reports.

+* Through BusinessObjects Enterprise via the BusinessObjects
Enterprise Web desktop (InfoView): Users employing this method
need only a browser and the assigned privileges of a licensed
BusinessObjects Enterprise seat. Seat? What’s a seat? In Business
Objects marketing lingo, the price of a BusinessObjects Enterprise
license is based on the number of seats it supports. This is the
number of people who are parked in front of computers running
BusinessObjects Enterprise at any one time.

1 Through a viewer: Viewers are available via the standalone Report
Application Server (RAS). (See the nearby sidebar, “What’s a Report
Application Server?” for more information.) The Crystal Reports Viewer
works offline and need not be connected to anything. All it needs is the
report file. Chapter 22 describe the Crystal Reports Viewer in detail.

Most of the viewers available are page viewers, which are programs that
display entire report pages. However, the Report Parts Viewer shows only
specific report objects, without showing the rest of the page the objects
are on. With the Report Parts Viewer, a user can see one part of a report
and then click a link to go to another part of the same report (or of a
different report) to get specific related information. Thus, you can give
users exactly the information they need, whichever report it’s in.

The Report Parts Viewer is not a preexisting tool in the way that the Crystal
Reports Viewer is. To embed the Report Parts Viewer in a Web page, you
must first invoke it with an ASP or a JSP page (written in VBScript or
JavaScript, respectively). I don’t go into those details here. Writing ASP or
JSP pages is more related to building Web sites than to creating Crystal
Reports documents. You might want to concentrate on mastering Crystal
Reports for the time being, and let a Web guru do the ASP or JSP coding.

Using Report Parts to Navigate a Report

You can move from one report object to another via a hyperlink. For

such navigation to work, however, the second report must be managed by
BusinessObjects Enterprise or by the standalone RAS. This type of navigation
is available only in the DHTML viewers, which are zero-client, server-side
viewers. You can link directly from an object in one report to an object in
another report.
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What's a Report Application Server?

Report Application Server (RAS) is a software  (software development kit), RAS connects to a
tool included with Crystal Reports, designed Web server to provide users with access to
for building, customizing, and delivering reports  Crystal Reports. RAS is more of a tool for system
over a network. In conjunction with its SDK  administrators — you probably won't be using it.

CMBER

A zero-client, server-side viewer requires nothing on the client machine other
than a browser. The viewer itself resides on the server.

The Report Parts Viewer and any of the page viewers both support naviga-
tion, but what the user sees is different in the two cases:

v~ Using Report Parts Viewer: When users are navigating between Report
Parts (using the Report Part Viewer), they link from one report object to
another report object. Both report objects are designated as Report
Parts: The only things that the users see when they follow a chain of
hyperlinks. The rest of the page remains out of view.

v~ Using a page viewer: When users view a report with a page viewer
and the report uses page navigation, they are linked from one object
to another, but can see the entire page that these objects are on.
Chapter 22 covers the Crystal Reports viewer, which is an example
of a page viewer.

You set up the navigation from the Hyperlink tab of the Format Editor
dialog box. I illustrate this action with a couple of examples in the
following sections.

Using the Report Parts Drill-down method

Drill-down is a standard capability of regular page navigation (see Chapter 6
for more about drill down), but Report Parts drill down is more restricted.
The Report Part Viewer emulates the drill-down functionality of Crystal
Reports but doesn’t provide full drill-down capability. You can drill down
from summary fields, group charts and maps, and fields in a report’s group
headers and group footers. Report Parts drill down from or to objects in
areport’s page header or page footer is not supported. Furthermore, all
destination objects (the objects you are linking to) must be in the same
report section.

Performing a Report Part drill down involves three steps:

1. Define the Initial Report Part settings.
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2. Create a Report Part Drill-down hyperlink.
3. Publish the report into the BusinessObjects Enterprise environment.

After these steps are completed, the Report Part is ready for viewing.
Following is a step-by-step example of Report Part Drill-down.

Defining Initial Report Part settings
The first thing you must do is define the Initial Report Part settings:

1. Open the report that holds the first Report Part.

You define its default home object as the starting point of the Report
Parts Drill-down.

For this example, open the Customer Orders Grouped by State or
District with Drill-down report created in Chapter 6. In Design view, it
looks similar to Figure 20-1.

2. Right-click the object you want to set as the default home object and
then choose Copy from its shortcut menu.

For this example: In Design view, right-click the text object in the Report
Header (RH) and choose Copy from its shortcut menu.

3. Choose File>Report Options.
The Report Options dialog box appears. See Figure 20-2.
4. In the Initial Report Part Settings area, click the Paste Link button.

The Object Name and Data Context fields are filled in automatically with
the name and data context of the home object you selected.

5. Click OK.

+ Cryitil Rogpiors - [Cutiemss O Drill - x
Hle Edit View [nsert Formgt Patabase Report Window Help
) & = N R r] 3 = @ % e S
B 4 U
P11 S o N R f (58 [ ] 1 =2 | 48 4]
Start Page  Customer Orders, Grouped by State or District with Drilidown
.Deslqn. Praview .

RE T AR S S Y f T,
A . . . -~
[ Customer Orders, Grouped by State or District |USA||
PH
o Print Date .
Tl Customear Hame Order Amount
Flgure 20-1: 7 roup 71 Hamo 3
Open a o B A e s
BRI . |
report to || I m o1 Orders.Order Amount
. L
begin. |

I | For Help, press F1 1 vl anoneini- 0] (g




Chapter 20: Navigating with Report Parts

|
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Creating a Report Part Drill-down hyperlink

After your initial Report Part setting is in place, you can create a Report Part
drill-down hyperlink. You can link to another location on the source report,
or you can link to a location on a different report. To keep this example
simple, link to another location on the same report:

1. Right-click the object that you selected to be the destination of the

hyperlink.

For example, if you're using the Customer Orders Grouped by State or
District with Drill-down report, right-click the Group #1 Name field in the

GH1 report section.

2. From the pop-up menu that opens, choose Format Field to display

Format Editor.

3. Click the Hyperlink tab, as shown in Figure 20-3.

4. In the DHTML Viewer Only area, select Report Part Drilldown.

The Hyperlink information area appears, showing a Details entry in the
Available Fields pane.

5. Expand the Details entry to see what fields are available as destina-
tions for the link, as shown in Figure 20-4.

6. Select the field you want to use as the destination of the hyperlink
and move it over to the Fields to Display pane.
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To follow along with the example, select CustomerNamel and then click
the > button pointing to the Fields to Display pane. In this case, you
want to display only the names of the customers, not the amount they
have ordered.
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7. Click OK to establish the hyperlink and dismiss the Format Editor.
8. Choose File>Save As.

For this example, save the file as Customer Orders, Grouped by State
or District with Drilldown and Hyperlink.

9. In Preview mode, double-click the destination object, only the under-
lying details for that report part are displayed. You do not get any
of the other objects that would normally be on the page.

For this example, double-click the Group #1 region name for a
particular state.

A drill down of the report part you specified displays.

You now have a report in which drill down displays only the data you want
to display rather than whole pages. Your users can access the data through a
Report Parts Viewer that’s embedded in an application that they’re using.

Publishing a Report Parts Drill-down report

Before a user out on the network can view the report, you must publish it into
the BusinessObjects Enterprise environment for access over the network. I do
not cover BusinessObjects Enterprise in this book. BusinessObjects XI Release
2 For Dummies shows you how to publish your report on a network.

Using the Another Report Object method

Report Part Drill-down is one of the two ways you can use Report Parts.
The other way is to select Another Report Object. With this option, you can
define a hyperlink path to objects in the same report or in a different report.
If you're defining a path to a different report, that report must either be
open in the same instance of Crystal Reports as the first report (managed
by BusinessObjects Enterprise), or it must be part of a standalone Report
Application Server environment. As with Report Part Drill-down, all destina-
tion objects must reside in the same report section. Linking to another
report is very similar to creating a Report Part Drill-down report.

To link from one report object to another report object in either the same or
a different report — and this need not be a drill-down operation — follow
these steps:

1. Open the source and target reports.

The source report is the one you copy an object from. The target report is
the one you add the hyperlink information to.

For this example, the source report is Customer Orders by State or
District (Mexico), and the destination report is Customer Orders,
Grouped by State or District (USA).
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|
Figure 20-5:
The link
between
objects is
selected.
|

. In the source report, right-click the destination object and choose
Copy from its shortcut menu.

For this example, the destination object is the Mexican flag graphic.

. Select the intended home object in your target report, and then
right-click it and then select Format Field from the shortcut menu.

[ use the Print Date object as the home object in the Customer Orders,
Grouped by State or District (USA) report.

. In Format Editor, click the Hyperlink tab and then select the Another
Report Object radio button (in the DHTML Viewer Only area), as
shown in Figure 20-5.

. In the Hyperlink Information area, click the Paste button.

The Report Title, Object Name, and Data Context fields are automatically
filled in.

. Click OK.

A hyperlink is established between your home object and a destination
object. Now you can create a series of hyperlinks in the same manner,
allowing users to move from one object to the next, to the next, using
a Report Part Viewer.
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In this part . . .

ou will have a fine sense of accomplishment after you

complete an excellent report that clearly conveys the
information that you intended to deliver. However, your
efforts are for naught if no one reads the report. Publishing
your report to its intended audience is an important final
step in the report-creation process.

You can publish a report via various methods. You can
make the report available on your organization’s local
area network (LAN), or you can print copies on a printer
and distribute them. Maybe you fax the report to people
at remote sites or put it on a Web site. Crystal Reports
supports all these methods of report distribution. Your
handiwork will be visible to all who should see it. And in
the case of posting on a Web site, your handiwork will be
visible to the world.




Chapter 21

Sending Your Reports
Out into the World

In This Chapter

Printing reports
Faxing reports
Exporting reports to different places

Discovering a few troubleshooting tips

Wlen creating a report in Crystal Reports, your ultimate goal is to get
the report into the hands of people who can use the information that

the report contains. These people might not have access to a computer run-
ning Crystal Reports, so several methods of distributing reports are available
that don’t depend on Crystal Reports being present. For example, you can
print the report on paper, send it directly from your computer via fax, or
export it to a variety of destinations.

Whether you're distributing your report as a printed document, fax, or com-
puter file, Crystal Reports makes it easy for you to get the report out in a
timely fashion and in the form you want.

Printing Your Report

After you complete report development, your report is ready to print, which
is the easiest way to produce a finished report. Choose Filec>Print=>Printer
from the main menu or click the Printer icon on the Standard toolbar. The
Print dialog box (as shown in Figure 21-1) appears, telling you the name of
the default printer and asking you which pages to print, how many copies to
print, and whether to collate copies.
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Figure 21-1:
The Print
dialog box,
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default
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Make the appropriate selections and then click OK. That’s all there is to it.
Your report is printed as you specify. Distribute the printed copies to the
people who should get them. Now your job is truly finished.

Faxing a Report

Maybe the intended recipients of your report aren’t close enough for you to
hand them a printed report, and a delivery service isn’t fast enough to get it
to them when they need it. In this case, you can fax the report directly from
your computer, provided (of course) that your computer is equipped with fax
software and either has a modem connection to the telephone network or is
set up to send faxes over the Internet.

To fax a report, you must change your default printer to a fax driver. Do this
as follows:
1. Choose File=>Printer Setup.

2. Select your fax driver from the list of printer drivers installed on your
computer.
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If you don’t find a fax driver among the list of installed printer drivers, it
probably means that your computer isn’t set up to send faxes. You have
to install fax software before you can fax any reports to recipients at
remote sites.

3. Click OK.
4. Click the Printer icon.

The Print dialog box appears. Your fax driver appears instead of your
printer driver.

5. Make the appropriate selections and then click OK.
Your fax software appears.

6. Follow the software’s instructions to send your report to its intended
recipients.

Exporting a Report

Crystal Reports can send reports to a variety of destinations, in a format
that’s appropriate for those destinations. You can export a report to
Microsoft Excel as a spreadsheet in Excel .x1s format or to Microsoft
Word as a word processing document in Word . doc format. That’s just
scratching the surface, however.

Export format types

The two broad categories of export formats are page-based and record-based.
Page-based formats try to produce an output that looks like the report, as much
as possible, given the limitations of the format type. This includes such attrib-
utes as font style, text color, text alignment, background color, and so on.
These formats also try to retain such layout features as object position, object
size, and the relationships between objects. Page-based formats are the ones
you will probably use if you expect people to be reading the exported report.

Record-based formats are more concerned with transmitting the data than
they are with how it is presented visually. Some formatting might be exported
along with the data, but a report exported in a record-based format won’t
look very much like the original. Record-based formats are primarily used
when you do not expect people to read the exported report. Instead, the
export is going to another software package, which will operate on the data
before presenting it to a human.

Table 21-1 lists the file-format types to which you can export a report.
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Table 21-1  File-format Types to Which You Can Export a Report

Page-based Adobe Acrobat (PDF)
Crystal Reports (RPT)
HTML 3.2
HTML 4.0
Microsoft Excel 97-2003
Microsoft Word 97-2003
Microsoft Word 97-2003 (Editable)
Rich Text Format (RTF)

Record-based Microsoft Excel (97-2003) Data-only
0DBC
Record style: Columns with Spaces
Record style: Columns without Spaces
Separated Values (CSV)
Tab-separated text (TTX)
Text (TXT)
XML

When you export a report to any format other than Crystal Reports format,
you might lose some or all of the report’s formatting. Crystal Reports tries to
retain as much formatting as possible, but in some cases, not much can be
saved.

Here are some facts about each of the supported export formats.

Adobe Acrobat (PDF)

PDF format is a page-based format; thus, a report exported in the PDF format
looks much like what the report looks like onscreen in preview mode. The
PDF format embeds TrueType fonts in the exported document but does not
support non-TrueType fonts. TrueType fonts are the most common fonts
available under Mac OS and Windows. They are a scalable, outline font that
looks good at any resolution, whether on paper or onscreen.

Crystal Reports (RPT)

Exporting in Crystal Reports RPT format is much like saving a report as an
RPT file. The difference is that when you export a report that you modified
to an RPT file, the original report RPT file is not affected.

HTML 3.2 and HTML 4.0

The HTML export formats are page-based. HTML 4.0 preserves both layout
and formatting, using DHTML. HTML 3.2 doesn’t do as good a job of preserv-
ing layout, but it’s supported for compatibility with older browsers. If you
have any images in your report, they are saved to separate files and hyper-
linked to the report.
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Microsoft Excel (97-2003)

Microsoft Excel format is another page-based format. It places report contents
into spreadsheet cells on a page-by-page basis. Excel has a 256-column limit,
so any report that requires more space is truncated. Excel format retains most
formatting but does not export line and box objects.

Microsoft Excel (97-2003) Data-only

Microsoft Excel Data-only is a record-based format. It exports the data, some
formatting, and summaries that are compatible with Excel functions, such as
SUM, AVERAGE, COUNT, MIN, and MAX.

Microsoft Word (97-2003)

Microsoft Word format is, of course, page-based. It produces an RTF (Rich
Text Format) file. The RTF file can contain drawing objects as well as text.
Individual objects are placed in text frames. This capability comes in handy
for fill-in forms. Empty text objects are reserved for entering text.

This format retains almost all formatting but does not allow text objects to be
placed outside the left edge of the page. This shouldn’t be a problem because
most people would not want to place anything off the edge of the page.

Microsoft Word (97-2003) Editable

This format is page-based, but not all layout and formatting are preserved.
For example, background color and fill pattern don’t carry over. On the plus
side, an entire document in this format can be edited by Microsoft Word.

obsC

ODBC is a record-based data exchange format. Use it to export to an ODBC-
compliant database.

Record Style — Columns with Spaces

This record-based format exports report data as text, only from Group and
Details areas. Output is one line per record, with spaces between the columns.

Record Style — Columns without Spaces

This format is like the preceding except that it doesn’t have spaces between
columns.

Rich Text Format (RTF)

Rich Text Format is Microsoft Word format, disguised to appear to be
non-proprietary.
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Separated Values (CSU)

Separated Values format is a record-based format where each value is sepa-
rated from others by an agreed-upon separation character, such as a comma.
If the separation character is indeed a comma, CSV stands for Comma
Separated Values.

Tab Separated Text (TTX)

Tab Separated Text format is a record-based format similar to Text format. It
preserves formatting to an extent, but multiline text objects are exported to
a single line, and all string values are enclosed in double quotes (" ").

Text

Text format is a record-based format whose output is plain text. Formatting is
not retained. This format assumes that a font of a constant dimension is used
throughout. You can specify a page break after a specified number of lines.
This might or might not correspond to the pagination of your report.

XML

XML format is record-based and uses the Crystal XML schema.

Export destinations

You may export a report to several destinations:

v An application

v A disk file

v A Microsoft Exchange folder
v Lotus Domino

v Lotus Domino Mail

v MAPI (Microsoft Mail)

To demonstrate the export process, export a report in Microsoft Excel format
to all the supported export destinations.

Exporting to an application

If you export to an application such as Microsoft Word or Microsoft Excel,
Crystal Reports exports to a temporary file and then launches the target
application and opens the report file in it.
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Here’s how to export a report to a Microsoft Excel file, as an example.

1. Open the report you want to export.

To follow along with this example, open Customer Orders, Grouped by
State or District (USA), which should look something like Figure 21-2.
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2. Choose Filew>Export->Export Report.
3. From the Format menu, select Microsoft Excel (97-2003).
4. From the Destination menu, select Application.

The Export dialog box looks like Figure 21-3.
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5. Click OK.
The Excel Format Options dialog box is displayed (see Figure 21-4).
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|
Figure 21-4:
The Excel
Format
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dialog box.
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6. Choose from these formatting options:

¢ Column widths based on the whole report, or any of the individual

sections of it

e Page headers and footers once per report, on each page, or none

at all

¢ Page breaks for each page

¢ Converting date values to strings

e Showing gridlines

I chose to export the whole report, export page headers and footers on
each page, and create page breaks for each page.

7. Click OK.

The Exporting Records dialog box appears. It gives a running count
of the number of records exported and the percent of completion.
Figure 21-5 shows it in mid-export.

_r'Expurting Records

Exporting Records
Cument Tolal

Reconds 687 1524

Excel is launched, and the exported report is displayed. Figure 21-6

shows the result.

The exported report looks very much like the original. Every line on the
report is displayed in a row of the spreadsheet. Spreadsheet columns
vary in width, depending on the width of the report objects. The only
clearly visible difference from the original report is the fact that the
rounded box around the report title was not exported.
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Ready

Exporting to a disk file
If you export to a disk file, Crystal Reports opens a dialog box that allows you
to specify a drive, directory, and filename for the report file. Here’s an exam-
ple of that operation.
1. Open the report that you want to export.
2. Choose Filew>Export->Export Report.
Alternatively, you could click the Export button on the Standard toolbar.
The Export dialog box appears.
3. Select a format.
For this example, choose Microsoft Excel (97-2003).
4. Select a destination.
For this example, choose Disk File.
5. Click OK.

The Excel Format Options dialog box appears. Gee, this all seems very
familiar to the preceding step list. Exporting to disk is pretty much the
same as when exporting to Excel.

6. Select the appropriate options and then click OK.
The Select Export File dialog box appears, as shown in Figure 21-7.

The dialog box assumes that you want to save the exported report in a
folder named Temp. This is probably not where you want to save it.

7. Move to the folder that you want to hold the exported report and then
click Save.

Your exported report is saved in Excel format and can now be opened in
and operated on by Excel.
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Exporting to a Microsoft Exchange folder
To export to a Microsoft Exchange folder, start by opening a report. Then dis-
play the Export Report dialog box, and select a format and destination. (See
the preceding sections if all this is unfamiliar turf.) Then do the following,
assuming that you're exporting in Excel format:

1. Select a format of Microsoft Excel (97-2003).

2. Select Exchange Folder for the destination.

3. Click OK.

Déja vu strikes again! The Excel Format Options dialog box appears.
4. Choose appropriate formatting options and then click OK.

Figure 21-8 shows the Choose Profile dialog box that appears, if one or
more profiles already exist.

Choose Profile 3]
Figure 21-8: |
The Choose Profike Name;  Voager v MNEw, ...
Profile
dialog box.
g | Ok il Cancel J[Cmﬁimb;}]
3

If it doesn’t appear, probably no profile has yet been created, and you
see the message shown in Figure 21-9.
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Figure 21-9:
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5. Choose a profile (as in Figure 21-8) and then click OK.
The Select a Folder dialog box appears.

6. Select the folder that you want to direct the exported report to and
then click OK.

The export takes place, and your report is located in the folder you
designate.

Exporting to Lotus Domino

Exporting to Lotus Domino starts off in much the same way as do the exports
cited earlier. The first difference is that in the Export dialog box, select Lotus
Domino as the destination. After you click OK, the same-old, same-old Excel
Format Options dialog box is displayed. Assuming you are still exporting in
Excel format, fill out the options as in the earlier step lists and then click OK.

At this point, if you don’t have Lotus Domino on your system, you receive an
error message that reads Couldn't load NROUTERL.DLL. If you do have
Lotus Domino on your system, the Select Database dialog box appears.
Double-click the Lotus Domino server you would like to export to, and then
select the database you would like to export to. After you click OK, you're
given the opportunity to enter a comment. Click OK again, and the export
commences.

Now, when a Lotus Domino user logs on to that database, your report appears
on that desktop.

Exporting to Lotus Domino Mail

Exporting to Lotus Domino Mail starts out the same way the earlier export
example start. In the Export dialog box, select Separated Values (CSV) for
format and Lotus Domino Mail as destination and then click OK. The
Separated Values Export Options dialog box opens. Choose a delimiter and
a separator, as well as several other options, as shown in Figure 21-10.

After choosing appropriate options, click OK. You might be asked to enter a
password. After doing so, the Send Mail window appears. Fill in the requested
information and then click Send.
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Exporting to MAPI (Microsoft Mail)

Just as you need Lotus Domino Mail installed to be able to export in that
format, you must have a Microsoft mail client (such as Microsoft Outlook,
Microsoft Mail, or Microsoft Exchange) installed and properly configured in
order for Exporting to MAPI to work. If your setup is configured properly,
specify MAPI in the Export dialog box and then click OK. The Excel Format
Options dialog box appears. Make appropriate entries and then click OK. In
the Send Mail dialog box that appears, fill in the address information and
click Send. The export process commences, and the report is sent to the
addressee.

Exporting to HTML

When you export to HTML, your report becomes readable on a standard Web
browser. You can send the HTML file that you produce to any compatible
destination, including a disk file. At the Export dialog box, fill in a Format of
HTML 4.0 and a Destination of Disk file.

Click OK to show the Select export rile dialog box, as shown in Figure 21-11.

Sclect export file %]
Entes the directony name i which to save the HTML pages and images for this repart. |
Directom name: Bage hle name:
kel Custormes Oiders, Grouped t
= et - Page navigator
(= DOCUME™
5 ussr [¥] Separate HTML pages
[£= LOCALS™1 ~ e T
. ©a
Dives: ~E f T
. () Pages Tom; o
He v |

Mote: HTML Exporting can produce mulliphs output fles. The dirsctory name specified i NOT uzad to
name an output He, bt bo create a DIHECTURY to hold all these hles.

Dy default, the base cutput file in this diectory is named <report names Fml If this drectory is accessible
i yous Webasite, browse this fle to view the report

[ ok | Cancel
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Specify the drive and directory where you want to send the file, choose a few
additional options, and then click OK. The export commences.

Exporting to an ODBC data source

You can export a Crystal Report directly to any Open Database Connectivity
(ODBC) data source, such as an SQL Server database. For this to work, you
must have an ODBC data source set up through your ODBC administrator.
After the report is in the database, it can be manipulated in a variety of ways,
depending on the capabilities of the data source.

In the Export dialog box, when you specify a format of ODBC, the destination
menu is grayed out. Click OK to show the ODBC Formats dialog box shown in
Figure 21-12.

ODBC Formats |5
BecaFics )
E—— Yo 2133'32?233;9 w [_concet
Hneme Samnle Datahass 11
Figure 21-12:
The ODBC
Formats
dialog box.
=

Select the database to which the report will be added as a new table and then
click OK. If the database is password protected, you are asked to enter a
Logon ID and a password. After you do, the Enter ODBC Table Name dialog
box appears.

Accept the default table name or give it a new one, and then click OK. Your
report is exported into that database as a new table.

Exporting to an XML file

To export to an XML file, select the XML format in the Export dialog box, spec-
ify a destination, and click OK. The XML Export Options dialog box appears
and asks you to choose an XML exporting format, as shown in Figure 21-13.

When you click OK, the Choose Export File dialog box appears, giving you a
chance to specify a folder and a filename for the XML file. Specify both and
then click the Save button. The export proceeds.
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XML Export Options %]
Please choose an XML exporting format:
Crystal Reports XML (default)
|
Figure 21-13:
The XML |
Export Output XML according to the bultn schema
Options
dialog box. = —

=

Troubleshooting Qutput Problems

Little can go wrong when you’re attempting to print a Crystal Reports report
to your system’s printer. If you can print a document from your word proces-
sor or another application, you should be able to print from Crystal Reports.

v If you can’t print from any of your applications: Check to confirm that
the printer is on and properly connected to your computer. Make
sure that your printer is identified as your computer’s default printer.

v If you can’t fax a report: Make sure that your fax software is properly
installed. Confirm that it works when sending a document from your
word processor. If your system won’t send a word processor document,
the fault is not with Crystal Reports. Make sure that your fax driver is
identified as your computer’s default printer.

v If you have trouble exporting a report: Make sure that you correctly
specify the format and the destination. Like printing and faxing reports,
exporting is pretty foolproof after you set up your connections properly.



Chapter 22
Displaying Reports Online

In This Chapter
Exporting a report to a static HTML page

Adding hyperlinks to your reports

Routing reports on your intranet with Crystal Server
Using a viewer to read a report

Hosting your reports on crystalreports.com

Integrating your reports with salesforce.com

A s organizations become more interconnected electronically, an emerging
trend is to communicate more over the network than by passing around
paper. In many cases, organizational intranets have become the communica-
tions medium of choice. Beyond the organization’s borders, extranets and the
Internet have assumed more important roles. Crystal Reports takes advantage
of this trend. Report features, such as drill down and subreports, require the
report reader to be online. It’s not hard to drill down into a sheet of paper, but
when you do, you don’t see very much, and it tends to ruin the surface of your
desk.

In this chapter, [ discuss the various electronic means of distributing reports.
The reports are distributed and accessed using a variety of tools. One of
these ways, I mentioned briefly in Chapter 21, namely exporting to a static
HTML page, visible on a local area network, a wide area network, or around
the world on the World Wide Web. One of the really handy features of HTML
is that it enables you to navigate from one page to another using hyperlinks.
Here I describe how to add hyperlinks to a Crystal report. A brand new way
to distribute reports is to make use of the crystalreports.com Web site hosted
by Business Objects. It provides a secure repository for your reports that are
always available to your authorized report viewers, as long as they have an
Internet connection.

The flipside of report publishing is report viewing. Reports on crystalreports.
com can be viewed with a common Web browser. Your readers can view
reports that reside on a local network using the Crystal Reports Viewer. You
can even attach a report to an e-mail message.
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Exporting to a Static HTML Page

Web pages, whether they're designed to be viewed by a small group of people
on a company intranet or by a worldwide audience on the Web, are imple-
mented by using HyperText Markup Language (HTML). A report created in
Crystal Reports can go online in several ways. Exporting to a static HTML
page is the easiest but also the most limited. The only thing that gets exported
is what’s visible onscreen.

V?‘“‘NG! When you export a report to a static HTML page, take note of the word static.
S The data in the report is only a snapshot of the data at the time of the export.
An exported report isn’t updated when the data in the original report changes.
To display the changed data, you have to export the report again.

For many applications, you don’t need to go beyond static HTML. In those
cases, exporting is as easy as 1-2-3. Well, actually, it’s as easy as 1-2-3-4:

1. Open the report that you want to export, and display the screen —
the main report or subreport — that you want to present to your
online audience.

2. Choose Filew>Export. Then, from the submenu that appears, choose
Export Report.

The Export dialog box appears.

3. From the Format drop-down list, select HTML 4.0. From the
Destination drop-down list, select Disk File. Then click OK.

The Select Export file dialog box appears, as shown in Figure 22-1.

Select export file ]
Entes the directony name i which to save the HTML pages and images for this repart.
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— |
Mote: HTML Exporting can produce mulliphs output fles, The dirsctory name specified i NOT uzad to
- name an output He, but bo create a DIHECTURY to hold all these hles.
Figure 22-1:
E I’t Dy default, the base cutput file in this diectory is named <report names Fml If this drectory is accessible
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4. Choose the drive and directory where you want to place the HTML
file, make a couple of additional selections as shown in Figure 22-1,
and then click OK.

An HTML version of your report is created and stored in the directory
you selected. From there, you can upload it to your Web server.

When you export a report to another format, such as HTML 4.0, you'll likely
lose some of the formatting of the original report. Crystal Reports does its
best to preserve the original formatting, but the appearance of the exported
report probably won’t match the original exactly. If you're not happy with
how the exported report looks, you might have to make changes to the origi-
nal to come up with a design that is less affected by the change of file type.

Figure 22-2 shows the top of the Customer Orders, Grouped by Region
(Mexico) report as it exists in Crystal Reports. Note that the title is
enclosed in a box with rounded corners.

After exporting the report to HTML 4.0, it looks like Figure 22-3.

The two reports look virtually identical except that the corners of the box
enclosing the title are no longer rounded.

More complex formatting features, however, such as cross-tabs and OLAP
grids, might not translate as well in the exported report. Judge each case
individually.

After you save your report to a disk file, you can upload the file to your Web
server in the same way that you upload any other files that appear on your
site.
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Adding a Hyperlink to a Report

One of the most valuable features of Web-based content is the capability to
quickly move between pages by using hyperlinks. By clicking a hyperlink
associated with a word, a phrase, or an image, a report reader can instantly
display a different page that provides more detail.

Crystal Reports enables you to add hyperlinks to your reports without your
having to become a HTML scripter. Here’s how:

1. In your report, select the object that you want to turn into a hyperlink
and then click the Insert Hyperlink icon on the Expert Tools toolbar.

Alternatively, right-click the selected object and choose Format Field or
Format Text.

The Hyperlink tab of Format Editor appears, as shown in Figure 22-4. If the
Hyperlink icon on the Expert Tools toolbar appears dimmed, it probably
means that you have not selected an object to anchor the hyperlink.

2. Select the type of hyperlink that you want.

For example, to link to a Web site, also type a Web site address in the
Hyperlink Information text box.

3. Click OK.
The anchor object doesn’t look any different, but now when you hover the

cursor over your hyperlink anchor object, it turns into the familiar pointing
hand, indicating that a click sends you somewhere else.

In addition to linking to a Web site, you can link to several places or even delete
a link; refer to Figure 22-4. Here’s a brief description of the options available:



Chapter 22: Displaying Reports Online 34 7

Format Editor |3
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+* No Hyperlink: Removes a hyperlink from the selected object.
1 A Website on the Internet: Links to a Web site.

v Current Website Field Value: Select this when you want to link to the
URL contained as a value in the selected object. This option appears
dimmed if no URL is contained as a value in the selected object.

v An E-mail Address: Enables users to send e-mail messages to a recipient
that you specify. When you select this option, the Hyperlink information
area changes, enabling you to enter an e-mail address.

v A File: Links to a file on the user’s computer.

v Current E-mail Field Value: Select this when you want to send an e-mail
message to the address contained as a value in the selected object. This
option appears dimmed if no address is contained as a value in the
selected object.

v Report Part Drilldown: Specifies which detail object is displayed when
the user drills down on a report part. (I explain Report Parts in Chapter
20.) This type of hyperlink works only with DHTML (dynamic HTML)
viewers, such as Internet Explorer 4.0 and above, and is dimmed if the
source object you chose is not appropriate for drill down.

v Another Report Object: Links directly to the object that the user speci-
fies. The destination object might be in this report or in another report.
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As a typical example of how to establish all of these hyperlinks, let’s link to a
Web site on the Internet. Follow these steps:

1.

Open the source report and select the object that you want as the
originator of the hyperlink.

. Click the Insert Hyperlink icon.
The Hyperlink tab of Format Editor appears.

3. In the Hyperlink Type area, select the A Website on the Internet radio

button.

4. In the Hyperlink Information area, fill in the URL of the Web site to

which you want to link.

Figure 22-5 shows what Format Editor looks like at this point.

5. Click OK to establish the link.

When the cursor hovers over the source object, it turns into the tradi-
tional hyperlink-indicating pointer hand icon. Double-clicking the source
object launches your default browser and displays the target Web site.

-
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Distributing Reports via
crystalreports.com
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crystalreports.com is a report storage and distribution service hosted by
Business Objects. You can upload your reports to crystalreports.com, where
they will be available over the Web to any users whom you designate and
issue passwords. Two editions are available:

v~ Starter: Free but with limited capacity

v Professional: Essentially unlimited but carries a monthly charge

When you store your reports on crystalreports.com, only users that you
authorize can view them.

To get started with crystalreports.com, you must first have some reports to
upload and some users who you want to be able to see them. Then, do the
following.
1. In your Internet browser, go to crystalreports.com.
There is quite a bit here.
¢ If you're a registered user: Click LOG IN to get started.
¢ If you're not a registered user, do the following:
a. Click TRY IT FREE.
You're taken to the Registration page shown in Figure 22-6.
b. Choose between the Starter and Professional editions.

You can register for the Starter Edition by giving your contact
information, or pop for the Professional Edition by giving the same
information and then arranging for making the monthly payments.

2. Log in.

You go to the crystalreports.com main page, as shown in Figure 22-7.

You can practice on some sample reports, as well as free downloads of Crystal
Reports Desktop Publisher and Crystal Reports Viewer. I discuss them both
later in this chapter. Crystal Reports Desktop Publisher is the tool you use to
upload reports to crystalreports.com. Crystal Reports Viewer is the tool with
which authorized users can view reports. It can be used by people on your
local intranet or over the Internet by people anywhere in the world.
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Integrating with salesforce.com

salesforce.com is an example of an on-demand customer relationship manage-
ment (CRM) solution that delivers strategic sales and marketing information
across organizational boundaries in large commercial organizations. crystal
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reports.com can be integrated into salesforce.com, adding business analytics
capability. As a result, information from salesforce.com and information from
an organization’s other data sources can be combined on a single screen to
give executives a strategic view of company operations. Information is dis-
played in a manner designed for quick, easy comprehension with customized
reports, dashboards, and graphical renderings. salesforce.com is just one
example. Many other business intelligence products include Crystal Reports
as their report writer. Reports generated in any of these environments can be
hosted on crystalreports.com.

Publishing to crystalreports.com with
Crystal Reports Desktop Publisher

Crystal Reports Desktop Publisher is a free utility that you can download
from the Business Objects Web site. You can use it to upload to crystal
reports.com the reports that you want to host there.

After you install Crystal Reports Desktop Publisher and launch it, you see the
screen shown in Figure 22-8.

Publish to crystalreports.com =IEE

New Document.. | | MewFolder.. | | Edt. || Reimeh | | Dela |
Taek Nams Local Path Frequancy Last Fun Time Las Fun Statug
Mesicy C'\Documents and Se 17312008 24123 PH Succsssluly ukoaded C'\Documents and 5¢
|
Figure 22-8:
The Crystal
Reports
Desktop
Publisher.
< >

As an example, publish the Customer Orders by State or District (Mexico)
report to crystalreports.com.

1. Put the files you want to upload to crystalreports.com into a folder by
themselves.

When you specify a folder to Crystal Reports Desktop Publisher, it
uploads all the reports it finds in that folder.

2. Click the New Folder button in the Desktop Publisher.
The Untitled Properties dialog box appears.
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3. Fill in the fields in the Untitled Properties dialog box.
The address of the destination server has been filled in for you.
Specify the following:
¢ The source directory of your upload folder
¢ Your identifying e-mail address
¢ Your crystalreports.com password

e The folder on crystalreports.com where you want your report to
go

4. When a dialog box pops up displaying your crystalreports.com folders,
specify one of them.

At this point, the Untitled Properties dialog box has been renamed to
reflect the Task Name you entered, and should look something like
Figure 22-9.

Be sure to fill in the Local Password field at the bottom of the dialog box
with your logon password on your local computer. If you don’t have

a logon password, create one. Without such as password, Publisher
cannot connect to crystalreports.com. The upcoming Figure 22-10 shows
the error message you receive if you don’t enter a local password into
the Properties dialog box.
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5. Finish in the properties window by doing one of the following:

e Click Run Now to upload the contents of the upload folder
immediately.

e Click the Edit button to schedule an upload later.

When you use crystalreports.com, you are entrusting your valuable business
information to Business Objects, an external organization. Clearly Business
Objects takes its fiduciary responsibility seriously and protects your informa-
tion from harm. However, technical difficulties can arise, no matter how well
designed a system is. When that happens, your information might become
unavailable to you, and you might see a message such as that shown in
Figure 22-10.

. Logon failure: user account restriction. Possible reasons are blank passwords not allowed, logon
hour restrictions, or a policy restriction has heen enforced

After a report is successfully uploaded to crystalreports.com, it’s available to
users whom you authorize to view it.

You can create a list of authorized users by importing a CSV file showing each
user’s information. You can do this from the Users tab on the crystalreports.
com main page as shown in Figure 22-11. The format you must follow in the
CSV file is specified by a template you can view by clicking under the Browse
button.

Who would have thought that a simple thing  were cut by a ship’s anchor that just happened
such as not having a password on your computer to be dropped in the wrong place in the
would stop you from uploading files? What other ~ Mediterranean Sea. There is no telling when
problems might be lurking in the shadows, wait- some unexpected event will prevent you from
ing for a chance to emerge and stop you cold? accessing crystalreports.com. It's wise to have
As | write this, India and most of the Middle East  a backup strategy in case your primary resource
have lost half of their Internet bandwidth for as  becomes unavailable.

long as a week because two undersea cables

Always have a backup
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Interactive Report Viewing with
Crystal Reports Uiewer

In order to create a Crystal report, you need to have Crystal Reports, either
2008 or one of its earlier versions. However, you don’t need Crystal Reports
to view a Crystal report. You can do that with the free Crystal Reports Viewer,
which you can download from the Business Objects Web site. The Crystal
Reports Viewer gives users most of the flexibility of Crystal Reports itself, but
is not quite as interactive. You cannot refresh a report from the Viewer, and
you cannot view reports that contain parameters. However, an organization
with a small number of developers can distribute the reports they create to a
large number of users very economically. When you launch the Viewer, you
see something similar to Figure 22-12.

The Community panel (on the left) is your link to resources that help you
get the most out of the Viewer. When you click any link there, your Internet
browser takes you to the appropriate topic on the Business Objects Web

site — maybe a sample report, or an article telling you how to perform a
given operation. There is also a forum where you can ask questions and
receive answers from other Crystal Reports Viewer users. As your familiarity
with the product grows, you can switch roles and be the person who is help-
ing rather than the person being helped.
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Opening a report in Crystal Reports Uiewer

You can open a report within the Viewer in several different ways. One way is
the familiar one of choosing File>Open. This works exactly the same way as
it does for many popular Windows applications. A second way is to click the
Open a Crystal Report icon on the toolbar just below the menu bar. The icon
looks like an open file folder. A third, and even simpler method, is to just drag
the report file icon from Windows Explorer into the Viewer.

Navigating a report

When you load a report into the Viewer, the Community side panel is replaced
by the Contents side panel, as shown in Figure 22-13. In this case, the Contents
side panel displays a map of report sections.

You can dismiss the side panel if you wish, to display the full width of the
report, by clicking the X in the panel’s upper-right corner. This is probably
the mode that you want to operate in, as shown in Figure 22-14.

Paging through a report

You want to be able to easily move through a multi-page report page by page.
The Viewer gives you this capability with the page movement icons in the
middle of the toolbar, just to the left of the display of which page you are on.
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Click the right-pointing arrow to move forward through the report; click the
left-pointing arrow to move back toward the beginning. Figure 22-15 shows
what this looks like on page 5 of a 29-page report.
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Moving directly to a specific section

To jump directly to a report section, just click that node in the tree diagram in
the Contents panel, which shows all the nodes in the report; see Figure 22-16.

If the Contents side panel is suppressed, just click the Contents tab on the
toolbar to redisplay it.
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Moving to a hidden section

Some reports have hidden sections. You can find these sections and view
what is contained in them, with the help of the Contents panel. Figure 22-17
shows a report that contains hidden details.

Notice the link icon to the left of all the state nodes in the tree. The link icon
indicates a hidden section at that node. Click the link icon for the node of
your choice to display the detailed information that is hidden in that section.
Figure 22-18 shows one example.
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Isolating report extracts

You can do for a section that is not hidden the same thing that you can do for
a hidden section: namely, select it and display it all by itself. To do this, right-
click the group heading for the group you want to isolate. A contextual menu
displays, as shown in Figure 22-19.
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Choose Isolate Information from the menu. The section you choose is displayed,
unadorned by headers and footers, and unaccompanied by any other sections.

Resizing the report to fit the Viewer

In the lower right of the Viewer is a zoom slider that you can use to change
the size of the report. The default size is set to 100, but you can make it
bigger or smaller as shown in Figure 22-20.

To the left of the slider are the Fit Page and Fit Width icons. Clicking the Fit
Page icon resizes the report page to fit entirely within the viewer. Clicking the
Fit Width icon resizes it to fill the viewer horizontally, but not necessarily
vertically.

Printing a report

Printing a report from the Crystal Reports Viewer is much like printing from
any Windows application. You can choose from two options: Print Current
Section and Print All (Include Hidden Sections). Select whichever of these
gives you what you want.
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E-mailing reports to your
friends and co-workers

E-mailing a report is easy. To attach your report to an e-mail, just choose File>
Attach to Email. Your e-mail client launches, with your report as an attachment.
All you have to do is type the e-mail address of the person you want to send
the report to, along with whatever message you want to include. Send the
e-mail like you normally would send any e-mail, and your report is on its way:.
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Sharing reports in a variety of formats

From Crystal Reports Viewer, you can export a report in Microsoft Excel,

Microsoft Word, or Adobe Reader format. Here’s how:

1. Choose File>Export Current Section.

2. Select one of the three available formats.

3. Select the directory you want to export to.

4. Verify the report name and export file type.

5. Click Save.

The report is exported in the specified format to the selected directory on

your system.
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Searching a haystack for
that elusive needle

To search for a word of phrase buried somewhere in a report, click the Search
tab to display the Search side panel. Enter the search term or phrase and
then click the Search button, as shown in Figure 22-21.

The Viewer scans the report and then displays the page number of each page
upon which the target word or phrase appears.

Accessing reports on crystalreports.com

The cool thing about having your reports available on crystalreports.com is
that any authorized user with an Internet connection can access them, using
nothing more than an ordinary browser. Users don’t need Crystal Reports or
Crystal Reports Viewer. A report accessed from crystalreports.com using a
browser looks something like Figure 22-22.
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Chapter 23
SQL Expression Fields

In This Chapter

Creating an SQL expression field

Adding an SQL statement to a repository
Modifying an SQL field

C’ystal Reports 2008 has a feature called SQL Commands. SQL is an interna-
tionally accepted standard language for dealing with relational databases.
Report writers, such as Crystal Reports, retrieve data from such databases.
They do so by translating the data retrieval part of the report into an SQL state-
ment that’s sent to the database. The database management system (DBMS)
executes the SQL statement on the data in the database, and then sends the
result set back to the report writer, which formats and displays it.

As you may know, some concepts that you can express in one language are
impossible to translate accurately into another language. I ran into this prob-
lem while trying to communicate with a taxi driver in Beijing, China, using my
community college Mandarin. I ended up on the wrong side of town, late at
night. A similar problem can happen with database reports.

Even though Crystal Reports provides handy wizards and dialog boxes, you
might have a hard time zeroing in on a particular data set. You might, however,
be able to get what you want by speaking the database’s native language, SQL.
SQL isn’t a particularly easy language to learn. (Hint: SQL For Dummies [Wiley],
by yours truly, can make it about as easy as possible.) If you make the effort to
learn SQL, you can extend the power of Crystal Reports. And when using the
SQL Commands feature of Crystal Reports, you can add anything you want to
your report. If the information you want is buried somewhere in your database,
you can retrieve it with SQL.

Creating an SQL Statement

To create an SQL statement, you must start with a report. Here are the steps
for adding an SQL statement to one of the reports that you created in an earlier
chapter.
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|
Figure 23-2:
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1. With the Xtreme sample database connected, open the Customer
Orders, Grouped by State or District (USA) report.

2. On the Expert Tools toolbar, click the Database Expert icon, or choose
Databaser>Database Expert.

The Database Expert dialog box appears, as shown in Figure 23-1. The
Xtreme sample database should be displayed in the Selected Tables pane,
with the Customer and Orders tables listed under it. In the Available Data
Sources pane, Add Command should be visible below the connection to
your database.

3. Double-click the Add Command node.
The Add Command to Report dialog box appears, as shown in Figure 23-2.
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Figure 23-3:
The SQL
statement.
|
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4. Type the following SQL statement in the left pane:

SELECT
Customer. [Customer ID],
Customer. [Customer Name],
Customer. [Last Year's Sales],
Customer.Region,
Customer.Country,
Orders. [Order Amount],
Orders. [Customer ID],
Orders. [Order Date]
FROM
Customer Customer INNER JOIN Orders Orders ON
Customer. [Customer ID] = Orders. [Customer
ID]
WHERE
(Customer.Country = "USA" OR
Customer.Country = "Canada") AND
Customer. [Last Year's Sales] < 10000.
ORDER BY
Customer.Country ASC,
Customer.Region ASC

Figure 23-3 shows the Add Command to Report dialog box after the SQL
command has been entered.

s AddC d To Report &
Enler SOL guery in Lhe box bedowr, Parameter List
st e EET

Customer, [Customer D],
Customer. [Customer Name],
Customer, [Last Year's Sales],
Customer, [Region],
Customer. [Country],

Orders. [Order Amount],

Orders. [Customer ID],
Crders, [Urder Dare]
FROM
Customer Customer INNER. JOIN Crders Orders ON
Cusstomes , [Customer I0] = Orders, [Customes ID]

(Custorner. [Country] ="USA™ OR

Customer, [Country] ="Canada’} AND

Customer. [Last Year's Sales] < 10000,
ORDER BY

Customer, [Country] ASC,

Customer. [Region] ASC

This rather lengthy SQL statement retrieves selected information from
the Customer and the Orders tables on all customers in either the USA
or Canada that had sales last year of less than $10,000. The records
returned are sorted first by country (Canada first, then USA) and then
by region (province or state).

The specific database driver that your system uses might differ from the
driver that my system uses. For example, my system accepts square
brackets around field names that contain blanks or other punctuation,
whereas yours might accept single or double quotes instead. If your
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system has Access, look at the syntax of the SQL that it generates, and
use the same thing. It’s important that Crystal Reports can distinguish
between field names and quoted strings such as "USA". It also needs to
be able to properly handle field names that include punctuation, such as
Last Year's Sales.

5. Click OK.
You return to Database Expert.
6. Click OK.
Database Expert displays Link view.
7. Click OK.
In my case, a Database Warning dialog box appears, stating

More than one database driver has been used in this
report. If you want to change the database
drivers use Database/Set Location.

Please make sure that no SQL Expression is added and
no server-side group-by is performed.

You can safely ignore this announcement. You might see more dialog
boxes. Click through them until you get to the Refresh Report Data
dialog box.

8. Click OK.

When all the dialog boxes go away, Report Designer displays your report.
Field Explorer has a new table named Command. Crystal Reports has
saved your query as a database table named Command. You can change
the name if you want.

Modifying an SOL Statement

Modifying an SQL command is similar to creating one. Here are the steps:
1. In the Selected Tables pane of Database Expert, find the statement
that you want to edit.
2. Right-click the statement and choose Edit Command.

The Modify Command dialog box appears, as shown in Figure 23-4. The
existing statement appears in the left pane, although its appearance may
vary from one implementation to another.

3. Make whatever changes to the statement that you want.

4. Click OK to execute the change, and then click OK again in Database
Expert.

You see Link view.
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'+ Modify C. d

Enler SOL guery in Lhe box bedowr,

SELECT
Customer, [Customer ID],
Customer. [Customer Name],
Customer, [Last Year's Sales],
Customer, [Region],
Customer. [Country],
Orders. [Order Amount],
Ordere. [Customer ID],
Cirders, [(rder Dare]

FROM

{Customer. [Country] ="USA" OR

Customer, [Country] ASC,
Customer. [Region] ASC

Customer Customer INNER JOIN Crders Orders ON
Cusstomer , [Custommer D] = Ordey s, [Cuslomer 1D]

Customer, [Cauntry] ="Canada”) AND
Customer. [Last Year's Sales] < 10000,
BY

Parameter List

Lreate. ..

o) (o)

5. Click OK.

6. When the Database Warning dialog box appears, click OK.
7. Click OK in the Refresh Report Data dialog box.

The revised SQL statement appears in Field Explorer under Database
Fields. If you select any of the fields under the statement and then click
the Field Explorer Browse button, a browse dialog box appears, display-
ing all the data that the report retrieved from that field. Figure 23-5
shows the result of browsing the statement’s Customer Name field.
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Modifying SQL statements that you create is a valuable capability. However
the real value of the SQL modification feature is in modifying the SQL that
Crystal Reports creates. When you create a report that displays data from
some data source, Crystal Reports creates an SQL statement to retrieve the
information you want from that source. It does its best, but may not neces-
sarily retrieve the information in the optimal way. In many cases it is possible
to considerably increase performance by fine-tuning the SQL that Crystal

Reports creates.
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Part Vi
The Part of Tens

The Sth Wave By Rich Tennant

“You ever get the feeling this project
could just up and die at any moment?”



In this part . . .

Fis Part of Tens distills information found in various
places throughout the book into lists of ten pithy
pointers for creating better reports. | recommend reading
Chapter 24 before you start each new report generation
project and also reading Chapter 25 when you’re wrapping
up a project. These guidelines will help you remember
something that you could do to improve your report.




Chapter 24

Ten Things to Do Before
You Create a Report

In This Chapter
Identifying and interviewing your users
Setting the report’s appearance, including graphics
Arbitrating conflicting demands
Nailing down the project’s scope and schedule
Verifying necessary data in the database
Determining how the report will be viewed

Determining the best report type for the users’ needs

Wth a great report-writing tool such as Crystal Reports, you might rea-
sonably assume that creating a report is an easy task that doesn’t

require much thought or effort. That would be a bad assumption. Creating
a high-quality report that truly meets users’ needs requires considerable
thought and effort even before you fire up Crystal Reports for the first time.
You should put thought and effort into at least these ten things before you
apply fingers to keyboard.

Identify the Users

Identifying the users might seem obvious, but it’s not as obvious as you
might think. Sure, the person who asked you to create the report is probably
someone who will use the report. But who else will benefit from using this
report? Other people in your client’s workgroup? Your client’s manager?
People in other workgroups or other departments? Perhaps even people

in other companies? Identifying all the probable users is important.
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Interview the Users

After you identify all the people who could benefit from your report, find out
what they need the report to tell them. What information should the report
contain? How should the information be presented? The only way to get the
complete answer is to interview at least one representative of each class of
user. However, interviewing them all is best. After all, what’s unimportant to
one class of users might be vital to another.

Get Agreement on the
Report’s Appearance

Users usually have strong preferences as to how they want information pre-
sented. Their idea of the ideal presentation might differ from what makes the
most sense to you. Make sure you develop a report that clearly presents
information that’s of interest to all the user communities. You might need to
create prototypes and hold meetings with all concerned parties as well as
negotiate with various user groups. Make sure that everyone will support
the report’s user interface before you put effort into developing it.

Arbitrate Conflicting Demands

When you have a diverse user community, almost certainly the needs of one
group or individual will conflict with the needs of another. For example,

one group might want the information presented in one format, while a
second group insists on receiving the information in a different format.
Someone has to find a compromise that’s acceptable to all parties. As a
neutral outside party, this arbitrator often turns out to be you.

Nail Down the Project Scope

After everyone agrees on what they want, get agreement on exactly what will
be included in the project. To make sure that the project doesn’t keep expand-
ing as you go along, get a signed agreement from the client on the project’s
scope. This agreement protects both the developer and the client. From the
beginning, everyone knows what will be delivered.



Chapter 24: Ten Things to Do Before You Create a Report 3 73

Nail Down the Project Schedule

After you know the project’s scope, estimate how long it will take you to com-
plete the project. Make sure you plan for adequate time to do a good job. If
the schedule is agreed to in advance, you have a solid defense against clients
who want you to speed up development so that they can have reports sooner.
Quality generally suffers when a reasonable schedule is accelerated.

Verify That the Necessary
Data Is in the Database

If you're going to build a report based on data in a database, it helps if the
data you need is actually in the database. Sometimes clients ask for a report
that their database can’t support because the data just isn’t there. You need
to verify with a database query that the data you need is indeed present.

Determine How the Report
Will Be Viewed

<MBER

Because you can view a report created in Crystal Reports in several ways,
start by determining the primary way your user community will view it. Will
users view it on a computer that’s connected to the database that the report
is based on? If so, they can refresh the data to get up-to-the-minute reports.
They can also drill down for detail and view the report, including charts and
maps, in color.

If users will be looking primarily at printed reports, they obviously can’t drill
down. Remember that the data in a report is but a snapshot of the data when
the report was printed, so it might not be up to date. Furthermore, if your
report is printed in black and white, color obviously won’t show up.

Design your report with your users in mind and optimize the report for the
best viewing.
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Determine the Best Report
Type for the Users’ Needs

Perhaps the best way to present your client’s data is a standard report or a
cross-tab report. Or, maybe an OLAP report. Based on the underlying data
and how users want it to be presented, choose the most appropriate report
type and then build the report based on that type.

Decide Whether to Include
Charts or Maps

Some types of reports can be immeasurably enhanced by the inclusion of
appropriate charts or maps. Charts present the data in a way that goes directly
to the viewer’s brain. Sometimes, columns of numbers just don’t have the same
effect. In those cases, adding charts or maps can be a good idea. In other cases,
using a chart won’t add to an understanding of the data — and might actually
obscure it. Evaluate each case individually to decide whether charts or maps
are appropriate.



Chapter 25

Ten Ways to Give Your
Reports More Pizzazz

In This Chapter
Use the correct fonts
Use color tastefully
Enclose text in boxes
Emphasize objects with drop shadows
Produce a consistent appearance with templates
Add an image
Add a chart
Add a map
Combine two objects with an underlay
Separate the summary from the details with drill down

ou say you want to make your reports more visually appealing? Crystal

Reports can help you do that. In this chapter, I mention ten simple ways
to help you lift your reports out of the category of ordinary into the rarified
atmosphere of truly extraordinary. You can give your reports maximum
impact by tastefully combining several of the techniques in this chapter.

Use the Correct Fonts

Beyond the bare facts presented in a report, you might also want your report
to convey a feeling or emotion. Perhaps you want the report to put the reader
in a sober, strictly business frame of mind. Or you might want the report to
playfully remind readers of things that are fun. You might want to call particu-
lar attention to certain parts of the report, while burying other parts in a way
that makes them easy to overlook. You can accomplish much of this with a
judicious choice of fonts.
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A wide variety of font styles are available, and you can use several in the same
report although you should try to avoid going overboard with too many font
styles. Three different styles are usually plenty. You can also vary the size of
the font, and whether it is bold, italic, or underlined. By combining all these
options, you can have your report project an image that enhances what the
bare words and numbers in the report have to say. It’s also a good idea to use
the most common fonts. The people reading your reports on their computers
may not have all the fonts available that you have on your development
machine.

Use Color Tastefully

Reports that are meant to be viewed on a computer screen can make use of

a full palette of color. So can reports that will be printed on a color printer.
Color capability makes it feasible to incorporate charts, maps, and graphical
images in your reports. You can use color to emphasize text elements or to
set off drawing elements, such as lines and boxes. You can even give different
sections their own unique background colors.

Use your imagination to think of ways to use color to enhance your reports.
Remember, however, to not overuse color effects. Make sure that any color

effects are appropriate to the material and what you'’re trying to communi-

cate. Don’t use multiple colors just because you can.

Enclose Text in Boxes

One way to make titles and important areas of text stand out is to enclose
them in boxes. Crystal Reports makes it easy to enclose text in a box. You
can give the box sharp or rounded corners, and you can give it any color
available on your palette. Boxes are a good way to call attention to text.

Emphasize Boxes with Drop Shadows

You can give a box (as described in the preceding section) even more empha-
sis by giving it a drop shadow. A drop shadow makes the box appear to come
out of the page in a 3-D effect. To get a drop shadow, just right-click the box
and choose Format Box. In the Format Editor dialog box that appears, select
the Drop Shadow option. When you click OK, the drop shadow appears on
your box.
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The drop shadow feature is available only with rectangular boxes. If you
round the corners of your box, the drop shadow feature is unavailable.

Produce a Consistent Appearance
with Templates

You can determine many of the formatting details of a report with a template.
Using a template also helps you to maintain consistency from one report to
the next. For example, you can have one template for one type of report and
another template for another type. Readers will become accustomed to
seeing information presented in a consistent way from one report to the next.

Add an Image

An old bromide says that a picture is worth a thousand words. Sometimes
that’s true, and sometimes it’s not. When a picture can help you get your
point across, use it. Crystal Reports makes it easy to insert graphical images
into your reports wherever you want them. You can use this capability for
corporate logos, photographs, drawings, or images of any kind.

Add a Chart

Numeric data presented in tabular form conveys the facts but often doesn’t
clearly show trends or relationships among data items. Charts, whether they
are line charts, bar charts, pie charts, or some other kind, can show trends
and relationships clearly. When trends or relationships in data are important,
by all means use a chart to bring out that point and hammer it home.

Add a Map

For some kinds of reports, it’s important to show readers where things are. If
your data has anything to do with geographical locations, such as sales terri-
tories or political boundaries, the Crystal Reports mapping facility can make

your report much more valuable. Maps cover the entire globe, showing coun-
tries as well as individual states and provinces.
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Combine Two Objects with an Underlay

You can give your report a watermark effect by underlaying words or symbols
in a light font beneath the main text of your report. You can also use this
facility to position a chart or map next to the text that it refers to rather than
above or below it. For example, with an underlay, you might line up a chart
with the detail section that contains the data from which the chart is drawn.

Separate the Summary from
the Details with Drill Down

The drill-down facility in Crystal Reports makes use of the fact that more and
more people view reports on their computer screens rather than read them
on paper. Drill-down capability allows viewers to interact with the report,
viewing detail when they want to see it and skimming past it when they don’t.
A person can quickly get the gist of what they want from the report and then
move on to make decisions based on what they’ve learned.
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Numerics ®

() (parentheses), in functions, 173

“..” (double quotes), enclosing character
strings, 183

#...# (pound signs), enclosing datetime
literals, 184

‘... (single quotes), enclosing character
strings, 183

3-D riser charts, 271

3-D surface charts, 272

80/20 rule, 149

o/ o

absolute formatting. See also conditional
formatting
definition, 10
graphical elements, 128-130
rounded boxes, 129-130
undoing, 124
absolute formatting, fonts
adding to a report, 126-128
appropriate style, 125
color, 125
continuity, 125
examples, 126
readability, 124
size, 125
variety, 125
viewer availability, 124-125, 127
Adobe Flash. See Flash
Adobe PDF, exporting reports to, 332
Advanced layout maps, 284, 286-288
Alexander, Michael, 295
aliases for OLAP report dimensions,
235-236
All option, 164

animation. See Flash visualizations

Another Report Object method,
319, 325-326

applets, 217

application services, 309

applications, exporting reports to, 334-337

area charts, 269-270

arguments in formulas, 168

Arrange Lines option, 104

array data types, 184-185

ascending sort order, 76

attributes, database, 19

audience definition, 37-38

authorizing online viewers, 349

automatic report distribution, 308

axes, charts, 261

Axes tab, 261

ol e

backing up your data, 353
banded paper, simulating, 109-110, 111
bar chart maps, 286
barcode generator, 11, 114-116
bins, map, 284-285
bitmapped objects, storing, 313
Blank Report option
company logo, 25-26
connecting to a database, 21-22
date printed, 32-34
descriptive information, 34-35
Details section, 23, 27-29
field width issues, 30-32
Page Footer, 32-34
Page Header, 23, 29
page numbers, 32-34
previewing the report, 30-32
Report Footer, 23, 34
Report Header, 23, 25-27
report sections, 23
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Blank Report option (continued)
report title, 26-27, 32-34
unwanted commas, 30-31
width, setting, 24

books and publications
Crystal Xcelsius For Dummies, 295
SQL All-in-One Desk Reference For

Dummies, 52
SQL For Dummies, 6th Edition, 52

Boolean data types, 184

Bottom Percentage option, 165

boxes
around text, 102, 376
drop shadows, 376-377
rounded corners, 129-130

bubble charts, 273-274

Business Views, 306

BusinessObjects Enterprise Repository
automatic report update, 317
bitmapped objects, storing, 313
custom functions, 313-315
deleting objects, 318
folders, adding, 312
image objects, in reports, 314-315
overview, 311-312
SQL commands, 314-315
stored objects, modifying, 315-316
text objects, 313-315
viewing reports, 320

oo

calculations
cross-tab reports, 255-256
OLAP reports, 243
case conversion, character strings, 183

CCM (central configuration manager), 309

cells, cross-tab reports, 256-257
central management console (CMC), 309
character strings

case conversion, 183

data type, 183

enclosing in quotes, 183

parser, 183

string data types, 183

string parser, 183

Chart Expert
Axes tab, 261
Color Highlight tab, 263
Data tab, 260-261
Options tab, 262
Text tab, 263
Type tab, 260

charts
axes, formatting, 261
changing, 267
color, 262
color highlights, 263
creating, 263-266
Crystal Reports features, 11
data, selecting, 260-261, 281-282
data point labels, 262
default fonts, setting, 138
drilling down, 266
evaluating the need for, 274, 377
gridlines, 261
layout, for data types, 278-279
layout, specifying, 260-261
legends, 262
OLAP reports, 228
placement, effects on data, 280, 282
text format, 263
titles, 263
transparent background, 262
troubleshooting, 281-282
type, selecting, 260

charts, types of
3-Driser, 271
3-D surface, 272
area, 269-270
bubble, 273-274
doughnut, 270-271
funnel, 277
Gantt, 276-277
gauge, 276
histogram, 278
line, 268-269
numeric axis, 275-276
percent bar, 268
pie, 270
radar, 273
side-by-side bar, 267-268
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stock, 274-275
XY scatter, 272-273
clauses, in formulas, 168
CMC (central management console), 309
color
banded paper simulation, 108-110
charts, 262-263
fonts, 125
OLAP report background, 234-235
report section backgrounds, 107-110
tasteful use of, 376
Color Highlight tab, 263
Color tab, 107-110
columns
cross-tab reports, 255-257
database, 19
OLAP reports, 228-230
combining objects, 378
combining reports. See subreports
Comma Separated Values (CSV), exporting
reports to, 334
commas, unwanted, 30-31
Common tab, 105-106
conditional formatting. See also absolute
formatting
adding to a report, 130-132
definition, 10
Format Editor, 130-132
with formulas, 11, 106
highlighting, 132-134
Highlighting Expert, 132-134
report sections, 106
connecting to databases. See databases,
connecting to
container applications (OLE), 207
container documents (OLE), 207
content, choosing, 39
continuity, fonts, 125
control structures
Default clause, 187
Do While, 189
If-Then-Else, 186-187
For, 187-188
Select Case, 187

creating
charts, 263-266
custom formulas, 169-173. See also
Formula Workshop
functions, 169-173
SQL statements, 363-366
SWF files, 295-298
creating maps
Advanced layout, 286-288
Cross-Tab layout, 289-291
Group layout, 288-289
creating reports. See also Report Creation
Wizard
data summaries. See cross-tab reports;
OLAP reports
from existing reports, 50
grouped by performance. See Top N
Reports
mailing labels, 117-120
from scratch. See Blank Report option
Cross-Tab layout maps, 284, 289-291
Cross-tab Report Wizard, 49
cross-tab reports. See also OLAP reports
calculations, 255-256
cells, width and height adjustment,
256-257
columns, 255-257
creating, 245-249
fields, formatting, 257-258
formatting, 256-258
printing, 258
purpose of, 245
readability, 256-258
rows, 255-257
summarizing groups, 249-255
suppressing selected data, 258
Crystal Reports
definition, 9
development environment, 320
editions, 13
feature summary, 10-13
native format (. rpt), 12
starting, 18-19
Crystal Reports Desktop Publisher, 351-353
Crystal Reports Developer, 307
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Crystal Reports Server
application services, 309
Business Views, 306

CCM (central configuration manager), 309
CMC (central management console), 309

components, 305
connecting to data sources, 306
Crystal Reports Developer, 307
distributing reports, 307-308
formatting reports, 307
InfoView, 310
management tools, 309
publishing reports, 307-308
security, 308
system management, 308-309
viewing reports, 310
Web services, 309-310

Crystal Reports Viewer
e-mailing reports, 360
exporting to alternate formats, 360
hidden sections, viewing, 358
isolating report extracts, 359
moving to specific sections, 357
navigating reports, 355-359
opening a report, 354
overview, 354
paging through reports, 355-357
printing a report, 359
resizing the view, 359
searching, 361

Crystal Xcelsius
adding to reports, 294-299
Crystal Xcelsius For Dummies, 295
overview, 293-294

Crystal Xcelsius, Flash visualizations
dynamic interaction, 300-302
SWF files, creating, 295-298
viewing, 300

Crystal Xcelsius For Dummies, 295

crystalreports.com, 349-350, 351-353,

361-362

CSV (Comma Separated Values), exporting

reports to, 334
currency data types, 183

custom functions
checking, 138
from the Repository, 315
storing in the Repository, 313-314

o) e

data mining. See cross-tab reports; OLAP
(On-Line Analytical Processing)
data sources. See databases
Data tab, 260-261
data types
arrays, 184-185
Boolean, 184
currency, 183
data, 183-184
date, 183-184
datetime, 183-184
definition, 168
numbers, 182-183
ranges, 184
simple types, 182-184
sorting, 76
string, 183
time, 183-184
data visualization. See Crystal Xcelsius
Database tab, 137
databases
attributes, 19
columns, 19
definition, 19
fields, 19
records, 19
relational, 19
rows, 19
sample, 18
supported by Crystal Reports, 13
tables, 19
views, customizing, 137-138
Xtreme Mountain Bikes database, 18
xtreme .mdb database, 18, 21
databases, connecting to
choosing an interface, 53-54
Crystal Reports Server, 306
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direct access interface, 51
guidelines for, 53-54
IT managers, 53-54
ODBC (Open Database Connectivity)
sources, 51-52
OLE DB providers, 53
xtreme.mdb, 21-22
databases, extracting data. See also SQL
database queries
with formulas, 64-66
indexing the data, 72
missing data, 73-74
modifying extracted data, 62-64, 70-73
with parameter fields, 66-73
retrieval keys, 72
at runtime, 66-73
Select Expert, 57-64
selective retrieval, 72
slow extraction, 73-74
troubleshooting, 73-74
unwanted data, 73-74
date data types, 183-184
date printed, 32-34
datetime data types, 183-184
decision support tool. See Crystal Xcelsius
declaring variables, 185-186
Default clause, 187
Delete Last Line option, 104
deleting
formulas, 182
report section guidelines, 104
Repository objects, 318
Dependency Checker tab, 138
descending sort order, 76
descriptive report information, 34-35. See
also report metadata
Design mode, customizing, 137
designing reports
audience definition, 37-38
choosing content, 39
frequency of publication, 38-39
important factors, 37-38
report purpose, 38-39

designing reports, appearance
first impressions, 40
fonts, 42
formatting the report, 40
graphic elements, 41
page layout, 42
presenting information, 40
readability, 42
reinforcing your message, 42
style, as communication, 41-42
designing reports, preparation for
charts and maps, evaluating need for, 374
conflicting demands, resolving, 372
data availability, verifying, 373
project scope, setting, 372
report appearance, agreeing on, 372
report type, selecting, 374
schedule, estimating, 373
users, identifying, 371
users, interviewing, 372
viewing mode, determining, 373
destination objects, 321
details, displaying. See drilling down
Details section, 23, 27-29
dimensions, OLAP reports
aliases for, 235-236
background colors, 234-235
labeling, 237-238
showing/hiding, 239-240
slicing and dicing, 222, 226-228
direct access database interface, 51
disk files, exporting reports to, 337-338
displaying reports online. See also Crystal
Reports Viewer
authorizing viewers, 349
backing up your data, 353
closing the report, 16
Crystal Reports Desktop Publisher,
351-353
crystalreports.com, 349-350, 351-353,
361-362
displaying details. See drilling down
failed upload attempts, 353
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displaying reports online (continued)
following hyperlinks, 14
hyperlinks, 346-348
interactive viewing, 354-362
LAN (local area network), 16
loss of formatting, 345
versus paper reports, 14
passwords, 352
publishing reports, 307-308
salesforce.com, 350-351
scrolling the report, 16
selecting a report, 15
starting Crystal Reports, 14
static HTML pages, 344-346
Web site, 16
distributing reports
See also displaying reports online
See also exporting reports
See also faxing reports
See also printing reports
Crystal Reports Server, 307-308
selected elements. See Report Parts
Do While, 189
Domino, exporting reports to, 339
Domino Mail, exporting reports to, 339
dot-density maps, 285
double quotes (“...”), enclosing character
strings, 183
doughnut charts, 270-271
drilling down
adding to reports, 92-95
charts, 266
enabling/disabling, 103, 105, 113-114
OLAP reports, 230-232
online reports, 14
reports, 196-197
subreports, 196-197
tab overflow, 197

oF o

e-mailing reports, 360
embedding
external objects in reports. See OLE
(Object Linking and Embedding);
Shockwave Flash objects
versus linking, 215
equal-count bins, 284-285

equal-range bins, 285
error warnings. See Report Alerts
Excel, exporting reports to, 333-337
Exchange folder, exporting reports to,
338-339
exporting reports
from Crystal Reports Viewer, 360
formatting loss, 332
troubleshooting, 342
exporting reports, destinations
applications, 334-337
disk files, 337-338
Excel, 334-337
HTML, 340-341
Lotus Domino, 339
Lotus Domino Mail, 339
MAPI, 340
Microsoft Exchange folder, 338-339
ODBC data source, 341
static HTML pages, 344-346
XML file, 341
exporting reports, format types
CSV (Comma Separated Values), 334
Excel, 333
HTML 3.2, 332
HTML 4.0, 332
ODBC, 333
page-based, 331-332
PDF, 332
record style, 333
record-based, 331-332
RPT, 332
RTF (Rich Text Format), 333
summary of, 332
text, 334
TTX (Tab Separated Text), 334
Word, 333
XML, 334
expressions, checking, 138

ofF e

faxing reports, 330-331, 342
fields
cross-tab reports, 257-258
customizing, 138
database, 19
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default fonts, setting, 138
width issues, 30-32
Fields tab, 138
filtering data, OLAP reports, 243
first impressions, 40
Fit Section option, 104
Flash integration, 12
Flash visualizations
dynamic interaction, 300-302
SWF files, creating, 295-298
viewing, 300
fonts
adding to a report, 126-128
appropriate style, 125
artistic choices, 375
color, 125
continuity, 125
defaults, setting, 138
examples, 126
readability, 124
in report design, 42
size, 125
variety, 125
viewer availability, 124-125, 127
Fonts tab, 138
For Loop, 187-188
Format Editor, 130-132, 233
formatting
chart axes, 261
formulas, 181-182
formatting, absolute
definition, 10
fonts, 124-128
graphical elements, 128-130
rounded boxes, 129-130
undoing, 124
formatting, conditional
adding to a report, 130-132
definition, 10
Format Editor, 130-132
with formulas, 11, 106
highlighting, 132-134
Highlighting Expert, 132-134
report sections, 106
formatting reports
cross-tab reports, 256-258
Crystal Reports Server, 307
custom functions for, 11

designing formats, 40
formulas for, 11, 106
loss during export, 332, 345
OLAP reports, 232-238
Options dialog box, 137-138
formatting reports, Section Expert. See
also Section Formatting menu
Color tab, 107-110
Common tab, 105-106
Hide (Drill-Down OK) option, 105
Keep Together option, 105
Paging tab, 106-107
Print at Bottom of Page option, 105
Suppress Blank Section, 105
Suppress (No Drill-Down) option, 105
Underlay Following Sections, 105
formatting reports, Section Formatting
menu. See also Section Expert
Arrange Lines option, 104
Delete Last Line option, 104
Fit Section option, 104
Hide (Drill-Down OK) option, 103, 113-114
Insert Line option, 103
Insert Section Below option, 104
Select All Section Objects, 104
Show Long Section Names... option, 103
Suppress (No Drill-Down) option,
103, 113-114
forms, aligning text in, 136
Formula Editor, 173-174
Formula Editor icon, 106
Formula Editor tab, 138
Formula Expert, 175-177
Formula Workshop
creating custom formulas, 169-173
deleting formulas, 182
formatting formulas, 181-182
formatting OLAP reports, 233
Formula Editor, 173-174
Formula Expert, 175-177
functions, 169-173
modifying formulas, 182
SQL Expression Editor, 180
formulas
arguments, 168
changing, 182
checking, 138
clauses, 168
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formulas (continued)
in conditional formatting, 11, 106
creating custom. See Formula Workshop
database extraction, 64—66
deleting, 182
formatting, 181-182
formatting reports, 11, 106
Formula Expert, 175—177
group selection, 177-179
parameters, 168
record selection, 178-180
saved data selection, 178
selection, 177-180
syntax, 168
uses for, 167-168
formulas, control structures
Default clause, 187
Do While, 189
If-Then-Else, 186-187
For, 187-188
Select Case, 187
formulas, data types
arrays, 184-185
Boolean, 184
currency, 183
data, 183-184
datetime, 183-184
definition, 168
numbers, 182-183
ranges, 184
simple types, 182-184
sorting, 76
string, 183
time, 183-184
formulas, functions
() (parentheses), 173
combining with operators, 170
creating, 169-173
definition, 168
dragging and dropping, 172
formula editor, 173-174
Formula Workshop, 169-173
naming conventions, 170
predefined, 168-169

types of, 171
typing, 172
wrapping in formulas, 173-174
formulas, operators
combining functions with, 170
definition, 168
dragging and dropping, 172
types of, 171
typing, 172
formulas, variables
assigning values to, 186
declaring, 185-186
definition, 168
global, 185
local, 185
naming conventions, 186
shared, 186
frequency of publication, 38-39
functions
() (parentheses), 173
combining with operators, 170
creating, 169-173
definition, 168
dragging and dropping, 172
formula editor, 173-174
Formula Workshop, 169-173
naming conventions, 170
predefined, 168-169
types of, 171
typing, 172
wrapping in formulas, 173-174
funnel charts, 277

oG o

Gantt charts, 276-277

gauge charts, 276

global variables, 185

graduated maps, 285

graphic elements
absolute formatting, 128-130
designing the report, 41
image formats, OLE, 208
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inserting in reports, 208-210

pictures in reports, 134-135, 377
graphs (charts)

axes, formatting, 261

changing, 267

color, 262

color highlights, 263

creating, 263-266

Crystal Reports features, 11

data, selecting, 260-261, 281-282

data point labels, 262

default fonts, setting, 138

drilling down, 266

evaluating the need for, 274, 377

gridlines, 261

layout, for data types, 278-279

layout, specifying, 260-261

legends, 262

OLAP reports, 228

placement, effects on data, 280, 282

text format, 263

titles, 263

transparent background, 262

troubleshooting, 281-282

type, selecting, 260
graphs (charts), types of

3-Driser, 271

3-D surface, 272

area, 269-270

bubble, 273-274

doughnut, 270-271

funnel, 277

Gantt, 276-277

gauge, 276

histogram, 278

line, 268-269

numeric axis, 275-276

percent bar, 268

pie, 270

radar, 273

side-by-side bar, 267-268

stock, 274-275

XY scatter, 272-273

gridlines, in charts, 261. See also
guidelines, in report sections
grids, OLAP reports
calculations, 243
filtering data, 243
grid lines, 236-237
grid structure, 226
overview, 222
pivoting, 240-241
reordering fields, 241-242
sorting data, 242-243
totals, 240
Group layout maps, 284, 288-289
group selection formulas, 177-179
groups of items
description, 85-89
invisible objects, 165
placing, 110-113
restarting page numbering, 106-107, 113
starting on new page, 110-112
subtotals for, 165
troubleshooting, 98-99
groups of items, sorting
All option, 164
based on performance. See Top N
Reports
Bottom Percentage option, 165
groups within groups, 85-89
invisible objects, 165
No Sort option, 164
subtotals for groups, 165
Top Percentage option, 164
troubleshooting, 165
guidelines, in report sections. See also
gridlines, in charts
adding, 103
arranging, 104
deleting, 104

o/ o

height, report sections, 101-102
Hide (Drill-Down OK) option,
103, 105, 113-114
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Highlighting Expert, 132-134, 233 logos, in reports, 25-26
histogram charts, 278 loops
horizontal lines, in report sections, Default clause, 187
102-103 Do While, 189
HTML, exporting reports to, 332, 340-341 If-Then-Else, 186-187
hyperlinks. See also linking For, 187-188
following, 14 Select Case, 187
in online reports, 346-348 Lotus Domino, exporting reports to, 339
Report Part Drill-Down, 323-325 Lotus Domino Mail, exporting reports
to, 339

o]e

icons, in this book, 4

ol o

If-Then-Else, 186-187 Mailing Label Report Wizard, 117-120
image formats, OLE, 208 mailing labels, creating, 117-120
images in reports. See graphic elements mailings, sorting by ZIP code, 120-121
indexing databases, 72 management tools, 309
InfoView, 310 MAPI, exporting reports to, 340
Insert Line option, 103 maps
Insert Section Below option, 104 Advanced layout, 284
interactive online viewing, 354-362 changing, 291
invisible group objects, 165 Cross-Tab layout, 284
IT managers, database guidelines, 53-54 Crystal Reports features, 11
evaluating the need for, 274, 377
PY K PY Group layout, 284
layouts, 284
Keep Together option, 105 OLAP layout, 284
placement, 286
PY L °® in subreports, 291

troubleshooting, 291-292

labeling OLAP report dimensions, 237-238 ~ Maps, creating

LAN (local area network), reading reports Advanced layout, 286-288
on, 16 Cross-Tab layout, 289-291

Layout tab, 137 Group layout, 288-289
legends, charts, 262 maps, types of

line charts, 268269 bar chart, 286
linking. See also hyperlinks bins, 284,_285
drill-down objects, 321-326 dot-density, 285

versus embedding, 215 equal-count bins, 284-285

external objects to reports. See OLE equal-range bins, 285
(Object Linking and Embedding); graduated, 285
Shockwave Flash objects natural break bins, 285

b ts t i ts, pie chart, 285
su 11;)87[1(;1638 2%é)r1mary reports ranged’ 984985

local variables. 185 standard deviation bins, 285



Index 389

Microsoft Excel, exporting reports to,
333-337

Microsoft Exchange folder, exporting
reports to, 338-339

Microsoft Word, exporting reports to, 333

multidimensional OLAP views, 220-221

o\ o

naming conventions
functions, 170
variables, 186
natural break bins, 285
navigating a report, 320-326
navigation. See Report Parts
nested sorts, 77-81
No Sort option, 164
null values, sorting, 77
number data types, 182-183
numeric axis charts, 275-276
numeric summaries, 159

o () o

Object Linking and Embedding (OLE). See
OLE (Object Linking and Embedding)
ODBC (Open Database Connectivity)
sources

connecting to, 51-52
exporting reports to, 333, 341

OLAP Cube Report Wizard, 49

OLAP Expert, 233

OLAP layout maps, 284

OLAP (On-Line Analytical Processing)
audience for, 220
connecting to a data source, 221, 222
direct connection, 221
multidimensional views, 220-221
Open OLAP gateway, 221
overview, 219-220

OLAP reports. See also cross-tab reports
charts, generating, 228
column widths, adjusting, 228-230
data source, specifying, 223-225
drilling down, 230-232
formatting, 232-238

generating, 228
pages, adding, 226-228
styles, predefined, 228
totals, 240
updating, 232-233
OLAP reports, dimensions
aliases for, 235-236
background colors, 234-235
labeling, 237-238
showing/hiding, 239-240
slicing and dicing, 222, 226-228
OLAP reports, grids
calculations, 243
filtering data, 243
grid lines, 236-237
grid structure, 226
overview, 222
pivoting, 240-241
reordering fields, 241-242
sorting data, 242-243
totals, 240
OLE DB providers, 53
OLE (Object Linking and Embedding). See
also cross-tab reports
container applications, 207
container documents, 207
embedded objects, 212-214, 217
graphic images, inserting, 208-210
image formats, 208
linked objects, 214-217
linking versus embedding, 215
overview, 207-208
server applications, 207
static objects, editing, 210-211
static objects, inserting, 208-210
on-demand subreports, 203-204
On-Line Analytical Processing (OLAP). See
OLAP (On-Line Analytical Processing)
Open Database Connectivity (ODBC)
sources
connecting to, 51-52
exporting reports to, 333, 341
Open OLAP gateway, 221
operators
combining functions, 170
definition, 168
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operators (continued)
dragging and dropping, 172
types of, 171
typing, 172
Options dialog box, 137-138
Options tab, 262
output
See displaying reports online
See exporting reports
See faxing reports
See printing reports
See publishing reports
See Report Parts
overlaying report sections, 105

opPe

page breaks
preventing, 105
removing, 157-159
Page Footer, 23, 32-34
Page Header, 23, 29
page layout, designing, 42
page numbering, resetting for each group,
106-107, 113
page numbers, 32-34
page viewer, 321
page-based export format, 331-332
Paging tab, 106-107
parameter fields, database extraction,
66-73
parameters, in formulas, 168
parentheses (()), in functions, 173
Pareto Principle, 149
passwords, online reports, 352
PDF, exporting reports to, 332
percent bar charts, 268
percentages
calculating, 89-90
grouping by, 160-163, 164, 165
performance
grouping reports by. See Top N Reports
sorting, 81-82
pictures in reports. See graphic elements
pie chart maps, 285

pie charts, 270
pivoting OLAP report grids, 240-241
postage, sorting by ZIP code, 120-121
pound signs (#...#), enclosing datetime
literals, 184
predefined functions, 168-169
preprinted forms, aligning text in, 136
Preview mode, customizing, 137
previewing the report, 30-32
Print at Bottom of Page option, 105
printing reports
basic method, 229-230
cross-tab reports, 258
from Crystal Reports Viewer, 359
reading reports on paper, 13-14
Report Footer, 105
running totals, 99, 112-113
troubleshooting, 342
publishing reports
See also displaying reports online
See also exporting reports
See also faxing reports
See also printing reports
automatic distribution, 308
Crystal Reports Server, 307-308
Publishing Wizard, 307-308
scheduled distribution, 308
selected elements. See Report Parts

o R o

radar charts, 273
range data types, 184
ranged maps, 284-285
RAS (Report Application Server), 321
readability
cross-tab reports, 256-258
designing for, 42
fonts, 124
page headers, 29
reading reports
See displaying reports online
See exporting reports
See faxing reports
See printing reports



Index 39 1

record selection formulas, 178-180
record style, export format, 333
record-based export format, 331-332
records, database, 19
reinforcing your message, 42
relational databases, 19
Report Alerts
definition, 139
message, composing, 139-141
trigger condition, specifying, 141-142
Report Creation Wizard
Cross-tab Report Wizard, 49
Mailing Label Report Wizard, 49
OLAP Cube Report Wizard, 49
Standard Report Creation Wizard, 43-49
Report Footer
contents of, 34
definition, 23
printing at bottom of page, 105
Report Header, 23, 25-27
report metadata, 139
report objects, storing. See BusinessObjects
Enterprise Repository
Report Parts
Another Report Object method,
319, 325-326
BusinessObjects Enterprise
Repository, 320
Crystal Reports development
environment, 320
destination objects, 321
hyperlinks, 323-325
linking objects, 321-326
navigating a report, 320-326
overview, 319-320
page viewer, 321
RAS (Report Application Server), 321
Report Parts Drill-down method,
319, 321-325
viewers, 320
viewing reports, 320
zero-client, server-side viewer, 321
Report Parts Drill-down method, 319,
321-325

report sections

background color, 107-110

banded colors, 108-110

blank sections, suppressing, 105

boxes around text, 102

company logo, 25-26

conditional formatting, 106

date printed, 32-34

Details, 23, 27-29

different colors for, 108

drilling down, enabling/disabling,
103, 105, 113-114

fitting fields to content, 28

fitting section to content, 104

formulas, for conditional formatting, 106

grouping related items. See groups
of items

guidelines, 103-104

height, setting, 101-102

horizontal lines, 102-103

inserting sections, 104

overlaying sections, 105

page breaks, preventing, 105

Page Footer, 23, 32-34

Page Header, 23, 29

page numbers, adding, 32-34

page numbers, resetting for each group,
106-107, 113

Report Footer, 23, 34, 105

Report Header, 23, 25-27

report title, 26-27, 32-34

selecting fields for, 27-29

selecting section objects, 104

toggling long/short section names, 103

vertical spacing, setting, 101-102

watermarks, 105

width, setting, 101-102

report sections, Section Expert

Color tab, 107-110

Common tab, 105-106

Hide (Drill-Down OK) option, 105

Keep Together option, 105

Paging tab, 106-107

Print at Bottom of Page option, 105

Suppress Blank Section, 105
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report sections, Section Expert (continued)
Suppress (No Drill-Down) option, 105
Underlay Following Sections, 105
report sections, Section Formatting
menu. See also report sections,
Section Expert
Arrange Lines option, 104
Delete Last Line option, 104
Fit Section option, 104
Hide (Drill-Down OK) option, 103, 113-114
Insert Line option, 103
Insert Section Below option, 104
Select All Section Objects, 104
Show Long Section Names... option, 103
Suppress (No Drill-Down) option,
103, 113-114
report title, 26-27, 32-34
Reporting tab, 138
reports. See also specific items
appearance. See designing reports;
formatting reports
definition, 9
linking external objects. See OLE
(Object Linking and Embedding);
Shockwave Flash objects
passing data between, 204-205
previewing, 30-32
printing. See printing reports
purpose, determining, 38-39
reading
See displaying reports online
See exporting reports
See faxing reports
See printing reports
within reports. See subreports
sections, 23
reports, embedding/linking OLE objects
container applications, 207
container documents, 207
embedded objects, 212-214, 217
graphic images, inserting, 208-210
image formats, 208
linked objects, 214-217
linking versus embedding, 215
overview, 207-208
server applications, 207

static objects, editing, 210-211
static objects, inserting, 208-210
reports, embedding/linking Shockwave
Flash objects, 217-218
reports, extracting selected parts
Another Report Object method,
319, 325-326
BusinessObjects Enterprise
Repository, 320
Crystal Reports development
environment, 320
destination objects, 321
hyperlinks, 323-325
linking objects, 321-326
navigating a report, 320-326
overview, 319-320
page viewer, 321
RAS (Report Application Server), 321
Report Parts Drill-down method,
319, 321-325
viewers, 320
viewing reports, 320
zero-client, server-side viewer, 321
reports, sorting
ascending order, 76
custom controls, 82-85
data types, 76
descending order, 76
grouping related items. See sorting
groups of items
on multiple fields, 77-81
nested sorts, 77-81
null values, 77
OLAP, 242-243
performance, 81-82
running totals, 97
troubleshooting, 98
by ZIP code, 120-121
repository for report objects. See
BusinessObjects Enterprise
Repository
rounded boxes, 129-130
rows
cross-tab reports, 255-257
database, 19
RPT, export format, 332



. rpt file extension, 12

RTF (Rich Text Format), exporting reports
to, 333

running totals, 94-97

runtime database extraction, 66-73

oS e

salesforce.com, 350-351
sample database, 18
saved data selection formulas, 178
scheduled report distribution, 308
searching with Crystal Reports Viewer, 361
Section Expert. See also Section
Formatting menu
Color tab, 107-110
Common tab, 105-106
Hide (Drill-Down OK) option, 105
Keep Together option, 105
Paging tab, 106-107
Print at Bottom of Page option, 105
Suppress Blank Section, 105
Suppress (No Drill-Down) option, 105
Underlay Following Sections, 105
Section Formatting menu. See also Section
Expert
Arrange Lines option, 104
Delete Last Line option, 104
Fit Section option, 104
Hide (Drill-Down OK) option, 103, 113-114
Insert Line option, 103
Insert Section Below option, 104
Select All Section Objects, 104
Show Long Section Names... option, 103
Suppress (No Drill-Down) option,
103, 113-114
security, 308
Select All Section Objects, 104
Select Case, 187
Select Expert, 57-64
selecting section objects, 104
selection formulas, 177-180
selective database retrieval, 72
server applications (OLE), 207
shared variables, 186, 204-205

Shockwave Flash objects in reports,
217-218. See also SWF files
Show Long Section Names... option, 103
side-by-side bar charts, 267-268
simple data types, 182-184
single quotes (‘..."), enclosing character
strings, 183
slicing and dicing OLAP report dimensions,
222, 226-228
Smart Tag & HTML Preview tab, 138
smart tags, 138
sorting groups of items
All option, 164
based on performance. See Top N
Reports
Bottom Percentage option, 165
groups within groups, 85-89
invisible objects, 165
No Sort option, 164
subtotals for groups, 165
Top Percentage option, 164
troubleshooting, 165
sorting reports
ascending order, 76
custom controls, 82-85
data types, 76
descending order, 76
grouping related items. See sorting
groups of items
on multiple fields, 77-81
nested sorts, 77-81
null values, 77
OLAP, 242-243
performance, 81-82
running totals, 97
troubleshooting, 98
by ZIP code, 120-121
SQL, origin of the term, 220
SQL All-in-One Desk Reference For
Dummies, 52
SQL commands, 314-315
SQL database queries
data extraction, 52
description, 52
nonprocedural nature of, 52
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SQL database queries (continued)
SQL All-in-One Desk Reference For
Dummies, 52
SQL For Dummies, 6th Edition, 52
SQL programmers, 53-54
SQL Expression Editor, 180
SQL For Dummies, 6th Edition, 52
SQL programmers, database guidelines,
53-54
SQL statements
creating, 363-366
modifying, 366-367
standard deviation maps, 285
Standard Report Creation Wizard,
43-49, 145-146
static HTML pages, 344-346
static OLE objects
editing, 210-211
inserting, 208-210
stock charts, 274-275
string data types, 183. See also
character strings
string parser, 183
style, as communication, 41-42
styles, predefined, 228
subreports
drilling down, 196-197
embedding below a report, 192-195
embedding beside a report, 195-196
linking to primary reports, 197-203, 205
maps in, 291
on-demand, 203-204
passing data between, 204-205
shared variables, 204-205
troubleshooting, 205
underlay formatting, 195-196
unlinked, 203
subtotals, 99
subtotals for groups, 165
summaries. See totals
Summarization icon, 159
summarizing groups, cross-tab reports,
249-255
summary fields, 159
summary reports, 155-157. See also cross-
tab reports; OLAP reports

Suppress Blank Section, 105

Suppress (No Drill-Down) option,
103, 105, 113-114

SWF files, creating, 295-298. See also
Shockwave Flash objects

system management, 308-309

oJ e

tab overflow, 197
Tab Separated Text (TTX), exporting
reports to, 334
tables, database, 19
Template Expert, 10
templates
applying to a report in progress,
145-146
applying to an existing report, 143-145
for consistent appearance, 377
definition, 143
in the Standard Report Creation Wizard,
145-146
text
adding from a file, 136-137
aligning in forms, 136
boxes around, 102, 376
in charts, 263
exporting reports to, 334
text objects
default fonts, setting, 138
from the Repository, 314-315
storing in the Repository, 313
text summaries, 159
Text tab, 263
3-D riser charts, 271
3-D surface charts, 272
time data types, 183-184
titles
charts, 263
report, 26-27, 32-34
Top N Reports
adjusting the report, 152-154
creating the report, 150-152
displaying group totals, 154-155
hiding details, 155-157



line spacing, adjusting, 163
numeric summaries, 159
by percentages, 160-163
removing page breaks, 157-159
summaries, types of, 159
Summarization icon, 159
summary reports, 155-157
text summaries, 159
for a variable N, 161-163
Top Percentage option, 164
totals, OLAP reports, 240
totals, running
collecting, 94-97
printing, 99, 112-113
sorting, 97
subtotals, 99
troubleshooting, 99
transparent background, charts, 262
troubleshooting
charts, 281-282
database extraction, 73-74
exporting reports, 342
group sorts, 165
grouping, 98-99
maps, 291-292
running totals, 99
sorting, 98
subreports, 205
TTX (Tab Separated Text), exporting
reports to, 334
Type tab, 260

o lf o

Underlay Following Sections, 105
underlay formatting
combining objects, 378
subreports, 195-196
undoing absolute formatting, 124
unlinked subreports, 203
unwanted commas, 30-31
updating OLAP reports, 232-233
uploads, failed attempts, 353

oo

variables
assigning values to, 186
declaring, 185-186
definition, 168
global, 185
local, 185
naming conventions, 186
shared, 186
vertical spacing, report sections,
101-102
video. See Flash visualizations
viewers for reports. See also Crystal
Reports Viewer
BusinessObjects Enterprise Web
desktop, 320
Crystal Reports development
environment, 320
Crystal Reports Server, 310
Report Parts, 320
zero-client, server-side viewer, 321
viewing reports
See displaying reports online
See exporting reports
See faxing reports
See printing reports

o[/ o

warnings, report errors. See Report
Alerts
watermarks, 105
Web, reading reports on. See displaying
reports online
Web services, 309-310
What-if scenarios, 12
width
cross-tab cells, 256-257
OLAP columns, 228-230
report fields, 24, 30-32
report sections, 101-102
wizards
Cross-tab Report, 49
Mailing Label Report, 117-120
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wizards (continued

OLAP Cube Report, 49

Publishing, 307-308

Report Creation, 43-49

Standard Report Creation, 43-49, 145-146
Word, exporting reports to, 333

o X o
Xcelsius. See Crystal Xcelsius
XML, exporting reports to, 334, 341

Xtreme Mountain Bikes database, 18
xtreme .mdb database, 18
XY scatter charts, 272-273

o/ o

zero-client, server-side viewer, 321
ZIP code, sorting by, 120-121
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